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Preface

This preface describes the purpose, audience, organization, and conventions of this guide, and provides 
information on how to obtain related documentation.

The preface covers these topics:

• Purpose, page xvii

• Audience, page xvii

• Organization, page xvii

• Related Documentation, page xix

• Conventions, page xix

• Obtaining Documentation, page xx

• Documentation Feedback, page xxi

• Cisco Product Security Overview, page xxi

• Obtaining Technical Assistance, page xxiii

• Obtaining Additional Publications and Information, page xxiv

Purpose
The Cisco Unified CallManager Bulk Administration Guide provides instructions for using the Bulk 
Administration menu of Cisco Unified CallManager Administration.

Audience
This document provides information for network administrators and engineers who are responsible for 
managing the Cisco Unified CallManager system. Administering Cisco Unified CallManager Bulk 
Administration (BAT) requires knowledge of telephony and IP networking technology.

Organization
Table 1 provides the organization of this guide.
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Organization
Table 1 Layout of BAT Tool User Guide

Chapter Description

Part 1 Cisco Unified CallManager Bulk Administration 
Overview

Provides an overview of BAT and installation instructions.

Part 2 Upload/Download Files

Describes how to upload and download files.

Part 3 Phones

Describes how to add phones, phones and users, computer 
telephony integration (CTI) ports, and CTI ports and users 
in batches rather than adding each device or combination 
individually. Also describes how to add or update lines, 
phone services, and speed dials and how to update and 
delete phones.

Part 4 Users

Describes how to add, update, and delete batches of users.

Part 5 Phones and Users

Part 6 Managers and Assistants

Describes how to add, update, or delete Manager Assistant 
Associations.

Part 7 User Device Profiles

Describes how to add, update, or delete User Device 
Profiles.

Part 8 Gateways

Describes how to add, update, or delete Cisco VG200 
gateways and ports, and how to add or delete Foreign 
Exchange Station (FXS) ports for Cisco Catalyst 6000 
analog interface modules. Also describes how to create a 
gateway directory number template for use with FXS ports.

Part 9 Forced Authorization Codes and Client Matter Codes

Describes how to add, update, or delete Client Matter 
Codes and Forced Authorization Codes

Part 10 Pickup Groups

Describes how to add, update, or delete call pickup groups.

Part 11 Scheduling Jobs

Describes how to schedule and activate jobs

Part 12 Cisco Unified CallManager Auto-Register Phone Tool

Describes how to install, configure, and use Unified CM 
Auto-Register Phone Tool.
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Related Documentation
Related Documentation
Refer to the following documents for further information about related Cisco IP telephony applications 
and products:

• Cisco Unified CallManager Administration Guide

• Cisco Unified CallManager System Guide

• Release Notes for Cisco Unified CallManager 

• Installing Cisco Unified CallManager

• Cisco Unified CallManager Serviceability Administration Guide

• Cisco Unified CallManager Serviceability System Guide

• Cisco Unified CallManager Security Guide

• Hardware Configuration Guide for the Cisco VG200

• Software Configuration Guide for the Cisco VG200

• Cisco VG248 Analog Phone Gateway Software Configuration Guide

• Cisco Unified IP Phone Administration Guide for Cisco Unified CallManager

• Cisco Unified CallManager Features and Services Guide

• Troubleshooting Guide for Cisco Unified CallManager

• Cisco Unified CallManager Assistant User Guide

Conventions
This document uses the following conventions:

Part 13 Troubleshooting BAT and Unified CM Auto-Register 
Phone Tool

Describes some common scenarios for bulk transaction log 
files and provides an explanation and resolution for various 
error messages that you may encounter while working with 
BAT or Unified CM Auto-Register Phone Tool.

Part 14 Appendix

Describes how to create text-based files for the devices and 
users for bulk transactions. Also provides example of file 
formats for different scenarios.

Table 1 Layout of BAT Tool User Guide (continued)

Convention Description

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.
xix
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Obtaining Documentation
Notes use the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in 
the publication.

Timesavers use the following conventions:

Timesaver Means the described action saves time. You can save time by performing the action described in the 
paragraph.

Tips use the following conventions:

Tip Means the information contains useful tips.

Cautions use the following conventions:

Caution  Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

Warnings use the following conventions:

Warning This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, you must be aware of the hazards involved with electrical circuitry and 
familiar with standard practices for preventing accidents.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

string A nonquoted set of characters. Do not use quotation 
marks around the string or the string will include the 
quotation marks.

screen font Terminal sessions and information the system displays 
are in screen font.

boldface screen 
font

Information you must enter is in boldface screen font.

Convention Description
xx
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Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
This product contains cryptographic features and is subject to United States and local country laws 
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply 
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors 
and users are responsible for compliance with U.S. and local country laws. By using this product you 
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local 
laws, return this product immediately.
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A summary of U.S. laws governing Cisco cryptographic products may be found at: 
http://www.cisco.com/wwl/export/crypto/tool/stqrg.html. If you require further assistance please 
contact us by sending email to export@cisco.com.

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you can access a Product 
Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you might have identified a 
vulnerability in a Cisco product, contact PSIRT:

• Emergencies— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

• Nonemergencies — psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to encrypt any sensitive 
information that you send to Cisco. PSIRT can work from encrypted information that is compatible with 
PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

The link on this page has the current PGP key ID in use.
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Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool automatically 
provides recommended solutions. If your issue is not resolved using the recommended resources, your 
service request will be assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at 
this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 
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Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at this 
URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
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Overview

The Cisco Unified CallManager Bulk Administration (BAT), a web-based application, performs bulk 
transactions to the Cisco Unified CallManager database. BAT lets you add, update, or delete a large 
number of similar phones, users, or ports at the same time. When you use Cisco Unified CallManager 
Administration, each database transaction requires an individual manual operation, while BAT 
automates the process and achieves faster add, update, and delete operations. 

Note The Bulk Administration menu is visible only on the first node of Cisco Unified CallManager server. 

Bulk Provision Service (BPS) administers and maintains all jobs that are submitted through Bulk 
Administration menu of Cisco Unified CallManager administration. This service can be started from 
Cisco Unified CallManager Serviceability.

The BPS Server service parameter determines if the service is activated on a particular server or not. BPS 
has to be activated only on the first node of Cisco Unified CallManager.

You can use BAT to work with the following types of devices and records:

• Add, update, and delete Cisco Unified IP Phones including voice gateway (VG) phones, computer 
telephony interface (CTI) ports, and H.323 clients, and migrate phones from Skinny Client Control 
Protocol (SCCP) to Session Initiation Protocol (SIP)

• Add, update, and delete users

• Add, update, and delete User Device Profiles

• Add, update, and delete Cisco Unified CallManager Assistant managers and assistants

• Add, update, and delete ports on a Cisco Catalyst 6000 FXS Analog Interface Module

• Add or delete Cisco VG200 analog gateways and ports

• Add or delete Forced Authorization Codes

• Add or delete Client Matter Codes

• Add or delete Call Pickup Groups

You can also work with these devices in combination with the user information. For example, when you 
add CTI ports and users, BAT allows you to “Enable CTI Application Use.” This saves time when you 
are adding users who have applications that require a CTI port, such as Cisco IP SoftPhone.

An optional component of BAT, the Cisco Unified CallManager Auto-Register Phone Tool, further 
reduces the time and effort that is involved in administering a large system. When you need to add a large 
block of new phones, you can use BAT to add the devices with dummy media access control (MAC) 
addresses instead of entering each MAC address in the data input file. After the phones are installed, the 
phone users or the administrator can call the Unified CM Auto-Register Phone Tool directory number, 
1-1
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follow the voice prompts, and download the correct user device profiles for their phones. For more 
information about the Unified CM Auto-Register Phone Tool tool, see Chapter 52, “Working with the 
Cisco Unified CallManager Auto-Register Phone Tool.”

Use the following topics to understand how to use BAT:

• Bulk Administration Installation, page 1-2

• BAT Data Input Files, page 1-2

• BAT Configuration Process, page 1-2

• Using the BAT Application, page 1-10

Bulk Administration Installation
BAT is installed as part of the Cisco Unified CallManager Administration. Refer to Cisco Unified 
CallManager Administration Guide for more details.

Additional Topics

See the “Related Topics” section on page 1-11.

BAT Data Input Files
Every device includes a multitude of individual attributes, settings, and information fields that enable 
the device to function in the network and provide its telephony features. Many devices have the same 
attributes and settings in common, while other values, such as the directory number, are unique to a user 
or to a device. To condense the BAT data input file contents, BAT uses templates for settings that devices 
usually have in common.

For bulk configuration transactions on the Cisco Unified CallManager database, the BAT process uses 
two components: a template for the device type and a data file in comma separated value (CSV) format 
that contains the unique values for configuring a new device or updating an existing record in the 
database. The CSV data file works in conjunction with the device template.

For instance, when you create a bulk transaction for a group of Cisco IP Phones, you set up the CSV data 
file that contains the unique information for each phone, such as the directory number and MAC address. 
In addition, you set up or choose the BAT template that contains the common settings for all phones in 
the transaction, such as a Cisco IP Phone 7960 template.

Additional Topics

See the “Related Topics” section on page 1-11.

BAT Configuration Process
BAT uses a multistep process to prepare the bulk configuration transaction. BAT uses a Bulk 
Administration menu options, to guide you through the configuration tasks. The BAT process includes 
these tasks:

1. Set up the template for data input.

2. Define a format for the CSV data file.
1-2
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3. Collect the data for each device in the bulk transaction.

4. Upload the data files choosing the relevant target and function for the transaction.

5. Validate the data input files with the Cisco Unified CallManager database.

6. Submit jobs for execution.

7. Schedule jobs.

8. Execute jobs to insert the devices into the Cisco Unified CallManager database. 

Using the BAT Menu

From the Bulk Administration menu, you can choose one of these device or configuration options:

• Upload/Download Files

• Phones

• Users

• Phones and Users

• Manager/Assistants

• User Device Profiles

• Gateways

• Forced Authorization Codes

• Client Matter Codes

• Call Pickup Group

• Job Scheduler

• Unified CM Auto-Register Phone Tool 

When you choose an option, the corresponding menu items display. For example, when you choose 
Phones, the following list of menu items displays:

• Phone Template—Create, locate, and modify a phone template.

• Phone File Format—Create, locate, and add a phone file format.

• Validate Phones—Validate phones records.

• Insert Phones—Add new phones.

• Update Phones—Locate and modify existing phones.

• Delete Phones—Locate and delete phones.

• Export Phones—Locate and export specific phone records or all phone records. 

• Add/Update Lines—Add new lines to existing phones, and locate and modify lines on existing 
phones.

• Reset/Restart Phones—Locate and reset or restart phones.

• Generate Phone Reports—Generate customized reports for phones. 

• Migrate Phones—Migrate phones from SCCP to SIP protocol.

When you choose a menu option from the Bulk Administration menu the corresponding window opens, 
such as the Phone Template Configuration window. The configuration window provides the entry fields 
for defining a template.
1-3
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Additional Topics

See the “Related Topics” section on page 1-11.

Using BAT Templates
As the first task in the BAT configuration process, you set up a template for the devices that you are 
configuring. You specify the type of phone or device that you want to add or modify, and then you create 
a BAT template that has features that are common to all the phones or devices in that bulk transaction.

You can create BAT templates for the following types of device options:

• Phones: All Cisco Unified IP Phone models and Cisco ATA 186, Cisco VGC phones, CTI ports, and 
H.323 clients.

• Gateways: Cisco VG200 and Cisco Catalyst 6000 FXS Analog Interface Module

• User Device Profiles: Cisco Unified IP Phone 7900 series and Cisco SoftPhone 

Define a BAT template by specifying values in the template fields that will be common to all the devices 
in the bulk transaction. The BAT template fields require similar values to those that you enter when you 
are adding a device in Cisco Unified CallManager Administration. 

Prior to creating the BAT template, make sure settings such as device pools, locations, calling search 
spaces, button templates, and softkey templates have already been configured in 
Cisco Unified CallManager Administration. 

After you create a BAT template, you save it with a name. Later in the configuration process, you 
associate the template name with the CSV data file. The system stores the templates, so they are reusable 
for future bulk transactions. For example, you can configure a Cisco IP Phone 7960 template with a 
specific button template and calling search space and then configure another Cisco IP Phone 7960 
template with a different button template and the Extension Mobility feature enabled. When you need to 
add a large number of phones with the same configuration, you can reuse the existing BAT template.

Master Phone Templates

When you are adding a group of phones that have multiple lines, you can create a master phone template 
that provides multiple lines and the most common values for a specific phone model. You can use the 
master template to add phones that have differing number of lines, but do not exceed the number of lines 
in the master phone template. For example, you can create a master phone template for a 
Cisco Unified IP Phone 7960 that has eight lines. You can use this template to add phones that have one 
line, two lines, or up to eight lines.

Additional Topics

See the “Related Topics” section on page 1-11.

Working with CSV Data Files
The CSV data file contains the unique settings and information for each individual device, such as its 
directory number, MAC address, and description. Make sure that all phones and devices in a CSV data 
file are the same phone or device model and match the BAT template. The CSV data file can contain 
duplicates of some values from the BAT template. Values in the CSV data file override any values that 
were set in the BAT template. You can use the override feature for special configuration cases. 
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Overriding Template Values Example

If you want most of the phones in the bulk transaction to be redirected to a voice-messaging system, you 
can set the Call Forward Busy (Internal/External) (CFB) and Call Forward No Answer 
(Internal/External) (CFNA) fields to the voice-messaging number. However, if a few phones in the bulk 
transaction need to be redirected to a secretary instead of to a voice messaging system, you can specify 
the secretary’s directory number in the Call CFB and CFNA fields in the CSV data file. Most of the 
phones will use the CFB and CFNA values from the BAT phone template, but certain phones will use 
the secretary’s directory number as specified in the CSV data file.

The CSV data file for phones can contain multiple directory numbers. Keep in mind that the number of 
directory numbers that are entered in the CSV data file must not exceed—but can be less than— the 
number of lines that are configured in the BAT phone template, or an error will result.

Use the following topics to understand the different types of CSV data files:

• CSV Data Files for Adding New Devices, page 1-5

• CSV Data Files to Update Existing Devices, page 1-5

• Customizing File Formats for CSV Data Files, page 1-6

CSV Data Files for Adding New Devices

When you are adding new devices to the system, you can use the Microsoft Excel spreadsheet that was 
designed to use with BAT. The BAT spreadsheet assists you with the following features:

• Data file templates with macros for the different devices

• Customized file format definition 

• Support for multiple phone lines

• Record error checking

• File conversion to CSV format

When you are creating new records, use the BAT spreadsheet, which is named BAT.xlt, because the data 
gets validated automatically when you export to the CSV format. For more information about using the 
BAT spreadsheet, see “Using the BAT Spreadsheet for Gathering Data” section on page 1-8. 

Note BAT.xlt validates data only for valid characters, data types, and field length for particular fields. For 
more information see the “Validating CSV Data File Phone Records” section on page 5-1.

For experienced BAT users who are comfortable with working in a CSV formatted file, you can use a 
text editor to create a CSV data file by following the sample text file that is provided on the device insert 
task window. For more information about text-based CSV data files, see Appendix A, “Text-Based CSV 
Files.”

Additional Topics

See the “Related Topics” section on page 1-11.

CSV Data Files to Update Existing Devices

To modify or update existing phones and devices, you need to locate the records for these devices. BAT 
provides two methods for locating phones, gateways, and device profiles. You can search by using a 
customized query or by using a custom file.
1-5
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Customized Queries

BAT provides a window for defining your query criteria. You can choose the specific device model 
and/or choose criteria from a list of device details and a list of line details. To locate all devices of a 
specific device model, such as Cisco IP Phone 7912, you choose the model but add no other criteria for 
the search. You get the records for all the Cisco Unified IP Phones 7912 that are configured in the 
database.

Custom Files

When no common attribute to use for a query exists, BAT provides the custom file option. A custom file 
includes device names or directory numbers. You can build a custom text file by putting each record on 
a separate line. The search gives you all the records that match the criteria.

Exported Files

When you need to move a group of phones, you can use the export utility. You use the export utility to 
extract existing records from the Cisco Unified CallManager database to move them into a CSV data 
file. When you move phones, use the option, Export Phones with the All Phone Details. This option 
generates an export file that contains records with all the information, including the device attributes, 
line attributes, and services, that is associated with that phone. You can also export phone records with 
specific details when phones have similar line configurations and you want to use a template. For more 
information about using the export utility to update devices, see Using Phone Export, page 9-1

Additional Topics

See the “Related Topics” section on page 1-11.

Customizing File Formats for CSV Data Files

CSV data files comprise a string of device attributes and information in a comma separated value (CSV) 
format. To insert data records into the Cisco Unified CallManager database, ensure that each data file is 
in the CSV format. In earlier releases of BAT, the CSV file had a fixed format with two options:

• Default format—CSV files that have a fixed and limited number of attributes and settings for each 
device.

• All details format—CSV files that are created by using the export utility and include all attributes 
and settings for each device.

The first row of every CSV data file shows the file format by displaying the name of each field that the 
CSV file includes. The file format information makes it easier to locate the entry for a specific field in 
the CSV data file. For instance, in the following sample CSV file, USER ID represents the fifth field in 
the header, and the fifth field in the CSV file for the phone shows “johns.”

Sample CSV Data File with the Default File Format:
MAC ADDRESS,DESCRIPTION,LOCATION,USER ID,DIRECTORY NUMBER 1,DISPLAY 1,LINE TEXT LABEL 
1,FORWARD BUSY EXTERNAL 1,FORWARD NO ANSWER EXTERNAL 1,FORWARD NO COVERAGE EXTERNAL 
1,FORWARD BUSY INTERNAL 1,FORWARD NO ANSWER INTERNAL 1,FORWARD NO COVERAGE INTERNAL 1,CALL 
PICKUP GROUP 1,SPEED DIAL NUMBER 1, SPEED DIAL LABEL 1
1231123245AB,SEP1231123245AB,Dallas,johns,9728437154,9728437154,Mike,9728437172,9728437196
,9728437127,9728437154,9728437178,9728437189,9728437121/TollByPass,1230000000,Helpdesk
9728437127,9728437154,9728437178,9728437189,Marketing,1230000000,Helpdesk
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Now, you can customize the file format for the CSV data file by using the Create Phone File Format 
Configuration window. You can add attributes to your file format that are also in the BAT template. This 
allows you to override the template entry with a specific attribute for a device. For instance, you can 
choose the route partition attribute for your file format and enter different partitions for each phone in 
the CSV data file.

From this window, you can choose specific attributes from Device fields and Line fields

The following device attributes always remain in each file format: 

• MAC Address

• Description

The File Format Configuration dialog box makes it easy to choose the device attribute in the Device Field 
box and click an arrow to move the attribute into the Selected Device Field box. You can select multiple 
attributes at the same time by holding down the Ctrl key.

You can rearrange the order of the device attribute fields and line attribute fields in the file format by 
using the Up and Down arrows. You can select an attribute and then click the Up arrow to move the item 
closer to the first record or click the down arrow to move the item further away from the first record. You 
cannot move line attributes before device attributes or change the order of speed dials.

Tip You can customize a CSV file format so it matches the arrangement of your employee phone information 
that is stored in another database. This method simplifies exporting data between a company database 
and the Cisco Unified CallManager database.

Sample CSV Data File with the Customized File Format:

Device fields—MAC Address, Description, Device Pool, Calling Search Space

Line fields—Directory number, Partition, Line Text Label (moved to position after directory number in 
file)

The File Format does not include speed-dial codes. Speed-dials can be chosen by selecting the Include 
Speed Dials in the CSV Format check box.

MAC ADDRESS,DESCRIPTION,DEVICE POOL,CSS,DIRECTORY NUMBER,LINE TEXT LABEL,PARTITION,
2234900AEF01,SEP2234900AEF01,DP_1,CSS_Restricted,
9725098827,Lobby Phone,Part1

Associating the File Format with the CSV Data File

When you are using a text editor to create a CSV data file, you can create a customized file format and 
then enter values in the same order as specified by that file format. Before inserting the text-based CSV 
data file that uses the customized file format, you must associate the file format name with the CSV data 
file. You can associate only one file format with a CSV data file.

Use the Add File Format window to choose the name of the CSV data file <CSVfilename>.txt from the 
File Name drop-down list. Next, you choose your file format from the File Format Name drop-down list. 
The data in the CSV data file must match the custom file format that you have chosen.

Additional Topics

See the “Related Topics” section on page 1-11.
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Using the BAT Spreadsheet for Gathering Data
The BAT spreadsheet simplifies the creation of CSV data files. You can add multiple devices and view 
the records for each device in a spreadsheet format. It allows you to customize the file format within the 
spreadsheet and provides validation and error checking automatically to help reduce configuration 
errors. The BAT spreadsheet includes tabs along the bottom of the spreadsheet for access to the required 
data input fields for the various devices and user combinations in BAT.

Note BAT.xlt validates data only for valid characters, data types, and field length for particular fields. For 
more information see the “Validating CSV Data File Phone Records” section on page 5-1.

The CSV data file works in combination with the BAT template. For example, when you choose the 
Phone tab in the BAT spreadsheet, you can leave Location, Forward Busy Destination, or Call Pickup 
Group blank. The values from the BAT phone template get used for these fields; however, if you specify 
values for Forward Busy Destination or Call Pickup Group, those values override the values for these 
fields that were set in the BAT phone template.

Tip When Cisco Unified CallManager is installed, the Microsoft Excel file for the BAT spreadsheet gets 
placed on the first node database server; however, you probably do not have Microsoft Excel running on 
the first node database server. You must download the file from the first node database server to the local 
machine on which you plan to work.

To download the file to a local machine, see Chapter 2, “Uploading and Downloading Files.”. Download 
the file BAT.xlt file to a local machine where Microsoft Excel is installed. 

To use the BAT.xlt spreadsheet to create a CSV data file, locate and double-click the BAT.xlt file. You 
must choose to “enable macros” when you open the BAT spreadsheet.

The spreadsheet displays a set of columns with attribute headings that specify the BAT field names, 
whether the field is a required or optional, and the maximum number of characters that are allowed in 
the field. 

Tabs for every device display along the bottom of the spreadsheet. When you click the tab for the type 
of device with which you want to work, the columns adjust to display all relevant fields for the chosen 
device. For example, to add phones and users all at once, click the tab that is marked Phones-Users. 

Next, define the file format for the CSV data file by clicking the Create File Format button. You can 
use the Field Selection dialog box to choose items and their order in your CSV data file. When you click 
Create, the columns in the spreadsheet adjust to your new file format.

In the first row, enter data for a device in all mandatory fields and any relevant optional fields. You enter 
data in a new row for each device.

Note The system treats blank rows in the spreadsheet as “end of file” markers and discards subsequent records.

After all device records are completed, you export the BAT spreadsheet data to the CSV file format that 
BAT must use to perform the bulk transaction with the Cisco Unified CallManager first node database. 

Note If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when you 
export to BAT format.
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The system saves the CSV formatted file as a text file to the a folder that you choose. The file name 
format follows:

<tabname><timestamp>.txt

where <tabname> represents the type of device input file that you created (such as phones, user device 
profiles), and <timestamp> represents the precise date and time that the file was created.

Next, you must upload the converted CSV data file (CSV format version) back to the 
Cisco Unified CallManager database server using Upload/Download Files option in the Bulk 
Administration of Cisco Unified CallManager Administration. For more information, refer to Chapter 2, 
“Uploading and Downloading Files.”

Additional Topics

See the “Related Topics” section on page 1-11.

Validating the BAT Data Input File
In the next task, you use the Validate File option. In this task, you choose the name of the CSV data file 
and the BAT template for the device or the model when you have a CSV data file with all details. You 
have these options for how records are validated:

Specific Details—For validating records that follow the Default or Custom file format.

All Details—For validating records from a file that was generated with the export utility by using the 
All Details option.

When you choose Validate, the system runs a validation routine to check for errors against the first node 
database. These checks include the following items:

• Fields, such as description, display text, and speed-dial label that do not have a dependency on a 
database table, use valid characters.

• Cisco Unified CallManager shows that groups, pools, partitions, and other referenced attributes are 
already configured.

• Number of lines that are configured on a device matches the device template. (Only for Specific 
Details)

Validation does not check for the existence of a user or for mandatory/optional fields that are BAT 
defined, such as the dummy MAC address.

After the transaction completes, click the Log File Name link in the Job configuration window to see a 
log file that displays the devices that could not be validated successfully and the error code. For more 
information on log files, see Chapter 54, “Troubleshooting Unified CM Auto-Register Phone Tool.”

Additional Topics

See the “Related Topics” section on page 1-11.

Inserting the BAT Data Input File
When the data input file has passed validation, you are ready to use the Insert window to add the device 
records into the Cisco Unified CallManager first node database. During this task, you choose the name 
of the data input file, the BAT template for the device, and the model, if applicable. You have these 
options for how records are validated:

Specific Details—For inserting records that use a customized file format.
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All Details—For inserting records from a file that was generated with the export utility by using the All 
Details option.

Enter Job Information details and click submit. A job is created that can be accessed using the Job 
Scheduler Option in the Bulk Administration menu. Use the Job Configuration window to view the 
status, and to schedule and activate the job.

Note If any line information for a phone record fails, BAT does not insert that phone record.

After the transaction completes, click the Log File Name link in the Job Configuration window to see a 
log file that displays the number of records that were added and the number of records that failed, 
including an error code. For more information on log files, see Chapter 54, “Troubleshooting 
Unified CM Auto-Register Phone Tool.”

Additional Topics

See the “Related Topics” section on page 1-11.

Using the BAT Application
The following topics provide information about the BAT application and how to start and use it:

• Accessing Cisco Unified CallManager Administration and BAT, page 1-10

• Using Online Help, page 1-10

• BAT Configuration Process, page 1-2

• BAT Data Input Files, page 1-2

A web browser, a resource-intensive application, can consume large amounts of system memory and 
CPU cycles. When the web browser takes resources away from Cisco Unified CallManager, it adversely 
affects call processing. Possible consequences of using the browser on the same machine as the web 
server and Cisco Unified CallManager include delayed dial tone and dropped calls.

Accessing Cisco Unified CallManager Administration and BAT
BAT, a web-based application, requires the use of a web browser. For more details and specifications, 
refer to Cisco Unified CallManager Administration Guide.

Additional Topics

See the “Related Topics” section on page 1-11.

Using Online Help
To access BAT online help, choose the Help menu. The Help menu provides two help features: 

• Contents and Index—Opens the BAT help file and allows you to browse for information or search 
the index. 

• For This Page—Opens the help directly for the window that you are currently viewing. You can still 
browse the remainder of the help or use the index.
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Online help provides a multivolume system that allows you to access several different help systems, all 
from the same window. You can also access a comprehensive search engine and index.

Additional Topics

See the “Related Topics” section on page 1-11.

Finding the Cisco Unified CallManager Version
To find the current version of Cisco Unified CallManager, choose Help > About. 

Additional Topics

See the “Related Topics” section on page 1-11.

Related Topics
• BAT Data Input Files, page 1-2

• BAT Configuration Process, page 1-2

• Using BAT Templates, page 1-4

• Working with CSV Data Files, page 1-4

• CSV Data Files for Adding New Devices, page 1-5

• CSV Data Files to Update Existing Devices, page 1-5

• Customizing File Formats for CSV Data Files, page 1-6

• Using the BAT Spreadsheet for Gathering Data, page 1-8

• Validating the BAT Data Input File, page 1-9

• Inserting the BAT Data Input File, page 1-9

• Using the BAT Application, page 1-10

• Accessing Cisco Unified CallManager Administration and BAT, page 1-10

• Using Online Help, page 1-10

• Finding the Cisco Unified CallManager Version, page 1-11
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This chapter describes the procedures to upload files to Cisco Unified CallManager first node and 
download files these files to a local machine.

Use the following procedures:

• Finding a File, page 2-1

• Downloading a File, page 2-2

• Uploading a File, page 2-3

• Deleting a File, page 2-3

Finding a File
Use the following procedure to find files that you can download from the Cisco Unified CallManager 
server.

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files. The Find and List Files window displays.

Step 2 From the first Find File where drop-down list box, choose one of the following options.

• Name

• Type

Step 3 From the second Find Job where drop-down list box, choose one of the following options.

• If you chose Name in Step 2, chose one of the following options and continue with Step 4.

– begins with 

– contains 

– is exactly

– ends with

– is empty

– is not empty

• If you chose Type in Step 2, continue with Step 4.

Step 4 Specify the appropriate search text, if applicable.
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Tip To find all files that are registered in the database, click Find without entering any search text.

Step 5 To further define your query and to add multiple filters, check the Search Within Results check box 
choose AND or OR from the drop-down box, and repeat steps 2 through 4. 

Step 6 If you chose Type in Step 2, from the Select item or enter search text drop-down list box, choose one of 
the following options.

• Insert Files

• Export Files

• Report Files

• Custom Files

• Log Files

• BAT Excel Template

Step 7 Click Find.

A list of discovered files displays by:

• File Name

• Function Type

If you chose Type in Step 2 and Log Files in Step 6, the list of discovered files displays by:

• File Name

• Launch Date and Time

To download a file(s) that you chose, see “Downloading a File” section on page 2-2.

Additional Topics

See the “Related Topics” section on page 2-4.

Downloading a File
Use the following procedure to download a file from the Cisco Unified CallManager server.

Procedure

Step 1 Find the files you want to download using the “Finding a File” section on page 2-1.

Step 2 Check the check boxes corresponding to the files that you want to download and click Download 
Selected. 

Note You can download all the files by clicking Select All and then clicking Download Selected.

Note If you select more than one file to download at a time, the files will be downloaded to a common 
zip file.
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Step 3 The File Download pop-up window displays. Click Save.

Step 4 In the Save As pop-up window, choose the location you want to save the file to and click Save.

Step 5 The Download Complete pop-up window displays. Click Open to open the downloaded file or click 
Close to open it at a later time.

Additional Topics

See the “Related Topics” section on page 2-4.

Uploading a File
Use the following procedure to upload a file to the Cisco Unified CallManager server.

Procedure

Step 1 Choose Bulk Administration > Upload/Download Files. The Find and List Files window displays.

Step 2 Click Add New. The File Upload Configuration window displays. 

Step 3 In the File text box, enter the full path of the file you want to upload or click Browse and locate the file.

Step 4 From the Select the Target drop-down list box, choose the target you want to use the file for.

Step 5 From the Transaction Type drop-down list box, choose the transaction type the file defines. 

Step 6 If you want to overwrite an existing file with the same name, check the Overwrite File if it Exists check 
box.

Step 7 Click Save. The status displays that the upload is successful. 

Additional Topics

See the “Related Topics” section on page 2-4.

Deleting a File
Use the following procedure to delete files.

Procedure

Step 1 Find the files that you want to delete using the “Finding a File” section on page 2-1.

Step 2 In the Search Results area, check the check box corresponding to the files that you want to delete. 

Step 3 Click Delete Selected.

Note To delete all files displayed in the Search Results area, click Select All and Delete Selected.

Step 4 To continue, click OK.
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Step 5 The files are now deleted from the server.

Note If any files that you chose for deletion are being used to execute any jobs, then these file will not 
be deleted.

Additional Topics

See the “Related Topics” section on page 2-4.

Related Topics
• Finding a File, page 2-1

• Downloading a File, page 2-2

• Uploading a File, page 2-3

• Deleting a File, page 2-3
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Cisco Unified CallManager Bulk Administration (BAT) gives the administrator a fast and efficient way 
to add, update, or delete large numbers of phones in batches, rather than performing individual updates 
through Cisco Unified CallManager Administration. You can use BAT to work with the following types 
of phones:

• Cisco Unified IP Phones (all models)

• CTI ports

• H.323 clients

The following topics provide information about using BAT to work with phone templates and other IP 
telephony devices:

• Adding Phones, page 3-1

• Using BAT Phone Templates, page 3-2

Adding Phones 
When you use BAT to add phones and other IP telephony devices to the Cisco Unified CallManager 
database, you can add multiple lines, services, and speed dials for each phone. You can also add CTI 
ports and H.323 clients.

You have two options for creating a CSV data file for phones:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

Use the following steps to add phones and IP telephony devices in bulk.

Step 1 Choose Bulk Administration > Phones > Phone Template. 

The Find and List Phone Templates window displays. See the “Using BAT Phone Templates” section 
on page 3-2 for information about configuring phone templates.

Step 2 To create a CSV data file for inserting phone templates using the BAT spreadsheet, see “Using the BAT 
Spreadsheet to Create a CSV Data File for Phones” section on page 3-28

Text Editor to Create the CSV Data File

a. Choose Bulk Administration > Phones > Phone File Format > Create File Format. 

The Find and List Phone File Formats window displays. See “Finding a Phone File Format” section 
on page 4-2 for information about configuring file formats for CSV data file.
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b. Use a text editor and create the CSV data file for phones that follows the file format that you want 
to use. For more information about creating a text-based CSV file, see the “Creating a Text-Based 
CSV File for Phones” section on page A-1.

c. Choose Bulk Administration > Phones > Phone File Format > Add File Format. 

The Add File to Format window displays. See the “Associating the File Format with the CSV Data 
File” section on page 4-5 for information about associating file formats.

Step 3 Choose Bulk Administration > Phones > Validate Phones. 

The Validate Phones window displays. See Chapter 5, “Validating Phone Records,” for information 
about validating phone records.

Step 4 Choose Bulk Administration > Phones > Insert Phones.

The Insert Phones window displays. See the “Inserting Phones into Cisco Unified CallManager” section 
on page 6-1 for information about inserting phone records into the Cisco Unified CallManager database.

Additional Topics

See the “Related Topics” section on page 3-41.

Using BAT Phone Templates
Use BAT phone templates to define the common phone attributes to add a group of new phones. Prior to 
creating the template, make sure phone settings such as device pool, location, calling search space, 
button template and softkey templates have already been configured in Cisco Unified CallManager 
Administration. You cannot create new settings in BAT.

Use these topics to work with BAT Phone Templates:

• Finding a BAT Phone Template, page 3-2

• Creating a New BAT Phone Template, page 3-4

• Adding or Updating Lines in a BAT Template, page 3-4

• Copying a BAT Phone Template, page 3-8

• Deleting Templates, page 3-9

• Field Descriptions for a BAT Phone Template, page 3-9

Finding a BAT Phone Template
Because you might have several phone templates, Cisco Unified CallManager lets you locate specific 
phone template on the basis of specific criteria. Use the following procedure to locate templates.

Note During your work in a browser session, your find/list search preferences are stored in the cookies on the 
client machine. If you navigate to other menu items and return to this menu item, or if you close the 
browser and then reopen a new browser window, your Cisco Unified CallManager search preferences 
are retained until you modify your search.
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Procedure

Step 1 Choose Bulk Administration > Phones > Phone Template.

The Find and List Phone Templates window displays. Use the two drop-down list boxes to search for a 
template.

Step 2 From the first Find Phone Templates where drop-down list box, choose one of the following criteria:

• Device Name

• Description

• Directory Number

• Calling Search Space

• Device Pool

• Device Type

• Call Pickup Group

• LSC Status

• Authentication String

• Device Protocol

• Security Profile

From the second Find Phone Template where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

Tip To find all Phone Templates that are registered in the database, click Find without entering any 
search text.

A list of discovered templates displays.

Step 4 From the list of records, click the device name that matches your search criteria.

The window displays the phone template that you choose.

Additional Information

See the “Related Topics” section on page 3-41.
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Creating a New BAT Phone Template
Use this procedure to create the phone template. After you create a phone template, you can add lines, 
services, and speed dials. Use the following procedure to create a phone template.

Procedure

Step 1 Choose Bulk Administration > Phones > Phone Template.

The Find and List Phone Templates window displays. 

Step 2 Click Add New. The Add a New Phone Template window displays.

Step 3 From the Phone Type drop-down list box choose the phone model, for which you are creating the 
template. Click Next.

Step 4 Choose the device protocol from the Select the Device Protocol drop-down list box. Click Next.

The Phone Template Configuration window displays with fields and default entries for the chosen device 
type.

Step 5 In the Phone Template Name field, enter a name for the template. The name can contain up to 50 
alphanumeric characters. Example: Sales_7960.

Step 6 In the Device Information area, enter the phone settings that this batch has in common. See Table 3-1 
for field descriptions. Some phone models and device types do not have all the attributes that the table 
lists.

Step 7 After you have entered all the settings for this BAT phone template, click Save.

Step 8 When the status indicates that the transaction has completed, you can add line attributes. 

Additional Information

See the “Related Topics” section on page 3-41.

Adding or Updating Lines in a BAT Template

To add one or more lines to the BAT template or to update existing lines, follow this procedure. The 
button template in use for this BAT template determines the number of lines that you can add or update. 
You can create a master phone template that has multiple lines. Then, you can use the master template 
to add phones with a single line or up to the number of lines in the master template. See the “Master 
Phone Templates” section on page 1-4 for more information.

Procedure

Step 1 Find the Phone Template you want to add line to, using the procedure in “Finding a BAT Phone 
Template” section on page 3-2

Step 2 In the Phone Template Configuration window, click Line [1] Add a new DN, in the Associated 
Information area.

The Line Template Configuration window displays.
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Note The maximum number of lines that display for a BAT template depends on model and button 
template that you chose when you created the BAT phone template.

Step 3 Enter or choose the appropriate values for the line settings that are described in Table 3-2. Keep in mind 
that all phones or user device profiles in this batch will use the settings that you choose for this line. 
Treat all fields as optional.

Step 4 Click Save.

BAT adds the line to the phone template configuration.

Step 5 Repeat Step 2 through Step 4 to add settings for any additional lines.

Note If you choose Back to Find/List from the Related Links drop-down list box in the upper, right, corner 
of the Line Template Configuration window, the Find and List Line Template window displays. To find 
existing line template, enter the appropriate search criteria and click Find. To add a new line template 
click Add New on Find and List Line Template window.

Note For some Cisco Unified IP Phone models, you can add Cisco Unified IP Phone services and speed dials 
to the template. For more information, see Adding or Updating IP Services in a BAT Template, page 3-5 
and Adding or Updating Speed Dials in a BAT Template, page 3-6.

Additional Information

See the “Related Topics” section on page 3-41.

Adding or Updating IP Services in a BAT Template

You can subscribe Cisco Unified IP Phone services to the Cisco Unified IP Phone models that include 
this feature.

Note You can bulk subscribe users or phones to IP services with common service parameters but not to IP 
services with unique service parameters.
This is valid only for services that are subscribed through a phone template. For services with unique 
parameters, values can be specified through CSV file.

Procedure

Step 1 Find the Phone Template you want add an IP Service to, using the procedure in “Finding a BAT Phone 
Template” section on page 3-2.

Step 2 In the Phone Template Configuration window, click Add a new SURL in the Associated Information 
area.

A popup window displays. In this window, you can subscribe to Cisco Unified IP Phone services that 
are available.
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Step 3 In the Select a Service drop-down list box, choose a service to which you want all phones to be 
subscribed. The Service Description box displays details about the service that you choose.

Step 4 Click Next.

Step 5 In the Service Name field, modify the name of the service if required.

Step 6 To associate these phone services to the phone template, click Subscribe .

Step 7 To add more services, repeat Step 3 through Step 6.

Step 8 To add all the services to the template, click Update.

Step 9 Close the popup window.

Step 10 You can add speed dials to the template by continuing to the “Adding or Updating Speed Dials in a BAT 
Template” section on page 3-6.

Additional Information

See the “Related Topics” section on page 3-41.

Adding or Updating Speed Dials in a BAT Template

You can add and update speed dials in the BAT template.

You can designate speed dials for phones and Cisco VGC phones if the Phone Button Template provides 
speed-dial buttons.

Procedure

Step 1 Find the Phone Template you want to add speed dials to, using the procedure in “Finding a BAT Phone 
Template” section on page 3-2

Step 2 In the Phone Template Configuration window, click Add a new SD in the Associated Information area, 
or choose Add/Update Speed Dials from the Related Links drop-down list box in the upper, right-hand 
corner of the window.

A popup window displays. In this window, you can designate speed-dial buttons for 
Cisco Unified IP Phones and expansion modules. The phone button template in use for this BAT 
template determines the number of available speed-dial buttons. 

Step 3 In the Speed Dial Settings area, enter the phone number, including any access or long-distance codes, in 
the Number field.

Step 4 In the Label field, enter a label that corresponds to the speed-dial number.

Step 5 In the ASCII Label field, enter the corresponding ASCII label for the speed-dial number.

Step 6 In the Abbreviated Dial Settings area, you can set abbreviated speed dials for applicable IP phone models 
by repeating Step 3 and Step 5.

Step 7 Click Save.

BAT inserts the speed-dial settings in the template, and the popup window closes.

Additional Topics

See the “Related Topics” section on page 3-41.
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Adding or Updating Busy Lamp Field in a BAT Template

You can add and update busy lamp filed speed dials in the BAT template.

You can designate busy lamp field speed dials for phones and Cisco VGC phones if the Phone Button 
Template provides speed-dial buttons.

Procedure

Step 1 Find the Phone Template you want to add speed dials to, using the procedure in “Finding a BAT Phone 
Template” section on page 3-2

Step 2 In the Phone Template Configuration window, click Add a new BLF SD in the Associated Information 
area, or choose Add/Update Busy Lamp Field Speed Dials from the Related Links drop-down list box 
in the upper, right-hand corner of the window.

A popup window displays. In this window, you can designate busy lamp field speed-dial (BLF SD) 
buttons for Cisco Unified IP Phones and expansion modules. The phone button template in use for this 
BAT template determines the number of available BLF SD buttons. 

Step 3 In the Speed Dial Settings area, enter the destination, including any access or long-distance codes, in the 
Destination field.

Step 4 Choose the directory number from the drop-down list box. You can click Find to search for directory 
numbers.

Step 5 In the Label field, enter a label that corresponds to the BLF SD number.

Step 6 In the ASCII Label field, enter the corresponding ASCII label for the BLF SD number.

Step 7 Click Save.

BAT inserts the BLF SD settings in the template, and the popup window closes.

Additional Topics

See the “Related Topics” section on page 3-41.

Modifying BAT Phone Templates
Use this procedure to view or modify an existing phone or user device profile template. You can add or 
update lines, services, and speed dials.

Procedure

Step 1 Find the Phone Template you want to modify, using the procedure in “Finding a BAT Phone Template” 
section on page 3-2

Step 2 In the Phone Template Configuration window, add, change, or remove settings in the template. See 
“Field Descriptions for a Phone Template” section on page 3-9 for more information.

Step 3 After you have modified the settings to update the template, click Save.

Step 4 If you want to update other attributes, choose one of the following procedures:

• Adding or Updating Lines in a BAT Template, page 3-4

• Adding or Updating IP Services in a BAT Template, page 3-5
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• Adding or Updating Speed Dials in a BAT Template, page 3-6

Additional Information

See the “Related Topics” section on page 3-41.

Copying a BAT Phone Template
You can copy the properties of a phone template into a new phone template when you want to change 
only a few fields.

Note The new template that you create must be the same device type as the original template, such as 
Cisco IP Phone model 7960.

Use the following procedure to copy an existing BAT phone template.

Procedure

Step 1 Find the Phone Template you want to copy, using the procedure in “Finding a BAT Phone Template” 
section on page 3-2

Step 2 In the Phone Template Configuration window, verify that this is the template that you want to copy and 
click Copy.

Note You can also copy the phone template from the Find and List Phone Templates window. Click 
the icon in the Copy or Copy with Lines column corresponding the phone template you wish to 
copy.

The template reproduces and creates a copy. The copy duplicates all the values that were specified in the 
original template. If you click the icon in the Copy with Lines column in the Find and List Phone 
Templates window, then all the lines associated with the template are also copied.

Step 3 In the Phone Template Name field, enter a name for the template. The name can contain up to 50 
alphanumeric characters. Example: Sales_7960.

Step 4 Update the fields as needed for the new template. See “Field Descriptions for a Phone Template” section 
on page 3-9 for information.

Step 5 Click Save. The template that is added to BAT displays in the Phone Templates column on the left.

Step 6 For more information on adding lines to the phone template, see the “Adding or Updating Lines in a BAT 
Template” section on page 3-4. You can also define services and speed-dial buttons.

Additional Topics

See the “Related Topics” section on page 3-41.
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Deleting Templates
You can delete BAT templates when you no longer require them. Use this procedure to delete a template.

Procedure

Step 1 Find the Phone Template you want to delete, using the procedure in “Finding a BAT Phone Template” 
section on page 3-2.

Step 2 In the Phone Template Configuration window, verify that this is the template that you want to delete and 
click Delete.

Note You can also delete the phone template from the Find and List Phone Templates window.check 
the check box next to the template you want to delete and click Delete Selected 

A message displays that asks you to confirm the delete operation.

Step 3 To delete the template, click OK. The template name disappears from the list of phone templates list on 
the Find and List Phone Templates window.

Caution If you submit a job that uses a particulate phone template and if you delete the phone template then the 
job also gets deleted.

Additional Topics

See the “Related Topics” section on page 3-41.

Field Descriptions for a BAT Phone Template
Table 3-1 provides descriptions of all possible fields that display when you are adding a BAT phone 
template for all IP telephony devices. Some device types do not require all the phone settings.

Some fields display the values that were configured in Cisco Unified CallManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have 
an asterisk as optional.

For related procedures, see the “Related Topics” section on page 3-41.

Table 3-1 Field Descriptions for a Phone Template

Field Description

Device Name Enter the device name.

Description Enter a description for the phone template you want to create.

Device Pool Choose the device pool for this group of phones/ports.

For devices, a device pool defines sets of common characteristics, 
such as region, date/time group, Cisco Unified CallManager group, 
and calling search space for auto-registration.
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Common Phone Profile From the drop-down list box, choose a common phone profile from 
the list of available common phone profiles.

Calling Search Space Choose the calling search space for this group of phones/ports.

A calling search space specifies the collection of Route Partitions 
that are searched to determine how a dialed number should be 
routed.

AAR Calling Search Space Choose the appropriate calling search space for the device to use 
when it performs automated alternate routing (AAR). The AAR 
calling search space specifies the collection of route partitions that 
are searched to determine how to route a collected (originating) 
number that is otherwise blocked due to insufficient bandwidth.

Media Resource Group List Choose the media resource group list (MRGL) for this group of 
phones/ports.

An MRGL specifies a list of prioritized media resource groups. An 
application can choose required media resources from the available 
ones according to the order that is defined in the MRGL.

User Hold Audio Source Choose the user hold audio source for this group of phones/ports.

The user hold audio source identifies the audio source from which 
music is played when a user places a call on hold.

Network Hold Audio Source Choose the network hold audio source for this group of IP phones 
or ports.

The network hold audio source identifies the audio source from 
which music is played when the system places a call on hold, such 
as when the user transfers or parks a call.

Location Choose the appropriate location for this group of IP phones or ports.

The location specifies the total bandwidth that is available for calls 
to and from this location. A location setting of None means that the 
locations feature does not keep track of the bandwidth that this 
Cisco IP Phone consumes.

User Locale Choose the country and language set that you want to associate with 
this group of IP phones.

This choice determines which cultural-dependent attributes exist 
for this user and which language displays for the user in the 
Cisco Unified CallManager user windows and phones.

Network Locale Choose the network locale that you want to associate with this 
group of phones. 

The Network Locale comprises a set of tones and cadences that 
Cisco gateways and phones use when communicating with the 
PSTN and other networks in a specific geographical area. 

Owner User ID Enter a user ID for the primary phone user.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Phone Load Name Enter the custom phone load, if applicable. 

Note Any value that is entered in this field overrides the default 
value for the chosen model.

For more information about Cisco IP Phone software and 
configuration, refer to the Cisco IP Phone Administration Guide for 
Cisco Unified CallManager 5.0, which is specific to the phone 
model.

Device Security Mode From the drop-down list box, choose the mode that you want to set 
for the device:

Use System Default—The phone uses the value that you specified 
for the enterprise parameter, Device Security Mode.

Non-secure—No security features exist for the phone. A TCP 
connection opens to Cisco Unified CallManager.

Authenticated—Cisco Unified CallManager provides integrity and 
authentication for the phone. A TLS connection using NULL/SHA 
opens.

Encrypted—Cisco Unified CallManager provides integrity, 
authentication, and encryption for the phone. A TLS connection 
using AES128/SHA opens

This field displays only if the phone model supports authentication 
or encryption.

Built In Bridge Enable or disable the built-in conference bridge for the barge 
feature by using the Built In Bridge drop-down list box (choose On, 
Off, or Default). 

For more configuration information, refer to the Barge and Privacy 
Features in the Cisco Unified CallManager Features and Services 
Guide.

Privacy For each phone that wants Privacy, choose On in the Privacy 
drop-down list box. 

For more configuration information, refer to Barge and Privacy 
Features in the Cisco Unified CallManager Features and Services 
Guide.

Retry Video Call as Audio This check box applies only to video endpoints that receive a call. 
If this phone receives a call that does not connect as video, the call 
tries to connect as an audio call.

By default, the system checks this check box to specify that this 
device should immediately retry a video call as an audio call (if it 
cannot connect as a video call) prior to sending the call to call 
control for rerouting.

If you uncheck this check box, a video call that fails to connect as 
video does not try to establish as an audio call. The call then fails to 
call control, and call control routes the call via Automatic Alternate 
Routing (AAR) and/or route/hunt list.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Ignore Presentation Indicators 
(Internal Calls Only)

Check this check box to configure call display restrictions on a 
call-by-call basis. When this check box is checked, 
Cisco Unified CallManager ignores any presentation restriction 
that is received for internal calls.

Allow Control of Device from 
CTI

Check this check box to allow control of all CTI controllable 
devices from CTI.

This check box can be enabled or disabled based on CTI 
Controllable Device Type and Device Protocol. For example, a 7960 
with SIP protocol is not supported by CTI, therefore, the check box 
should be disabled. A 7960 with SCCP protocol is supported by 
CTI, hence check box should be enabled.

Protocol Specific Information

Packet Capture Mode From the drop-down list box, choose the mode that you want to set 
for signal packet capture:

• None—Choose None if you do not want to specify a mode. 

• Real-Time Mode—Use this mode for real-time signal packet 
capture.

• Batch Processing Mode—Use this mode for batch processing 
signal packet capture mode.

Packet Capture Duration Enter the time for packet capture in minutes. You can enter a 
maximum duration of 300 minutes. The default duration specifies 
60 minutes.

Presence Group Used with the Presence feature, the SIP or SCCP phone serves as a 
watcher because it requests status about the presence entity, for 
example, directory number, that is configured as a BLF speed dial 
button on the phone.

If you want the phone to receive the status of the presence entity, 
choose a Presence group that is allowed to view the status of the 
Presence group that is applied to the directory number, as indicated 
in the Presence Group Configuration window.

Tip For more information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services Guide.

SIP Dial Rules If required, choose the appropriate SIP dial rule. SIP dial rules 
provide local dial plans for Cisco SIP IP Phones model 7905, 7912, 
7940, and 7960, so that users do not have to press a key or wait for 
a timer before the call gets processed. 

Leave the SIP Dial Rules field set to <None> if you do not want dial 
rules applied to the SIP IP Phone. This means the user will have to 
use the Dial softkey or wait for the timer to expire before the call 
gets processed.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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SCCP Phone Security Profile For SCCP phones, choose the security profile that you want to apply 
to the device. If the phone does not support the profile that you 
choose, Cisco Unified CallManager does not allow you to apply the 
configuration.

All phones require that you apply a security profile. If the phone 
does not support security, choose a nonsecure profile.

MTP Preferred Originating 
Codec

From the drop-down list box, choose the codec to use if a media 
termination point is required for SIP calls.

SIP Phone Security Profile For SIP phones, choose the security profile that you want to apply 
to the device. If the phone does not support the profile that you 
choose, Cisco Unified CallManager does not allow you to apply the 
configuration.

All phones require that you apply a security profile. If the phone 
does not support security, choose a nonsecure profile.

Rerouting Calling Search Space From the drop-down list box, choose a calling search space to use 
for rerouting. 

The rerouting calling search space of the referrer gets used to find 
the route to the refer-to target. When the Refer fails due to the 
rerouting calling search space, the Refer Primitive rejects the 
request with the “405 Method Not Allowed” message.

The redirection (3xx) primitive and transfer feature also uses the 
rerouting calling search space to find the redirect-to or transfer-to 
target.

Out-of-Dialog Refer Calling 
Search Space

From the drop-down list box, choose an out-of-dialog refer calling 
search space.

Cisco Unified CallManager uses the out-of-dialog (OOD) Refer 
Authorization calling search space (CSS) to authorize the SIP 
out-of-dialog Refer. The administrator can restrict the use of 
out-of-dialog Refer by configuring the OOD CSS of the Referrer. 
Refer Primitive rejects the OOD Refer request with a “403 
Forbidden” message.

SUBSCRIBE Calling Search 
Space

Used with the Presence feature, the SUBSCRIBE Calling Search 
Space determines how Cisco Unified CallManager routes the 
subscription requests that come from the phone. From the 
drop-down list box, choose the calling search space that you want 
to use for this purpose.

Tip For more information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services Guide.

SIP Profile Choose the default SIP profile or a specific profile that was 
previously created. SIP profiles provide specific SIP information 
for the phone such as default telephony event payload type, 
registration and keep alive timers, media ports, Iris, and dynamic 
DNS server addresses.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
3-13
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 3      Phone Template
Using BAT Phone Templates
Digest User Used with digest authentication (SIP security), choose an end user 
that you want to associate with the phone.

Ensure that you configured digest credentials for the user that you 
choose, as specified in the End User Configuration window.

After you save the phone configuration and reset the phone, the 
digest credentials for the user get added to the phone configuration 
file.

For more information on digest authentication, refer to the 
Cisco Unified CallManager Security Guide.

Unattended Port Check this check box to indicate an unattended port on this device.

Require DTMF Reception For SIP and SCCP phones, check this check box to require DTMF 
reception for this phone.

RFC2833 Disabled For SCCP phones, check this check box to disable RFC2833 
support.

Phone Button Template and Expansion Module Template Information

Phone Button Template Choose the button template for all phones in this group. Button 
templates determine the button identity (line, speed dial) and the 
button location on the phone. Button templates include the 
expansion modules.

Softkey Template Information

Softkey Template Choose the softkey template to be used for all phones in this group.

Expansion Module Information

Module 1 Choose the expansion module if installed in the phone.

Module 2 Choose the expansion module if installed in the phone.

Firmware Load Information 

 Module 1 Load Name Enter the firmware load for the first Cisco Unified IP Phone 
Expansion Module, if applicable. Leave this field blank to use the 
default load.

 Module 2 Load Name Enter the firmware load for the second Cisco Unified IP Phone 
Expansion Module, if applicable. Leave this field blank to use the 
default load. 

Cisco Unified IP Phone - External Data Locations 

Information Enter the help text URL for the information button for 
Cisco IP Phones.

Directory Enter the URL of the directory server for Cisco IP Phones.

Messages Enter the voice-messaging access pilot number for Cisco IP Phones.

Services Enter the URL for the services menu for Cisco IP Phones.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Authentication Server Enter the URL that the phone uses to validate requests that are made 
to the phones web server. If you do not provide an authentication 
URL, the advanced features on the Cisco Unified IP Phone models 
that require authentication will not function. Leave this field blank 
to accept the default setting.

By default, this URL accesses a Cisco Unified IP Phone User 
Options window that was configured during installation.

Proxy Server Enter the host and port (for example, proxy.cisco.com:80) that are 
used to proxy HTTP requests for access to non-local host addresses 
from the phones HTTP client.

If the phone receives a URL such as www.cisco.com in a service and 
the phone is not configured in the cisco.com domain, the phone uses 
the proxy server to access the URL. If the phone is configured in the 
cisco.com domain, the phone accesses the URL without using the 
proxy because it is in the same domain as the URL.

Leave this field blank to accept the default setting.

Idle Enter the URL of the XML service that will appear as the idle 
display on the Cisco Unified IP Phone LCD screen when the phone 
has not been used for the time that is specified in the Idle Time field. 
For example, you can display a logo on the LCD screen when the 
phone has not been used for 5 minutes. Leave this field blank to use 
the default value.

Idle Timer Enter the seconds that you want to elapse before the phone displays 
the URL that is specified in the Idle field. Leave this field blank to 
use the default value.

Extension Mobility (Device Profile) Information

Enable Extension Mobility 
Feature

Check this check box to enable the extension mobility feature. 
Extension mobility allows a user to log in and out of a 
Cisco IP Phone. Refer to the Cisco Unified CallManager Features 
and Services Guide for more information about extension mobility.

Log Out Profile Choose the profile that a phone should load when an extension 
mobility user logs out. You must configure logout profiles in 
Cisco Unified CallManager Administration.

Use Current Device Setting—This choice creates an autogenerated 
device profile as the default device profile.

Select a User Device Profile—This choice assigns a user device 
profile, which has already been defined, that becomes the default 
device profile for this device. 

The chosen user device profile gets loaded onto the device when no 
user is logged in. 

Certification Authority Proxy Function (CAPF) Information (These parameters display only for devices with 
the capability to support authentication or encryption.)

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
3-15
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 3      Phone Template
Using BAT Phone Templates
Certificate Operation From the drop-down list box, choose the Certification Operation 
that you want to perform from the following options:

• No Pending Operation—No pending Certification Operation 
lists for this device. Choosing this option disables the 
remaining CAPF fields. 

• Install/Upgrade—Install or upgrade a Certification Operation.

• Delete—Delete a Certification Operation

• Troubleshoot—Troubleshoot a Certification Operation.

Authentication String If you chose the By Authentication String option from the 
Authentication Mode drop-down list box in the security profile, this 
setting applies. Manually enter a numeric string that contains 4 to 
10 digits. To install, upgrade, or troubleshoot a locally significant 
certificate, the phone user or administrator must enter the 
authentication string on the phone.

Operation Completes By This field, which supports the Install/Upgrade, Delete, and 
Troubleshoot Certificate Operation options, specifies the date and 
time in which you must complete the operation. 

Certificate Operation Status This field displays the progress of the certificate operation; for 
example, <operation type> pending, failed, or successful, where 
operating type equals the Install/Upgrade, Delete, or Troubleshoot 
Certificate Operation options. You cannot change the information 
that displays in this field.

MultiLevel Precedence and Preemption (MLPP) Information

MLPP Indication If available, this setting specifies whether a device capable of 
playing precedence tones will use the capability when it places an 
MLPP precedence call.

From the drop-down list box, choose a setting to assign to this 
device from the following options:

• Default—This device inherits its MLPP indication setting from 
its device pool.

• Off—This device does not send indication of an MLPP 
precedence call.

• On—This device does send indication of an MLPP precedence 
call.

Note Do not configure a device with the following combination of 
settings: MLPP Indication is set to Off while MLPP 
Preemption is set to Forceful.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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MLPP Preemption If available, this setting specifies whether a device that is capable of 
preempting calls in progress will use the capability when it places 
an MLPP precedence call.

From the drop-down list box, choose a setting to assign to this 
device from the following options:

• Default—This device inherits its MLPP preemption setting 
from its device pool.

• Disabled—This device does not preempt calls in progress when 
it places an MLPP precedence call.

• Forceful—This device preempts calls in progress when it 
places an MLPP precedence call.

Note Do not configure a device with the following combination of 
settings: MLPP Indication is set to Off while MLPP 
Preemption is set to Forceful.

MLPP Domain (e.g., "0000FF") Enter a hexadecimal value for the MLPP domain associated with 
this device. Must be blank or a value between 0 and FFFFFF.

H.323 Device Information

Signaling Port The value designates the H.225 signaling port that this device uses.

The default value specifies 1720. Valid values include 1 through 
65535.

Retry Video Call as Audio This check box applies only to video endpoints that receive a call. 
If this phone receives a call that does not connect as video, the call 
tries to connect as an audio call.

By default, the system checks this check box to specify that the 
sending device should immediately retry a video call that does not 
connect as an audio call prior to sending the call to call control for 
rerouting.

If you uncheck this check box, a video call that fails to connect as 
video fails to call control. At this point, call control reroutes the call 
within the route list. If Automatic Alternate Routing (AAR) is 
configured and enabled, call control also reroutes the call between 
route lists.

Wait for Far End H.245 Terminal 
Capability Set

By default, the system keeps this check box checked to specify that 
Cisco Unified CallManager should initiate capabilities exchange. 
This check box specifies that the Cisco Unified CallManager needs 
to receive the far-end H.245 Terminal Capability Set before it sends 
its H.245 Terminal Capability Set.

H.323 Protocol Specific Information

SRTP Allowed When this check box is checked, IPSec needs to be configured in the 
network to provide end to end security. Failure to do so will expose 
keys and other information.

MTP Preferred Originating 
Codec

From the drop-down list box, choose the codec to use if a media 
termination point is required for SIP calls.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Media Termination Point 
Required

Use this field to indicate whether a media termination point (MTP) 
is used to implement features that H.323 does not support (such as 
hold and transfer).

Check the Media Termination Point Required check box if you want 
to use a media termination point to implement features. Uncheck the 
Media Termination Point Required check box if you do not want to 
use a media termination point to implement features.

Use this check box only for H.323 clients and those H.323 devices 
that do not support the H.245 empty capabilities set or if you want 
media streaming to terminate through a single source.

If you check this check box to require an MTP and this device 
becomes the endpoint of a video call, the call works as audio only.

H.323 Information

Outgoing Caller ID Pattern For incoming calls to the phone, enter the pattern, from 0 to 24 
digits, that you want to use for caller ID. 

Calling Party Selection Choose one of the following options to specify which directory 
number is sent: 

• Originator—Send the directory number of the calling device.

• First Redirect Number-—Send the directory number of the 
redirecting device. 

• Last Redirect Number—Send the directory number of the last 
device to redirect the call.

• First Redirect Number(external)—Send the directory number 
of the redirecting device. 

• Last Redirect Number(external)—Send the directory number of 
the last device to redirect the call.

Calling Party Presentation Choose whether the central office transmits or blocks caller ID:

• Choose Allowed if you want the central office to send caller ID. 

• Choose Restricted if you do not want the central office to send 
caller ID. 

• Default displays the caller ID unless the caller ID was restricted 
in a previous level in the call stream.

Display IE Delivery Check the check box to deliver the display information element (IE) 
in SETUP and CONNECT messages for the calling and called party 
name delivery service. 

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Redirecting Number IE 
Delivery—Outbound

Check this check box to include the Redirecting Number IE in the 
outgoing SETUP message from the Cisco Unified CallManager to 
indicate the first redirecting number and the redirecting reason of 
the call when the call is forwarded. 

Uncheck the check box to exclude the first redirecting number and 
the redirecting reason from the outgoing SETUP message. 

Use Redirecting Number IE for voice-messaging integration only. If 
your configured voice-messaging system supports Redirecting 
Number IE, check the check box. 

Redirecting Number IE 
delivery—Inbound

Use Redirecting Number IE when you are integrating a 
voice-messaging system that supports Redirecting Number IE. 

Check this check box to accept the Redirecting Number IE in the 
incoming SETUP message to the Cisco Unified CallManager. 

Uncheck the check box to exclude the Redirecting Number IE in the 
incoming SETUP message to the Cisco Unified CallManager. 

Gatekeeper Information

Gatekeeper Name Choose the gatekeeper for the gatekeeper-controlled H.323 device 
from the drop-down list box.

Note If you do not choose the device, the system disables the 
E.164, Technology Prefix, and Zone fields.

Note You cannot change the device to a gatekeeper-controlled 
phone if more than one directory number is configured for 
the device.

E.164 Choose the E.164 address that is registered with the gatekeeper.

Note Ensure the H.323 client is configured as a 
gatekeeper-controlled device.

Note You must enter a value in this field for a 
gatekeeper-controlled H.323 client. You can enter only 
numbers (0-9) and special characters # and * in this field.

Technology Prefix Enter the technology prefix to eliminate the need for entering the IP 
address for every Cisco Unified CallManager system when 
configuring the gw-type-prefix command. For example, you can 
enter 1#* in this field if you can use the following gw-type-prefix 
command on the gatekeeper:

gw-type-prefix 1#* default-technology.

Note You must enter a value in this field for a 
gatekeeper-controlled H.323 client. You can enter only 
numbers (0-9) and special characters # and * in this field. 

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Note To continue configuring the BAT phone template, go to the “Creating a New BAT Phone Template” 
section on page 3-4

Field Descriptions for Adding a Line to a BAT Template
Table 3-2 provides descriptions of all possible fields that display when you are adding a line in a BAT 
phone, gateway, or UDP template. Some device types do not require all the phone settings.

Some fields display the values that were configured in Cisco Unified CallManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have 
asterisk as optional.

For related procedures, see the “Related Topics” section on page 3-41.

Zone On the Gatekeeper, enter the specific zone with which 
Cisco Unified CallManager will register. The zone specifies the 
total bandwidth that is available for calls between this zone and 
another zone.

Note You must enter a value in this field for a 
gatekeeper-controlled phone. You can enter only letters, 
numbers, spaces, dashes, dots, and underscores in this field.

Gatekeeper Controlled H.323 
Client

Check this check box to configure the H.323 client gatekeeper as a 
controlled gatekeeper.

Secure Shell Information

Secure Shell User Enter a user ID for the secure shell user. If the phone you are 
configuring does not support secure shell access, this field does not 
display. Cisco Technical Assistance Center (TAC) uses secure shell 
for troubleshooting. Contact TAC for further assistance.

Secure Shell Password Enter the password for a secure shell user. If the phone you are 
configuring does not support secure shell access, this field does not 
display. Contact TAC for further assistance.

Product-Specific Configuration

Model-specific configuration 
fields defined by the device 
manufacturers 

The device manufacturer specifies the model-specific fields under 
product-specific configuration. Because they are dynamically 
configured, they can change without notice. 

To view field descriptions and help for product-specific 
configuration items, click the “i” information icon to the right of the 
Product Specific Configuration heading to display help in a popup 
dialog box.

If you need more information, refer to the documentation for the 
specific device that you are configuring or contact the manufacturer.

Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
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Table 3-2 Field Descriptions for Adding a Line to a BAT Template

Field Description

Directory Number Information

Line Template Name Enter a unique name for the line template.

Route Partition Choose a route partition to which the directory number belongs.

Note The directory number can appear in more than one 
partition.

Description Enter description for the line template

Alerting Name This name represents the name that displays during an alert to 
a shared directory number. For non-shared directory numbers, 
during alerts, the system uses the name that is entered in the 
Display field.

Alerting Name ASCII This field provides the same information as the Alerting Name 
field, but you must limit input to ASCII characters. Devices that 
do not support Unicode (internationalized) characters display 
the content of the Alerting Name ASCII field.

Active To view this check box on the Directory Number Configuration 
window, access an unassigned directory number from the Route 
Plan Report window. Checking this check box allows calls to 
this DN to be forwarded (if forwarding is configured). If check 
box is not checked, Cisco Unified CallManager ignores the 
DN.

Directory Number Settings

Voice Mail Profile Choose this parameter to make the pilot number the same as the 
directory number for this line. This action proves useful if you 
do not have a voice-messaging server that is configured for this 
phone.

Calling Search Space Choose partitions that are searched for numbers that are called 
from this directory number.

Note Changes cause an update of Pickup Group Names that 
are listed in the Call Pickup Group field. The setting 
applies to all devices that are using this directory 
number.

Presence Group Used with the Presence feature, the directory number serves as 
the presence entity; that is, watchers request the status of the 
directory number, so the real-time status of the directory 
number displays on the device.

If you want the phone to receive the status of the presence 
entity, make sure that the Presence group of the watcher is 
allowed to view the status of the Presence group that is applied 
to the directory number, as indicated in the Presence Group 
Configuration window. 

For information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services Guide.
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AAR Group Choose the automated alternate routing (AAR) group for this 
device. The AAR group provides the prefix digits that are used 
to route calls that are otherwise blocked due to insufficient 
bandwidth. 

Set AAR Group to <None> to prevent rerouting blocked calls.

User Hold Audio Source Choose the music on hold audio source to be played when the 
user presses HOLD to place a call on hold.

Network Hold Audio Source Choose the music on hold audio source to be played when the 
system places a call on hold while the user transfers a call or 
initiates a conference or call park.

Call Forward and Pickup Settings

Forward All Voice Mail Check this check box if you want calls to forward to the number 
that you chose in the voice-mail profile.

Checking this check box makes the Forward All Destination 
field and Forward All Calling Search Space check box not 
relevant. 

Forward All Destination Enter the directory number to which all calls are forwarded.

Note The setting applies to any dialable phone number, 
including an outside destination unless restricted, and 
to all devices that are using this directory number.

Forward All Calling Search Space Choose the calling search space to use when calls are forwarded 
to the specified destination.

Note This setting applies to all devices that are using this 
directory number.

Secondary Calling Search Space for 
Forward All 

Choose the secondary calling search space (CSS) from the 
drop-down list box. 

Because Call Forwarding is a line-based feature, in cases where 
the device calling search space is unknown, only the line calling 
search space is used to forward the call. If the line calling 
search space is restrictive and not routable, the forward attempt 
fails.

Addition of a secondary calling search space for Call Forward 
All provides a solution to enable forwarding. The primary 
calling search space for Call Forward All and secondary calling 
search space for Call Forward All get concatenated (Primary 
CFA CSS + Secondary CFA CSS) when processing Call 
Forward All. Cisco Unified CallManager uses this combination 
to validate the CFA destination and to forward the call.

Forward Busy Internal Voice Mail Check this check box if you want calls from an internal number 
forwarded to a number that you chose in the voice-mail profile.

Checking this check box makes the Forward Busy Internal 
Destination field and Calling Search Space check box not 
relevant.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)
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Forward Busy Internal Destination Enter the directory number to which an internal call is 
forwarded when the line is in use.

Note This setting applies to any internal dialable phone 
number and to all devices that are using this directory 
number.

Forward Busy Internal Calling 
Search Space

Choose the calling search space to use when internal calls are 
forwarded to the specified destination.

Note This setting applies to all devices that are using this 
directory number.

Forward Busy External Voice Mail Check this check box if you want calls from an external number 
forwarded to a number that you chose in the voice-mail profile.

Checking this check box makes the Forward Busy External 
Destination field and Calling Search Space check box not 
relevant. 

Forward Busy External Destination Enter the directory number to which an external call is 
forwarded when the line is in use.

Note This setting applies to any dialable external phone 
number, including an outside destination unless 
restricted, and to all devices that are using this directory 
number.

Forward Busy External Calling 
Search Space

Choose the calling search space to use when external calls are 
forwarded to the specified destination.

Note This setting applies to all devices that are using this 
directory number.

Forward No Answer Internal Voice 
Mail

Check this check box if you want calls from an internal number 
forwarded to the number that you chose in the voice-mail 
profile.

Checking this check box makes the Forward No Answer 
Internal Destination field and Calling Search Space check box 
not relevant. 

Forward No Answer Internal 
Destination

Enter a directory number to which an internal call is forwarded 
when the phone is not answered.

Note This setting applies to any internal dialable phone 
number and to all devices that are using this directory 
number.

Forward No Answer Internal 
Calling Search Space

Choose the calling search space to use when internal calls are 
forwarding to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)
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Forward No Answer External Voice 
Mail

Check this check box if you want calls to forward to an external 
number that you chose in the voice-mail profile.

Checking this check box makes the Forward No Answer 
Externally Destination field and External Calling Search Space 
check box are not relevant. 

Forward No Answer External 
Destination

Enter a directory number to which an external call is forwarded 
when the phone is not answered.

Note This setting applies to any external dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this directory 
number.

Forward No Answer External 
Calling Search Space

Choose the calling search space to use when external calls are 
forwarding to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number.

Forward No Coverage Internal 
Voice Mail

Check this check box if you want calls from an internal number 
forwarded to the number that you chose in the voice-mail 
profile.

Checking this check box makes the Forward No Answer 
Destination field and Calling Search Space check box not 
relevant. 

Forward No Coverage Internal 
Destination

Enter an directory number to which an internal call is forwarded 
when the phone has no coverage.

Note This setting applies to any internal dialable phone 
number and to all devices that are using this directory 
number.

Forward No Coverage Internal 
Calling Search Space

Choose the calling search space to use when internal calls are 
forwarding to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number.

Forward No Coverage External 
Voice Mail

Check this check box if you want calls from external number 
forwarded to the number that you chose in the voice-mail 
profile.

Checking this check box makes the Forward No Answer 
Destination field and Calling Search Space check box not 
relevant. 

Forward No Coverage External 
Destination

Enter a directory number to which an external call is forwarded 
when the phone has no coverage.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and 
to all devices that are using this directory number.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)
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Forward No Coverage External 
Calling Search Space

Choose the calling search space to use when external calls are 
forwarding to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number.

Forward on CTI Failure Voice Mail The Forward on CTI Failure field applies only to CTI route 
points and CTI ports. The settings in this row specify the 
forwarding treatment for external calls to this CTI route point 
or CTI port if the CTI route point or CTI port fails.

Check this check box to use settings in the Voice Mail Profile 
Configuration window. 

When this check box is checked, Cisco Unified CallManager 
ignores the settings in the Destination box and Calling Search 
Space. When this check box is checked for internal calls, the 
system automatically checks the Voice Mail check box for 
external calls. If you do not want external calls to forward to the 
voice-messaging system, you must uncheck the Voice Mail 
check box for external calls.

Forward on CTI Failure Destination This setting specifies the directory number to which an internal 
nonconnected call is forwarded when an application that 
controls that directory number fails. Use any dialable phone 
number, including an outside destination.

When you enter a destination value for internal calls, the system 
automatically copies this value to the Destination field for 
external calls. If you want external calls to forward to a 
different destination, you must enter a different value in the 
Destination field for external calls.

Forward on CTI Failure Calling 
Search Space

This setting applies to all devices that are using this directory 
number.

When you choose a Calling Search Space for internal calls, the 
system automatically copies this setting to the Calling Search 
Space setting for external calls. If you want external calls to 
forward to a different calling search space, choose a different 
setting in the Calling Search Space for external calls.

No Answer Ring Duration Enter the number of seconds to allow the call to ring before 
forwarding the call to the Forward No Answer Destination.

Call Pickup Group Choose a Pickup Group Name to specify the call pickup group, 
which can answer incoming calls to this directory number by 
dialing the appropriate pickup group number.

Multilevel Precedence and Preemption Alternate Party Settings 

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description
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Target (Destination) Enter the number to which MLPP precedence calls should be 
directed if this directory number receives a precedence call and 
neither this number nor its call forward destination answers the 
precedence call.

Values can include numeric characters, pound (#), and asterisk 
(*).

MLPP Calling Search Space From the drop-down list box, choose the calling search space to 
associate with the alternate party target (destination) number.

MLPP No Answer Ring Duration 
(Seconds)

Enter the number of seconds (between 4 and 30) after which an 
MLPP precedence call will be directed to the alternate party of 
this directory number if this directory number and its call 
forwarding destination have not answered the precedence call.

Leave this setting blank to use the value that is set in the 
Cisco Unified CallManager enterprise parameter, Precedence 
Alternate Party Timeout.

Line Settings for This Phone

Display (Internal Caller ID) Use this field only if you do not want the directory number to 
show on the line appearance. Enter text that identifies this 
directory number for a line/phone combination. 

Suggested entries include boss’s name, department’s name, or 
other appropriate information to identify multiple directory 
numbers to secretary/assistant who monitors multiple directory 
numbers.

Line Text Label Enter text that identifies this directory number for a line/phone 
combination.

Note The default language specifies English

External Phone Number Mask Enter the phone number (or mask) that is sent for Caller ID 
information when a call is placed from this line.

You can enter a maximum of 24 numbers and “X” characters. 
The Xs represent the directory number and must appear at the 
end of the pattern. For example, if you specify a mask of 
972813XXXX, an external call from extension 1234 displays a 
caller ID number of 9728131234.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description
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Message Waiting Lamp Policy Use this field to configure the handset lamp illumination policy. 
Choose one of the following options:

• Use System Policy (The directory number refers to the 
service parameter “Message Waiting Lamp Policy” 
setting.)

• Light and Prompt

• Prompt Only

• Light Only

• None

Setting applies only to the current device unless you check the 
check box at right (called Update Shared Device Settings) and 
click the Propagate selected button. (The check box at right 
displays only if other devices share this directory number.)

Ring Setting (Phone Idle) Choose the ring setting for the line appearance when an 
incoming call is received and no other active calls exist on that 
device. Choose one of the following options:

• Use system default

• Disable

• Flash only

• Ring once

• Ring

Ring Setting (Phone Active) Choose the ring setting that is used when this phone has another 
active call on a different line. Choose one of the following 
options:

• Use system default

• Disable

• Flash only

• Ring once

• Ring

• Beep only

Multiple Call/Call Waiting Settings

Maximum Number of Calls You can configure up to 184 calls for a line on a device in a 
cluster, with the limiting factor being the device. As you 
configure the number of calls for one line, the calls available for 
another line decrease. 

The default specifies 4. If the phone does not allow multiple 
calls for each line, the default specifies 2. 

For CTI route points, you can configure up to 10,000 calls for 
each port. The default specifies 5000 calls. 

Use this field in conjunction with the Busy Trigger field.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)
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Note To complete the procedure for phones and UDPs, go to the “Adding or Updating Lines in a BAT 
Template” section on page 3-4. To complete the updates for gateways, see Chapter 43, “Gateway 
Template.”

Note You can edit the device or line by choosing device name in the Associated Devices list box and clicking 
Edit Device or Edit Line Appearance. 

Using the BAT Spreadsheet to Create a CSV Data File for Phones
When you are adding new phones or IP telephony devices to the system, you can use the Microsoft Excel 
spreadsheet that was designed to use with BAT. The spreadsheet has macros that automatically adjust the 
options for the selected devices. You can define the file format within the spreadsheet, and the BAT 
spreadsheet uses the data file formats to display the fields for the CSV data file. 

Use the following procedure to create the CSV data file by using the BAT spreadsheet for adding new 
phones and other IP telephony devices.

For information about installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet 
for Gathering Data” section on page 1-8.

Busy Trigger This setting, which works in conjunction with Maximum 
Number of Calls and Call Forward Busy, determines the 
maximum number of calls to be presented at the line. If 
maximum number of calls is set for 50 and the busy trigger is 
set to 40, then incoming call 41 gets rejected with a busy cause 
(and will get forwarded if Call Forward Busy is set). If this line 
is shared, all the lines must be busy before incoming calls get 
rejected.

Use this field in conjunction with Maximum Number of Calls 
for CTI route points. The default specifies 4500 calls.

Forwarded Call Information Display for this Device

Caller Name Check this check box to include the caller’s name in the display 
when a forwarded call is received. Default leaves this check box 
checked.

Caller Number Check this check box to include the caller’s number in the 
display when receiving a forwarded call. 

Redirected Number Check this check box to include the redirected number in the 
display when receiving a forwarded call. 

Dialed Number Check this check box to include the dialed number in the 
display when a forwarded call is received. The default setting 
leaves this check box checked.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description
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Procedure

Step 1 To open the BAT spreadsheet, locate and double-click the BAT.xlt file 

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To display the phones options, click the Phones tab at the bottom of the spreadsheet.

Step 4 Choose a radio button for one of the following device types:

• Phones

• CTI Port 

• H.323 Client

• VGC Phones

• VGC Virtual Phones

The spreadsheet displays options that are available for the chosen device. For example, when you choose 
Phones, fields for the number of phone lines and the number of speed dials display.

Note The device type that you select determines the validation criteria for data in the BAT 
spreadsheet.

Step 5 To choose the device and line fields that you can define for each phone, click Create File Format. The 
Field Selection popup window displays.

Step 6 To choose the device fields, click a device field name in the Device Field box, and then click the arrow 
to move the field to the Selected Device Fields box.

A CSV data file must include MAC Address/Device Name, and Description; therefore, these fields 
always remain selected.

Tip You can select a range of items in the list by holding down the Shift key. To select random field 
names, hold down the Ctrl key and click field names. 

Step 7 Click a line field name in the Line Field box and click the arrow to move the field to the Selected Line 
Fields box.

Tip You can change the order of the items in the Selected Line and Device boxes. Choose an item 
and use the up arrow to move the field closer to the beginning of the list, or the down arrow to 
move the item to the end of the list.

Step 8 Click Create to modify the CSV data file format. A message asks whether you want to overwrite the 
existing CSV format. 

Step 9 Click OK. New columns for the selected fields display in the BAT spreadsheet in the order that you 
specified.

Step 10 Scroll to the right to locate the Number of Phone Lines box. The number of lines that you specify here 
must not exceed the number of lines that are configured in the BAT template.
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Note When you insert a CSV data file, the number of lines on phones must not exceed the number of 
lines in the BAT phone template, or you receive an error.

Step 11 For phones, you must enter the number of speed-dial buttons in the Number of Speed Dials box. After 
you enter the number, columns display for each speed-dial number.

Note When you insert the data records, do not exceed the number of speed dials that are configured 
in the BAT template, or an error will result when the CSV data file and BAT phone template are 
inserted.

Step 12 Enter data for an individual phone on each line in the spreadsheet. Complete all mandatory fields and 
any relevant optional fields. Each column heading specifies the length of the field and whether it is 
required or optional. Table 3-3 describes all the phone fields in the BAT spreadsheet. 

Step 13 If you did not enter the MAC address for each phone, check the Create Dummy MAC Address check 
box.

When you choose the dummy MAC address option, you can update the phones later with the correct 
MAC address by manually entering this information into Cisco Unified CallManager Administration or 
by using the Unified CM Auto-Register Phone Tool tool. See the “Introducing Cisco Unified CM 
Auto-Register Phone Tool” section on page 52-2 for more information about Unified CM Auto-Register 
Phone Tool.

Note If you are adding CTI ports, the dummy MAC address option gives a unique device name to each 
CTI port in the form of the dummy MAC addresses.
Do not use the dummy MAC address option for H.323 clients, VGC phones, or VGC virtual 
phones.

Step 14 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT 
Format.

The system saves the file to your choice of a folder on your local workstation under the following 
filename: 

<tabname>-<timestamp>.txt 

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> 
represents the precise date and time that the file was created.

Note If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when 
you export to BAT format.
If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. 
The system does not convert data that is entered after a blank line to the BAT format.

Note A CSV filename with a comma (for example, abcd,e.txt) cannot be uploaded to the 
Cisco Unified CallManager server.
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You must upload the CSV data file to the Cisco Unified CallManager first node database server, so BAT 
can access the CSV data file. For more information on uploading and downloading files, see Chapter 2, 
“Uploading and Downloading Files.” 

Note For information on how to read the exported CSV data file, click the link to View Sample File in the 
Insert Phones window in BAT.

Additional Topics

See the “Related Topics” section on page 3-41.

Field Descriptions for Phones in the BAT Spreadsheet

Table 3-3 provides descriptions of the phone fields that are available for adding device and line details 
in a CSV data file. For related procedures, see the “Related Topics” section on page 3-41.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet

Field Description

Device Fields 

MAC Address/Device Name Enter the MAC address for phones, VGC virtual phones, and VGC 
phones. Enter a unique identifier (Device Name) for the CTI port or 
H.323 client. You can check the Create Dummy MAC Addresses 
check box to automatically generate unique device identifiers.

Description Enter a description such as “Conference Room A” or “John Smith” 
that identifies the phone or device. 

Media Resource Group List Enter the media resource group list (MRGL) for this group of 
phones/ports.

An MRGL specifies a list of prioritized media resource groups. An 
application can choose required media resources from the available 
ones according to the order that is defined in the MRGL.

User Hold Audio Source Enter the user hold audio source that this group of IP phones or CTI 
ports should use.

The user hold audio source identifies the audio source from which 
music is played when a user places a call on hold.

Network Hold Audio Source Enter the network hold audio source that this group of IP phones or 
CTI ports should use.

The network hold audio source identifies the audio source from which 
music is played when the system places a call on hold, such as when 
the user transfers or parks a call.

User Locale Enter the country and language set that you want to associate with this 
group of IP phones.

This choice determines which cultural-dependent attributes exist for 
this user and which language displays for the user in the 
Cisco Unified CallManager user windows and phones.
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Network Locale Enter the network locale that you want to associate with this group of 
phones. 

The Network Locale comprises a set of tones and cadences that Cisco 
gateways and phones use when communicating with the PSTN and 
other networks in a specific geographical area. 

Softkey Template Enter the softkey template to be used for all phones in this group.

Common Phone Profile From the drop-down list box, choose a common phone profile from 
the list of available common phone profiles.

Presence Group Used with the Presence feature, the SIP or SCCP phone serves as a 
watcher because it requests status about the presence entity, for 
example, directory number, that is configured as a BLF speed dial 
button on the phone.

If you want the phone to receive the status of the presence entity, 
choose a Presence group that is allowed to view the status of the 
Presence group that is applied to the directory number, as indicated in 
the Presence Group Configuration window.

Tip For more information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services Guide.

Phone Load Name Enter the custom phone load, if applicable. 

Note Any value that is entered in this field overrides the default 
value for the chosen model.

Value does not apply for CTI ports. 

Security Profile Enter the security profile that you want to apply to the device. If the 
phone does not support the profile that you choose, 
Cisco Unified CallManager does not allow you to apply the 
configuration.

All phones require that you apply a security profile. If the phone does 
not support security, choose a nonsecure profile.

SUBSCRIBE Calling Search 
Space

Used with the Presence feature, the SUBSCRIBE Calling Search 
Space determines how Cisco Unified CallManager routes the 
subscription requests that come from the phone. From the drop-down 
list box, choose the calling search space that you want to use for this 
purpose.

Tip For more information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services Guide.

E.164 Choose the E.164 address that is registered with the gatekeeper.

Note Ensure the H.323 client is configured as a 
gatekeeper-controlled device.

Note You must enter a value in this field for a gatekeeper-controlled 
H.323 client. You can enter only numbers (0-9) and special 
characters # and * in this field. 

User ID Enter the user ID for the phone user.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
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Media Resource Group List This list provides a prioritized grouping of media resource groups. An 
application chooses the required media resource, such as a Music On

Hold server, from among the available media resources according to 
the priority order that is defined in a Media Resource List.

AAR Calling Search Space Enter the appropriate calling search space for the device to use when 
it performs automated alternate routing (AAR). The AAR calling 
search space specifies the collection of route partitions that are 
searched to determine how to route a collected (originating) number 
that is otherwise blocked due to insufficient bandwidth.

MLPP Domain Enter a hexadecimal value for the MLPP domain associated with this 
device. Must be blank or a value between 0 and FFFFFF

MLPP Indication If available, this setting specifies whether a device capable of playing 
precedence tones will use the capability when it places an MLPP 
precedence call.

• Default—This device inherits its MLPP indication setting from 
its device pool.

• Off—This device does not handle nor process indication of an 
MLPP precedence call.

• On—This device does handle and process indication of an MLPP 
precedence call.

MLPP Preemption If available, this setting specifies whether a device that is capable of 
preempting calls in progress will use the capability when it places an 
MLPP precedence call.

• Default—This device inherits its MLPP indication setting from 
its device pool.

• Off—This device does not handle nor process indication of an 
MLPP precedence call.

• On—This device does handle and process indication of an MLPP 
precedence call.

Packet Capture Mode Enter the mode that you want to set for signal packet capture:

• None—Choose None if you do not want to specify a mode. 

• Real-Time Mode—Use this mode for real-time signal packet 
capture.

• Batch Processing Mode—Use this mode for batch processing 
signal packet capture mode.

Packet Capture Duration Enter the time for packet capture in minutes. You can enter a 
maximum duration of 300 minutes.

Authentication String Enter a numeric string that contains 4 to 10 digits. To install, upgrade, 
or troubleshoot a locally significant certificate, the phone user or 
administrator must enter the authentication string on the phone.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
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Ignore Presentation Indicator Enter Yes or No to configure call display restrictions on a call-by-call 
basis. When this check box is checked, Cisco Unified CallManager 
ignores any presentation restriction that is received for internal calls.

SIP Profile Enter the default SIP profile or a specific profile that was previously 
created. SIP profiles provide specific SIP information for the phone 
such as default telephony event payload type, registration and keep 
alive timers, media ports, Iris, and dynamic DNS server addresses.

Digest User Used with digest authentication (SIP security), choose an end user that 
you want to associate with the phone.

Ensure that you configured digest credentials for the user that you 
choose, as specified in the End User Configuration window.

After you save the phone configuration and reset the phone, the digest 
credentials for the user get added to the phone configuration file.

For more information on digest authentication, refer to the 
Cisco Unified CallManager Security Guide.

Log Out Profile Enter the profile that a phone should load when an extension mobility 
user logs out. You must configure logout profiles in 
Cisco Unified CallManager Administration.

Use Current Device Setting—This choice creates an autogenerated 
device profile as the default device profile.

Select a User Device Profile—This choice assigns a user device 
profile, which has already been defined, that becomes the default 
device profile for this device. 

The chosen user device profile gets loaded onto the device when no 
user is logged in. 

SIPCodec_MTPPreferredOri
gCodec

Enter the codec to use if a media termination point is required for SIP 
calls.

Dial Rules If required, enter the appropriate SIP dial rule. SIP dial rules provide 
local dial plans for Cisco SIP IP Phones model 7905, 7912, 7940, and 
7960, so that users do not have to press a key or wait for a timer before 
the call gets processed. 

Leave the SIP Dial Rules field set to <None> if you do not want dial 
rules applied to the SIP IP Phone. This means the user will have to use 
the Dial softkey or wait for the timer to expire before the call gets 
processed.

Calling Search Space Reroute Enter a calling search space to use for rerouting. 

The rerouting calling search space of the referrer gets used to find the 
route to the refer-to target. When the Refer fails due to the rerouting 
calling search space, the Refer Primitive rejects the request with the 
“405 Method Not Allowed” message.

The redirection (3xx) primitive and transfer feature also uses the 
rerouting calling search space to find the redirect-to or transfer-to 
target.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
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Calling Search Space Refer Enter an out-of-dialog refer calling search space.

Cisco Unified CallManager uses the out-of-dialog (OOD) Refer 
Authorization calling search space (CSS) to authorize the SIP 
out-of-dialog Refer. The administrator can restrict the use of 
out-of-dialog Refer by configuring the OOD CSS of the Referrer. 
Refer Primitive rejects the OOD Refer request with a “403 Forbidden” 
message.

Certificate Operation Enter the Certification Operation that you want to perform from the 
following options:

• No Pending Operation—No pending Certification Operation lists 
for this device. Choosing this option disables the remaining 
CAPF fields. 

• Install/Upgrade—Install or upgrade a Certification Operation.

• Delete—Delete a Certification Operation

• Troubleshoot—Troubleshoot a Certification Operation.

Certificate Operation 
Completion Time 

This field, which supports the Install/Upgrade, Delete, and 
Troubleshoot Certificate Operation options, specifies the date and 
time in which you must complete the operation. 

Secure Shell User Enter a user ID for the secure shell user. If the phone you are 
configuring does not support secure shell access, this field does not 
display. Cisco Technical Assistance Center (TAC) uses secure shell 
for troubleshooting. Contact TAC for further assistance.

Secure Shell Password Enter the password for a secure shell user. If the phone you are 
configuring does not support secure shell access, this field does not 
display. Contact TAC for further assistance.

Device Pool Enter the appropriate device pool.

The device pool specifies a collection of properties for this device 
including CallManager Group, Date/Time Group, Region, and Calling 
Search Space for auto registration of devices.

Built-in Bridge Enter On, Off, or Default to enable or disable the built-in conference 
bridge for the barge feature.

For more configuration information, refer to the Barge and Privacy 
Features in the Cisco Unified CallManager Features and Services 
Guide.

Calling Search Space Enter the appropriate calling search space. A calling search space 
comprises a collection of partitions that are searched for numbers that 
are called from this phone number. The value that you choose applies 
to all devices that are using this phone number. For configuration 
information about calling search space refer to Cisco Unified 
CallManager Administration Guide.

Location Choose the appropriate location for this phone. A location setting of 
Hub_None means that the locations feature does not keep track of the 
bandwidth that this phone consumes.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
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Module 1 Enter the appropriate expansion module or none.

Module 1 Load Name Enter the custom software for the appropriate expansion module, if 
applicable.

The value that you enter overrides the default value for the current 
model. Ensure the firmware load matches the module load.

Module 2 Enter the appropriate expansion module or none.

Module 2 Load Name Module 2 Load Name Enter the custom software for the second 
expansion module, if applicable. 

The value that you enter overrides the default value for the current 
model. Ensure the firmware load matches the module load.

Phone Template Enter the phone template name that you created for this type of bulk 
transaction.

Authentication Server Enter the URL that the phone uses to validate requests that are made 
to the phones web server. If you do not provide an authentication 
URL, the advanced features on the Cisco Unified IP Phone models 
that require authentication will not function. Leave this field blank to 
accept the default setting.

By default, this URL accesses a Cisco Unified IP Phone User Options 
window that was configured during installation.

Proxy Server Enter the host and port (for example, proxy.cisco.com:80) that are 
used to proxy HTTP requests for access to non-local host addresses 
from the phones HTTP client.

If the phone receives a URL such as www.cisco.com in a service and 
the phone is not configured in the cisco.com domain, the phone uses 
the proxy server to access the URL. If the phone is configured in the 
cisco.com domain, the phone accesses the URL without using the 
proxy because it is in the same domain as the URL.

Idle Enter the URL of the XML service that will appear as the idle display 
on the Cisco Unified IP Phone LCD screen when the phone has not 
been used for the time that is specified in the Idle Time field. 

For example, you can display a logo on the LCD screen when the 
phone has not been used for 5 minutes. 

Idle Timer Enter the seconds that you want to elapse before the phone displays 
the URL that is specified in the Idle field. 

Owner User ID Enter a user ID for the primary phone user.

Line Fields (Optional)

Directory Number Enter the directory number, up to 24 digits and special characters, for 
the phone.

Route Partition Enter a route partition to which the directory number belongs.

Note The directory number can appear in more than one partition.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
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Display Enter the text that you want to display on the called party’s phone 
display, such as the user name (John Smith) or phone location 
(Conference Room 1).

Note If this filed is left blank the system uses the value that is 
entered in the Directory Number field.

Note The default language specifies English.

Line Text Label Enter text that identifies this directory number for a line/phone 
combination. 

Note The default language specifies English

Voice Mail Profile Enter this parameter to make the pilot number the same as the 
directory number for this line. This action proves useful if you do not 
have a voice-messaging server that is configured for this phone.

Line Calling Search Space Enter partitions that are searched for numbers that are called from this 
directory number.

Note Changes cause an update of Pickup Group Names that are 
listed in the Call Pickup Group field. The setting applies to all 
devices that use this directory number.

AAR Group Enter the automated alternate routing (AAR) group for this device. 
The AAR group provides the prefix digits that are used to route calls 
that are otherwise blocked due to insufficient bandwidth. 

Set AAR Group to <None> to prevent rerouting blocked calls.

Line User Hold Audio Source Enter the music on hold audio source to be played when the user 
presses Hold and places a call on hold.

Line Network Hold Audio 
Source

Enter the music on hold audio source to be played when the system 
places a call on hold while the user transfers a call or initiates a 
conference or call park.

Forward All CSS Choose the calling search space to use when a call is forwarded to the 
specified destination.

Note This setting applies to all devices that are using this directory 
number. 

Secondary Calling Search 
Space for Forward All 

Enter the secondary calling search space (CSS) from the drop-down 
list box. 

Because Call Forwarding is a line-based feature, in cases where the 
device calling search space is unknown, only the line calling search 
space is used to forward the call. If the line calling search space is 
restrictive and not routable, the forward attempt fails.

Addition of a secondary calling search space for Call Forward All 
provides a solution to enable forwarding. The primary calling search 
space for Call Forward All and secondary calling search space for Call 
Forward All get concatenated (Primary CFA CSS + Secondary CFA 
CSS) when processing Call Forward All. Cisco Unified CallManager 
uses this combination to validate the CFA destination and to forward 
the call.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)
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Forward All Destination Enter the directory number to which all calls are forwarded.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward Busy External CSS Enter the calling search space to use when a call from an external 
number is forwarded to the specified destination.

Note This setting applies to all devices that are using this directory 
number. 

Forward Busy Internal CSS Enter the calling search space to use when a call from an internal 
number is forwarded to the specified destination.

Note This setting applies to all devices that are using this directory 
number. 

Forward Busy Destination 
External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward Busy Destination 
Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Calling Search Space 
Forward No Answer External 

Enter the calling search space to use when a call from an external 
number is forwarded to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number.

Forward No Answer Internal 
CSS

Enter the calling search space to use a call from an internal number is 
forwarded to the specified destination. The setting displays only if it 
is configured in the system.

Note This setting applies to all devices that are using this directory 
number.

Forward No Answer 
Destination External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward No Answer 
Destination Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)
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Forward No Coverage 
External CSS

Enter the calling search space to use when a call from an external 
number is forwarded to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number. 

Forward No Coverage 
Internal CSS

Enter the calling search space to use when a call from an internal 
number is forwarded to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number. 

Forward No Coverage 
Destination External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone does not have coverage.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward No Coverage 
Destination Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone does not have coverage.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Calling Search Space 
Forward on Failure 
External/Internal

(CTI ports only) Enter the calling search space to use when a call from 
an internal or external call is forwarded to the specified destination. 
The setting appears only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number.

Forward on Failure 
Destination External/Internal

(CTI ports only) Enter the directory number to which a call coming 
from an internal or an external number should be forwarded when a 
phone or CTI application fails.

Forward on CTI Failure 
Destination

This setting specifies the directory number to which an internal 
nonconnected call is forwarded when an application that controls that 
directory number fails. Use any dialable phone number, including an 
outside destination.

When you enter a destination value for internal calls, the system 
automatically copies this value to the Destination field for external 
calls. If you want external calls to forward to a different destination, 
you must enter a different value in the Destination field for external 
calls.

Forward on CTI Failure 
Calling Search Space

This setting applies to all devices that are using this directory number.

When you choose a Calling Search Space for internal calls, the system 
automatically copies this setting to the Calling Search Space setting 
for external calls. If you want external calls to forward to a different 
calling search space, choose a different setting in the Calling Search 
Space for external calls.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)
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Call Pickup Group Choose a Pickup Group Name to specify the call pickup group, which 
can answer incoming calls to this directory number by dialing the 
appropriate pickup group number.

External Phone Number 
Mask

Enter the phone number (or mask) that is sent for Caller ID 
information when a call is placed from this line.

You can enter a maximum of 24 numbers and “X” characters. The Xs 
represent the directory number and must appear at the end of the 
pattern. For example, if you specify a mask of 972813XXXX, an 
external call from extension 1234 displays a caller ID number of 
9728131234.

No Answer Ring Duration 
(CFNA)

Enter the number of seconds to allow the call to ring before 
forwarding the call to the Forward No Answer Destination.

Target Destination (MLPP) Enter the number to which MLPP precedence calls should be directed 
if this directory number receives a precedence call and neither this 
number nor its call forward destination answers the precedence call.

Values can include numeric characters, pound (#) ,and asterisk (*).

Calling Search Space (MLPP) Enter the calling search space to associate with the alternate party 
target (destination) number.

No Answer Ring Duration 
(MLPP)

Enter the number of seconds (between 4 and 30) after which an MLPP 
precedence call will be directed to this directory number’s alternate 
party if this directory number and its call forwarding destination have 
not answered the precedence call.

Leave this setting blank to use the value that is set in the 
Cisco Unified CallManager enterprise parameter, Precedence 
Alternate Party Timeout.

Maximum Number of Calls You can configure up to 200 calls for a line on a device in a cluster, 
with the limiting factor being the device. As you configure the number 
of calls for one line, the calls available for another line decrease. 

The default specifies 4. If the phone does not allow multiple calls for 
each line, the default specifies 2. 

For CTI route points, you can configure up to 10,000 calls for each 
port. The default specifies 5000 calls. Use this field in conjunction 
with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum Number of 
Calls and Call Forward Busy, determines the maximum number of 
calls to be presented at the line. If maximum number of calls is set for 
50 and the busy trigger is set to 40, then incoming call 41 gets rejected 
with a busy cause (and will get forwarded if Call Forward Busy is set). 
If this line is shared, all the lines must be busy before incoming calls 
get rejected.

Use this field in conjunction with Maximum Number of Calls for CTI 
route points. The default specifies 4500 calls.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)
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Note To complete the procedure, go to the “Using the BAT Spreadsheet to Create a CSV Data File for Phones” 
section on page 3-28.

Related Topics
• Adding Phones, page 3-1

• Using BAT Phone Templates, page 3-2

• Creating a New BAT Phone Template, page 3-4

• Adding or Updating Lines in a BAT Template, page 3-4

• Adding or Updating IP Services in a BAT Template, page 3-5

• Adding or Updating Speed Dials in a BAT Template, page 3-6

• Modifying BAT Phone Templates, page 3-7

• Copying a BAT Phone Template, page 3-8

Alerting Name This name represents the name that displays during an alert to a shared 
directory number. For non-shared directory numbers, during alerts, 
the system uses the name that is entered in the Display field.

Route Filter Enter a name in the Route Filter Name field. The name can contain up 
to 50 alphanumeric characters and can contain any combination of 
spaces, periods (.), hyphens (-), and underscore characters (_). Ensure 
each route filter name is unique to the route plan.

Note Use concise and descriptive names for your route filters. The 
CompanynameLocationCalltype format usually provides a 
sufficient level of detail and is short enough to enable you to 
quickly and easily identify a route filter. For example, 
CiscoDallasMetro identifies a route filter for toll free, 
inter-local access and transport area (LATA) calls from the 
Cisco office in Dallas.

Dial Plan Enter a dial plan; for example, North American Numbering Plan.

User Hold MOH Audio 
Source

Enter the audio source to use for music on hold (MOH) when a user 
initiates a hold action.

Line Network Hold MOH 
Audio Source

Enter the audio source to use for music on hold (MOH) when the 
network initiates a hold action.

E.164 Enter the E.164 address that is registered with the gatekeeper.

Note Ensure the H.323 client is configured as a 
gatekeeper-controlled device.

Note You must enter a value in this field for a gatekeeper-controlled 
H.323 client. You can enter only numbers (0-9) and special 
characters # and * in this field.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)
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Related Topics
• Deleting Templates, page 3-9

• Field Descriptions for a BAT Phone Template, page 3-9

• Using the BAT Spreadsheet to Create a CSV Data File for Phones, page 3-28

• Field Descriptions for Phones in the BAT Spreadsheet, page 3-31
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Phone File Format

The following topics provide information about configuring file formats for CSV data files that are 
created by using a text editor.

• Using a Text Editor to Create the CSV Data File for Phones, page 4-1

• Finding a Phone File Format, page 4-2

• Configuring a Phone File Format, page 4-2

• Associating the File Format with the CSV Data File, page 4-5

• Creating a Text-Based CSV File for Phones, page A-1

Using a Text Editor to Create the CSV Data File for Phones
You can create the CSV data file by using lines of ASCII text with values separated by commas. The 
comma separated values (CSV) file provides textual information in tabular form. For more information 
about text-based CSV files for phones, see the “Creating a Text-Based CSV File for Phones” section on 
page A-1.

Use one of these file format options to identify the device and line fields within the CSV data file:

• Default Phone—Contains a predetermined set of phone device and line fields.

• Simple Phone—Contains basic device and line fields for phones.

• Custom—Contains device and line fields that you choose and order yourself.

You cannot modify or delete the Simple Phone or Default Phone file formats.

Note When you use the Cisco Unified CallManager Bulk Administration (BAT) spreadsheet to create the 
CSV data file, you can create the file format within the spreadsheet. When you use a text editor to create 
the CSV data file, you need to create a file format or use the simple or default file format. You enter the 
values in the text-based file in the same order as specified in the file format.

Additional Information

See the “Related Topics” section on page 4-6
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Finding a Phone File Format
Use the following procedure to find a phone file format.:

Procedure

Step 1 Choose Bulk Administration > Phones > Phone File Format > Create File Format.

The Find and List Phone File Formats window displays.

Step 2 From the Find Phone File Format where Format Name drop-down list box, choose one of the following 
criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

Tip To find all Phone formats, click Find without entering any search text.

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box and 
choose AND or OR from the drop-down box, and repeat steps 2 and 3.

Step 5 From the list of records, click the file format name that matches your search criteria.

The Phone File Format Configuration window displays.

Additional Information

See the “Related Topics” section on page 4-6

Configuring a Phone File Format
Use the following topics to create, copy, modify, or delete a phone file format:

• Creating a File Format, page 4-2

• Copying a File Format, page 4-3

• Modifying a File Format, page 4-4

• Deleting a File Format, page 4-5

Creating a File Format
To create your file format for the text-based CSV data file, use the following procedure.
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Procedure

Step 1 Choose Bulk Administration > Phones > Phone File Format > Create File Format.

Step 2 Click Add New. The Phone File Format Configuration window displays.

Step 3 In the Format Name field, enter a name for this custom format.

Step 4 Under Device Fields, choose the device field names that you want to define for each phone. In the Device 
Field box, click a device field name and click the arrow to move the field to the Selected Device Fields 
box.

A CSV data file must include MAC Address/Device Name and Description; therefore, these fields are 
always selected.

Tip You can select several random field names in the list by holding down the Ctrl key, and then clicking the 
arrow to select them together. You can select a range of items by using the Shift key.

Step 5 Click line field names in the Line Field box and click the arrow to move the fields to the Selected Line 
Fields box.

Tip You can change the order of the items in the Selected Line Fields and Selected Device Fields boxes. 
Select an item and then use the up arrow to move the field closer to the beginning of the list or the down 
arrow to move it to the end of the list.

Step 6 In the IP Phone Services Maximums area, enter the maximum values for the following fields:

• Maximum Number of Speed Dials

• Maximum Number of IP Phone Services

• Maximum Number of IP Phone Service Parameters

Step 7 To save your custom file format, click Save. The name of the file format displays in the File Format 
Names list in the Find and List Phone File Formats window.

Additional Topics

See the “Related Topics” section on page 4-6.

Copying a File Format
To copy an existing format for the CSV data file, use the following procedure.

Procedure

Step 1 Find the phone file format you want to copy using “Finding a Phone File Format” section on page 4-2. 

Step 2 In the Search Results area, choose a file format that you want to copy. The Phone File Format 
Configuration window displays.

Step 3 To make a copy of the chosen file format, click Copy.
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Note To copy the file format, you can also click the corresponding Copy icon in the Find and List Phone File 
Formats window. 

Step 4 In the Format Name field, enter a new name for the copied format.

Step 5 Modify the copied format by using one of these methods:

• Add new fields by choosing them from the Device Fields or Line Fields box, and then clicking the 
arrow to move the chosen fields into the Selected Device Field or Selected Line Fields box.

• Remove selected fields by choosing them from the Selected Device Fields or Selected Line Fields 
box, and then clicking the arrow to move the chosen fields into the Device Field or Line Fields box.

• Change the order of the fields by choosing a field name in the Selected Device Field or Selected Line 
Fields box and using the up or down arrow to change its location.

Step 6 After making your changes, click Save to save the copied file format with changes in the list.

Additional Topics

See the “Related Topics” section on page 4-6.

Modifying a File Format
To modify an existing file format for the CSV data file, use the following procedure. You can modify 
custom formats only.

Procedure

Step 1 Find the phone file format you want to copy using “Finding a Phone File Format” section on page 4-2. 

Step 2 In the Search Results area, choose a file format that you want to modify. The Phone File Format 
Configuration window displays.

Step 3 Modify the copied format by using one of these methods:

• Add new fields by choosing them from the Device Fields or Line Fields box, then clicking the arrow 
to move the chosen fields into the Selected Device Field or Selected Line Fields box.

• Remove fields by choosing them from the Selected Device Fields or Selected Line Fields box, then 
clicking the arrow to move the selected fields into the Device Field or Line Fields box. You cannot 
remove the required fields: Number of lines, MAC address, and description.

• Change the order of the fields by choosing a field name in the Selected Device Field or Selected Line 
Fields box and using the up or down arrow to change its location.

Step 4 After making your changes, click Save to save the changes to the file format.

.

Additional Topics

See the “Related Topics” section on page 4-6.
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Deleting a File Format
To delete an existing file format for the CSV data file, use the following procedure.You can delete only 
custom formats.

Procedure

Step 1 Find the phone file format you want to copy using “Finding a Phone File Format” section on page 4-2. 

Step 2 In the Search Results area, verify that this is the file(s) that you want to delete.

Step 3 To remove the file format(s) from the list, click Delete selected. A message asks you to confirm that you 
want to delete the file format(s). Click OK to continue. The system removes the file format(s) name from 
the list.

Note Make sure to browse the entire list of displayed results before clicking Delete Selected.

Additional Topics

See the “Related Topics” section on page 4-6.

Associating the File Format with the CSV Data File
When you used a text editor to create the CSV data file, you created a file format for entering values in 
the text-based file. You entered values in the text file in the order that the file format specified 

After the CSV data file is completed, you need to associate the file format with the text-based CSV data 
file. After associating the file format with the CSV file,   the names for each field display as the first 
record in the CSV data file. You can use this information to verify that you entered the values for each 
field in the correct order.

To add the file format with the text-based CSV data file, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Phones > Phone File Format > Add File Format. Add File Format 
window displays.

Step 2 In the File Name field, choose the text-based CSV file that you created for this transaction.

Step 3 In the File Format Name field, choose the file format that you created for this type of bulk transaction.

Step 4 Click Submit to create a job for associating the matching file format with the CSV data file. 

Step 5 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

Additional Topics

See the “Related Topics” section on page 4-6.
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Related Topics
• Using a Text Editor to Create the CSV Data File for Phones, page 4-1

• Finding a Phone File Format, page 4-2

• Configuring a Phone File Format, page 4-2

• Associating the File Format with the CSV Data File, page 4-5

• Creating a Text-Based CSV File for Phones, page A-1
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Validating Phone Records

When you choose Validate Phones, the system runs a validation routine to check that the CSV data file 
and Cisco Unified CallManager Bulk Administration (BAT) phone template have populated all required 
fields, such as device pool and locations. The validation also checks for discrepancies with the first node 
database. 

Before You Begin

• You must have a BAT phone template for the devices that you are adding. You can use a master 
phone template with multiple lines to add phones that have a single line or several lines. See the 
“Master Phone Templates” section on page 1-4 for more information.

• You must have a data file in comma separated variable (CSV) format that contains the unique details 
for the phones or other IP telephony devices. 

Validating CSV Data File Phone Records
To validate your CSV data file phone records, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Phones > Validate Phones. 

The Validate Phones Configuration window displays.

Step 2 Click Validate Phones Specific Details radio button to validate phone records that use a customized file 
format. Continue with steps 4 and 5.

Step 3 Click Validate Phones All Details radio button to validate phone records from an exported phones file 
that was generated by using the All Details option.

Step 4 In the File Name drop-down list box, choose the CSV data file that you created for this specific bulk 
transaction.

Step 5 For the Specific Details option, in the Phone Template Name drop-down list box, choose the BAT phone 
template that you created for this type of bulk transaction. 

Step 6 To verify the chosen CSV data file with the first node database, click Submit. 

Step 7 The job gets submitted and gets executed immediately.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”
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Related Topics
For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the“Related Topics” section on page 5-2. 

Related Topics
• Validating CSV Data File Phone Records, page 5-1

• Phone Template

• Phone File Format
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Inserting Phones

To add phones, Cisco VGC phones, CTI ports, or H.323 clients into the Cisco Unified CallManager 
database, use the following procedure.

Before You Begin

• You must have a Cisco Unified CallManager Bulk Administration (BAT) phone template for the 
devices that you are adding. 

• You must have a data file in comma separated value (CSV) format that contains the unique details 
for the phones or other IP telephony devices. 

• Upload the data files by choosing the relevant target and function for the transaction. 

• Before you insert phones, validate the phone records.

Use the following procedure to insert phones into Cisco Unified CallManager

Inserting Phones into Cisco Unified CallManager
Use the following procedure to insert phones into Cisco Unified CallManager

Procedure

Step 1 Choose Bulk Administration > Phones > Insert Phones. 

The Phone Insert Configuration window displays.

Step 2 Click Insert Phones Specific Details radio button to insert phone records that use a customized file 
format. Continue with steps 4 and 6.

Step 3 Click Insert Phones All Details radio button to insert phone records from an exported phones file that 
was generated by using the All Details option.

Step 4 In the File Name drop-down list box, choose the CSV data file that you created for this specific bulk 
transaction. Check the Allow Update Phone with Custom File check box to allow updating the phone 
with the custom file you chose.

Step 5 Checking the Override Configuration Settings check box overwrites the existing phone settings with the 
information that is contained in the file that you want to insert. 

Step 6 For the Specific Details option, in the Phone Template Name drop-down list box, choose the BAT phone 
template that you created for this type of bulk transaction. 
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Related Topics
If you did not enter individual MAC addresses in the CSV data file, you must check the Create Dummy 
MAC Address check box. If you are adding CTI ports, the dummy MAC address option provides a 
unique device name for each CTI port in the form of dummy MAC addresses. 

This field automatically generates dummy MAC addresses in the following format: 
XXXXXXXXXXXX
where X represents any 12-character, hexadecimal (0-9 and A-F) number.

• If you do not know the MAC address of the phone that will be assigned to the user, choose this 
option. When the phone is plugged in, a MAC address registers for that device.

• If you supplied MAC addresses or device names in the data input file, do not choose this option.

You can update the phones or devices later with the correct MAC address by manually entering this 
information into Cisco Unified CallManager Administration or by using Unified CM Auto-Register 
Phone Tool. See the “Introducing Cisco Unified CM Auto-Register Phone Tool” section on page 52-2 
for more information about Unified CM Auto-Register Phone Tool. Skip to Step 9.

Step 7 In the Job Information area, enter the Job description.

Step 8 Click the Run Immediately radio button to insert the phone records immediately or, click Run Later to 
insert the phone records at a later time.

Step 9 Click Submit to create a job for inserting the phone records. 

Step 10 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Related Topics
• Phone Template

• Phone File Format

• Uploading and Downloading Files

• Validating Phone Records
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Updating Phones

To update phone settings, such as changing or adding the device pool or calling search space for a group 
of similar phones, use the Update Phones option. You can locate the existing phone records by these two 
methods:

• Using Query to Update Phones, page 7-1

• Using a Custom File to Update Phones, page 7-2

Using Query to Update Phones
To create a query to locate phones to update, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Phones > Update Phones > Query.

The Update Phones Query window displays.

Note You can update all phones by not specifying a query and clicking Find. Skip to the “Choosing 
the Update Parameters” section on page 7-3.

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name

• Description

• Directory Number

• Calling Search Space

• Device Pool

• Device Type

• Call Pickup Group

• LSC Status

• Authentication String

• Location

• Phone Load Name
7-1
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• Device Protocol

• Security Profile

From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable. 

Tip To find all Phones that are registered in the database, click Find without entering any search text.

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 3.

Step 5 Click Find.

A list of discovered phones displays. 

The Update Phones window displays the details of the phones that you choose.

To complete the procedure for updating phones, continue to the “Choosing the Update Parameters” 
section on page 7-3.

Using a Custom File to Update Phones
To create a custom file to search for phones to update, use the following procedure.

Before You Begin

1. Identify the devices that you need to update. 

2. Create a text file that lists one of these options on a separate line

– MAC addresses and device names

– Directory numbers

Note You can have MAC addresses and device names in the same custom file, but directory numbers 
must be in a separate custom file.

3. Upload the text file to the Cisco Unified CallManager server. See the “Uploading a File” section on 
page 2-3. 

To update phones by using a list of phones in a custom file, use the following procedure.
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Procedure

Step 1 Choose Bulk Administration > Phones > Update Phones > Use Custom File.

The Update Phones Custom Configuration window displays.

Step 2 In the Update Phones where drop-down list box, choose the type of custom file that you have created 
from one of the following criteria:

• Device Name (includes MAC addresses)

• Directory Number

• Description

Step 3 In the list of custom files, choose the filename of the custom file for this update. 

Step 4 Click Find. 

If the query results are not what you expected, you can change the custom file selections.

To complete the procedure for updating phones, continue to the “Choosing the Update Parameters” 
section on page 7-3.

Choosing the Update Parameters
After you have defined the query or custom file to search for phones, use this procedure to choose 
parameters and define values for updating phones.

Procedure

Step 1 In the Update Phones Query window, click Next. The Update Phones shows the type of query that you 
chose. If you want to change the type of query, click Back.

Step 2 Specify the setting that you want to update for all the records that you have defined in your query or 
custom file. You can choose multiple parameters to update. See the “Field Descriptions for Updating 
Phones” section on page 7-4 for descriptions of parameters. 

Step 3 In the Value field for the checked parameter, enter the new value or choose a value from the list box.

Step 4 In the Reset/Restart Phones area, check one of the following choices:

• Don’t Reset/Restart devices—To reset/restart devices at a later time.

• Reset devices—To reset (power-cycle) the phones 

• Restart devices—To reset phones without power-cycling

Step 5 Update the required phone parameters. See Table 7-1 lists the field descriptions for updating phones.

Step 6 Click Submit to create a job for updating the records. 

Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on Jobs, see Chapter 51, “Scheduling Jobs.” 

For information on log files, see “BAT Log Files” section on page 54-3
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Additional Topics

See the “Related Topics” section on page 7-11.

Field Descriptions for Updating Phones
Table 7-1 provides descriptions for all possible fields that display when you are updating phones. Some 
device types do not require all the phone settings. For related procedures, see the “Related Topics” 
section on page 7-11.

Values that appear in some fields display from Cisco Unified CallManager. You must configure these 
values by using Cisco Unified CallManager Administration.

Table 7-1 Field Descriptions for Update Phones

Field Description

Description Enter a description that makes the device easy to recognize. 

Device Pool Choose the device pool to which this group of phones/ports 
should belong.

A device pool defines sets of common characteristics for devices, 
such as region, date/time group, Cisco Unified CallManager 
group, and calling search space for auto-registration.

Phone Button Template Choose the appropriate phone button template. The phone button 
template determines the configuration of buttons on a phone and 
identifies which feature (line, speed dial, and so on) is used for 
each button.

Cisco Unified CallManager does not make this field available for 
H.323 clients or CTI ports.

Softkey Template Choose the softkey template to be used for all phones in this 
group.

Calling Search Space Choose the calling search space to which this group of 
phones/ports should belong.

A calling search space specifies the collection of route partitions 
that are searched to determine how a dialed number should be 
routed.

AAR Calling Search Space Choose the appropriate calling search space for the device to use 
when it performs automated alternate routing (AAR). The AAR 
calling search space specifies the collection of route partitions 
that are searched to determine how to route a collected 
(originating) number that is otherwise blocked due to insufficient 
bandwidth.

Media Resource Group List Choose the media resource group list (MRGL) to which this 
group of phones/ports should belong.

An MRGL specifies a list of prioritized media resource groups. 
An application can choose required media resources among the 
available ones according to the priority order that is defined in the 
MRGL.
7-4
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 7      Updating Phones
Field Descriptions for Updating Phones
User Hold Audio Source Choose the user-hold audio source for this group of phones or 
ports.

The user-hold audio source plays music when a user places a call 
on hold.

Network Hold Audio Source Choose the network hold audio source that this group of IP 
phones or CTI ports should use.

The network-hold audio source plays music when the system 
places a call on hold, such as when the user transfers or parks a 
call.

Location Choose the location to which this group of phones/ports should 
belong. 

A location indicates the remote location that is accessed by using 
restricted bandwidth connections.

User Locale Choose the country and language set that you want to associate 
with this user. 

This choice determines which cultural-dependent attributes exist 
for this user and which language displays for the user in the 
Cisco Unified CallManager user windows and phones.

Network Locale Choose the network locale that you want to associate with this 
user. 

The Network Locale comprises a set of tones and cadences that 
Cisco gateways and phones use when they are communicating 
with the PSTN and other networks in a specific geographical area. 

Built in Bridge Enable or disable the built-in conference bridge for the barge 
feature by using the Built In Bridge drop-down list box (choose 
On, Off, or Default). 

For more configuration information, refer to the Barge and 
Privacy Features in the Cisco Unified CallManager Features and 
Services Guide.

Privacy For each phone that wants Privacy, choose On in the Privacy 
drop-down list box. 

For more configuration information, refer to Barge and Privacy 
Features in the Cisco Unified CallManager Features and 
Services Guide.

Owner User ID Enter a user ID for the primary phone user.

Phone Load Name Enter the custom phone load, if applicable. 

Note Any value that is entered in this field overrides the default 
value for the chosen model and specifies the custom 
software for a Cisco Unified IP Phone.

Ignore Presentation Indicators Check this check box if the system must ignore presentation 
indicators.

Retry Video Call as Audio Check this check box to retry a video call as an audio call.

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
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Allow Control of Device from 
CTI

Check this check box to allow CTI to control and monitor this 
device.

If the associated directory number specifies a shared line, the 
check box should be enabled as long as at least one associated 
device specifies a combination of device type and protocol that 
CTI supports.

Protocol Specific Information

Packet Capture Mode From the drop-down list box, choose the mode that you want to 
set for signal packet capture:

None—Choose None if you do not want to specify a mode. 

Real-Time Mode—Use this mode for real-time signal packet 
capture.

Batch Processing Mode—Use this mode for batch processing 
signal packet capture mode.

Packet Capture Duration Enter the time for packet capture in minutes. You can enter a 
maximum duration of 300 minutes. The default duration specifies 
60 minutes.

Presence Group Used with the Presence feature, the SIP or SCCP phone serves as 
a watcher because it requests status about the presence entity, for 
example, directory number, that is configured as a BLF speed dial 
button on the phone.

If you want the phone to receive the status of the presence entity, 
choose a Presence group that is allowed to view the status of the 
Presence group that is applied to the directory number, as 
indicated in the Presence Group Configuration window.

Tip For more information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services 
Guide.

SCCP Phone Security Profile For SCCP phones, choose the security profile that you want to 
apply to the device. If the phone does not support the profile that 
you choose, Cisco Unified CallManager does not allow you to 
apply the configuration.

All phones require that you apply a security profile. If the phone 
does not support security, choose a nonsecure profile.

Tip The CAPF settings that are configured in the profile relate 
to the Certificate Authority Proxy Function settings that 
display in the Phone Configuration window. If you want 
to manage manufacture-installed certificates (MICs) or 
locally significant certificates (LSC), you must configure 
the CAPF settings in the profile and in the Phone 
Configuration window.

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
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SUBSCRIBE Calling Search 
Space

Used with the Presence feature, the SUBSCRIBE Calling Search 
Space determines how Cisco Unified CallManager routes the 
subscription requests that come from the phone. From the 
drop-down list box, choose the calling search space that you want 
to use for this purpose.

Tip For more information on the Presence feature, refer to the 
Cisco Unified CallManager Features and Services 
Guide.

Unattended Port Check this check box to indicate an unattended port on this 
device.

Require DTMF Reception For SIP and SCCP phones, check this check box to require DTMF 
reception for this phone.

External Data Locations Information

Information Enter the help text URL for the information button .

Directory Enter the URL of the directory server. 

Messages Enter the voice-messaging access pilot number.

Services Enter the URL for the services menu. 

Authentication Server Enter the URL that the phone uses to validate requests that are 
made to the phones web server. If you do not provide an 
authentication URL, the advanced features on 
Cisco Unified IP Phones that require authentication will not 
function. Leave this field blank to accept the default setting.

By default, this URL accesses a Cisco Unified IP Phone User 
Options window that was configured during installation.

Proxy Server Enter the host and port (for example, proxy.cisco.com:80) that are 
used to proxy HTTP requests for access to non-local host 
addresses from the phones HTTP client.

If the phone receives a URL such as www.cisco.com in a service 
and the phone is not configured in the cisco.com domain, the 
phone uses the proxy server to access the URL. If the phone is 
configured in the cisco.com domain, the phone accesses the URL 
without using the proxy because it is in the same domain as the 
URL.

Leave this field blank to accept the default setting.

Idle Enter the URL to display on the Cisco Unified IP Phone window 
when the phone has not been used for the time that is specified in 
the Idle Time field. For example, you can display a logo on the 
window when the phone has not been used for 5 minutes. Leave 
this field blank to use the default value.

Idle Timer Enter the seconds that you want to elapse before the phone 
displays the URL that is specified in the Idle field. Leave this field 
blank to use the default value.

Extension Information

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
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Extension Mobility Choose 0-Off if you want to disable this feature or choose 1-On 
to enable this feature.

Extension mobility allows a user to log in and out of a 
Cisco IP Phone. Refer to the Cisco Unified CallManager 
Features and Services Guide for more information about 
extension mobility.

IP Services1 Use Cisco Unified CallManager Administration to choose any 
services that have been configured. 

IP Services2 Use Cisco Unified CallManager Administration to choose any 
services that have been configured. 

Using Cisco Unified CallManager Bulk Administration (BAT), 
you cannot update more than 2 IP services in one transaction. 

Certification Authority Proxy Function (CAPF) Information (These parameters display only for devices with 
the capability to support authentication or encryption.)

Certificate Operation From the drop-down list box, choose the Certification Operation 
that you want to perform from the following options:

• No Pending Operation—No pending Certification 
Operation lists for this device. Choosing this option disables 
the remaining CAPF fields. 

• Install/Upgrade—Install or upgrade a Certification 
Operation.

• Delete—Delete a Certification Operation

• Troubleshoot—Troubleshoot a Certification Operation.

Generate Unique Authentication 
Device for Each Device

Check this check box, if needed

Authentication String If Authentication Mode is By Authentication String, enter the 
Authentication String. Alternately, to get a system-generated 
string, click Generate String.

Operation Completes By Enter the date by which the Certification Operation will complete. 
The date format specifies YYYY: MM: DD: HH. The default 
completion date specifies 10 days from the current system date.

MultiLevel Precedence and Preemption (MLPP) Information

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
7-8
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 7      Updating Phones
Field Descriptions for Updating Phones
MLPP Indication If available, this setting specifies whether a device that is capable 
of playing precedence tones will use the capability when it places 
an MLPP precedence call.

From the drop-down list box, choose a setting to assign to this 
device from the following options:

• Default—This device inherits its MLPP indication setting 
from its device pool.

• Off—This device does not send indication of an MLPP 
precedence call.

• On—This device does send indication of an MLPP 
precedence call.

Note Do not configure a device with the following combination 
of settings: MLPP Indication is set to Off while MLPP 
Preemption is set to Forceful.

MLPP Preemption If available, this setting specifies whether a device that is capable 
of preempting calls in progress will use the capability when it 
places an MLPP precedence call.

From the drop-down list box, choose a setting to assign to this 
device from the following options:

• Default—This device inherits its MLPP preemption setting 
from its device pool.

• Disabled—This device does not preempt calls in progress 
when it places an MLPP precedence call.

• Forceful—This device preempts calls in progress when it 
places an MLPP precedence call.

Note Do not configure a device with the following combination 
of settings: MLPP Indication is set to Off while MLPP 
Preemption is set to Forceful.

MLPP Domain (e.g., "0000FF") Enter a hexadecimal value for the MLPP domain associated with 
this device. Must be blank or a value between 0 and FFFFFF.

Secure Shell Information

Secure Shell User Enter a user ID for the secure shell user. If the phone you are 
configuring does not support secure shell access, this field does 
not display. Cisco Technical Assistance Center (TAC) uses secure 
shell for troubleshooting. Contact TAC for further assistance.

Secure Shell Password Enter the password for a secure shell user. If the phone you are 
configuring does not support secure shell access, this field does 
not display. Contact TAC for further assistance.

Assign IP Phone Services

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
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Add All Services From This 
Template

From the drop-down list box, choose the template that contains 
list of services that you want to update the phones with. 

You can click the Edit IP Phone Service link to update the 
subscribed Cisco IP phones services on the template.

Remove Duplicate Check this check box to remove duplicate IP Phone Services. If 
you check this check box, the system removes the duplicate 
service subscriptions from phones and User Device Profiles. The 
IP system deletes Services based on the IP Service name.

Product Specific Information

Device Security Mode From the drop-down list box, choose the mode that you want to 
set for the device:

Use System Default—The phone uses the value that you specified 
for the enterprise parameter, Device Security Mode.

Non-secure—No security features exist for the phone. A TCP 
connection opens to Cisco Unified CallManager.

Authenticated—Cisco Unified CallManager provides integrity 
and authentication for the phone. A TLS connection that uses 
NULL/SHA opens.

Encrypted—Cisco Unified CallManager provides integrity, 
authentication, and encryption for the phone. A TLS connection 
that uses AES128/SHA opens

This field applies only if the phone model supports authentication 
or encryption.

Remove Duplicate IP Services 
from all Phones and Device 
Profiles

Check this check box to remove duplicate IP Phone Services. If 
you check this check box, the system removes the duplicate 
service subscriptions from phones and User Device Profiles. The 
IP system deletes Services based on the IP Service name.

Disable Speakerphone Check this check box to disable the speakerphone.

Disable Speakerphone and 
Headset

Check this check box to disable the speakerphone and headset 

Forwarding Delay Use this field to enable or disable forwarding delay. Choose 
enable when you want the port to wait a few seconds before 
forwarding a call.

PC Port Use this field to enable or disable the PC port on phones that have 
internal switches. Users can connect a PC or workstation to the 
phone by using the port labeled “10/100 PC” on the back of the 
phone.

Setting Access Use this field to choose whether the user has access to phone 
settings. The options include Enabled and Disable.

Gratuitous ARP Choose Enabled or Disabled to control gratuitous ARP.

PC Voice VLAN Access Choose Enabled or Disabled to control access to a PC voice 
VLAN.

Video Capabilities Choose Enabled or Disabled to control video capabilities access.

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
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Note To complete the procedure, go to “Choosing the Update Parameters” section on page 7-3.

Related Topics
• Using Query to Update Phones, page 7-1

• Using a Custom File to Update Phones, page 7-2

• Choosing the Update Parameters, page 7-3

• Field Descriptions for Updating Phones, page 7-4

Auto Line Select Choose Enabled or Disabled to allow automatic line selection on 
the phone.

Web Access Choose Enabled or Disabled to allow web access on the phone.

Table 7-1 Field Descriptions for Update Phones (continued)

Field Description
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Deleting Phones

Use these procedures to delete a group of phones or other IP telephony devices from the 
Cisco Unified CallManager database. 

You can locate existing phone records by these two methods:

• Using Query to Delete Phones, page 8-1.

• Using a Custom File to Delete Phones, page 8-3

Using Query to Delete Phones 
Use the following procedure to delete phones by creating a query to locate the phone records.

Procedure 

Step 1 Choose Bulk Administration > Phones > Delete Phones > Query.

The Bulk Phones Delete Configuration window displays.

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name

• Description

• Directory Number

• Calling Search Space

• Device Pool

• Device Type

• Call Pickup Group

• LSC Status

• Authentication String

• Device Protocol

• Security Profile

• Unassigned DN

From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with
8-1
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• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable. 

Tip To find all Phones that are registered in the database, click Find without entering any search text.

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, repeat steps 2 and 3.

Step 5 Click Find.

A list of discovered phones displays by:

• Device Name

• Description

• Device Pool

• Device Protocol

• Status

• IP Address

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to delete phone records immediately or, click Run Later to delete 
the phone records at a later time.

Step 8 Click Submit to create a job for deleting the phone records. 

Note Make sure to browse the entire list of displayed results before submitting the job.

Step 9 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Caution If you do not enter any information in the query text box, the system deletes all phone records. Because 
the delete action is final, you cannot retrieve deleted records.

Additional Topics

See the “Related Topics” section on page 8-4.
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Using a Custom File to Delete Phones 
You can create a custom file of phones that you want to delete by using a text editor. You can have MAC 
addresses and device names in the same custom file, but you cannot have directory numbers in the same 
file. You need to create separate files—one file that contains the device names and MAC addresses and 
another file that contains the directory numbers. 

Before You Begin

1. Create a text file that lists one of these details for the phones that you want to delete:

– Device names and MAC addresses

– Description

– Directory numbers

2. Put each item on a separate line in the text file.

3. Upload the custom file to Cisco Unified CallManager server. For more details on uploading files, 
see the “Uploading a File” section on page 2-3. 

To delete phones that are listed in a custom file, use the following procedure.

Procedure 

Step 1 Choose Bulk Administration > Phones > Delete Phones > Custom File.

The Bulk Phones Delete Configuration window displays.

Step 2 In the Delete Phones where drop-down list box, choose the type of custom file that you have created from 
one of the following criteria:

• Device Name (includes MAC addresses)

• Directory Number

• Description

Step 3 In the list of custom files, choose the filename of the custom file for this delete.

Step 4 Click Find. A list of phones matching your search criteria display.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to delete phone records immediately or, click Run Later to delete 
the phone records at a later time.

Step 7 Click Submit to create a job for deleting the phone records. 

Step 8 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 8-4.
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Related Topics
• Using Query to Delete Phones, page 8-1

• Using a Custom File to Delete Phones, page 8-3
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Exporting Phones

You can use the export utility to merge records from multiple Cisco Unified CallManager servers onto 
one Cisco Unified CallManager server. Use this procedure to move records from one 
Cisco Unified CallManager server to another. Only export the records that you are interested in moving. 
Perform the following procedures:

• Exporting Phone Records, page 9-3

• Exporting User Records, page 19-1

• Exporting User Device Profile Records, page 39-3

• (Optional) Edit the CSV file with a text editor. The record format must follow the format that is 
specified for that file format. For example, records for phones need to follow the phone file format. 

Caution Use extreme care when editing the CSV file. Phones might not work if you insert records that are in the 
wrong format.

1. Upload the CSV file to Cisco Unified CallManager server. See the “Uploading a File” section on 
page 2-3.

Caution Because the order in which the records are inserted is important, you must insert user records first. This 
ensures that devices properly associate with existing users.

2. Insert User Records. 

3. Insert Phone Records.

4. Insert User Device Profile Records.

5. Check the log files for errors. See the “Viewing Export Log Files” section on page 25-11.

Additional Information

See the “Related Topics” section on page 9-5.

Using Phone Export
You can choose between two file format options when you are exporting phone records:

Specific Details—For phones that have similar configurations.
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All Details—For phones that have different line configurations, such as multiple partitions or calling 
search spaces.

Default Phone File Format

Choosing Default phone file format allows you to export records by using a defined query. 

Table 9-1 lists the fields that are exported when you choose the Default Phone file format.

All Phone Details File Format

When you export phone records by using All Phone Details option, you export phone records for a 
particular model of phone along with all the device field information, different line attributes, and 
services that are associated with the phone or you can export all phone models in a single file. To export 
all phone types to a single file you can choose All Phone Types from the Select the Device Type 
drop-down list box. You cannot use the query to limit the number of records. 

Table 9-2 lists the fields that are exported when you choose the All Phone Details file format.

Note The device name, not the MAC Address, gets saved when you choose to export by using the All Phone 
Details file format. 

Table 9-1 Exported Fields in the Default Phone File Format

Field Types Exported Fields

Device Fields MAC Address, Description, Location

Line Fields Directory Number, Display, Line Text Label, Forward 
Busy External, Forward Busy Internal, Forward No 
Answer Internal, Forward No Answer External, Forward 
No Coverage Internal, Forward No Coverage External, 
Call Pickup Group

User Fields User ID

Speed Dials Speed Dials

Table 9-2 Exported Fields in the All Phone Details File Format  

Field Types Exported Fields

Device Fields Device Name, Description, Owner User ID, Device Pool, 
CSS, AAR CSS, Media Resource Group List, User Hold 
Audio Source, Network Hold Audio Source, Location, 
User Locale, Network Locale, Phone Button Template, 
Expansion Module type I, Expansion Module type II, 
Softkey Template, Phone Load Name, Module 1 Load 
Name, Module 2 Load Name, Login user ID, Built in 
Bridge, MLPP Indication, MLPP Preemption, MLPP 
Domain, Retry Video call as Audio, Privacy, Security 
Mode, Ignore Presentation Indicators, Single Packet 
Capture mode, Packet Capture Duration, Certificate 
Operation, Authentication Mode, Authentication String, 
Key Size (bits), Operation Completes By
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Additional Information

See the “Related Topics” section on page 9-5.

Exporting Phone Records
To export phone records from Cisco Unified CallManager, use this procedure.

Procedure

Step 1 Choose one of the following options:

Model Specific 
Device Fields

Information, Directory, Messages, Services, 
Authentication Server, Proxy Server, Idle, Idle Timer, 
Enable Extension Mobility, Logout Profile, Login User 
ID, Login Time, Logout Time, Product Specific XML

Line Fields Directory Number, Partition, Voice Mail Profile, Line 
CSS, AAR Group, Line User Hold Audio Source, Line 
Network Hold Audio Source, Auto Answer, Forward All 
to Voice Mail, Forward All Destination, Forward All 
CSS, Forward Busy External to Voice Mail, Forward 
Busy External Destination, Forward Busy External CSS, 
Forward No Answer External to Voice Mail, Forward No 
Answer External Destination, Forward No Answer 
External CSS, Forward On Failure to Voice Mail, 
Forward On Failure Destination, Forward on Failure 
CSS, Call pickup group, Forward Busy Internal to Voice 
Mail, Forward Busy Internal Destination, Forward Busy 
Internal CSS, Forward No Answer Internal to Voice 
Mail, Forward No Answer Internal Destination, Forward 
No Answer Internal CSS, Forward No Call Coverage 
External to Voice Mail, Forward No Call Coverage 
External Destination, Forward No Call Coverage 
External CSS, Forward No Call Coverage Internal to 
Voice Mail, Forward No Call Coverage Internal 
Destination, Forward No Call Coverage Internal CSS, 
Display, External Phone Number Mask, Message 
Waiting Lamp Policy, Ring Setting When Idle, Line Text 
Label, Ring Setting When Active, No Answer Ring 
Duration, MLPP Target Destination, MLPP Calling 
Search Space, MLPP No Answer Ring Duration, Max 
Num Calls, Busy Trigger, Call Info Display Mask, 
Alerting Name

User Fields User ID

Speed Dials Speed Dial Number, Speed Dial Label

Services Service Name, Subscribed Service Name, Parameter 
Name, Parameter Value

Table 9-2 Exported Fields in the All Phone Details File Format (continued) 

Field Types Exported Fields
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Using Phone Export
• Bulk Administration > Phones > Export Phones > Specific Details. The Export Phones Query 
window displays. 

• Bulk Administration > Phones > Export Phones > All Details. The Export Phone Configuration 
window displays.

Step 2 Choose from the following options:

• For All Phone Details option, choose the type of device or specific model in the Device Type 
drop-down list box. See Table 9-1 for the list of exported fields in this format. Skip to Step 5.

• For Specific Details option, choose the type of device or specific model in the Device Type 
drop-down list box. See Table 9-2 for the list of exported fields in the default phone format.

Step 3 For Specific Phone Details, choose SIP or SCCP from the Device Protocol drop-down list box.

Step 4 For Specific Phone Details, you can customize the export file by choosing which set of phones to export, 
but the phone details are not configurable. 

a. From the first Find Phone where, drop-down list box, choose from the following options:

– Device Name

– Description

– Directory Number

– Calling Search Space

– Device Pool

– Call Pickup Group

– LSC Status

– Authentication String

– Security Profile

b. In the second drop-down list box, choose from the following options:

– begins with

– contains 

– is exactly

– ends with

– is empty

– is not empty

c. In the search field/list box, either choose or enter the value that you want to locate, such as a device 
name.

d. You can click the Search Within Results check box and choose AND or OR to add multiple filters 
and repeat Substep a. through Substep c. to further define your query.

e. Click Find. The search results display. 

f. Click Next. The Export Phones Configuration window displays. 

g. Choose a phone file format from the File Format drop-down list box. 

Step 5 Enter the export file name in the File Name text box.

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to export phone records immediately or, click Run Later to 
export at a later time.
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Related Topics
Step 8 Click Submit to create a job for exporting phone records. 

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

You can search and download the exported file using the Upload/Download Files option in the Bulk 
Administration menu. See Chapter 2, “Uploading and Downloading Files.”. 

Additional Information

See the “Related Topics” section on page 9-5.

Exporting and Importing Phones with More Than One User
When you export phone records that have multiple users who control a phone, the export utility 
generates a unique phone record for each user. The phone information remains the same, but each record 
has a different user ID.

The exported file name gets suffixed with the timestamp. If a recurring job is scheduled for export 
phones, then the information gets exported with same filename but different timestamps.

When you import the exported file that has phones with multiple users, then all users are exported in the 
same record. 

The log file for the import transaction will show that the phone insertions failed for all users except the 
first user that is associated with the phone.

Additional Information

See the “Related Topics” section on page 9-5.

Related Topics
• Exporting Phone Records, page 9-3

• Exporting User Records, page 19-1

• Exporting User Device Profile Records, page 39-3
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Adding and Updating Lines for Phones

To update line attributes for a specific group of devices or user device profiles, use the Update Lines 
option. Lines for a phone and a user device profile get updated at the same time when both are part of 
the query result.

Note When a phone is deleted from the Cisco Unified CallManager database, the directory number remains 
in the database. To manage these orphan directory numbers, you can use the Update Lines option to 
search for unassigned directory numbers and delete or update these directory numbers.

You can add lines to a group of existing phones or user device profiles in the Cisco Unified CallManager 
database. When you use the template to add new lines, you cannot change phone services or speed dials. 
Cisco Unified CallManager Bulk Administration (BAT) ignores those fields on the template when you 
add lines to existing devices. 

To update line attributes and add lines and add lines to existing phones or user device profiles, use the 
following procedures:

• Using Query to Update Lines, page 10-1

• Adding Lines to Existing Phones and UDPs, page 10-7

• Using the BAT Spreadsheet to Add Lines to Existing Phones, page 10-8

Using Query to Update Lines
To update lines, use the following procedure:

Procedure

Step 1 Choose Bulk Administration > Phones > Add/Update Lines > Update Lines or Bulk Administration 
> User Device Profiles > Add/Update Lines > Update Lines.

The Update Lines Query window displays.

Note You can update all lines by not specifying a query. Skip to the “Field Descriptions for Updating 
Lines” section on page 10-3.
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Using Query to Update Lines
Step 2 From the first Find Line where drop-down list box, choose one of the following criteria:

• Directory Number

• Route Pattern

• Line Description

• Calling Search Space (Phone)

• Calling Search Space (Line)

• Device Pool

• Device Description

• Line Position

• Unassigned DN 

• Call Pickup Group

Note To locate and delete orphaned directory numbers, use “unassigned DN.”

From the second Find Line where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 In the search field list box, choose or enter the value that you want to locate. For example, you can 
choose the Line Partition from the list or enter a range of directory numbers.

Tip To find all lines that are registered in the database, click Find without entering any search text.

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 3.

Step 5 To display the records that are going to be affected, click Find.

A list of discovered lines displays by:

• Pattern/Directory Number

• Partition

• Description

Step 6 Click Next. The Update Lines window shows the type of query that you chose at the top. If you want to 
change the type of query, click Back.

Step 7 Specify the setting that you want to update for all the records that you have defined in your query. You 
can choose multiple parameters to update. See the “Field Descriptions for Updating Lines” section on 
page 10-3 for descriptions of the parameters.

Step 8 In the Value field for the checked parameter, enter the new value or choose a value from the list box.

Step 9 In the Job Information area, enter the Job description.
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Using Query to Update Lines
Step 10 Click the Run Immediately radio button to insert lines immediately or, click Run Later to insert at a later 
time.

Step 11 Click Submit to create a job for inserting the phone records. 

Step 12 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 10-11.

Field Descriptions for Updating Lines
Table 10-1 provides the field descriptions for updating line details. For related procedures, see the 
“Related Topics” section on page 10-11.

Values that display in some fields display from Cisco Unified CallManager. You must configure these 
values by using Cisco Unified CallManager Administration. 

Table 10-1 Field Descriptions for Updating Line Details

Field Description

Line Partition Choose a partition. A partition indicates the route partition to which the 
directory number belongs.

Note The directory number can appear in more than one partition.

Calling Search Space (Line) Choose the partitions that are searched for numbers that are called from 
this directory number.

Note Changes cause an update of the Pickup Group Names that are 
listed in the Call Pickup Group field. The setting applies to all 
devices that are using this directory number.

Calling Search Space 
Forward All 

Choose the calling search space to use when a call is forwarded to the 
specified destination.

Note This setting applies to all devices that are using this directory 
number. 

Forward All Destination Enter the directory number to which all calls are forwarded.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Forward All to Voice Mail Check this check box to forward all calls to the number that you chose 
in the voice-messaging profile.

Checking this check box makes the values in the Forward All 
Destination field and Calling Search Space check box not relevant. 

Calling Search Space 
Forward Busy External

Choose the calling search space to use when a call from an external 
number is forwarded to the specified destination.

Note This setting applies to all devices that are using this directory 
number. 
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Calling Search Space 
Forward Busy Internal

Choose the calling search space to use when a call from an internal 
number is forwarded to the specified destination.

Note This setting applies to all devices that are using this directory 
number. 

Forward Busy Destination 
External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Forward Busy Destination 
Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Forward Busy to Voice Mail 
External

Check this check box to forward calls from an external number to the 
number that you chose in the voice-messaging profile when the line is in 
use.

Checking this check box makes the values in the Forward Busy 
Destination field and Calling Search Space check box not relevant. 

Forward Busy to Voice Mail 
Internal

Check this check box to forward calls from an internal number to the 
number that you chose in the voice-messaging profile when the line is in 
use.

Checking this check box makes the values in the Forward Busy 
Destination field and Calling Search Space check box are not relevant. 

Calling Search Space 
Forward No Answer 
External 

Choose the calling search space to use when a call from an external 
number is forwarded to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number.

Calling Search Space 
Forward No Answer Internal

Choose the calling search space to use a call from an internal number is 
forwarded to the specified destination. The setting displays only if it is 
configured in the system.

Note This setting applies to all devices that are using this directory 
number.

Forward No Answer 
Destination External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Table 10-1 Field Descriptions for Updating Line Details (continued)

Field Description
10-4
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 10      Adding and Updating Lines for Phones
Using Query to Update Lines
Forward No Answer 
Destination Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Forward No Answer to 
Voice Mail External

Check this check box to forward unanswered calls from an external 
number to the number that you chose in the voice-messaging profile.

Checking this check box makes the values in the Forward No Answer 
Destination field and Calling Search Space check box are not relevant. 

Forward No Answer to 
Voice Mail Internal

Check this check box to forward unanswered calls from an internal 
number to the number that you chose in the voice-messaging profile.

Checking this check box makes the values in the Forward No Answer 
Destination field and Calling Search Space check box are not relevant. 

Calling Search Space 
Forward No Coverage 
External 

Choose the calling search space to use when a call from an external 
number is forwarded to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number. 

Calling Search Space 
Forward No Coverage 
Internal 

Choose the calling search space to use when a call from an internal 
number is forwarded to the specified destination. The setting displays 
only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number. 

Forward No Coverage 
Destination External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone does not have coverage.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Forward No Coverage 
Destination Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone does not have coverage.

Note This setting applies to any dialable phone number, including an 
outside destination unless restricted, and to all devices that are 
using this directory number.

Forward No Coverage to 
Voice Mail External

Check this check box to forward calls from an external number to the 
number that you chose in the voice-messaging profile when the phone 
does not have coverage.

Checking this check box makes the values in the Forward No Answer 
Destination field and Calling Search Space check box are not relevant. 

Forward No Coverage to 
Voice Mail Internal

Check this check box to forward calls from an external number to the 
number that you chose in the voice-messaging profile when the phone 
does not have coverage.

Checking this check box makes the values in the Forward No Answer 
Destination field and Calling Search Space check box are not relevant. 

Table 10-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Calling Search Space 
Forward on Failure 
External/Internal

(CTI ports only) Choose the calling search space to use when a call from 
an internal or external call is forwarded to the specified destination. The 
setting appears only if it is configured in the system.

Note This setting applies to all devices that are using this directory 
number.

Forward on Failure 
Destination 
External/Internal

(CTI ports only) Enter the directory number to which a call coming from 
an internal or an external number should be forwarded when a phone or 
CTI application fails.

Forward on Failure to Voice 
Mail External/Internal

(CTI ports only) Check this check box to forward failed calls from 
external or internal numbers to the number that you chose in the 
voice-messaging profile.

Call Forward No Answer 
Ring Duration

Enter the number of seconds (between 1 and 300) to allow the call to 
ring, before forwarding the call to the destination number entered in the 
Forward No Answer Destination field.

Note Leave this field blank to use the value that is set in the 
Cisco Unified CallManager service parameter, Forward No 
Answer Timer.

User Hold Audio Source Choose the music on hold audio source that plays when the user presses 
the Hold button or softkey to put a call on hold.

Network Hold Audio Source Choose the music on hold audio source that plays when the system 
places a call on hold such as when user transfers a call or initiates a 
conference or call park. 

Auto Answer Choose this parameter if you want all lines that are updated here to use 
the auto answer feature. With auto answer, Cisco Unified CallManager 
automatically answers calls when a headset is in use. A zip tone plays to 
alert the user that an incoming call connected.

Voice Mail Profile Choose this parameter to make the pilot number the same as the 
directory number for this line. This choice proves useful if you do not 
have a voice-messaging server that is configured for this phone.

Ring Setting When Idle Choose the type of ring for an incoming call on a phone.

Ring Setting when Active Choose the type of ring for an incoming call on a phone, which is used 
when this phone has another active call on a different line.

Call Pickup Group Name Choose a Pickup Group Name to specify the call pickup group, which 
can answer incoming calls to this directory number by dialing the 
appropriate pickup group number.

AAR Group Choose the automated alternate routing (AAR) group for this device. 
The AAR group provides the prefix digits that are used to route calls that 
are otherwise blocked due to insufficient bandwidth. 

Set AAR Group to <None> to prevent rerouting blocked calls.

Target (Destination) MLPP Enter the number to which MLPP precedence calls should be directed if 
this directory number receives a precedence call and neither this number 
nor its call forward destination answers the precedence call.

Values can include numeric characters, pound(#), and asterisk (*).

Table 10-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Adding Lines to Existing Phones and UDPs
Note To complete the procedure, go to the “Using Query to Update Lines” section on page 10-1.

Adding Lines to Existing Phones and UDPs
Use the following procedure to add lines to exiting phones and UDP templates:

MLPP Calling Search Space From the drop-down list box, choose the calling search space to 
associate with the alternate party target (destination) number.

MLPP No Answer Ring 
Duration

Enter the number of seconds (between 4 and 30) after which an MLPP 
precedence call will be directed to this directory number’s alternate 
party if this directory number and its call forwarding destination have 
not answered the precedence call.

Leave this setting blank to use the value that is set in the 
Cisco Unified CallManager enterprise parameter, Precedence Alternate 
Party Timeout.

External Phone Number 
Mask

Enter the phone number (or mask) that is sent for Caller ID information 
when a call is placed from this line.

You can enter a maximum of 30 numbers and “X” characters. The Xs 
represent the directory number and must appear at the end of the pattern. 
For example, if you specify a mask of 972813XXXX, an external call 
from extension 1234 displays a caller ID number of 9728131234.

Maximum Number of Calls You can configure up to 184 calls for a line on a device in a cluster, with 
the limiting factor being the device. As you configure the number of 
calls for one line, the calls available for another line decrease. 

The default specifies 4. If the phone does not allow multiple calls for 
each line, the default specifies 2. 

For CTI route points, you can configure up to 10,000 calls for each port. 
The default specifies 5000 calls. 

Use this field in conjunction with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum Number of 
Calls and Call Forward Busy, determines the maximum number of calls 
to be presented at the line. If maximum number of calls is set for 50 and 
the busy trigger is set to 40, then incoming call 41 gets rejected with a 
busy cause (and will get forwarded if Call Forward Busy is set). If this 
line is shared, all the lines must be busy before incoming calls get 
rejected.

Use this field in conjunction with Maximum Number of Calls for CTI 
route points. The default specifies 4500 calls.

Table 10-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Before You Begin

• You must have a BAT template for this transaction. See the “Adding or Updating Lines in a BAT 
Template” section on page 3-4.

• You must have a CSV data file for this transaction. See the “Using the BAT Spreadsheet to Add 
Lines to Existing Phones” section on page 10-8 for information.

Procedure

Step 1 Choose Bulk Administration > Phones > Add/Update Lines > Add Lines.

The Phone Add Lines window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.

Step 3 If you are changing the phone settings for existing phones in the template, check the Override the 
existing configuration check box. The user phone information also gets updated when this check box 
is checked.

Step 4 In the Select Templates area, choose one of the following options:

• To add lines to phones, choose Phone Template. 

In the Template Name field, choose the BAT phone template to use for this bulk transaction.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to insert the phone records immediately or, click Run Later to 
insert the phone records at a later time.

Step 7 Click Submit to create a job for adding lines to existing phones and UDPs. 

Step 8 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 10-11.

Using the BAT Spreadsheet to Add Lines to Existing Phones
To create the CSV data file by using the BAT spreadsheet for adding lines to existing phones, use the 
following procedure.

For information about installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet 
for Gathering Data” section on page 1-8.

Procedure

Step 1 To open the BAT Spreadsheet, locate and double-click the BAT.xlt file. For more information on 
uploading and downloading files, see Chapter 2, “Uploading and Downloading Files.”

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To display the fields, click the Add Lines tab at the bottom of the spreadsheet.
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Step 4 Enter data for an individual phone on each line in the spreadsheet. Complete all mandatory fields and 
any relevant optional fields. Each column heading specifies the length of the field and whether it is 
required or optional. Table 10-2 describes the fields for adding lines in the BAT spreadsheet.

Step 5 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT 
Format.

The system saves the file to C:\XLSDataFiles\ or you can use Browse to save your file in another existing 
folder on your local workstation. The filename is

<tabname>-<timestamp>.txt 

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> 
represents the precise date and time that the file was created.

Note If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when 
you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. 
The system does not convert data that is entered after a blank line to the BAT format.

Upload the file to the Cisco Unified CallManager server. See the “Uploading a File” section on page 2-3.

Note For information on how to read the exported CSV data file, click the link to View Sample File in the 
Insert Phones window in BAT.

Additional Topics

See the “Related Topics” section on page 10-11.

Field Descriptions for Adding Lines By Using the BAT Spreadsheet
Table 10-2 provides the field descriptions when you are adding lines by using the BAT spreadsheet. For 
related procedures, see the “Related Topics” section on page 10-11.

Table 10-2 Field Descriptions for Adding Lines by Using the BAT Spreadsheet

Field Description

MAC Address Enter the MAC address for phones, VGC virtual phones, and VGC 
phones. Enter a unique identifier for CTI ports and H.323 clients.

Line Index Enter a number between 1 and 34 for the line index of a phone.

Directory Number Enter a directory number, up to 24 numerals and special characters, 
for this line.
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Display Enter the text that you want to display on the called party’s phone 
display, such as the user name (John Smith) or phone location 
(Conference Room 1).

Note If this filed is left blank the system uses the value that is 
entered in the Directory Number field.

Note The default language specifies English.

Line Text Label Enter text that identifies this directory number for a line/phone 
combination. 

Note The default language specifies English

Forward Busy External Enter the directory number to which a call that is coming from an 
external number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward No Answer External Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward No Coverage 
External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone does not have coverage.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward Busy Internal Enter the directory number to which a call that is coming from an 
internal number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward No Answer Internal Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Forward No Coverage Internal Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone does not have coverage.

Note This setting applies to any dialable phone number, including 
an outside destination unless restricted, and to all devices that 
are using this directory number.

Call Pickup Group Enter a Pickup Group Name to specify the call pickup group, which 
can answer incoming calls to this line by dialing the appropriate 
pickup group number.

Table 10-2 Field Descriptions for Adding Lines by Using the BAT Spreadsheet

Field Description
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Related Topics
• Using Query to Update Lines, page 10-1

• Adding Lines to Existing Phones and UDPs, page 10-7

• Using the BAT Spreadsheet to Add Lines to Existing Phones, page 10-8
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Resetting or Restarting Phones

You can reset or restart devices without updating any attributes. Use this procedure if a problem arises, 
and you must reset or restart the phones with a bulk transaction.

You can choose between two methods to locate phones you want to reset or restart:

• Using Query to Reset or Restart Phones, page 11-1

• Using a Custom File to Reset or Restart Phones, page 11-2

Using Query to Reset or Restart Phones
To reset or restart phones by creating a query to locate the phones, use the following procedure.

Procedure 

Step 1 Choose Bulk Administration > Phones > Reset/Restart Phones > Query.

The Reset/Restart Phones Configuration window displays.

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name

• Description

• Directory Number

• Calling Search Space

• Device Pool

• Device Type

• Call Pickup Group

• LSC Status

• Authentication String

• Device Protocol

• Security Profile

From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with

• contains 
11-1
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• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable. 

Tip To find all Phones that are registered in the database, click Find without entering any search text.

Step 4 To further define your query, you can choose AND or OR to add multiple filters and repeat steps 2 and 3.

Step 5 Click Find.

A list of discovered templates displays by:

• Device Name

• Description

• Device Pool

• Device Protocol

• Status

• IP Address

Step 6 From the list of records, click the device name that matches your search criteria.

Step 7 Click one of the following options:

• Reset—To reset (power-cycle) the phones 

• Restart—To reset phones without power-cycling

Step 8 In the Job Information area, enter the Job description.

Step 9 Click the Run Immediately radio button to insert the phone records immediately or, click Run Later to 
insert the phone records at a later time.

Step 10 Click Submit to create a job for inserting the phone records. 

Step 11 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 11-3.

Using a Custom File to Reset or Restart Phones 
You can create a custom file of phones that you want to reset or restart by using a text editor. You can 
use either device names or directory numbers in the custom file. 

Before You Begin

1. Create a text file that lists one of these details for the phones that you want to reset or restart:
11-2
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 11      Resetting or Restarting Phones
Related Topics
– Device names 

– Description

– Directory numbers

2. Put each item on a separate line in the text file.

3. Upload the file to the first node of Cisco Unified CallManager. See the “Uploading a File” section 
on page 2-3.

To reset or restart phones by using a custom file, use the following procedure.

Procedure 

Step 1 Choose Bulk Administration > Phones > Reset/Restart Phones > Custom File.

The Reset/Restart Phones Custom Configuration window displays.

Step 2 In the Update Phones where drop-down list box, choose the type of custom file that you have created 
from one of the following criteria:

• Device Name (includes MAC addresses)

• Directory Number

• Description

Step 3 In the list of custom files, choose the filename of the custom file for this update. 

Caution If no information is entered into the query text box, the system resets or restarts all phones.

Step 4 Click Find.

Step 5 Click one of the following:

• Reset—To reset (power-cycle) the phones 

• Restart—To reset phones without power-cycling

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to insert the phone records immediately or, click Run Later to 
insert the phone records at a later time.

Step 8 Click Submit to create a job for inserting the phone records. 

Step 9 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 11-3.

Related Topics
• Using Query to Reset or Restart Phones, page 11-1
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• Using a Custom File to Reset or Restart Phones, page 11-2
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Generating Phone Reports

Cisco Unified CallManager Bulk Administration (BAT) provides reports to help you manage records 
effectively. You can create and save reports that provide information about phones, users, user device 
profiles, managers and assistants, and gateway records. You can save these reports with a filename and 
store them in a folder on the first node server to review and print.

You can customize BAT reports for phones and for user device profiles to meet your particular needs by 
choosing items from a list of device fields and line fields. You can also choose how to arrange the fields 
in the report. The system generates the report in the CSV file format. Because reports for users, 
managers, assistants, and gateways have a fixed format, you cannot customize them.

Example

You need to have a list of all the directory numbers with their forwarding destinations by phone model. 
You can generate a Phone Report for the Cisco Unified IP Phone model 7960 and choose these query 
details: Device Name, Directory Number, Forward Busy Destination, Forward No Answer Destination, 
and Label. You can arrange the report fields, so the Label field follows the Directory Number field and 
precedes the two forward destination numbers.

Additional Information

See the “Related Topics” section on page 12-6.

Generating Reports for Phones
To generate reports for phones and other IP telephony devices, use this procedure.

Procedure

Step 1 Choose Bulk Administration > Phones > Generate Phone Reports.

The Report Phone Query window displays.

Step 2 In the first Find Phone(s) where drop-down list box, choose the field to query such as Model or Directory 
Number.

Step 3 In the second drop-down list box, choose the search criteria such as begins with, contains, or is empty.

Step 4 In the search field/list box, either choose or enter the value that you want to locate, such as the model 
name from the list or directory number range.

Step 5 Specify the appropriate search text, if applicable. 
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Tip To generate a report for all Phones that are registered in the database, click Find without entering 
any search text.

Step 6 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 through 5.

Step 7 Click Find.

A list of discovered phones displays.

Step 8 Click Next to choose details for your type of report. The Generate Phone Report Configuration window 
displays and shows the Query that you chose. If you want to change the type of query, click Back.

Step 9 In the Report File Name field, enter your name for this report (required). 

Step 10 In the Available Device Fields drop-down list box, choose a device item and click the arrow to move the 
item into the Selected Fields for this Report list. You can choose one or more fields to include in your 
report. For a list of device and live fields, see the “Reports for Phones and IP Telephony Devices” section 
on page 12-3.

Step 11 Arrange the order of the items in the Selected Device Fields for this Report list by choosing an item and 
clicking the Up arrow or Down arrow to move the item to another position in the list.

Step 12 In the Available Line Fields drop-down list box, choose a line item and click the arrow to move the item 
into the Selected Fields for this Report list. You can choose one or more fields to include in your report.

Step 13 Arrange the order of the line items in the Selected Line Fields for this Report list by choosing an item 
and clicking the Up arrow or Down arrow to move the item to another position in the list.

Note You must specify at least one device or line field to generate a report.

Step 14 if you want to include IP phone services fields in your report, check the check boxes for Speed Dial 
Services and/or IP Phone Services.

Step 15 In the Job Information area, enter the Job description.

Step 16 Click the Run Immediately radio button to generate the report immediately or, click Run Later to 
generate the report later.

Step 17 Click Submit to create a job for inserting the phone records. 

Step 18 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

You can search and download the report file using the Upload/Download Files option in the Bulk 
Administration menu. See Chapter 2, “Uploading and Downloading Files.” 

Additional Information

See the “Related Topics” section on page 12-6.
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Reports for Phones and IP Telephony Devices
You can produce phone reports for all phones and IP telephony devices or limit the report to one of these 
options:

• Phone Model—Choose one from the list of models that are configured in the cluster.

• Device Name—Specify a filter or use exact name.

• Description—Specify a filter or use exact description.

• Phone Load Name—Specify a filter or use exact name.

• Device Pool—Choose one from a list of device pools that are configured in the cluster.

• Calling Search Space—Choose one from a list of CSS that are configured in the cluster.

• Location—Choose one from a list of locations that are configured in the cluster.

• Directory Number—Specify a filter or use exact number.

After choosing the phone report type, you can choose the device and line details to include in the report. 

You can choose from these Device fields:

• AAR Calling Search Space

• AAR Neighborhood

• Authentication String

• Built In Bridge

• Calling Search Space

• Calling Search Space Reroute

• Certificate Operation

• Certificate Status

• Common Profile

• Country

• Description

• Device Name

• Device Pool

• Device Profile

• Device Protocol

• Device_Default Profile

• Dial Rules

• Last Login user ID

• Load Information

• Location

• Login Duration

• Login Time

• MLPP Domain

• MLPP Indication
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• Media Resource List

• Model

• Network Hold MOH Audio Source

• Network Location

• Packet Capture Duration

• Packet Capture Mode

• Phone Template

• Preemption

• Privacy

• Product

• Public Key

• Qsig

• SIP Profile

• Secure Shell Password

• Secure Shell User ID

• Security Profile

• Softkey Template

• Upgrade Finish Time

• User ID

You can choose from these Line fields:

• Alerting Name

• Auto Answer

• CSS_Device Failure

• CSS_MWI

• Call Forward Duration

• Calling Line Presentation Bit

• Calling Name Presentation Bit

• Calling Party Prefix Digits

• Connected Line Presentation Bit

• Connected Name Presentation Bit

• Device Failure DN

• Directory Number

• CSS (Forward All)

• CSS (Forward Busy External) 

• CSS (Forward Busy Internal) 

• CSS (Forward No Answer External) 

• CSS (Forward No Answer Internal) 

• CSS (Forward On Failure) 
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• CSS (Forward No Coverage External) 

• CSS (Forward No Coverage Internal) 

• Forward All Destination

• Forward Busy Destination External 

• Forward Busy Destination Internal 

• Forward No Answer Destination External 

• Forward No Answer Destination Internal 

• Forward on Failure Destination

• Forward No Coverage Destination External 

• Forward No Coverage Destination Internal 

• Forward on CTI Failure CSS

• Line AAR Neighborhood

• Line Alerting Name ASCII

• Line Description

• Line Network Hold MOH Audio Source

• MLPP No Answer Ring Duration (Seconds)

• Route Partition

• Secondary Call Forward All CSS

• Target CSS

• Target Destination

• User Hold MOH Audio Source

Additional Information

See the “Related Topics” section on page 12-6.

Producing a List of Phones with Dummy MAC Addresses
To generate a list of phones that are using dummy MAC addresses, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Phones > Generate Phone Reports.

The Report Phone Query window displays.

Step 2 In the first Find Phone(s) where drop-down list box, choose Device Name.

Step 3 In the second drop-down list box, choose begins with.

Step 4 In the text field, enter BAT. All phones that are added with a dummy MAC address have device names 
that begin with BAT. 

Step 5 Click Find. The text Device Name begins with ‘BAT’ and displays in the query text box.

Step 6 Click Next. The Generate Phone Report Configuration window displays.
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Step 7 Complete the report by going to Step 9 in the procedure for Generating Reports for Phones.

Additional Information

See the “Related Topics” section on page 12-6.

Viewing Report Log Files
BAT generates log files for each report transaction and stores them on the first node of 
Cisco Unified CallManager server. You can find the link to log files for this job from the Job 
configuration window for this job. For more details, see Chapter 51, “Scheduling Jobs.”

Additional Information

See the “Related Topics” section on page 12-6.

Related Topics
• Generating Reports for Phones, page 12-1

• Reports for Phones and IP Telephony Devices, page 12-3

• Producing a List of Phones with Dummy MAC Addresses, page 12-5

• Viewing Report Log Files, page 12-6
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Migrating Phones

Using Cisco Unified CallManager Bulk Administration (BAT), you can migrate a group of phones from 
Skinny Client Control Protocol (SCCP) to Session Initiation Protocol (SIP). 

Migrating Phones 
Use the following procedure to migrate phones.

Procedure 

Step 1 Choose Bulk Administration > Phones > Migrate Phones> SCCP to SIP.

The Migrate Phones—SCCP to SIP window displays.

Step 2 From the first Find Phone where drop-down list box, choose one of the following criteria:

• Device Name

• Description

• Directory Number

• Calling Search Space

• Device Pool

• Device Type

• Call Pickup Group

• LSC Status

• Authentication String

• Location

• Phone Load Name

• Security Profile

Step 3 From the second Find Phone where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with
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• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable. 

Tip To find all phones that are registered in the database, click Find without entering any search text.

Step 5 To further define your query, check the check box corresponding to Search Within Results Using 
drop-down list box. You can choose AND or OR to add multiple filters. Repeat steps 2 through 4.

Step 6 Click Find.

A list of discovered phones displays by:

• Device Name

• Description

• Device Pool

• Device Protocol

• Status

• IP Address

Step 7 Click Next.

Step 8 Choose the phone template from the drop-down list box.

Note SCCP to SIP migration will pick up only SIP protocol specific default values from this template 
during migration. It will not pick any other value from the template.

Step 9 In the Job Information area, enter the Job description.

Step 10 Click the Run Immediately radio button to migrate phone records immediately or, click Run Later to 
migrate at a later time.

Step 11 Click Submit to create a job for migrating the phone records. 

Note After submitting a job for migrating phones from SCCP to SIP, make sure that you reset these 
phones. Reset phones using Bulk Administration > Phones > Reset/Restart Phones > Query. 
See “Using Query to Reset or Restart Phones” section on page 11-1. 

Step 12 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 13-3.
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Related Topics
• Migrating Phones, page 13-1

• Using Query to Reset or Restart Phones, page 11-1

• Scheduling Jobs
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Adding Users

You can use Cisco Unified CallManager Bulk Administration (BAT) to add a group of new users and to 
associate users to phones and other IP Telephony devices in the Cisco Unified CallManager database. 

Note If you use your corporate directory and have Lightweight Directory Access Protocol (LDAP) 
synchronization enabled (in Cisco Unified CallManager Administration, choose System > LDAP > 
LDAP System), then you cannot use BAT to insert/update or delete users. For more details on LDAP, 
refer to Cisco Unified CallManager Administration Guide 5.0.

This chapter describes working with users.

Use the following topics to manage user records and to work with user combinations, such as phones and 
users or CTI ports and user records in the Cisco Unified CallManager LDAP directory:

• Adding Users, page 14-1

• Exporting User Records, page 19-1

• Generating Reports for Users, page 21-1

Adding Users
To add users to the Cisco Unified CallManager LDAP Directory in bulk, you must perform these steps:

1. Create a comma separated values (CSV) data file to define individual values for each user that you 
want to add. 

– See the “Using the BAT Spreadsheet to Create the CSV Data File for Users” section on 
page 14-2.

– For information about creating a text-based CSV data file for users, see the “Creating a 
Text-Based CSV File for Users” section on page A-6.

2. Use BAT to insert the users to the Cisco Unified CallManager directory. See the “Inserting Users to 
Cisco Unified CallManager” section on page 16-1.

Note When you are adding users who have applications that require a CTI port, such as 
Cisco IP SoftPhone, BAT can associate CTI ports to existing users.

Additional Topics

See the “Related Topics” section on page 14-5.
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Using the BAT Spreadsheet to Create the CSV Data File for Users 
You can provide details for adding new users to the Cisco Unified CallManager directory in the BAT 
spreadsheet and convert it a CSV data file.

For information about installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet 
for Gathering Data” section on page 1-8.

To create the CSV data file for adding new users in bulk, use the following procedure.

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file. 

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To add users, click the Users tab at the bottom of the spreadsheet. 

Step 4 Complete all mandatory fields and any relevant optional fields. Each column heading specifies the length 
of the field and whether it is required or optional.

In each row, provide the information as described in Table 14-1. If a user has multiple devices, the device 
name field should be repeated, once for each device.

Table 14-1 Field Descriptions in BAT Spreadsheet for Adding Users

Field Description

First Name Enter the first name, up to 50 characters, of the phone user.

Middle Name Enter the middle name, up to 50 characters, of the phone user.

Last Name Enter the last name, up to 50 characters, of the phone user.

User ID Enter the user ID , from 1 to 30 characters, for the user of this phone.

Password Enter the password, up to 20 characters, that the user needs to access 
the Cisco IP Phone Configuration window.

You must specify the Password either in the CSV data file or by 
using the BAT user interface during user template addition. If you 
want to apply individual passwords for each user or groups of users, 
specify the password information in the CSV data file. If you want 
to use a default password for all users, provide the default password 
when you insert the users in BAT.

Manager User ID Enter manager user ID, up to 30 characters, for the user of this 
phone.

Department Enter the department number, up to 30 characters, for the user of 
this phone.

PIN Enter the personal identification number (PIN) , up to 20 numerals, 
to be used for extension mobility.

You must enter a PIN either in the CSV data file or by using the BAT 
user interface during user template addition. If you want to apply 
individual PINs for each user or groups of users, specify the PIN in 
the CSV data file.To use a default PIN that all users can use, provide 
default PIN when you insert the users in BAT.
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User Device Profile Enter the user device profile for this user and device, up to 50 
characters. You can choose the user device profile from the list of 
existing UDPs in Cisco Unified CallManager Administration that 
appears in BAT. 

User Locale Enter the language and country set that you want to associate with 
this user. Your choice determines which cultural-dependent 
attributes exist for this user and which language displays in the 
Cisco Unified CallManager user windows and phones.

Controlled Device Name1 Enter the name, up to 50 characters, for the phone or device that you 
want to associate with this user. 

Note The Controlled Device Name field(s) displays when the 
Number of Controlled Devices field, at the extreme right in 
the spreadsheet, is set to greater than Zero.

Telephone Number Enter the telephone number, up to 50 numerals for the primary 
extension (usually Line 1) for the phone.

Primary Extension This field displays after the user is added and represents the primary 
directory number for the user. You choose no primary line when you 
associate devices to the user. Users can have multiple lines on their 
phones.

Associated PC This field, which is required for Cisco SoftPhone and 
Cisco Unified CallManager Attendant Console users, displays after 
the user is added.

ICD Extension From the drop-down list box, choose an ICD extension for this end 
user.

Mail ID Release 5.0(2) of Cisco Unified CallManager Administration will 
provide this description.

Controlled Device Name 2 Enter the name, up to 50 characters, for any additional phones that 
you want to associate with this user.

Note The Controlled Device Name field(s) displays when the 
Number of Controlled Devices field, at the extreme right in 
the spreadsheet, is set to greater than Zero.

Note You must complete the Controlled Device Name1 field first 
and then add more Controlled Device Name entries.

Presence Group Enter the presence group that watches the status of the directory 
number, the presence entity.

For information on the Presence feature, refer to Cisco Unified 
CallManager Features and Services Guide.

Table 14-1 Field Descriptions in BAT Spreadsheet for Adding Users (continued)

Field Description
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Step 5 To enter additional device names that will be associated to a new user, click the Add More Devices 
button .

Note You can associate all devices, including CTI ports, ATA ports, and H.323 clients, with a user.

Note To associate auto-generated device profiles to new users using BAT, BAT administrators can 
enter the ADP name in the xlt, in User Device Profile column.

Step 6 Click Export to BAT Format to transfer the data from the BAT Excel spreadsheet into a CSV formatted 
data file.

The system saves the file to C:\XLSDataFiles\ or use Browse to save the file to another existing folder. 
The filename is:

<tabname>-<timestamp>.txt 

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> 
represents the precise date and time that the file was created.

SUBSCRIBE Calling Search 
Space

All calling search spaces that you configure in 
Cisco Unified CallManager Administration display in the 
SUBSCRIBE Calling Search Space drop-down list box.

The SUBSCRIBE Calling Search Space determines how 
Cisco Unified CallManager routes the Presence subscription 
requests that come from the end user. To configure a calling search 
space specifically for this purpose, you configure a calling search 
space as you do all calling search spaces (Call Routing > Class 
Control > Calling Search Space). 

For information on how to configure a calling search space, see the 
Cisco Unified CallManager Administration Guide.

Digest Credentials When you configure digest authentication for SIP phones, 
Cisco Unified CallManager challenges the identity of the phone 
every time the phone sends a SIP request to 
Cisco Unified CallManager. The digest credentials that you enter in 
this field get associated with the phone when you choose a digest 
user in the Phone Configuration window. 

Enter a string of alphanumeric characters.

For more information on digest authentication, refer to the 
Cisco Unified CallManager Security Guide.

User Group Enter the user group to which the user belongs.

Note The User Group field(s) displays when the Number of User 
Groups field, at the extreme right in the spreadsheet, is set 
to greater than Zero.

Table 14-1 Field Descriptions in BAT Spreadsheet for Adding Users (continued)

Field Description
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Note If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when 
you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. 
Data that is entered after a blank line does not get converted to the BAT format.

You must upload the CSV data file to the first node of Cisco Unified CallManager database server, so 
BAT can access the data file. See Chapter 2, “Uploading and Downloading Files.”

Note For information on how to read the exported CSV data file, click the link to View Sample File in the 
Insert Users window in BAT.

Additional Topics

See the “Related Topics” section on page 14-5.

Related Topics
• Adding Users, page 14-1

• Exporting User Records, page 19-1

• Generating Reports for Users, page 21-1

• BAT Log Files, page 54-3.
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User Template

You can use Cisco Unified CallManager Bulk Administration (BAT) user templates to define the 
common user attributes to add a group of new users.

Use these topics to work with BAT User Templates:

• Finding a BAT User Template, page 15-1

• Creating a New BAT User Template, page 15-2

• Modifying BAT User Templates, page 15-3

• Copying a BAT User Template, page 15-3

• Deleting Templates, page 15-3

• Field Descriptions for a BAT User Template, page 15-4

Finding a BAT User Template
Because you might have several user templates, Cisco Unified CallManager lets you locate specific user 
template on the basis of specific criteria. Use the following procedure to locate templates.

Note During your work in a browser session, your find/list search preferences are stored in the cookies on the 
client machine. If you navigate to other menu items and return to this menu item, or if you close the 
browser and then reopen a new browser window, your Cisco Unified CallManager search preferences 
are retained until you modify your search.

Procedure

Step 1 Choose Bulk Administration > Users > User Template.

The Find and List User Templates window displays. Use the two drop-down list boxes to search for a 
template.

Step 2 From the first Find User Templates where drop-down list box, choose one of the following criteria:

• User Template Name

• Department

From the second Find User Template where drop-down list box, choose one of the following criteria:

• begins with
15-1
allManager Bulk Administration Guide



Chapter 15      User Template
Creating a New BAT User Template
• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

Tip To find all User Templates that are registered in the database, click Find without entering any 
search text.

A list of discovered templates displays by:

• User Template

• Department

Step 4 From the list of records, click the user template that matches your search criteria.

The window displays the user template that you choose.

Additional Information

See the “Related Topics” section on page 15-6

Creating a New BAT User Template
Use this procedure to create a new user template.

Procedure

Step 1 Choose Bulk Administration > Users > User Template. 

The Find and List User Templates window displays. 

Step 2 Click Add New. The User Template Configuration window displays.

Step 3 Enter the user settings that this group of users have in common. See “Field Descriptions for a BAT User 
Template” section on page 15-4.

Step 4 Click Save.

When the user template is added to the database, the status indicates that the transaction has completed.

Additional Information

See the “Related Topics” section on page 15-6
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Modifying BAT User Templates
Use this procedure to view or modify an existing user template. 

Procedure

Step 1 Find the user template you want to modify, using the procedure in “Finding a BAT User Template” 
section on page 15-1

Step 2 In the User Template Configuration window, add, change, or remove settings in the template. See 
“Table 15-1Field Descriptions for a User Template in BAT” section on page 15-4 for more information.

Step 3 After you modified the settings to update the template, click Save.

Additional Information

See the “Related Topics” section on page 15-6

Copying a BAT User Template
You can copy the properties of a user template into a new user template when you want to change only 
a few fields.

Use the following procedure to copy an existing BAT phone template.

Procedure

Step 1 Find the user template you want to copy, using the procedure in “Finding a BAT User Template” section 
on page 15-1

Step 2 In the User Template Configuration window, verify that this is the template that you want to copy and 
click Copy.

The template reproduces and creates a copy. The copy duplicates all the values that were specified in the 
original template. 

Step 3 Update the fields as needed for the new template. See “Table 15-1Field Descriptions for a User Template 
in BAT” section on page 15-4 for information.

Step 4 Click Save. 

Additional Topics

See the “Related Topics” section on page 15-6.

Deleting Templates
You can delete BAT templates when you no longer require them. Use this procedure to delete a template.
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Procedure

Step 1 Find the user template you want to delete, using the procedure in “Finding a BAT User Template” 
section on page 15-1.

Step 2 In the User Template Configuration window, verify that this is the template that you want to delete and 
click Delete.

Note You can also delete the user template from the Find and List User Templates window.check the 
check box next to the template you want to delete and click Delete Selected 

A message displays that asks you to confirm the delete operation.

Step 3 To delete the template, click OK. The template name disappears from the list of user templates list on 
the Find and List User Templates window.

Note If you submit a job with a particular user template, and if you delete the user template before the 
execution of the job, then the job also gets deleted. You have to resubmit the job by creating another user 
template.

Additional Topics

See the “Related Topics” section on page 15-6.

Field Descriptions for a BAT User Template
Table 15-1 provides descriptions of all possible fields that display when you are adding a BAT user 
template. For related procedures, see the “Related Topics” section on page 15-6.

In the BAT user interface, field names that have an asterisk require an entry. Treat fields that do not have 
an asterisk as optional.

Table 15-1 Field Descriptions for a User Template in BAT

Field Description

User Template Name Enter a unique name, up to 30 alpha-numeric characters, for the 
user template.

Password Enter the password, up to 20 characters, that the user needs to 
access the Cisco IP Phone Configuration window.

You must specify the Password either in the CSV data file or by 
using the BAT user interface during user template addition. If you 
want to apply individual passwords for each user or groups of 
users, specify the password information in the CSV data file. If 
you want to use a default password for all users, provide the 
default password when you insert the users in BAT.

Confirm Password Reenter the password for confirmation.
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Default Password to User ID Check this check box if you want to make the user ID as the 
default password for all users.

PIN Enter the personal identification number (PIN) , up to 20 
numerals, to be used for extension mobility.

You must enter a PIN either in the CSV data file or by using the 
BAT user interface during user template addition. If you want to 
apply individual PINs for each user or groups of users, specify the 
PIN in the CSV data file.To use a default PIN that all users can 
use, provide default PIN when you insert the users in BAT.

Confirm PIN Reenter the PIN for confirmation.

Default PIN to Telephone Number Check this check box to make the telephone number as the default 
PIN.

Default Telephone Number to 
Primary Extension

Check this check box to make the telephone number as the 
primary extension.

Default Mail ID to User ID Check this check box to default mail ID to user ID.

Manager User ID Enter manager user ID, up to 30 characters, for the user of this 
phone.

Department Enter the department number, up to 30 characters, for the user of 
this phone.

User Locale Choose the language and country set that you want to associate 
with this user from the drop-down list box. Your choice 
determines which cultural-dependent attributes exist for this user 
and which language displays in the Cisco Unified CallManager 
user windows and phones.

Associated PC This field, which is required for Cisco SoftPhone and 
Cisco Unified CallManager Attendant Console users, displays 
after the user is added.

Default Profile Choose the default profile for this user from the default Profile 
Drop-down list box. 

Presence Group From the drop-down list box, choose the presence group that 
watches the status of the directory number, the presence entity.

For information on the Presence feature, refer to Cisco Unified 
CallManager Features and Services Guide.

Table 15-1 Field Descriptions for a User Template in BAT

Field Description
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Note To continue configuring the BAT phone template, go to the “Creating a New BAT User Template” 
section on page 15-2

Related Topics
• Finding a BAT User Template, page 15-1

• Creating a New BAT User Template, page 15-2

• Modifying BAT User Templates, page 15-3

• Copying a BAT User Template, page 15-3

• Deleting Templates, page 15-3

• Field Descriptions for a BAT User Template, page 15-4

SUBSCRIBE Calling Search 
Space

All calling search spaces that you configure in 
Cisco Unified CallManager Administration display in the 
SUBSCRIBE Calling Search Space drop-down list box.

The SUBSCRIBE Calling Search Space determines how 
Cisco Unified CallManager routes the Presence subscription 
requests that come from the end user. To configure a calling 
search space specifically for this purpose, you configure a calling 
search space as you do all calling search spaces (Call Routing > 
Class Control > Calling Search Space). 

For information on how to configure a calling search space, see 
the Cisco Unified CallManager Administration Guide.

Digest Credentials When you configure digest authentication for SIP phones, 
Cisco Unified CallManager challenges the identity of the phone 
every time the phone sends a SIP request to 
Cisco Unified CallManager. The digest credentials that you enter 
in this field get associated with the phone when you choose a 
digest user in the Phone Configuration window. 

Enter a string of alphanumeric characters.

For more information on digest authentication, refer to the 
Cisco Unified CallManager Security Guide.

Allow Control of Device from 
CTI 

Check this check box to allow CTI to control and monitor this 
device. 

If the associated directory number specifies a shared line, the 
check box should be enabled as long as at least one associated 
device specifies a combination of device type and protocol that 
CTI supports.

User Group From the drop-down list box, choose the user group to which the 
user belongs.

Table 15-1 Field Descriptions for a User Template in BAT

Field Description
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Inserting Users

You can use Cisco Unified CallManager Bulk Administration (BAT) to add a group of users to the 
Cisco Unified CallManager directory.

Inserting Users to Cisco Unified CallManager
To add a group of users to the Cisco Unified CallManager directory, use the following procedure.

Before You Begin

You must have a CSV data file that contains the user names, controlled device names, and directory 
numbers. You can create the CSV data file by using one of these methods:

• BAT spreadsheet that is converted to CSV format

• Export utility that produces an export file of user data

If you are inserting files that are generated with the export utility, insert the files in descending order 
based on the _MgrLevel# suffix, where # is 1 through 20. Insert the file with the _user suffix last to 
ensure that the user record for a manager exists prior to use of the User ID for a manager in the Manager 
User ID field.

Procedure

Step 1 Choose Bulk Administration > Users > Insert Users. 

The Insert Users Configuration page displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.

Step 3 If the CSV data file was created by using the export utility, check the File created with Export Users 
check box. 

Step 4 Choose the user template you want to use for this insert from the User Template Name drop-down list 
box.

Note The User Device Profile, Controlled Device Name, and Directory Number should already exist 
in the Cisco Unified CallManager database. 

Step 5 In the Job Information area, enter the Job description.
16-1
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Step 6 Click the Run Immediately radio button to insert the user records immediately or, click Run Later to 
insert the user records at a later time.

Step 7 Click Submit to create a job for inserting the user records. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Note The field values that you enter in the CSV file for inserting users will override the values 
provided in the user template.

Note When you are inserting users by using an exported BAT file, you might get errors stating “User 
ID already exists” for some users that were exported in more than one file. For example, a list 
of first line managers and a list of users might both include the same manager user ID.

Additional Topics

See the “Related Topics” section on page 16-2.

Related Topics
• Creating a New BAT User Template, page 15-2

• Field Descriptions for a BAT User Template, page 15-4

• Inserting Users to Cisco Unified CallManager, page 16-1
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Updating Users

Update the existing user information that is in the database using the following procedure:

• Updating Users, page 17-1

• Retaining Stored Values, page 17-1

• Using the BAT Spreadsheet to Create a CSV Data File for Updating Users, page 17-2

• Updating Users in Cisco Unified CallManager, page 17-5

Updating Users
To update existing user information that is in the Cisco Unified CallManager database, use the following 
steps:

1. Create a comma separated values (CSV) data file to define individual values for each user that you 
want to update.

– See the “Using the BAT Spreadsheet to Create a CSV Data File for Updating Users” section on 
page 17-2.

– For a text-based CSV file, see the “Updating Users File Format” section on page A-8.

Note To keep values or settings that were previously stored in the Cisco Unified CallManager 
directory, see the“Retaining Stored Values” section on page 17-1.

2. Use Cisco Unified CallManager Bulk Administration (BAT) to insert the updated user records that 
are in the Cisco Unified CallManager database. See the Updating Users in 
Cisco Unified CallManager, page 17-5.

Additional Topics

See the “Related Topics” section on page 17-5.

Retaining Stored Values
When you are updating user records, you might want to keep values or settings for a user that were 
previously stored in the Cisco Unified CallManager directory. You can use a symbol such as“#” for 
fields where the value must be retained. In following example CSV data file, the # tells BAT to keep the 
Manager field the same as the one that was previously entered in the DC directory.
17-1
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userid,#,department,,,123456789012,

To identify the value to use to retain a stored value, use the following procedure.

Procedure

Step 1 Choose Bulk Administrator > Users > Update Users. 

The User Update Configuration window displays.

Step 2 Notice the Value for fields to be ignored box. When you insert the CSV data file with the updated user 
values, you must enter the symbol that you used to retain values in this box.

Step 3 Decide what symbol you want to use for retaining values. 

Step 4 Enter this value that is in the Value for fields to be ignored box into the BAT spreadsheet box.

Step 5 Use this symbol in BAT spreadsheet fields for any values that you want to retain.

Additional Topics

See the “Related Topics” section on page 17-5

Using the BAT Spreadsheet to Create a CSV Data File for Updating Users
To create the CSV data file for updating a group of existing users, use the following procedure. 

Procedure

Step 1 Download and open the BAT.xlt file. See Chapter 2, “Uploading and Downloading Files.”

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To add user information, click the Update Users tab at the bottom of the spreadsheet.

Step 4 Complete all mandatory fields and any relevant optional fields. Each column heading specifies the length 
of the field and whether it is required or optional. Use Table 17-1 for descriptions of the BAT spreadsheet 
fields.

Table 17-1 Field Descriptions in the BAT Spreadsheet for Updating Users 

Field Description

User ID Enter the user ID, from 1 to 30 characters, for the user of this 
phone.

Manager Enter manager user ID, up to 30 characters, for the user of this 
phone.

Department Enter the department number, up to 50 characters, for the user of 
this phone.

User Device Profile Enter the user device profile, up to 50 characters, for this user and 
device. You can choose the user device profile from the list of 
existing UDPs in Cisco Unified CallManager Administration that 
appears in BAT. 
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User Locale Enter the language and country, up to 50 characters, set that you 
want to associate with this user. Your choice determines which 
cultural-dependent attributes exist for this user and which 
language displays in the Cisco Unified CallManager user 
windows and phones.

Password Enter the password, up to 20 characters, that the user needs to 
access the Cisco IP Phone Configuration window.

You must specify the Password either in the CSV data file or by 
using the BAT user interface during user template addition. If you 
want to apply individual passwords for each user or groups of 
users, specify the password information in the CSV data file. If 
you want to use a default password for all users, provide the 
default password when you insert the users in BAT.

PIN Enter the personal identification number (PIN), up to 20 
numerals, to be used for extension mobility.

You must enter a PIN either in the CSV data file or by using the 
BAT user interface during user template addition. If you want to 
apply individual PINs for each user or groups of users, specify the 
PIN in the CSV data file.To use a default PIN that all users can 
use, provide default PIN when you insert the users in BAT.

Telephone Number Enter your telephone number. 

Primary Extension This field displays after the user is added and represents the 
primary directory number for the user. You choose no primary 
line when you associate devices to the user. Users can have 
multiple lines on their phones.

If the system is configured for Unity Integration, the Create Voice 
Mailbox link displays.

Associated PC This field, which is required for Cisco SoftPhone and 
Cisco Unified CallManager Attendant Console users, displays 
after the user is added.

ICD Extension Enter an ICD extension for this end user.

Mail ID Enter your e-mail ID. 

Controlled Device MAC Address This field displays after the user is added. After the device is 
associated, this field displays the description information (for 
example, the MAC address) that the user controls.

Directory Number Enter the directory number, up to 24 numerals, for the primary 
extension (usually Line 1) for the phone.

Presence Group Enter the presence group that watches the status of the directory 
number, the presence entity.

For information on the Presence feature, refer to Cisco Unified 
CallManager Features and Services Guide.

Table 17-1 Field Descriptions in the BAT Spreadsheet for Updating Users  (continued)

Field Description
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Step 5 In the Value for fields to be ignored box, enter the symbol that you will use to tell BAT that you want to 
keep the value that was previously stored in the DC directory. Enter the same value in the value of the 
field you want to retain.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click the Export to BAT format 
button. 

The system saves the file to C:\XlsDataFiles\ (or to your choice of another existing folder). The filename 
is

Update_Users-timestamp.txt (or to your choice of filename)

Note If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when 
you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. 
Data that is entered after a blank line does not get converted to the BAT format.

You must upload the CSV data file to the first node of Cisco Unified CallManager server, so BAT can 
access the CSV data file. See the “Uploading a File” section on page 2-3

Note For information on how to read the CSV data file, click the link to View Sample File in the 
Update Users window in BAT.

SUBSCRIBE Calling Search 
Space

All calling search spaces that you configure in 
Cisco Unified CallManager Administration display in the 
SUBSCRIBE Calling Search Space drop-down list box.

The SUBSCRIBE Calling Search Space determines how 
Cisco Unified CallManager routes the Presence subscription 
requests that come from the end user. To configure a calling 
search space specifically for this purpose, you configure a calling 
search space as you do all calling search spaces (Call Routing > 
Class Control > Calling Search Space). 

For information on how to configure a calling search space, see 
the Cisco Unified CallManager Administration Guide.

Digest Credentials When you configure digest authentication for SIP phones, 
Cisco Unified CallManager challenges the identity of the phone 
every time the phone sends a SIP request to 
Cisco Unified CallManager. The digest credentials that you enter 
in this field get associated with the phone when you choose a 
digest user in the Phone Configuration window. 

Enter a string of alphanumeric characters.

For more information on digest authentication, refer to the 
Cisco Unified CallManager Security Guide.

Table 17-1 Field Descriptions in the BAT Spreadsheet for Updating Users  (continued)

Field Description
17-4
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 17      Updating Users
Related Topics
Additional Topics

See the “Related Topics” section on page 17-5.

Updating Users in Cisco Unified CallManager
To update a group of user records in the to Cisco Unified CallManager directory, use this procedure.

Before You Begin

You must have a CSV data file with updated user information. See the “Using the BAT Spreadsheet to 
Create a CSV Data File for Updating Users” section on page 17-2 for instructions.

Procedure

Step 1 Choose Bulk Administrator > Users > Update Users. 

The User Update Configuration window displays.

Step 2 From File Name drop-down list box, choose the CSV data file that you created for this bulk transaction. 

Step 3 From the User Template Name drop-down list box, choose the user template that you created for this 
bulk transaction.

Step 4 In the Value for fields to be ignored box, enter the symbol that you used to tell BAT that you want to 
keep the value that was previously stored in the DC directory. See the “Retaining Stored Values” section 
on page 17-1 for more information.

Note The value entered in the CSV file for updating users will override the values provided in the user 
template.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to update the user records immediately or, click Run Later to 
insert the user records at a later time.

Step 7 Click Submit to create a job for updating the user records. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 17-5.

Related Topics
• Updating Users, page 17-1

• Retaining Stored Values, page 17-1

• Using the BAT Spreadsheet to Create a CSV Data File for Updating Users, page 17-2
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• Updating Users in Cisco Unified CallManager, page 17-5

• Uploading and Downloading Files
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Delete Users

You can delete a group of users from the Cisco Unified CallManager directory. You can locate existing 
user records by using one of these two methods:

• Using Query to Delete Users, page 18-1

• Using a Custom File to Delete Users, page 18-2

Using Query to Delete Users 
To delete users when you want to create a query filter to locate the user records, use the following 
procedure.

Procedure

Use the following procedure to delete users by creating a query to locate the user records.

Step 1 Choose Bulk Administration > Users > Delete Users > Query.

The Delete Users Configuration window displays.

Step 2 From the first Find User where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department Name

From the second Find User where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty
18-1
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Step 3 Specify the appropriate search text, if applicable. 

Tip To find all users that are registered in the database, click Find without entering any search text.

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 3.

Step 5 Click Find.

A list of discovered templates displays by:

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department Name

• LDAP Sync Status

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to delete user records immediately or, click Run Later to delete 
the user records at a later time.

Step 8 Click Submit to create a job for deleting the user records. 

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 18-3.

Using a Custom File to Delete Users 
To locate and delete users, you can create a custom file of user IDs by using a text editor.

Before You Begin

1. Create a text file that lists each user ID that you want to delete on a separate line. 

2. Upload the custom file with the first node of the Cisco Unified CallManager server. See Chapter 2, 
“Uploading and Downloading Files.”

To delete users by using a custom file, use the following procedure.

Procedure 

Step 1 Choose Bulk Administration > Users > Delete Users > Custom File.

The Find and List Users - Delete Users Based on Custom File window displays.
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Step 2 In Delete Users where drop-down list box, choose one of the following criteria: 

• User ID

• First Name

• Middle Name

• Last Name

• Department

Step 3 In the Custom file where drop-down list box, choose the filename for the custom file.

Step 4 To check that the query includes the information that you need, click Find.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to delete user records immediately or, click Run Later to delete 
the user records at a later time.

Step 7 Click Submit to create a job for deleting the user records. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 18-3.

Related Topics
• Using Query to Delete Users, page 18-1

• Using a Custom File to Delete Users, page 18-2
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Exporting Users

When you use Cisco Unified CallManager Bulk Administration (BAT) to export user records, the export 
utility sorts users according to the organizational hierarchy in the database. T

From the Exports Users Configuration window, if Default User Format is selected from the File Format 
drop-down list box. the export utility only exports the default user device profile that is associated with 
a user. You must insert the other user device profiles for that user separately by using 
Cisco Unified CallManager Administrator.

Exporting User Records
When you export user records, some users might have a blank PIN because these user records were 
created prior to Cisco Unified CallManager 3.1. If this is the case, you must specify a default PIN before 
reinserting the user records in the BAT user interface.

Use this procedure to export User records from Cisco Unified CallManager.

Procedure

Step 1 Choose Bulk Administration > Users > Export Users.

The Export Users Query window displays.

Step 2 In the first Find User where drop-down list box, choose a field to query from the following options:

• User ID

• First Name 

• Middle Name

• Last Name

• Manager

• Department

Step 3 In the second drop-down list box, choose from the following options:

• begins with

• contains 

• is exactly

• ends with
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• is empty

• is not empty

Step 4 In the search field/list box, enter the value that you want to locate, such as a specific name or User ID.

Note To choose users from more than one department, enter multiple departments in this field. For 
example, to choose users from departments 12 and 34, enter 12, 34 in the third box instead of 
performing two operations. 

Step 5 You can click the Search Within Results check box and choose AND or OR to add multiple filters and 
repeat Step 2 through Step 4 to further define your query.

Step 6 Click Find. The search results display.

Note To find all users that are registered in the database, click Find without entering any search text.

Step 7 Click Next.

Step 8 Enter the export users file name in the File Name text box.

Step 9 Choose file format from the File Format drop-down list box. 

Step 10 In the Job Information area, enter the Job description.

Step 11 Click the Run Immediately radio button to export user records immediately or, click Run Later to export 
at a later time.

Step 12 Click Submit to create a job for exporting user records. 

Step 13 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

You can search and download the exported file using the Upload/Download Files option in the Bulk 
Administration menu. See Chapter 2, “Uploading and Downloading Files.”.

Additional Information

See the “Related Topics” section on page 19-2.

Related Topics
• Exporting User Records, page 19-1
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Resetting Passwords and PINs

You can reset the password that users use when they log on to the Cisco Unified IP Phone User Options 
window. You can also reset the PINs for the extension mobility feature that users use when they log in 
to Cisco Unified IP Phones. Use this action when you must reset a group of users to a default password 
or to a default PIN without updating any other attributes.

Resetting Passwords and PINs
You have two ways to choose users for resetting passwords and PINs:

• Using Query to Reset User Password and PIN, page 20-1

• Using a Custom File to Reset User Password and PIN, page 20-3

Using Query to Reset User Password and PIN
To use a query to locate users and reset passwords and PINs to a default value, use the following 
procedure.

Procedure

Step 1 Choose Bulk Administration > Users > Reset Password/PIN > Query.

The Reset Password/PIN for Users Query window displays.

Step 2 To locate the users that you want to reset, define the query filter. 

Step 3 From the first Find User where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department

From the second Find User where drop-down list box, choose one of the following criteria:

• begins with
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• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable, and click Find.

Note To choose users from more than one department, enter multiple departments separated with a 
comma in this field. For example, to choose users from departments 12 and 14, enter 12, 14 in 
the third box instead of performing two operations. 

Tip To find all users that are registered in the database, click Find without entering any search text.

Step 5 To further define your query, you can choose AND or OR to add multiple filters and repeat steps 3 and 4.

Step 6 Click Find.

A list of discovered users displays by:

• User ID

• First Name

• Middle Name

• Last Name

• Manager

• Department Name

• LDAP Sync Status

Step 7 Click Next.

Step 8 Enter the values that you want to update for all the records that you defined in your query. 

• Password—Enter the default password that users use when they log on to the 
Cisco Unified IP Phone User Options window.

• Confirm Password—Reenter the password.

• PIN—Enter the default PIN for the extension mobility feature that users should use when they log 
in to a Cisco Unified IP Phone. 

• Confirm PIN—Reenter the PIN.

Step 9 In the Job Information area, enter the Job description.

Step 10 Click the Run Immediately radio button to change passwords or PINs immediately or, click Run Later 
to change them at a later time.

Step 11 Click Submit to create a job for resetting passwords or PINs. 

Step 12 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”
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For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 20-4.

Using a Custom File to Reset User Password and PIN 
To locate users and to reset passwords and PINs to default values, you can create a custom file of user 
IDs by using a text editor.

Before You Begin

1. Create a text file that lists each user ID on a separate line for which you want to reset password or 
PIN. 

2. Upload the custom file into Cisco Unified CallManager first node. See “Uploading a File” section 
on page 2-3.

To reset user passwords and PINS by using a custom file, use the following procedure.

Procedure 

Step 1 Choose Bulk Administration > Users > Reset Password/PIN > Custom File.

The Find and List Users - Reset Pwd/Pin for users based on custom file window displays.

Step 2 In Reset Pwd/PIN for Users where drop-down list box, choose the field that you used in the custom file 
from the following options:

• User ID

• First Name

• Middle Name

• Last Name

• Department

Step 3 In the In Custom File drop-down list box, choose the filename for the custom file.

Step 4 In the Job Information area, enter the Job description.

Step 5 Click the Run Immediately radio button to change passwords or PINs immediately or, click Run Later 
to change them at a later time.

Step 6 Click Submit to create a job for resetting passwords or PINs. 

Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3. The log file displays the number 
of users that were updated and the number of records that failed, including an error code. 

Additional Topics

See the “Related Topics” section on page 20-4.
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Related Topics
• Using Query to Reset User Password and PIN, page 20-1

• Using a Custom File to Reset User Password and PIN, page 20-3
20-4
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Cisco Unified C
OL-9421-01
C H A P T E R 21

Generating User Reports

Cisco Unified CallManager Bulk Administration (BAT) provides reports to help you manage records 
effectively. You can create and save reports that provide information about phones, users, user device 
profiles, managers and assistants, and gateway records. You can save these reports with a filename and 
store them in a folder on Cisco Unified CallManager first node to review and print.

Additional Information

See the “Related Topics” section on page 21-2.

Generating Reports for Users
Reports for users have a fixed format. You can generate a report for all users by not specifying any query 
options, or you can specify a limited set of query options.

To generate a report for users, use this procedure.

Procedure

Step 1 Choose Bulk Administration > Users > Generate User Reports. The Find and List Users window 
displays.

Note You can generate a report for all users by not specifying a query, or you can generate a report for 
specific users by using following steps:

Step 2 In Select Users Where scroll box, choose from these query options: User ID, Department, First Name, 
Middle Name, Last Name, Manager.

Step 3 In the second drop-down list box, choose from the following search criteria.

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty
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Step 4 In the search field box, enter the value that you want to locate, such as the exact user ID or the last name 
of a user.

You can add multiple values to the search field box by separating them with a comma as shown in 
this example: JohnJ, PaulP, SueS, JoeJ

Tip To generate a report for all users that are registered in the database, click Find without entering 
any search text.

Step 5 Click Find. A list of discovered user records displays.

Step 6 Click Next to choose details for your type of report. If you want to change the type of query, click Back.

Step 7 In the File Name field, enter your name for this report (required). 

Step 8 In the Available Fields drop-down list box, choose an item and click the arrow to move the item into the 
Selected Fields for this Report list. You can choose one or more fields to include in your report. 

Step 9 Arrange the order of the items in the Selected Fields for this report list by choosing an item and clicking 
the Up arrow or Down arrow to move the item to another position in the list.

Step 10 In the Job Information area, enter the Job description.

Step 11 Click the Run Immediately radio button to generate report immediately or, click Run Later.

Step 12 Click Submit to create a job for generating user reports. 

Step 13 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

You can search and download the report file using the Upload/Download Files option in the Bulk 
Administration menu. See Chapter 2, “Uploading and Downloading Files.”.

Additional Information

See the “Related Topics” section on page 21-2.

Viewing Report Log Files
BAT generates log files for each report transaction and stores them on the first node of 
Cisco Unified CallManager server. You can find the link to log files for this job from the Job 
configuration window for this job. For more details, see Chapter 51, “Scheduling Jobs.”

Additional Information

See the “Related Topics” section on page 21-2.

Related Topics
• Generating Reports for Users, page 21-1

• Viewing Report Log Files, page 21-2
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Phones with Users

You can use Cisco Unified CallManager Bulk Administration to add a group of users and their phones 
on a Cisco Unified CallManager server in one bulk transaction. You have two options for creating a CSV 
data file for the phones:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

You can access the Insert Phones with Users option by choosing Bulk Administration > Phones and 
Users from the Cisco Unified CallManager Administration main menu.

Adding New Phones with Users
Use the following steps to insert phones with users. 

1. Create a comma separated values (CSV) data file to define individual values for each phone/user 
record that you want to update.

– See the “Using the BAT Spreadsheet to Add Phones with Users” section on page 22-1.

– For a text-based CSV file, see the “Phones With Users Combinations File Format” section on 
page A-2.

2. Associate file format with the CSV data file.

– See the “Adding Phones/Users File Format” section on page 23-1.

3. Validate Phones with users records 

– See the “Validating Phones and Users Records” section on page 24-1.

4. Insert Phones with users records.

– See the “Inserting Phones with Users to Cisco Unified CallManager” section on page 25-1.

Using the BAT Spreadsheet to Add Phones with Users 
To create the CSV data file for adding phones and users in bulk, use the following procedure. 

For information about installing and using the BAT spreadsheet, see “Using the BAT Spreadsheet for 
Gathering Data” section on page 1-8.
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Step 1 Locate and double-click BAT.xlt file to open the BAT spreadsheet. For more information on 
downloading BAT.xlt file, see Chapter 2, “Uploading and Downloading Files.”

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 Click the Phones-Users tab at the bottom of the spreadsheet.

Step 4 Follow steps 4 through 14 in the Using the BAT Spreadsheet to Create a CSV Data File for Phones, page 
3-28.

For descriptions for the user information fields, see Table 14-1Field Descriptions in BAT Spreadsheet 
for Adding Users, page 14-2.

Additional Topics

See the “Related Topics” section on page 22-2.

Related Topics
• Adding New Phones with Users, page 22-1

• Phones With Users Combinations File Format, page A-2

• Adding Phones/Users File Format, page 23-1

• Validating Phones and Users Records, page 24-1

• Inserting Phones with Users to Cisco Unified CallManager
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Phones and Users File Format

To create a comma separated values (CSV) data file to define individual values for each user that you 
want to update.

• See the “Using the BAT Spreadsheet to Add Phones with Users” section on page 22-1.

• For a text-based CSV file, see the “Phones With Users Combinations File Format” section on 
page A-2.

When you use a text editor to create the CSV data file, you create a file format for entering values in the 
text-based file. You enter values in the text file in the order that the file format specifies.

After the CSV data file is completed, you need to associate the file format with the text-based CSV data 
file. After associating the file format with the CSV file,   the names for each field display as the first 
record in the CSV data file. You can use this information to verify that you entered the values for each 
field in the correct order.

Adding Phones/Users File Format 
To add the file format with the text-based CSV data file, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Phones and Users> Phones & Users File Format > Assign File 
Format. The Add File Format Configuration window displays.

Step 2 In the File Name field, choose the text-based CSV file that you created for this transaction.

Step 3 In the File Format Name field, choose the file format that you created for this type of bulk transaction.

Step 4 Click Submit to create a job for associating the matching file format with the CSV data file. 

Step 5 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 23-2.
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Related Topics
• Using the BAT Spreadsheet to Add Phones with Users, page 22-1

• Phones With Users Combinations File Format, page A-2

• BAT Log Files, page 54-3
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Validating Phones and Users

You can use Cisco Unified CallManager Bulk Administration (BAT) to add a group of users and their 
phones on a Cisco Unified CallManager server in one bulk transaction. You have two options for 
creating a CSV data file for the phones:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

You can access the Insert Phones with Users option by choosing Bulk Administration > 
Phones and Users from the Cisco Unified CallManager Administration main menu.

Before you Begin

1. Create a comma separated values (CSV) data file to define individual values for each phone/user 
that you want to validate.

– See the “Validating Phones and Users Records” section on page 24-1.

– For a text-based CSV file, see the “Phones With Users Combinations File Format” section on 
page A-2.

2. Associate file format with the CSV data file.

– See the “Associating the File Format with the CSV Data File” section on page 4-5.

Validating Phones and Users Records
When you choose Validate Phones/Users, the system runs a validation routine to check that the CSV data 
file and BAT phone template have populated all required fields, such as device pool and locations. The 
validation checks only the device fields and their dependencies. Users fields are not validated.

Before You Begin

• You must have a BAT phone template for the devices that you are adding. You can use a master 
phone template with multiple lines to add phones that have a single line or several lines. See the 
“Master Phone Templates” section on page 1-4 for more information.

• You must have a CSV data file that you created by using one of these options:

– Validating Phones and Users Records, page 24-1 

– Creating a text-based CSV file in the Phones With Users Combinations File Format, page A-2.

To validate your CSV data file records, use the following procedure.
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Step 1 Choose Bulk Administration > Phones and Users > Validate Phones/Users. The Validate 
Phones/Users Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this specific bulk transaction.

Step 3 In the Phone Template Name field, choose the BAT phone template that you created for this bulk 
transaction. 

Step 4 Click Submit to create a job for validating users and phones. 

Step 5 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 24-2.

Related Topics
• Phones With Users Combinations File Format, page A-2

• Associating the File Format with the CSV Data File, page 4-5

• BAT Log Files, page 54-3

• Scheduling Jobs
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Inserting Phones and Users

To add a group of phones and users to the Cisco Unified CallManager database and directory, use the 
following procedure.

Inserting Phones with Users to Cisco Unified CallManager
Before you Begin

1. Create a comma separated values (CSV) data file to define individual values for each phones with 
users that you want to insert.

– See the “Using the BAT Spreadsheet to Add Phones with Users” section on page 22-1.

– For a text-based CSV file, see the “Phones With Users Combinations File Format” section on 
page A-2.

2. Associate file format with the CSV data file.

– See the “Adding Phones/Users File Format” section on page 23-1.

3. Validate Phones with users records 

– See the “Validating Phones and Users Records” section on page 24-1.

Use the following procedure to insert phones with users into Cisco Unified CallManager:

Procedure

Step 1 Choose Bulk Administration > Phones & Users > Insert Phones with Users. 

The Insert Phones/Users window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.

Step 3 In the Phone Template Name field, choose the BAT phone template that you used for this transaction.

If you did not enter individual MAC addresses in the CSV data file, you must check the Create Dummy 
MAC Address check box. If you are adding CTI ports, the dummy MAC address option provides a 
unique device name for each CTI port in the form of dummy MAC addresses. 

This field automatically generates dummy MAC addresses in the following format: 
BATXXXXXXXXXXXX
where X represents any 12-character, hexadecimal (0-9 and A-F) number.

• If you do not know the MAC address of the phone that will be assigned to the user, chose this option. 
When the phone is plugged in, a MAC address registers for that device.
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• If you supplied MAC addresses or device names in the data input file, do not choose this option.

You can update the phones or devices later with the correct MAC address by manually entering this 
information into Cisco Unified CallManager Administration or by using Unified CM Auto-Register 
Phone Tool. See the“Introducing Cisco Unified CM Auto-Register Phone Tool” section on page 52-2 
for more information about Unified CM Auto-Register Phone Tool. 

Step 4 In the User Template Name field, choose the BAT user template that you used for this transaction

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to insert phones with users immediately or, click Run Later to 
insert phones with users at a later time.

Step 7 Click Submit to create a job for deleting the user records. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 25-2.

Related Topics
• Using the BAT Spreadsheet to Add Phones with Users, page 22-1

• Phones With Users Combinations File Format, page A-2

• Adding Phones/Users File Format, page 23-1

• Validating Phones and Users Records, page 24-1

• Scheduling Jobs, page 51-1

• Introducing Cisco Unified CM Auto-Register Phone Tool, page 52-2

• BAT Log Files, page 54-3
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Working with Cisco Unified CallManager 
Assistant

You can use Cisco Unified CallManager Bulk Administration (BAT) to manage the 
Cisco Unified CallManager Assistant feature in Cisco Unified CallManager. BAT allows you to add IP 
phones for managers and assistants. See the following sections for information:

• Configuring Phones in Proxy Line Mode for Cisco Unified CM Assistant, page 26-2

• Configuring Phones in Shared Line Mode for Cisco Unified CM Assistant, page 26-7

You can add, update, and delete managers or assistants with their associations in bulk transactions. See 
the Creating the CSV Data File for Manager-Assistant Associations, page 26-9.

The following topics explain the options for managing Cisco Unified CM Assistant with BAT:

• Inserting Manager-Assistant Associations to Cisco Unified CallManager, page 27-1

• Deleting Manager-Assistant Associations from Cisco Unified CallManager, page 28-1

• Deleting Managers from Cisco Unified CallManager, page 29-1

• Deleting Assistants from Cisco Unified CallManager, page 30-1

For more information related to Cisco Unified CM Assistant, refer to this documentation.

• Cisco Unified CallManager Features and Services Guide 

• Cisco Unified CallManager Assistant User Guide

Overview of Phones and Lines for Use with Cisco Unified CM 
Assistant

The Cisco Unified CM Assistant feature works with several Cisco Unified IP Phone models and device 
profiles. Cisco Unified CM Assistant provides two modes for configuring managers and assistants lines 
for use with Cisco Unified CM Assistant features.

• Proxy mode—The manager’s primary line associates with a proxy line that has a different directory 
number on the assistant’s phone. See the “Configuring Phones in Proxy Line Mode for 
Cisco Unified CM Assistant” section on page 26-2.

• Shared line mode—The manager and assistant have a shared line on their phones that uses the same 
directory number and partition. See the “Configuring Phones in Shared Line Mode for 
Cisco Unified CM Assistant” section on page 26-7.
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Note You can associate users to devices/phones only if they support Unified CM Assistant.

You can use BAT to set up the manager and assistant phones with either proxy lines or shared lines.

Configuring Phones in Proxy Line Mode for Cisco Unified CM Assistant
To prepare for configuring manager and assistant phones with Unified CM Assistant proxy line support, 
you must complete the following tasks:

1. Cisco recommends that you use the Cisco Unified CM Assistant Configuration Wizard to set up and 
configure Unified CM Assistant requirements for your system. The wizard automatically creates the 
phone templates for Unified CM Assistant manager and assistant, route points, partitions, 
translation patterns, and calling search space for the Cisco Unified CM Assistant service. To run the 
Cisco Unified CM Assistant Configuration Wizard ensure BAT and the wizard are on the same 
server. Refer to the Cisco Unified CallManager Features and Services Guide for information about 
running the Cisco Unified CM Assistant Configuration Wizard. 

Note You can use the Cisco Unified CM Assistant Configuration Wizard only one time to set up the 
Unified CM Assistant configuration requirements for your system. After running the 
configuration wizard, you can only view, but not change, your configuration with the wizard. 

2. To add new phones and users for managers and assistants, use the Unified CM Assistant manager 
and Unified CM Assistant assistant phone templates that the Cisco Unified CM Assistant 
Configuration Wizard produced on the BAT server. Use the BAT templates to configure phones for 
proxy mode only. For information about the templates, see the “Default Settings for Unified CM 
Assistant Manager and Assistant Phone Templates” section on page 26-2.

3. For existing manager and assistant phones, you can change the manager and assistant phones to 
correspond to the Unified CM Assistant phone templates by using either of these methods: 

– You can use the Add Lines feature in BAT to modify existing phones to resemble the 
Unified CM Assistant phone templates. See the “Adding Lines to Existing Phones and UDPs” 
section on page 10-7.

– You can delete the original phones and add new phones by using the Unified CM Assistant 
phone templates for managers and assistants. Follow the procedures for setting up new phones 
in the “Adding Phones” section on page 3-1. 

4. After you configure the phones and lines for managers and assistants, you associate the manager and 
assistant lines for Unified CM Assistant control. For information about Unified CM Assistant line 
configurations, see the “Manager and Assistant Proxy Line Configurations” section on page 26-3.

Default Settings for Unified CM Assistant Manager and Assistant Phone Templates 

Table 26-1 lists the default settings for the Unified CM Assistant manager phone template. 
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Table 26-2 lists the default settings for the Unified CM Assistant assistant phone template.

Manager and Assistant Proxy Line Configurations

BAT assigns Unified CM Assistant line configurations by mapping the manager’s primary lines on the 
phone to proxy lines on the assistant phone. When you use the Unified CM Assistant manager and 
assistant default templates that the Unified CM Assistant wizard created, you can associate from one to 
five manager lines on one assistant phone. For phones configured with the Unified CM Assistant 
templates, this example shows the line configurations when you associate two manager phones to an 
assistant phone.

Manager 1 Phone:

• Line 1— Primary line

Table 26-1  Default Settings for Manager Phone Templates for Proxy Lines

Field Default Value

Softkey Template Standard Unified CM Assistant Manager

Phone Button Template Standard Cisco Unified IP Phone model 7960 (2 lines)

Line1 Primary line 

• CSS = Generated_Unified CM Assistant_CSS_I_E

• Partition = Generated_Unified CM Assistant_Managers

Line 2 Incoming Intercom line

• CSS = Generated_Unified CM Assistant_CSS_M_E 

• Partition = Generated_Unified CM Assistant_Everyone 

• Also configure auto answer with headset option.

Services Unified CM AssistantPhoneService 

Table 26-2 Default Settings for Assistant Phone Template for Proxy Lines

Field Default Value

Softkey Template Standard Unified CM Assistant Assistant

Phone Button Template Standard Cisco Unified IP Phone 7960 Assistant

Expansion Module 1 14-button expansion module 

One line on base phone and five 
lines on expansion module

For Proxy lines, one line on base phone and five lines on expansion 
module have the following default configuration:

• CSS = Unified CM Assistant_CSS_M_E 

• Partition = Generated_Unified CM Assistant_Everyone

Line 7

(On Expansion Module)

Intercom line

• CSS = Generated_Unified CM Assistant_CSS_I_E 

• Partition = Generated_Unified Unified CM 
Assistant_Everyone 

• Also configure auto answer with headset option.
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• Line 2— Intercom line

Manager 2 Phone:

• Line 1— Primary line

• Line 2— Intercom line

Assistant Phone:

• Line 1—Primary line

• Line 2—Proxy line for Manager 1

• Line 3—Proxy line for Manager 2

• Lines 4 through 6 are unassigned

• Line 7—Intercom line

Lines 4 through 6 remain available for other manager associations.

When you associate multiple managers to an assistant phone, BAT creates proxy lines based on the order 
in the CSV data file. BAT creates the first manager-assistant line by assigning all the manager’s primary 
lines as proxy lines to the unassigned lines on the assistant phone. BAT continues creating individual 
manager-assistant proxy lines based on the order of the CSV record until all lines on the assistant phone 
are assigned or all managers in the CSV record are associated. 

When you associate multiple assistants to a manager primary line, BAT assigns assistants to the manager 
based on the order in the CSV data file. BAT assigns the manager’s primary lines based on the first 
assistant’s number of available lines. For example, a manager’s phone has two primary lines. The first 
assistant, who is listed in the CSV data file, has only one available line. Consequently, BAT associates 
only one primary line for the manager and one proxy line on all the assistant phones that are listed in the 
CSV record.

Unified CM Assistant Manager Phone Configuration

Table 26-3 lists all possible line configurations for a manager phone that BAT can set up when using 
manager-assistant associations.

Table 26-3  Manager Phone Line Configuration

Number of Available Lines Configuration

One line Line 1—Primary line (Unified CM Assistant controlled)

Intercom line (none)

Two lines

(Default Unified CM Assistant 
manager phone template)

Line 1—Primary line (Unified Unified CM Assistant 
controlled)

Line 2—Intercom line (optional)

More than two lines Last line gets configured as the intercom line.

The number of available lines on the assistant phone determines 
the number of manager lines that get associated with proxy 
lines.
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Unified CM Assistant Assistant Phone Configuration

Table 26-4 lists the default line configuration for the assistant phones that BAT sets up during 
manager-assistant associations.

Proxy Line Example for Cisco Unified CM Assistant Manager and Assistant Phones

You associate two managers, each with three existing lines, to an assistant phone with six unassigned 
lines. BAT sets the following line configurations on the manager and assistant phones. 

Manager 1 Phone:

• Line 1—Manager primary line (DN is 2355)

• Line 2—Manager primary line (DN is 2366)

• Line 3—Manager intercom line

Manager 2 Phone:

• Line 1—Manager primary line (DN is 2656)

• Line 2—Manager primary line (DN is 2666)

• Line 3—Manager intercom line

Assistant Phone:

• Line 1—Assistant primary line (DN is 3333)

• Line 2—Proxy line 1 for Manager 1 (DN is 3455)

Table 26-4 Assistant Phone Line Configurations

Number of Available Lines Configuration

One line Line 1—Proxy line

Intercom line (none)

Two lines Line 1—Primary line

Line 2—Proxy line 

Intercom line (none)

Three lines Line 1—Primary line

Line 2—Proxy line 

Line 3—Intercom line

More than three lines Line 1—Primary line

Line 2—Proxy line

Last line gets configured as the intercom line

All other lines get configured as proxy lines

Seven lines

(Default Unified CM Assistant 
assistant phone template)

Line 1—Primary line

Line 2 through line 6 can get configured as proxy lines to support 
up to five managers.

Line 7—Intercom line
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• Line 3—Proxy line 1 for Manager 2 (DN is 3656))

• Line 4—Proxy line 2 for Manager 1 (DN is 3366)

• Line 5—Proxy line 2 for Manager 2 (DN is 3666)

• Line 6—Available

• Line 7—Assistant intercom line

When you associate a manager phone that has preexisting primary lines, you must ensure that the number 
of unassigned lines on the assistant phone equals or is greater than the number of primary lines on the 
manager phone. For instance, BAT does not allow you to create an association between a manager that 
has a phone with four configured primary lines and an assistant with only three available lines.

Setting Up New Phones for Unified CM Assistant Managers and Assistants with Proxy Lines

To set up new phones for Unified CM Assistant managers and assistants that use proxy lines, use the 
following procedure.

Before You Begin

1. Run the Unified CM Assistant Configuration Wizard to create the Unified CM Assistant templates, 
partition, and calling search space.

2. If you want to associate more than five managers to an assistant, you must access the Unified CM 
Assistant Assistant Template and make a copy with a new name. Add more lines to the template to 
accommodate the additional managers.

Step 1 Choose BAT Administrator> Phones > Phones Template. The Phone Template Configuration window 
displays.

Note Because BAT Unified CM Assistant templates are write protected, you want to make changes to 
these templates, you must make a copy of the template and then edit the template with your 
changes.

See the “Default Settings for Manager Phone Templates for Proxy Lines” section on page 26-3 for 
descriptions of the manager phone template fields. 

See the “Default Settings for Assistant Phone Template for Proxy Lines” section on page 26-3 for 
descriptions of the assistant phone template fields. 

Step 2 Create the CSV data file for manager phones and another file for assistant phones by using these options:

• Use the BAT spreadsheet and choose the Phones tab.

• Use a text editor and refer to the manager or assistant template fields as a guide.

Step 3 Use the procedure in the “Adding Phones” section on page 3-1 for detailed steps to insert new phones.

Setting Up Unified CM Assistant Proxy Lines on Existing Phones

To set up lines on existing phones for managers and assistants, use the following procedure.

Step 1 Choose BAT Administration > Phones > Add Lines. The Phone Add Lines window displays.
26-6
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 26      Working with Cisco Unified CallManager Assistant
Overview of Phones and Lines for Use with Cisco Unified CM Assistant
Step 2 If you need to copy and modify the Unified CM Assistant templates for BAT, see these topics for 
reference:

• Table 26-1Default Settings for Manager Phone Templates for Proxy Lines, page 26-3

• Table 26-2Default Settings for Assistant Phone Template for Proxy Lines, page 26-3 

Note If you changed any configuration information (for example, partition names) when you ran the 
Cisco Unified CM Assistant Configuration Wizard, you must use the same configuration 
information for the fields when you edit the template. 

Step 3 Create the CSV data file for manager phones and another file for assistant phones by using one of these 
options:

• Use the BAT spreadsheet and choose the Add Lines tab.

• Use a text editor and use the manager or assistant template fields as a guide.

Step 4 To set up manager and assistant lines on existing phones, use the procedure in Adding Lines to Existing 
Phones and UDPs, page 10-7. 

Additional Topics

See the “Related Topics” section on page 26-12.

Configuring Phones in Shared Line Mode for Cisco Unified CM Assistant
To configure manager and assistant phones with shared line support, you must perform the following 
tasks:

1. You must set up the Unified CM Assistant service parameters for shared line support in 
Cisco Unified CallManager. Refer to the Cisco Unified CallManager Features and Services Guide 
for information.

2. You need a phone button template with five or more lines for the Cisco Unified IP Phone model 
7960.

3. Configure the phones for managers and assistants by using the following guidelines:

Manager Phones in Shared Line Mode

Use the procedures for setting up new phones by using BAT in the “Adding Phones” section on page 3-1. 

Create a BAT template to add new or update existing manager phones with the following phone settings:

• Assign the Softkey template: Standard Unified CM Assistant Shared Mode Manager.

• Add primary lines to share with assistants, if needed.

• Set up the voice-messaging profile on the primary line.

• Add an incoming intercom line (optional).

• Add speed-dial buttons for outgoing intercom targets (optional).

• Set the user locale.
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Assistant Phones in Shared Line Mode

Use the procedures for setting up new phones by using BAT in the “Adding Phones” section on page 3-1.

Create a BAT template to add new or update existing assistant phones with the following phone settings:

• Assign the Softkey template: Standard Unified CM Assistant Assistant

• If you are using a Cisco 14-button expansion module (7914) for additional lines, specify the 
expansion module type in the BAT template.

Note Cisco Unified IP Phone model 7960 phone button templates include expansion module lines.

• Add a personal primary line.

• Add shared lines for each associated manager. Use the same directory number and partition as the 
primary line on the manager phone.

• Add an incoming intercom line (optional)

• Add speed dials to the managers intercom lines (optional)

• Set the user locale

1. To add lines to existing manager or assistant phones, see the “Adding Lines to Existing Phones and 
UDPs” section on page 10-7. Use the line settings as specified in these sections:

– Manager Phones in Shared Line Mode, page 26-7 

– Assistant Phones in Shared Line Mode, page 26-8 

2. After you configure the phones and lines for managers and assistants, you associate the manager and 
assistant lines for Unified CM Assistant control. Follow the procedures in the “Creating the CSV 
Data File for Manager-Assistant Associations” section on page 26-9.

Manager and Assistant Shared Line Configurations

BAT associates Cisco Unified CM Assistant line configurations to shared lines that are assigned to the 
manager and the assistant phones.You set the shared line mode in the manager’s configuration when 
associating managers with assistants. 

In shared line mode, the manager’s line corresponds to a shared line on the assistant phone. For example, 
in order to associate two managers with an assistant, you add two lines to the assistant phone that have 
the same directory numbers and partitions as the primary lines on the manager phones.

Manager 1 Phone:

• Line 1— Primary line (DN is 2355)

• Line 2— Intercom line (optional)

Manager 2 Phone:

• Line 1— Primary line (DN is 2875)

• Line 2— Intercom line (optional)

Assistant’s Phone:

• Line 1—Assistant’s primary line (DN is 3356)

• Line 2—Shared line with Manager 1 (DN is 2355)
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• Line 3—Shared line with Manager 2 (DN is 2875)

• Lines 4 through 6 are available

• Line 7—Intercom line (optional)

You can add lines 4 through 6 as shared lines for other managers.

When you add multiple manager lines to an assistant phone, all lines on the assistant phone must use 
shared line mode. You cannot mix proxy and shared lines on the assistant phone. Likewise, when a 
manager has multiple assistants, all associations must use shared line mode. 

When you associate multiple assistants to a manager who has shared line mode, BAT assigns 
Unified CM Assistant associations only to those assistants that are also using shared line mode. 

Additional Topics

See the “Related Topics” section on page 26-12.

Creating the CSV Data File for Manager-Assistant Associations
When you use BAT to insert manager-assistant associations to the Cisco Unified CallManager database, 
you can add new associations or update existing associations.

You have two options for creating a CSV data file for manager-assistant associations:

• Using the BAT Spreadsheet to Add or Update Manager-Assistants Associations, page 26-9

• Using a text editor to create a text file in CSV format by using the “Managers and Assistants File 
Formats” section on page A-12.

When you create an association for a new manager, you need to enter a device name. When you update 
a manager with an existing Unified CM Assistant record, consider these fields optional. See the 
“Manager and Assistant Proxy Line Configurations” section on page 26-3 for information about how 
BAT assigns line configurations on manager and assistant phones. BAT does not allow you to assign the 
intercom line of a manager to a proxy line for an assistant if the number of manager lines is greater than 
or equal to three.

Using the BAT Spreadsheet to Add or Update Manager-Assistants Associations
The BAT spreadsheet includes data file templates with macros to make it easy to add, update, or delete 
manager-assistant associations. For information about installing and using the BAT spreadsheet, see the 
“Using the BAT Spreadsheet for Gathering Data” section on page 1-8.

To use the BAT spreadsheet for adding new Unified CM Assistant associations, use the following 
procedure. You can use two ways to set up the manager-assistant configurations:

• To create manager-assistant associations with the default line configuration, see the “Creating 
Default Manager-Assistant CSV Data Files” section on page 26-10. 

For the default line configurations for the manager and assistant phones, see Table 26-3 and 
Table 26-4. 

• If you want to assign proxy lines that do not follow the default line configuration, see the “Creating 
Custom Manager-Assistant CSV Data Files” section on page 26-11.
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Creating Default Manager-Assistant CSV Data Files

To create the CSV data file for inserting or updating manager-assistant association for both proxy and 
shared mode by using the default configuration, use the following procedure. 

Procedure

Step 1 Download and open the BAT.xlt file to open the BAT spreadsheet. See the“Downloading a File” section 
on page 2-2.

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To display the manager-assistant association options, click the Default Managers-Assistants tab at the 
bottom of the spreadsheet.

Step 4 Scroll to the right side of the template until you see the radio buttons and choose the type of associations 
for this transaction:

• One manager, multiple assistants

• One assistant, multiple managers

Step 5 Complete all mandatory fields and any relevant, optional fields. 

If you choose the One manager, multiple assistants radio button, enter the following information in 
each row:

• Manager ID—Enter the user ID, up to 30 characters, of the manager.

• Assistant ID#—Enter the user IDs, up to 30 characters, for the assistants to whom the manager will 
be associated.

The # symbol represents the number of assistants that are assigned to a manager.

Note To add more assistants, click Add more Assistants.

If you choose the One assistant, multiple managers radio button, enter the following information in 
each row:

• Assistant ID—Enter the user ID, up to 30 characters, of the assistant.

• Manager ID#—Enter the user IDs, up to 30 characters, for the managers to whom the assistant will 
be associated.

The # symbol represents the number of managers assigned to an assistant.

Note To add more managers, click Add more Managers.

Step 6 Choose the operation that you want to perform:

• To create new manager-assistant associations, click Insert.

• To delete a manager or an assistant from a manager-assistant association, click Delete.

Step 7 To transfer the data from the BAT spreadsheet into a CSV data file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles or to your choice of another existing folder. The filename 
is

<type of operation>ManagerAssistants-timestamp.txt 
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where <type of operation> specifies the type of operation that was chosen in Step 6, and “timestamp” 
represents the precise date and time that the file was created.

Upload the CSV data file to the first node of Cisco Unified CallManager, so BAT can access the CSV 
data file. See the “Uploading a File” section on page 2-3. 

For information on how to read the exported CSV file, in the BAT Insert Managers/Assistants window, 
click the link to View Sample File.

Additional Topics

See the “Related Topics” section on page 26-12.

Creating Custom Manager-Assistant CSV Data Files

When you have existing phones that you want to set up with manager-assistant associations, you can use 
the Custom Managers-Assistants tab in the BAT spreadsheet. To create the CSV data file for inserting or 
updating manager-assistant associations for proxy lines on the assistant phones, use the following 
procedures. 

Procedure

Step 1 Download the BAT.xlt file from Cisco Unified CallManager server. See the “Downloading a File” 
section on page 2-2.

Step 2 Open the BAT.xlt file. When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To display the manager-assistant association options, click the Custom Managers-Assistants tab at the 
bottom of the spreadsheet.

Step 4 Scroll to the right side of the template until you see Number of Proxy Lines box. In that box, enter the 
number of proxy lines that you are assigning to an assistant. The spreadsheet adds Proxy Line DN and 
Manager Line DN Columns based on the number that you enter.

Complete all mandatory fields and any relevant, optional fields. 

• Manager ID—Enter the user ID of the manager.

• Device Name—Enter the device name that are assigned to the manager’s phone.

• Intercom DN—Enter the directory number for the manager’s intercom line. (Optional)

• Assistant ID—Enter the user IDs for the assistants to whom the manager will be associated.

• Device Name—Enter the device name that are assigned to the assistant’s phone.

• Intercom DN—Enter the directory number for the assistant’s intercom line. (Optional)

• Proxy Line DN#—Enter the directory number for the assistant’s proxy line.

• Manager Line DN#—Enter the directory number for the manager’s primary line.

The # symbol represents the number of proxy lines that are associated to a manager.

Step 5 To transfer the data from the BAT spreadsheet into a CSV data file, click Export to BAT Format button.

The system saves the file to C:\XLSDataFiles or to your choice of another existing folder. The filename 
is Custom Managers-Assistants-timestamp.txt.

Upload the CSV data file to the first node of Cisco Unified CallManager, so BAT can access the CSV 
data file. See the “Uploading a File” section on page 2-3. 
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For information on how to read the exported CSV file, in the BAT Insert Managers/Assistants window, 
click the link to View Sample File.

Additional Topics

See the “Related Topics” section on page 26-12.

Related Topics
• Overview of Phones and Lines for Use with Cisco Unified CM Assistant, page 26-1

• Creating the CSV Data File for Manager-Assistant Associations, page 26-9

• Inserting Manager-Assistant Associations to Cisco Unified CallManager, page 27-1

• Configuring Phones in Proxy Line Mode for Cisco Unified CM Assistant, page 26-2

• Configuring Phones in Shared Line Mode for Cisco Unified CM Assistant, page 26-7

• Deleting Manager-Assistant Associations from Cisco Unified CallManager, page 28-1

• Deleting Managers from Cisco Unified CallManager, page 29-1

• Deleting Assistants from Cisco Unified CallManager, page 30-1

For more information related to Cisco Unified CM Assistant, refer to this documentation.

• Cisco Unified CallManager Features and Services Guide 

• Cisco Unified CallManager Assistant User Guide
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Inserting Managers/Assistants

You can use Cisco Unified CallManager Bulk Administration (BAT) to manage the 
Cisco Unified CallManager Assistant feature in Cisco Unified CallManager. BAT allows you to add IP 
phones for managers and assistants.

The Cisco Unified CM Assistant feature works with several Cisco Unified IP Phone models and device 
profiles. Cisco Unified CM Assistant provides two modes for configuring managers and assistants lines 
for use with Cisco Unified CM Assistant features.

• Proxy mode—The manager’s primary line associates with a proxy line that has a different directory 
number on the assistant’s phone. See the “Configuring Phones in Proxy Line Mode for 
Cisco Unified CM Assistant” section on page 26-2.

• Shared line mode—The manager and assistant have a shared line on their phones that uses the same 
directory number and partition. See the “Configuring Phones in Shared Line Mode for 
Cisco Unified CM Assistant” section on page 26-7.

You can use BAT to set up the manager and assistant phones with either proxy lines or shared lines.

Inserting Manager-Assistant Associations to 
Cisco Unified CallManager

To insert new manager-assistant associations or update existing associations, you need a CSV data file. 
See the “Creating the CSV Data File for Manager-Assistant Associations” section on page 26-9 for 
information.

When BAT updates manager assistant associations, it does not change existing Cisco Unified CM 
Assistant line configurations for the intercom directory number or associated devices.

Caution The Manager-Assistant association fails when the assistant phone does not have enough lines to support 
the minimum Cisco Unified CM Assistant configuration. 

Before you Begin

Make sure that you have configured manager and assistant phones by using one of the following two 
procedures:

• Configuring Phones in Proxy Line Mode for Cisco Unified CM Assistant, page 26-2

• Configuring Phones in Shared Line Mode for Cisco Unified CM Assistant, page 26-7
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To add or update new manager-assistant associations to Cisco Unified CallManager database, use the 
following procedure. 

Procedure

Step 1 Choose Bulk Administration > Managers/Assistants > Insert Managers/Assistants. The 
Manager/Assistant Options window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.

Step 3 If the managers use extension mobility to log in, check the Configure managers as mobile managers 
check box.

Step 4 When all the phones have shared lines, check the Uses shared lines check box.

Step 5 In Insert Options area, choose the type of CSV data file that you created:

• Default—If you created a standard CSV data file, choose the type of associations for this transaction 
based on the data in the CSV file.

– Associate one or more assistants to a manager

– Associate one or more managers to an assistant

• Custom—If you created a custom CSV data file for proxy mode.

Step 6 In the Job Information area, enter the Job description.

Step 7 To insert the managers/assistants immediately, click the Run Immediately radio button or, to insert the 
managers/assistants at a later time, click Run Later.

Step 8 To create a job for inserting the managers/assistants records, click Submit. 

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

Note For information on log files, see “BAT Log Files” section on page 54-3.When BAT performs an 
update to an assistant or manager configuration and the changes are only partially 
completed—because there were not enough available lines—the whole transaction record fails.

Step 10 For changes to take effect, you must restart Cisco Unified CM Assistant service. 

Additional Topics

See the “Related Topics” section on page 27-2.

Related Topics
• Configuring Phones in Proxy Line Mode for Cisco Unified CM Assistant, page 26-2

• Configuring Phones in Shared Line Mode for Cisco Unified CM Assistant, page 26-7

• Creating the CSV Data File for Manager-Assistant Associations

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
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Deleting Managers/Assistants

You can use Cisco Unified CallManager Bulk Administration (BAT) to delete a specific 
manager-assistant association from the Cisco Unified CallManager database. For example, the assistant 
with the user ID, jmorgan, is assigned to two managers with user IDs, rcraig and dbaker. If you want to 
change the manager-assistant association, so the assistant, jmorgan is only assigned to rcraig, you can 
delete the jmorgan-dbaker association by creating a CSV data file with the following entry:

Example
jmorgan,dbaker

Deleting Manager-Assistant Associations from 
Cisco Unified CallManager

If you want to delete a manager or an assistant from all manager-assistant associations, see the following 
sections:

• Deleting Managers from Cisco Unified CallManager, page 29-1 

• Deleting Assistants from Cisco Unified CallManager, page 30-1

To delete specific manager-assistant associations from Cisco Unified CallManager, use this procedure.

Before You Begin

You must have a CSV data file that contains the user IDs for the specific managers and assistants 
associations that you want to delete. See Chapter 26, “Working with Cisco Unified CallManager 
Assistant”.

Procedure

Step 1 Choose Bulk Administration > Managers/Assistants > Delete Managers/Assistants. The Delete 
Managers/Assistants Configuration window displays.

Step 2 In the File Name field, choose the CSV file that you created for this type of bulk transaction. 

Step 3 Choose the type of deletion:

• Delete associated assistants for one manager

• Delete associated managers for one assistant

Step 4 In the Job Information area, enter the Job description.
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Step 5 To delete the managers/assistants immediately, click the Run Immediately radio button or, to delete the 
managers/assistants at a later time, click Run Late.

Step 6 Click Submit to create a job for deleting the required managers/assistants associations. 

Step 7 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 28-2.

Related Topics
• Deleting Managers from Cisco Unified CallManager, page 29-1 

• Deleting Assistants from Cisco Unified CallManager, page 30-1
28-2
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Cisco Unified C
OL-9421-01
C H A P T E R 29

Deleting Managers

When you delete Unified CM Assistant managers, Cisco Unified CallManager maintains information on 
the manager as a user in the directory. For example, if a manager with the user ID, rmartinez, has two 
assistants with user IDs, dbell and jkent, you can disassociate rmartinez from both assistants by deleting 
rmartinez as a manager in the Cisco Unified CallManager database. The directory still shows rmartinez 
as a user.

Deleting Managers from Cisco Unified CallManager
You can delete managers with all their manager-assistant associations from the 
Cisco Unified CallManager database and LDAP Directory. To access the Delete Managers option, 
choose Bulk Administration > Managers/Assistants > Delete Managers.

You have two ways for locating existing records to delete:

• Using Query to Delete Manager Associations, page 29-1

• Using a Custom File to Delete Manager Associations, page 29-2.

Using Query to Delete Manager Associations
To delete managers from their associations with assistants from Cisco Unified CallManager directory, 
use this procedure.

Procedure

Step 1 Choose BAT Administration > Managers/Assistants > Delete Managers > Query. The Delete 
Managers Configuration window displays.

Step 2 From the first Find Managers where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Department
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From the second Find Managers where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable. 

Tip To find all managers that are registered in the database, click Find without entering any search 
text.

Note To choose managers from more than one department, enter multiple departments in this field. 
For example, to choose managers from departments 12 and 24, enter 12, 24 in the third box 
instead of performing two operations. 

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 3.

Step 5 Click Find.

A list of discovered managers displays by:

• User ID

• First Name

• Middle Name

• Last Name

• Department 

Step 6 In the Job Information area, enter the Job description.

Step 7 To delete the managers immediately, click the Run Immediately radio button or, click Run Later to delete 
the managers at a later time.

Step 8 To create a job for deleting chosen managers, click Submit. 

Step 9 To schedule and/or activate this job, use the Job Scheduler option in the Bulk Administration main menu.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 29-3.

Using a Custom File to Delete Manager Associations
You can create a custom file by using a text editor to locate manager associations that you want to delete.
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Before You Begin

1. Create a text file that lists user IDs for managers that you want to delete

2. Put each user ID on a separate line.

3. Upload the custom file to the first node of Cisco Unified CallManager server. See the “Uploading a 
File” section on page 2-3

To delete managers associations by using a custom file, use the following procedure.

Procedure 

Step 1 Choose BAT Administration > Managers/Assistants > Delete Managers > Custom File. The Delete 
Managers Configuration window displays.

Step 2 In Select managers where field, keep the identifier, User ID.

Step 3 In the second field, in Custom File drop-down list box, choose the name of the custom file that you 
created for this transaction.

Step 4 Click Find.

The list of discovered managers displays.

Step 5 In the Job Information area, enter the Job description.

Step 6 To delete the managers immediately, click the Run Immediately radio button, or click Run Later to 
delete the managers at a later time.

Step 7 To create a job for deleting chosen managers, click Submit. 

Step 8 To schedule and/or activate this job, use the Job Configuration window.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Related Topics
• Deleting Manager-Assistant Associations from Cisco Unified CallManager, page 28-1

• Deleting Assistants from Cisco Unified CallManager, page 30-1

• BAT Log Files, page 54-3

• Uploading a File, page 2-3

• Scheduling Jobs, page 51-1
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Deleting Assistants

When you delete Unified CM Assistant assistants, Cisco Unified CallManager maintains information on 
the assistant as a user in the directory. For example, Assistant thudson is assigned to two managers, hart 
and dstewart. You can disassociate thudson from both managers by deleting thudson as an assistant in 
the Cisco Unified CallManager database. The directory still shows thudson as a user.

Deleting Assistants from Cisco Unified CallManager
You have two ways for locating existing records to delete:

• Using Query to Delete Assistants Associations, page 30-1

• Using a Custom File to Delete Assistant Associations, page 30-2.

Using Query to Delete Assistants Associations
To delete assistants from their associations with managers from Cisco Unified CallManager directory, 
use this procedure.

Procedure

Step 1 Choose BAT Administration > Managers/Assistants > Delete Assistants > Query. The Delete 
Assistants Configuration window displays.

Step 2 From the first Find Assistants where drop-down list box, choose one of the following criteria:

• User ID

• First Name

• Middle Name

• Last Name

• Department

From the second Find Assistants where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly
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• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable. 

Tip To find all assistants that are registered in the database, click Find without entering any search 
text.

Note To choose assistants from more than one department, enter multiple departments in this field. 
For example, to choose managers from departments 12 and 24, enter 12, 24 in the third box 
instead of performing two operations. 

Step 4 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 3.

Step 5 Click Find.

A list of discovered assistants displays by:

• User ID

• First Name

• Middle Name

• Last Name

• Department 

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to delete assistants immediately or, click Run Later to delete 
assistants at a later time.

Step 8 Click Submit to create a job for deleting assistants. 

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 30-3.

Using a Custom File to Delete Assistant Associations
You can create a custom file by using a text editor to locate assistant associations that you want to delete.

Before You Begin

1. Create a text file that lists user ID for assistants that you want to delete, putting each on a separate 
line.
30-2
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 30      Deleting Assistants
Related Topics
2. Upload the custom file to the first node of Cisco Unified CallManager server. See the “Uploading a 
File” section on page 2-3.

To delete assistants associations by using a custom file, use the following procedure.

Procedure 

Step 1 Choose BAT Administration > Managers/Assistants > Delete Assistants > Custom File. The Delete 
Assistants Configuration window displays.

Step 2 In Select Assistants where field, keep the identifier, User ID.

Step 3 In the second field, in Custom File drop-down list box, choose the name of the custom file that you 
created for this transaction.

Step 4 Click Find.

The list of discovered assistants displays.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to delete assistants immediately or, click Run Later to delete 
assistants at a later time.

Step 7 Click Submit to create a job for deleting assistants. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 30-3.

Related Topics
• Deleting Assistants from Cisco Unified CallManager, page 30-1

• Deleting Assistants from Cisco Unified CallManager, page 30-1
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Generating Reports for Managers/Assistants

Reports for Cisco Unified CM Assistant managers and assistants have a fixed format. You can generate 
a report by specifying a set of query options for either managers or assistants.

Generating Reports for Unified CM Assistant Managers and 
Assistants

To generate reports for managers or assistants, use this procedure.

Procedure

Step 1 Choose one of these options:

• Bulk Administration > Managers/Assistants > Generate Unified CM Assistant Manager 
Reports. The Manager Reports window displays.

• Bulk Administration > Managers/Assistants > Generate Unified CM Assistant Assistant 
Reports. The Assistant Reports window displays.

Step 2 You can generate a report for all managers or assistants by not specifying a query, or you can generate a 
report for specific managers or assistants by using following steps:

a. In Find Managers (or Assistants) where drop-down list box, choose from these query options: 

– User ID

– First Name

– Middle Name

– Last Name

– Department

b. In the second drop-down list box, choose from the following options:

– begins with

– contains 

– is exactly

– ends with

– is empty
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– is not empty

c. In the search field box, enter the value that you want to locate, such as the exact user ID or the last 
name of a user.

You can add multiple values to the search field box by separating them with a comma as shown in 
this example: JohnJ, PaulP, SueS, JoeJ

d. Click Find.

Note To further define your query, you can choose AND or OR to add multiple filters and repeat steps 
a through d.

Step 3 Click Next to choose details for your type of report. If you want to change the type of query, click Back.

Step 4 In the File Name field, enter your name for this report (required). 

Step 5 In the File Format field select a file format from the drop-down list box.

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to generate manager/assistant report immediately or, click Run 
Later to generate the report at a later time.

Step 8 Click Submit to create a job for generating the report. 

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Cisco Unified CallManager Bulk Administration (BAT) saves the report file on the first node of the 
Cisco Unified CallManager server.

Additional Information

See the “Related Topics” section on page 31-2.

Viewing Report Log Files
BAT generates log files for each report transaction and stores them on the first node of the database 
server, search for the job by using the Job Scheduler option in the Bulk Administration menu. In the Job 
Configuration window, click the link in the Log File Name column corresponding to the job for which 
you want to view the log file for. For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Information

See the “Related Topics” section on page 31-2.

Related Topics
• Generating Reports for Unified CM Assistant Managers and Assistants, page 31-1
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Related Topics
• Viewing Report Log Files, page 31-2

• BAT Log Files, page 54-3

• Scheduling Jobs, page 51-1
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User Device Profiles

The User Device Profiles (UDP) option in Cisco Unified CallManager Bulk Administration (BAT) 
allows you to add or delete large numbers of user device profiles. In addition, you can add or update 
lines for user device profiles. The system uses UDPs in conjunction with the extension mobility feature. 

The following topics explain the options for managing user device profiles in more detail:

• Adding User Device Profiles, page 32-1

• Inserting User Device Profiles for User Devices, page 37-1

• Deleting User Device Profiles, page 38-1

• Exporting User Device Profile Records, page 39-3

• Updating Lines for User Device Profiles, page 40-1

• Adding Lines to Existing Phones and UDPs, page 10-7

• Generating Reports for User Device Profiles, page 42-1

Adding User Device Profiles
When you use BAT to add user device profiles to the Cisco Unified CallManager database, you can add 
multiple lines and other features. 

Choose from two options for creating a CSV data file for user device profiles:

• Use the BAT spreadsheet (BAT.xlt) and export the data to the CSV format.

• Use a text editor to create a text file in CSV format (for experienced users).

To add user device profiles to the Cisco Unified CallManager database in bulk, use this procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > User Device Profile Template. 

The Find and List UDP Templates window displays. See the “Creating a Cisco Unified CallManager 
Bulk Administration (BAT) Template for User Device Profiles” section on page 33-2 for information 
about configuring UDP templates.

Step 2 Create the CSV data file by following the steps for one of these options.

a. BAT Spreadsheet option
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Open the BAT spreadsheet and create the CSV data file. See the “Using the BAT Spreadsheet to 
Create User Device Profile CSV Data Files” section on page 32-2.

b. Text Editor option

– Choose Create UDP File Format. 

The UDP File Format Query window displays. See the “Configuring User Device Profile File 
Formats” section on page 34-1 for information about configuring file formats for CSV data file.

– Use a text editor and create the CSV data file for user device profiles that follows the file format 
that you want to use. For more information about creating a text-based CSV file, see 
Appendix A, “Creating a Text-Based CSV File for User Device Profile.”

– Choose Add File Format. 

The Add File Format Configuration window displays. See the “Adding a File Format” section 
on page 35-1 for information about file formats.

Step 3 Choose Validate User Device Profiles. 

The User Device Profiles Validation window displays. See the “Validating User Device Profiles” section 
on page 36-1 for information about validating user device profile records.

Step 4 Choose Insert User Device Profiles.

The User Device Profiles Insert Configuration window displays. See the “Inserting User Device Profiles 
for User Devices” section on page 37-1 for information about inserting user device profile records into 
the Cisco Unified CallManager database.

Additional Topics

See the “Related Topics” section on page 32-10.

Using the BAT Spreadsheet to Create User Device Profile CSV Data Files
When you are adding new user device profiles, you can use the BAT spreadsheet. You can define the file 
format within the spreadsheet, and the spreadsheet uses the data file formats to display the fields for the 
CSV data file. 

For information about locating and using the BAT spreadsheet, see the “Using the BAT Spreadsheet for 
Gathering Data” section on page 1-8.

To create the CSV data file by using the BAT spreadsheet for adding new user device profiles, use the 
following procedure.

Procedure

Step 1 Download the BAT.xlt file from the Cisco Unified CallManager server. See the “Downloading a File” 
section on page 2-2.

Step 2 Open the BAT spreadsheet. When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To display the User Device Profiles options, click the User Device Profile tab at the bottom of the 
spreadsheet.

Step 4 To choose the device and line fields that you can define for each user device profile, click Create File 
Format. The Field Selection popup window displays.
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Step 5 To choose the device fields, click a device field name in the Device Field box, and then click the arrow 
to move the field to the Selected Device Fields box.

A CSV data file must include Device Profile Name and Description; therefore, these fields always 
remain selected.

Tip You can select a range of items in the list by holding down the Shift key. To select random field 
names, hold down the Ctrl key and click field names. 

Step 6 Click a line field name in the Line Field box and click the arrow to move the field to the Selected Line 
Fields box.

Tip You can change the order of the items in the Selected Line and Device boxes. Choose an item 
and use the up arrow to move the field closer to the beginning of the list or chose the down arrow 
to move the item to the end of the list.

Step 7 To modify the CSV data file format, click Create. A message asks whether you want to overwrite the 
existing CSV format. 

Step 8 Click OK. New columns for the selected fields display in the BAT spreadsheet in the order that you 
specified.

Step 9 To locate the Number of Phone Lines box, scroll to the right. The number of lines that you specify here 
must not exceed the number of lines that are configured in the BAT template or an error will result when 
you insert the CSV data file and UDP template.

Step 10 You must enter the number of speed-dial buttons in the Number of Speed Dials box. After you enter the 
number, columns display for each speed-dial number.

Note Do not exceed the number of speed dials that are configured in the User Device Profile template, 
or an error will result when you insert the CSV data file and UDP template.

Step 11 Enter data for an individual user device profile on each line in the spreadsheet. Complete all mandatory 
fields and any relevant optional fields. Each column heading specifies the length of the field and whether 
it is required or optional. See Table 32-1 for descriptions of the fields in the BAT spreadsheet.

Step 12 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to 
BAT Format.

The system saves the file to C:\XLSDataFiles\ or to your choice of another existing folder on your local 
workstation. The filename is

<tabname>-<timestamp>.txt 

where <tabname> represents the type of input file that you created, such as phones, and <timestamp> 
represents the precise date and time that the file was created.

Upload the CSV file to Cisco Unified CallManager server using the “Uploading a File” section on 
page 2-3. 

Note For information on how to read the exported CSV data file, click the link to View Sample File in the 
Insert User Device Profiles window in BAT.
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Additional Topics

See the “Related Topics” section on page 32-10.

Field Descriptions for User Device Profile Fields in the BAT Spreadsheet

Table 32-1 describes all the user device profile fields in the BAT spreadsheet. For related procedures, see 
the “Related Topics” section on page 32-10

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description

Device Fields (Mandatory Fields)

Device Profile Name Enter a unique identifier for the device profile name.

Description Enter a description such as “Conference Room A” or “John 
Smith” to help identify the phone or device. 

Device Fields (Optional Fields)

User Locale Enter the country and language set that you want to associate with 
this group of IP phones.

This choice determines which cultural-dependent attributes exist 
for this user and which language displays for the user in the 
Cisco Unified CallManager user windows and phones.

Softkey Template Enter the softkey template to be used for all phones in this group.

User ID Enter the user ID for the phone user.

Login User ID Enter the login user ID for a default profile.

If the user device profile is used as a logout profile, specify the 
login user ID that will be associated with the phone. After the user 
logs out from this user device profile, the phone will 
automatically log in to this login user ID.

User Hold Audio Source Enter the user hold audio source that this group of IP phones or 
CTI ports should use.

The user hold audio source identifies the audio source from which 
music is played when a user places a call on hold.

Phone Template Enter the phone template name that you want to associate with 
this user device profile.

MLPP Indication This setting specifies whether a device that is capable of playing 
precedence tones will use the capability when it places an MLPP 
precedence call.

MLPP Preemption If available, this setting specifies whether a device that is capable 
of preempting calls in progress will use the capability when it 
places an MLPP precedence call.

MLPP Domain Enter a hexadecimal value for the MLPP domain associated with 
this device. Must be blank or a value between 0 and FFFFFF.

Line Fields (Optional Fields)

Directory Number Enter the directory number for the phone.
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Route Partition Choose a route partition to which the directory number belongs.

The directory number can appear in more than one partition.

Display Enter the text that you want to display on the called party’s phone 
display, such as the user name (John Smith) or phone location 
(Conference Room 1). 

Note If this filed is left blank the system uses the value that is 
entered in the Directory Number field.

Note The default language specifies English.

Forward All CSS Choose the calling search space to use when a call is forwarded to 
the specified destination.

Note This setting applies to all devices that are using this 
directory number. 

Forward All Destination Enter the directory number to which all calls are forwarded.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Forward Busy External CSS Choose the calling search space to use when a call from an 
external number is forwarded to the specified destination.

Note This setting applies to all devices that are using this 
directory number. 

Forward Busy Internal CSS Choose the calling search space to use when a call from an 
internal number is forwarded to the specified destination.

Note This setting applies to all devices that are using this 
directory number. 

Forward Busy Destination 
External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Forward Busy Destination 
Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the line is in use.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Calling Search Space Forward No 
Answer External 

Choose the calling search space to use when a call from an 
external number is forwarded to the specified destination. The 
setting displays only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number.

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
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Forward No Answer Internal CSS Choose the calling search space to use a call from an internal 
number is forwarded to the specified destination. The setting 
displays only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number.

Forward No Answer Destination 
External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Forward No Answer Destination 
Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone is not answered.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Forward No Coverage External 
CSS

Enter the calling search space to use when a call from an external 
number is forwarded to the specified destination. The setting 
displays only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number. 

Forward No Coverage Internal 
CSS

Enter the calling search space to use when a call from an internal 
number is forwarded to the specified destination. The setting 
displays only if it is configured in the system.

Note This setting applies to all devices that are using this 
directory number. 

Forward No Coverage Destination 
External

Enter the directory number to which a call that is coming from an 
external number is forwarded when the phone does not have 
coverage.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Forward No Coverage Destination 
Internal

Enter the directory number to which a call that is coming from an 
internal number is forwarded when the phone does not have 
coverage.

Note This setting applies to any dialable phone number, 
including an outside destination unless restricted, and to 
all devices that are using this directory number.

Calling Search Space Forward on 
Failure External/Internal

(CTI ports only) Enter the calling search space to use when a call 
from an internal or external call is forwarded to the specified 
destination. The setting appears only if it is configured in the 
system.

Note This setting applies to all devices that are using this 
directory number.

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
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Forward on Failure Destination 
External/Internal

(CTI ports only) Enter the directory number to which a call 
coming from an internal or an external number should be 
forwarded when a phone or CTI application fails.

Call Forward No Answer Ring 
Duration

Enter the number of seconds (between 1 and 300) to allow the call 
to ring, before forwarding the call to the destination number 
entered in the Forward No Answer Destination field.

Leave this field blank to use the value that is set in the 
Cisco Unified CallManager service parameter, Forward No 
Answer Timer.

Route Filter Enter a name in the Route Filter Name field. The name can 
contain up to 50 alphanumeric characters and can contain any 
combination of spaces, periods (.), hyphens (-), and underscore 
characters (_). Ensure each route filter name is unique to the route 
plan.

Use concise and descriptive names for your route filters. The 
CompanynameLocationCalltype format usually provides a 
sufficient level of detail and is short enough to enable you to 
quickly and easily identify a route filter. For example, 
CiscoDallasMetro identifies a route filter for toll free, inter-local 
access and transport area (LATA) calls from the Cisco office in 
Dallas.

E164 Always use a unique E.164 number. Do not use null value.

Voice Mail Profile Enter this parameter to make the pilot number the same as the 
directory number for this line. This action proves useful if you do 
not have a voice-messaging server configured for this phone.

Line Calling Search Space Enter partitions that are searched for numbers that are called from 
this directory number.

Note Changes cause an update of the call pickup names that are 
listed in the Call Pickup Group field. The setting applies 
to all devices that are using this directory number.

AAR Group Enter the automated alternate routing (AAR) group for this 
device. The AAR group provides the prefix digits that are used to 
route calls that are otherwise blocked due to insufficient 
bandwidth. 

Set AAR Group to <None> to prevent rerouting blocked calls.

Line User Hold Audio Source Enter the music on hold audio source to be played when the user 
presses Hold and places a call on hold. 

Line Network Hold Audio Source Enter the music on hold audio source to be played when the 
system places a call on hold while the user transfers a call or 
initiates a conference or call park.

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
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Auto Answer Enter one of the following values to activate the Auto Answer 
feature for this directory number:

• Auto Answer Off <Default>

• Auto Answer with Headset

• Auto Answer with Speakerphone (Intercom)

Note Make sure that the headset or speakerphone is not 
disabled when you choose Auto Answer with Headset or 
Auto Answer with Speakerphone.

No Answer Ring Duration 
(CFNA)

Enter the number of seconds to allow the call to ring before 
forwarding the call to the Forward No Answer Destination.

Call Pickup Group Enter the Pickup Group Name to specify the call pickup group, 
which can answer incoming calls to this line by dialling the 
appropriate pickup group number. 

To use the BAT phone template entry, leave this field blank. 

Target Destination (MLPP) Enter the number to which MLPP precedence calls should be 
directed if this directory number receives a precedence call and 
neither this number nor its call forward destination answers the 
precedence call.

Values can include numeric characters, pound (#) ,and asterisk 
(*).

Target CSS (MLPP) From the drop-down list box, choose the calling search space to 
associate with the alternate party target (destination) number.

No Answer Ring Duration 
(MLPP)

Enter the number of seconds (between 4 and 30) after which an 
MLPP precedence call will be directed to this directory number’s 
alternate party if this directory number and its call forwarding 
destination have not answered the precedence call.

Leave this setting blank to use the value that is set in the 
Cisco Unified CallManager enterprise parameter, Precedence 
Alternate Party Timeout.

Line Text Label Enter text that identifies this directory number for a line/phone 
combination. 

Note The default text specifies English

External Phone Number Mask Enter the phone number (or mask) that is sent for Caller ID 
information when a call is placed from this line.

You can enter a maximum of 30 numbers and “X” characters. The 
Xs represent the directory number and must appear at the end of 
the pattern. For example, if you specify a mask of 972813XXXX, 
an external call from extension 1234 displays a caller ID number 
of 9728131234.

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
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Maximum Number of Calls You can configure up to 200 calls for a line on a device in a 
cluster, with the limiting factor being the device. As you 
configure the number of calls for one line, the calls available for 
another line decrease. 

The default specifies 4. If the phone does not allow multiple calls 
for each line, the default specifies 2. 

For CTI route points, you can configure up to 10,000 calls for 
each port. The default specifies 5000 calls. Use this field in 
conjunction with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum Number 
of Calls and Call Forward Busy, determines the maximum number 
of calls to be presented at the line. If maximum number of calls is 
set for 50 and the busy trigger is set to 40, then incoming call 41 
gets rejected with a busy cause (and will get forwarded if Call 
Forward Busy is set). If this line is shared, all the lines must be 
busy before incoming calls get rejected.

Use this field in conjunction with Maximum Number of Calls for 
CTI route points. The default specifies 4500 calls.

Message Waiting Lamp Policy Use this field to configure the handset lamp illumination policy. 
Choose one of the following options:

• Use System Policy (The directory number refers to the 
service parameter “Message Waiting Lamp Policy” setting.)

• Light and Prompt

• Prompt Only

• Light Only

• None

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
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Related Topics
• Adding User Device Profiles, page 32-1

• Inserting User Device Profiles for User Devices, page 37-1

• Deleting User Device Profiles, page 38-1

• Exporting User Device Profile Records, page 39-3

• Updating Lines for User Device Profiles, page 40-1

• Adding Lines to Existing Phones and UDPs, page 10-7

• Generating Reports for User Device Profiles, page 42-1

Ring Setting (Phone Idle) Choose the ring setting for the line appearance when an incoming 
call is received and no other active calls exist on that device. 
Choose one of the following options:

• Use system default

• Disable

• Flash only

• Ring once

• Ring

Ring Setting (Phone Active) Choose the ring setting that is used when this phone has another 
active call on a different line. Choose one of the following 
options:

• Use system default

• Disable

• Flash only

• Ring once

• Ring

• Beep only

Table 32-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
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User Device Profile Template

Use the procedures in this chapter for creating and modifying user device profiles. 

This chapter has the following procedure:

• Finding a User Device Profile Template, page 33-1

• Creating a Cisco Unified CallManager Bulk Administration (BAT) Template for User Device 
Profiles, page 33-2

• Modifying a Template, page 33-4

• Related Topics, page 33-5

Finding a User Device Profile Template
Because you might have several user device profile (UDP) templates, Cisco Unified CallManager lets 
you locate specific template on the basis of specific criteria. Use the following procedure to locate 
templates.

Note During your work in a browser session, your find/list search preferences are stored in the cookies on the 
client machine. If you navigate to other menu items and return to this menu item, or if you close the 
browser and then reopen a new browser window, your Cisco Unified CallManager search preferences 
are retained until you modify your search.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > User Device Profile Template.

The Find and List UDP Templates window displays. Use the two drop-down list boxes to search for a 
template.

Step 2 From the first Find UDP Template where drop-down list box, choose one of the following criteria:

• Profile Name

• Profile Description

• Device Type

From the second Find UDP Template where drop-down list box, choose one of the following criteria:

• begins with
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• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

Tip To find all UDP templates that are registered in the database, click Find without entering any 
search text.

A list of discovered templates displays by:

• Name

• Description

• Device Type

• Profile Type

Step 4 From the list of records, click the template name that matches your search criteria.

The UDP Template Configuration window displays.

Additional Information

See the “Related Topics” section on page 33-5

Creating a Cisco Unified CallManager Bulk Administration 
(BAT) Template for User Device Profiles

Use this procedure to create a template to add user device profiles in bulk. 

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > User Device Profile Template. 

Step 2 Click Add New. The UDP Template Configuration window displays. 

Step 3 From the Device Type drop-down list box, choose the model of user device profile. Click Next. 

Step 4 In the User Device Profile Template Name field, enter a unique name, which can contain up to 50 
characters.

Depending on the model of device, some of the following fields do not display.

• User Hold Audio Source—Choose the audio source that is played when the user puts a call on hold.

• User Locale—Choose the country and language set for with this profile.

• Phone Button Template—Choose a phone button template for this profile. 

• Softkey Template—Choose the appropriate softkey template for this profile.
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• MLPP Indication—To specify whether the device can play precedence tones when placing an 
MLPP precedence call, choose one of the following:

– Default—To inherit the MLPP indication from the device pool.

– Off—Does not send MLPP indication tones.

– On—Sends indication of an MLPP precedence call.

• MLPP Preemption—To specify whether the device can preempt calls in progress when placing an 
MLPP precedence call, choose one of the following:

– Default—To inherit the MLPP preemption setting from the device pool.

– Off—Does not preempt calls when it places an MLPP precedence call.

– On—preempts calls in progress when it places an MLPP precedence call.

Note Do not configure a device with MLPP Indication set to Off while MLPP Preemption is set to 
On.

• MLPP Domain—Enter a hexadecimal value for the MLPP domain associated with this device. 
Must be blank or a value between 0 and FFFFFF.

• Expansion Module Information—Choose the type of expansion module if installed in the phone 
or choose <None> for Module 1 and Module 2.

• Login User ID—Enter the login user ID for a default profile. After the user logs out from using the 
user device profile, the user device profile will automatically log in to this login user ID and use the 
default profile.

Tip You can obtain help in finding a valid login user ID by choosing the Select Login User ID link 
below the Login User ID field. A separate dialog box pops up. In the Login User ID field, enter 
the first few characters of the login user ID that you want to use, and all login user IDs that match 
the pattern that you entered will display in the Selected login user ID field. Choose the desired 
ID and click OK. 

Step 5 Check the Ignore Presentation Indicators (Internal Calls Only) check box, as needed.

Step 6 Click Save. The UDP Template Configuration window displays. 

Step 7 Depending on the phone button template that you chose, links display to add lines, speed dials settings, 
subscribed Cisco IP phone service settings, and busy lamp field speed dial settings. 

For some Cisco Unified IP Phone models, you can add Cisco Unified IP Phone services and Speed Dials 
to the template. See Chapter 3, “Phone Template” for more information in adding or lines, IP services, 
and speed dials for BAT templates. 

Additional Information

See the “Related Topics” section on page 33-5
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Modifying a Template
You can modify the properties of a template when you want to change only a few fields for the same 
device.

To modify and update details in an existing BAT template, use the following procedure.

Procedure

Step 1 Find the UDP template you want to modify using the“Finding a User Device Profile Template” section 
on page 33-1.

Step 2 From the list of displayed templates, click the template name you want to modify. The chosen template 
details display in the UDP Template Configuration window.

Step 3 Verify that this is the template that you want to modify.

Step 4 Modify the details in the template fields as needed.

Step 5 Click Save to save the changes to the existing template.

Additional Topics

See the “Related Topics” section on page 33-5.

Copying a Template
You can copy the properties of a template into a new template when you want to change only a few 
fields.

Note The new template that you create must be the same device type as the original template, such as 
Cisco IP User Device Profile model 7960. 

Use the following procedure to copy an existing BAT template.

Procedure

Step 1 Find the UDP template you want to copy using the“Finding a User Device Profile Template” section on 
page 33-1.

Step 2 From the list of displayed templates, click the template name you want to copy. The chosen template 
details display in the UDP Template Configuration window.

Note You can also copy the template by clicking the icon in the Copy column corresponding to the 
template you want to copy. 

Step 3 Verify that this is the template that you want to copy and click Copy. The template reproduces and 
creates a copy. The copy duplicates all the values that were specified in the original template.

Step 4 In the User Device Profile Template Name field, enter a new template name, up to 50 alphanumeric 
characters.
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Step 5 Update the fields as needed for the new template.

Step 6 Click Save. The template that is added to BAT displays in the Templates column on the left.

Additional Topics

See the “Related Topics” section on page 33-5.

Deleting Templates
You can delete BAT templates when you no longer require them. Use this procedure to delete a template.

Procedure

Step 1 Find the UDP template you want to delete using the“Finding a User Device Profile Template” section 
on page 33-1.

Step 2 From the list of displayed templates, click the template name you want to delete. The chosen template 
details display in the UDP Template Configuration window.

Note You can also delete the template by checking the check box next to the template name and 
clicking Delete Selected. 

Step 3 Verify that this is the template that you want to delete and click Delete. A message displays that asks 
you to confirm the delete operation.

Step 4 Click OK to delete the template. The template name disappears from the list of templates in the Find and 
List UDP Templates window.

Additional Topics

See the “Related Topics” section on page 33-5.

Related Topics
• Finding a User Device Profile Template, page 33-1

• Creating a Cisco Unified CallManager Bulk Administration (BAT) Template for User Device 
Profiles, page 33-2

• Modifying a Template, page 33-4
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User Device Profile File Format

When you use a text editor to create your CSV data file, you must use a file format to identify the device 
and line fields within the CSV data file.You have these options for the file format:

• Default User Device Profile—Contains a predetermined set of user device profile device and line 
fields.

• Simple User Device Profile—Contains basic device and line fields for user device profiles. 

• Customized—Contains device and line fields that you choose and order yourself.

Before creating the CSV file in the text editor, you need to choose an existing file format or create a new 
file format. You can then enter the values as specified in the file format in the text-based CSV data file.

Configuring User Device Profile File Formats
The following topics provide information about configuring file formats for CSV data files that are 
created by using a text editor.

• Finding a UDP File Format, page 34-1

• Creating a UDP File Format, page 34-2

• Copying a File Format, page 34-3

• Modifying a File Format, page 34-4

• Deleting a File Format, page 34-4

Finding a UDP File Format
To find a user device profile file format, use the following procedure.

Step 1 Choose Bulk Administration > User Device Profiles > UDP File Format > Create UDP File Format.

The UDP File Format Query window displays. 

Step 2 From the Find UDP File Format where Format Name drop-down list box, choose one of the following 
criteria:

• begins with

• contains 

• is exactly
34-1
allManager Bulk Administration Guide



Chapter 34      User Device Profile File Format
Configuring User Device Profile File Formats
• ends with

• is empty

• is not empty

Step 3 Specify the appropriate search text, if applicable, and click Find.

Tip To find all UDP templates that are registered in the database, click Find without entering any 
search text.

A list of discovered templates displays by name of the file format.

Step 4 From the list of records, click the file format name that matches your search criteria.

The UDP File Format Configuration window displays.

Additional Information

See the “Related Topics” section on page 34-5

Creating a UDP File Format
To create your UDP file format for the text-based CSV data file, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Create a File Format. The Update File Format 
Query window displays.

Step 2 Click Add new. The Update File Format Configuration window displays.

Step 3 In the UDP File Format Name field, enter a name for this customized format.

Step 4 Under Device Fields, choose the device field names that you want to define for each user device profile. 
Click a device field name in the Device Field box and click the arrow to move the field to the Selected 
Device Fields box.

A CSV data file must include Device Profile Name, and Description; therefore, these fields always 
remain selected.

Tip You can select several random field names in the list by holding down the Ctrl key, then clicking 
the arrow to select them together. You can select a range of items by using the Shift key.

Step 5 Click line field names in the Line Field box and click the arrow to move the fields to the Selected Line 
Fields box.

Note Directory Number is a mandatory field if you select line fields in the file format.
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Tip You can change the order of the items in the Selected Line Fields and Selected Device Fields 
boxes. Select an item and then use the up arrow to move the field closer to the beginning of the 
list or use the down arrow to move it to the end of the list.

Step 6 Enter the maximum number of lines, speed dials, IP Phone Services, and IP Phone Service Parameters, 
you want to include in the CSV file, in their corresponding text boxes.

Note You can enter zero for maximum number of speed dials, IP Phone Services, and IP Phone 
Service Parameters, if you do not want to include them in the CSV file. But, the maximum 
number of lines should not be zero if line fields are chosen in the file format.

Step 7 To save your customized file format, click Save. The name of the file format displays in the UDP File 
Format Query window.

Additional Topics

See the “Related Topics” section on page 34-5.

Copying a File Format
To copy an existing format for the CSV data file, use the following procedure.

Procedure

Step 1 Find the UDP File Format you want to copy by using the “Finding a UDP File Format” section on 
page 34-1. 

Step 2 In the Search Results area, click the file format name that you want to copy. The File Format 
Configuration window displays.

Step 3 To make a copy of the chosen file format, click Copy.

Note You can also copy a file format by clicking the icon in the Copy column corresponding to the 
format you want to copy, in the UDP File Format Query window.

Step 4 In the File Format Name field, enter a new name for the copied format.

Step 5 Modify the copied format by using one of these methods:

• Add new fields by choosing them from the Device Fields or Line Fields box, and then clicking the 
arrow to move the chosen fields into the Selected Device Field or Selected Line Fields box.

• Remove chosen fields by choosing them from the Selected Device Fields or Selected Line Fields 
box, and then clicking the arrow to move the chosen fields into the Device Field or Line Fields box.

• Change the order of the fields by choosing a field name in the Selected Device Field or Selected Line 
Fields box and using the up or down arrow to change its location.

Step 6 After making your changes, click Save to save the copied file format with changes in the list.
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Additional Topics

See the “Related Topics” section on page 34-5.

Modifying a File Format
To modify an existing format for the CSV data file, use the following procedure.

Procedure

Step 1 Find the UDP File Format you want to update by using the “Finding a UDP File Format” section on 
page 34-1. 

Step 2 In the Search result area, click the file format name that you want to modify. The File Format 
Configuration window displays.

Step 3 Modify the copied format by using one of these methods:

• Add new fields by choosing them from the Device Fields or Line Fields box, and then clicking the 
arrow to move the chosen fields into the Selected Device Field or Selected Line Fields box.

• Remove the chosen fields by choosing them from the Selected Device Fields or Selected Line Fields 
box, and then clicking the arrow to move the chosen fields into the Device Field or Line Fields box.

• Change the order of the fields by choosing a field name in the Selected Device Field or Selected Line 
Fields box and using the up or down arrow to change its location.

Step 4 After making your changes, click Save to save the changes to the file format.

.

Additional Topics

See the “Related Topics” section on page 34-5.

Deleting a File Format
To delete an existing file format for the CSV data file, use the following procedure.

Procedure

Step 1 Find the UDP File Format you want to delete by using the “Finding a UDP File Format” section on 
page 34-1. 

Step 2 In the Search result area, click the file format name that you want to delete. The File Format 
Configuration window displays. Verify that you want to delete this file.

Step 3 To remove the file format from the File Format Name list, click Delete. A message asks you to confirm 
that you want to delete the file format. Click OK to continue. The file format name is removed from the 
list.
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Note You can also delete a file format by checking the corresponding check box and clicking Delete. 
You can delete all the file formats by clicking Select All and then clicking Delete Selected.

Additional Topics

See the “Related Topics” section on page 34-5.

Related Topics
• Configuring User Device Profile File Formats, page 34-1

• Adding a File Format, page 35-1
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Adding User Device Profile File Format

After you have entered all the values into the text-based CSV data file in the order that the file format 
specified, you need to upload the text-based CSV data file to the first node in 
Cisco Unified CallManager. For more information on uploading files, see “Uploading a File” section on 
page 2-3. You must then associate the file format with the text-based CSV data file.

Adding a File Format 
To associate the file format with the text-based CSV data file, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profile > UDP File Format > Add File Format. The Add 
File Format Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.

Step 3 In the File Format Name field, choose the file format that you created for this type of bulk transaction.

Step 4 To add the matching file format with the CSV data file, click Submit.

A job is created in the Job Scheduler option in the Bulk Administration menu. Use Job Configuration 
window to modify the job schedule. 

For more information on jobs, see Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Related Topics
• Adding a File Format, page 35-1

• Uploading a File, page 2-3

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
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Validating User Device Profiles 

When you choose Validate User Device Profiles, the system runs a validation routine to check that the 
CSV data file has all required fields, such as device profile name and directory number, populated and 
checks for discrepancies with the first node database. 

Before You Begin

• You must have a user device profile template for the devices that you are adding. You can use a user 
device profile template with multiple lines to add user device profiles that have a single line. See 
the “Creating a Cisco Unified CallManager Bulk Administration (BAT) Template for User Device 
Profiles” section on page 33-2.

• You must have a CSV data file that contains the unique details for the user device profiles. See these 
options:

– “Using the BAT Spreadsheet to Create User Device Profile CSV Data Files” section on 
page 32-2.

– “Validating User Device Profiles” section on page 36-1.

Validating User Device Profiles
To validate your CSV data file user device profile records, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Validate User Device Profiles. 

The User Device Profiles Validation window displays.

Step 2 Choose the Insert option that corresponds to your CSV data file:

• Validate UDP Specific Details—If you are validating User Device Profile records that use a file 
format.

• Validate UDP All Details—If you are validating user device profile records from an export file that 
was generated by using the All Details option. 

Step 3 In the File Name field, choose the CSV data file that you created for this specific bulk transaction.

Step 4 For Validate UDP Specific Details option, in the UDP Template Name field, choose the 
Cisco Unified CallManager Bulk Administration (BAT) User Device Profile template that you created 
for this type of bulk transaction. 

Step 5 To verify the chosen CSV data file with the database, click Submit. 
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A job is created in the Job Scheduler option in the Bulk Administration menu. Use Job Configuration 
window to modify the job schedule. For more information on jobs, see the Chapter 51, “Scheduling 
Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Related Topics
• Creating a Cisco Unified CallManager Bulk Administration (BAT) Template for User Device 

Profiles, page 33-2

• Using the BAT Spreadsheet to Create User Device Profile CSV Data Files, page 32-2

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
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Generating UDPs

You can use Cisco Unified CallManager Bulk Administration (BAT) to set up extension mobility 
quickly by generating and inserting profiles for all IP phone users. BAT generates user device profiles 
for all phones, regardless of the number of devices that the user controls. For example, if a user controls 
two devices, BAT generates two separate user device profiles, one for each device and associates them 
to the same user. BAT sets one of the generated user device profiles as the default user device profile 
for the user. BAT generates user device profiles for all IP phones based on the phone button template 
for each phone model.

Note You do not use a user device profile template or a CSV data file to perform this action. When BAT 
generates these user device profiles, they are associated with the user.

Inserting User Device Profiles for User Devices
To generate user device profiles for all users, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Insert User Device Profiles. The User Device 
Profiles Insert Configuration window displays.

Step 2 Click Insert User Device Profiles Specific Details radio button to insert UDP records that use a 
customized file format. Continue with steps 4 and 5.

Step 3 Click Insert User Device Profiles All Details radio button to insert UDP records from an exported UDP 
file that was generated by using the All Details option.

Step 4 In the File Name drop-down list box, choose the CSV data file that you created for this specific bulk 
transaction. 

Step 5 For the Specific Details option, in the User Device Profiles Template Name drop-down list box, choose 
the BAT phone template that you created for this type of bulk transaction. 

Note When you are inserting a file that was generated with the export utility, use the appended suffixes 
to guide you in choosing a phone template with the correct line configuration. The export utility 
appends a numerical suffix_n for each line that is configured on a phone. For example, an export 
file with the name “sales_7960_1_3.txt” indicates that all phone records in this file have lines 1 
and 3 configured.
37-1
allManager Bulk Administration Guide



Chapter 37      Generating UDPs
Related Topics
If you did not enter individual MAC addresses in the CSV data file, you must check the Create Dummy 
MAC Address check box. If you are adding CTI ports, the dummy MAC address option provides a 
unique device name for each CTI port in the form of dummy MAC addresses. 

This field automatically generates dummy MAC addresses in the following format: 
XXXXXXXXXXXX
where X represents any 12-character, hexadecimal (0-9 and A-F) number.

• If you do not know the MAC address of the phone that will be assigned to the user, choose this 
option. When the phone is plugged in, a MAC address registers for that device.

• If you supplied MAC addresses or device names in the data input file, do not choose this option.

You can update the phones or devices later with the correct MAC address by manually entering this 
information into Cisco Unified CallManager Administration or by using Unified CM Auto-Register 
Phone Tool. See the “Introducing Cisco Unified CM Auto-Register Phone Tool” section on page 52-2 
for more information about Unified CM Auto-Register Phone Tool. Skip to Step 8.

Note If you are changing the phone settings for existing phones in the template, check the Override 
the existing configuration check box. The user device profile information also gets updated 
when this check box is checked.

Note If you want BAT to generate and insert user device profile records for all phones based on the 
user’s current IP Phone, choose Based on devices controlled by users radio button. 

Note If you want the device to use the generated user device profile as the logout profile, check the 
Set User Device Profile as Log Out Profile for the device check box.

Step 6 In the Job Information area, enter the Job description.

Step 7 Click the Run Immediately radio button to insert the UDP records immediately or, click Run Later to 
insert at a later time.

Step 8 Click Submit to create a job for inserting the phone records. 

Step 9 Use the Job Scheduler option in the Bulk Administration main menu to schedule and activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Note If any information for a record fails, BAT does not insert that user device profile record.

Additional Topics

See the “Related Topics” section on page 37-2.

Related Topics
• Inserting User Device Profiles for User Devices, page 37-1
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• Scheduling Jobs, page 51-1

• Introducing Cisco Unified CM Auto-Register Phone Tool, page 52-2

• BAT Log Files, page 54-3
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Deleting User Device Profiles

Use these procedures to delete a group of user device profiles (UDPs) from the 
Cisco Unified CallManager database. 

You can locate existing phone records by these two methods:

• Using Query to Delete UDP, page 38-1.

• Using a Custom File to Delete UDPs, page 38-2

Using Query to Delete UDP
To locate the records that you want to delete, you must define a query filter. To delete UDPs from 
Cisco Unified CallManager, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Delete User Device Profiles > Query.

The Delete User Device Profiles Configuration window displays.

Step 2 From the Find drop-down list box, choose one of the following options:

• User

• Autogenerated

• All

Step 3 From the first Device Profiles where drop-down list box, choose one of the following criteria: 

• Profile Name

• Description

• Device Type

Step 4 From the second Device Profiles where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with
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• is empty

• is not empty

Step 5 Specify the appropriate search text, if applicable. 

Tip To find all UDPs that are registered in the database, click Find without entering any search text.

Step 6 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 5.

Step 7 Click Find.

A list of discovered templates displays by:

• Device Profile Name

• Description

• Device Type

• Profile Type

Step 8 In the Job Information area, enter the Job description.

Step 9 Click the Run Immediately radio button to delete UDP records immediately or, click Run Later to delete 
them at a later time.

Step 10 Click Submit to create a job for deleting the phone records. 

Step 11 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Caution If you do not enter any information in the query text box, the system deletes all UDP records. Because 
the delete action is final, you cannot retrieve deleted records.

Additional Topics

See the “Related Topics” section on page 38-3.

Using a Custom File to Delete UDPs 
You can create a custom file of UDPs that you want to delete by using a text editor. You can have device 
profile name, device profile description, and directory number in the same custom file, but you cannot 
have directory numbers in the same file. You need to create separate files—one file that contains the 
device names and MAC addresses and another file that contains the directory numbers.

Note You cannot delete UDPs with shared lines by using a custom file.

Before You Begin

1. Create a text file that lists one of these details for the UDPs that you want to delete:
38-2
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 38      Deleting User Device Profiles
Related Topics
– Profile names 

– Profile description

– Directory numbers

2. Put each item on a separate line in the text file.

3. Upload the custom files to the Cisco Unified CallManager server first node. See “Uploading a File” 
section on page 2-3.

To delete UDPs that are listed in a custom file, use the following procedure.

Procedure 

Step 1 Choose Bulk Administration > User Device Profiles > Delete User Device Profiles > Custom File.

The Delete User Device Profiles Configuration window displays.

Step 2 In the Delete drop-down list box choose one of the following options:

• User

• Autogenerated

• All

Step 3 In the Device Profiles where drop-down list box, choose the type of custom file that you have created 
from one of the following criteria:

• Profile Name

• Profile Description

• Directory Number

Step 4 In the list of custom files, choose the filename of the custom file for this delete.

Step 5 Click Find.

Step 6 A list of UDPs matching your search criteria displays. 

Step 7 Click Submit to create a job to delete the UDPs. 

Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job. 
For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 38-3.

Related Topics
• Using Query to Delete UDP, page 38-1

• Using a Custom File to Delete UDPs, page 38-2

• Uploading a File, page 2-3

• Scheduling Jobs, page 51-1

• Introducing Cisco Unified CM Auto-Register Phone Tool, page 52-2
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• BAT Log Files, page 54-3
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Using User Device Profile Export

You can choose between two file format names when you are exporting user device profile records:

• All User Device Profile Details: To export all the line attributes, services and User IDs that are 
associated with the user device profile.

• Specific User Device Profile Details: To export a limited set of details that are associated with the 
user device profile

All User Device Profile Details Format
For phones that have different line configurations, such as multiple partitions or calling search spaces, 
use the All User Device Profile Details format.

Table 39-1 lists the fields that are exported when you choose the All User Device Profile Details file 
format. 

Table 39-1 Exported Fields in the All User Device Profile Details File Format

Field Types Exported Fields

Device Fields User Device Profile Name, Description, Device Pool, 
Calling Search Space, AAR Calling Search Space, Media 
Resource Group List, User Hold Audio Service, Network 
Hold Audio Source, Login User ID, User Locale, 
Network Locale, Phone Button Template, Expansion 
Module Type I, Expansion Module Type II, Softkey 
Template, Phone Load Name, Module 1 Load Name, 
Module 2 Load Name, MLPP Indication, MLPP 
Preemption, MLPP Domain

Model Specific 
Device Fields

Information, Directory, Messages, Services, 
Authentication Server, Proxy Server, Idle, Idle Timer, 
Enable Extension Mobility, Logout Profile, Login User 
ID, Login Time, Logout Time
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Specific User Device Profile Format
To export a limited set of details that are associated with the user device profile, use the Default User 
Device Profile format. You can choose specific query options to customize the export file.

Table 39-2 lists the fields that can be exported when you choose the Default User Device Profile format. 
For more information about related procedures, see the “Related Topics” section on page 39-4

Line Fields Directory Number, Partition, Voice Mail Profile, Line 
CSS, AAR Group, Line User Hold Audio Source, Line 
Network Hold Audio Source, Auto Answer, Forward All 
to Voice Mail, Forward All Destination, Forward All 
CSS, Forward Busy External to Voice Mail, Forward 
Busy External Destination, Forward Busy External CSS, 
Forward No Answer External to Voice Mail, Forward No 
Answer External Destination, Forward No Answer 
External CSS, Forward On Failure to Voice Mail, 
Forward On Failure Destination, Forward on Failure 
CSS, Call pickup group, Forward Busy Internal to Voice 
Mail, Forward Busy Internal Destination, Forward Busy 
Internal CSS, Forward No Answer Internal to Voice 
Mail, Forward No Answer Internal Destination, Forward 
No Answer Internal CSS, Forward No Call Coverage 
External to Voice Mail, Forward No Call Coverage 
External Destination, Forward No Call Coverage 
External CSS, Forward No Call Coverage Internal to 
Voice Mail, Forward No Call Coverage Internal 
Destination, Forward No Call Coverage Internal CSS, 
Display, External Phone Number Mask, Message 
Waiting Lamp Policy, Ring Setting When Idle, Line Text 
Label, Ring Setting When Active, No Answer Ring 
Duration, MLPP Target Destination, MLPP Calling 
Search Space, MLPP No Answer Ring Duration, Max 
Num Calls, Busy Trigger, Call Info Display Mask, 
Alerting Name

User Fields User ID

Speed Dials Speed Dial Number, Speed Dial Label

Services Service Name, Subscribed Service Name, Parameter 
Name, Parameter Value

Table 39-1 Exported Fields in the All User Device Profile Details File Format

Field Types Exported Fields
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Additional Information

See the “Related Topics” section on page 39-4.

Exporting User Device Profile Records
To export user device profiles from Cisco Unified CallManager, use this procedure.

Procedure

Step 1 Choose one of the following options:

• Bulk Administration > User Device Profiles > Export User Device Profiles > Specific Details. 
The Export User Device Profiles Query window displays.

• Bulk Administration > User Device Profiles > Export User Device Profiles > All Details. The 
Export User Device Profiles Configuration window displays. 

Step 2 For All Details option, choose the type of device or specific model from the Device Type drop-down list 
box. Skip to Step 4.

Step 3 For Specific Details option, you can customize the export file and set any of the following detail options:

a. Choose Device Type and Device Protocol from the drop-down list boxes. 

b. In the first Find a User Device Profile drop-down list box, choose from the following options:

– Profile Name

– Profile Description

c. In the second drop-down list box, choose from the following options:

– begins with

– contains 

– is exactly

– ends with

– is empty

– is not empty

d. In the search field box, enter the value that you want to locate, such as a specific profile name or 
profile description. 

Table 39-2 Exported Fields in the Default User Device Profile File Format

Field Types Exported Fields

Device Fields MAC Address, Description, Login User ID

Line Fields Directory Number,Display,Line Text Label,Forward 
Busy External,Forward Busy Internal,Forward No 
Answer External,Forward No Answer Internal,Forward 
No Coverage External,Forward No Coverage 
Internal,Call pickup group

Speed Dials Speed Dials
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e. You can click the Search Within Results check box and choose AND or OR to add multiple filters 
and repeat b. through d. to further define your query.

f. Click Find. The search results display.

g. Click Next.

h. Choose file format from the File Format drop-down list box. 

Step 4 In the File Name field, enter the file name that you want to use.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to export user device profiles immediately or, click Run Later 
to export at a later time.

Step 7 Click Submit to create a job for exporting user device profiles. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Information

See the “Related Topics” section on page 39-4.

Related Topics
• Specific User Device Profile Format, page 39-2

• All User Device Profile Details Format, page 39-1

• Exporting User Device Profile Records, page 39-3

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
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Updating Lines for User Device Profiles

To update line attributes for a specific group of devices or user device profiles, use the Update Lines 
option. Lines for a phone and a user device profile get updated at the same time when both are part of 
the query result.

Note When a phone is deleted from the Cisco Unified CallManager database, the directory number remains 
in the database. To manage these orphan directory numbers, you can use the Update Lines option to 
search for unassigned directory numbers and delete or update these directory numbers.

Updating Lines for User Device Profiles
Use the following procedures to update lines for User Device Profiles:

• Using Query to Update Lines, page 40-1

• Field Descriptions for Updating Lines, page 40-3

Using Query to Update Lines
To update lines, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Add/Update Lines > Update Lines.

The Update Lines Query window displays.

Note You can update all lines by not specifying a query. Skip to “Field Descriptions for Updating 
Lines” section on page 40-3.

Step 2 From the first Find Line where drop-down list box, choose one of the following criteria:

• Directory Number

• Route Pattern

• Line Description
40-1
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• Calling Search Space (Phone)

• Calling Search Space (Line)

• Device Pool

• Device Description

• Line Position

• Unassigned DN 

• Call Pickup Group

Note To locate and delete orphaned directory numbers, use “Unassigned DN.”

Step 3 From the second Find Line where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 In the search field list box, choose or enter the value that you want to locate. For example, you can choose 
the Line Partition from the list or enter a range of directory numbers.

Tip To find all lines that are registered in the database, click Find without entering any search text.

Step 5 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 4.

Step 6 To display the records that are going to be affected, click Find.

A list of discovered lines displays by:

• Pattern/Directory Number

• Partition

• Description

Step 7 Click Next. The Update Lines window shows the type of query that you chose at the top. If you want to 
change the type of query, click Back.

Step 8 Specify the setting that you want to update for all the records that you have defined in your query. You 
can choose multiple parameters to update. See the “Field Descriptions for Updating Lines” section on 
page 40-3 for descriptions of the parameters.

Step 9 In the Job Information area, enter the Job description.

Step 10 Click the Run Immediately radio button to insert lines immediately or, click Run Later to insert at a later 
time.

Step 11 Click Submit to create a job for inserting the phone records. 

Step 12 Use the Job Configuration window to schedule and/or activate this job.

For more information on jobs, see Chapter 51, “Scheduling Jobs.”
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Field Descriptions for Updating Lines
For information on log files, see “BAT Log Files” section on page 54-3.

Note If any information for a line record fails, Cisco Unified CallManager Bulk Administration 
(BAT) does not update that line record.

Additional Topics

See the “Related Topics” section on page 40-10.

Field Descriptions for Updating Lines
Table 40-1 provides the field descriptions for updating line details.

Values that display in some fields display from Cisco Unified CallManager. You must configure these 
values by using Cisco Unified CallManager Administration. For related procedures, see the “Related 
Topics” section on page 40-10.

Table 40-1 Field Descriptions for Updating Line Details

Field Description

Directory Number Information

Route Partition Choose a route partition to which the directory number 
belongs.

Note The directory number can appear in more than 
one partition.

Alerting Name Enter the name that must display during an alert to a 
shared directory number. For non-shared directory 
numbers, during alerts, the system uses the name entered 
in the Display field.

Directory Number Settings

Voice Mail Profile Choose this parameter to make the pilot number the same 
as the directory number for this line. This choice proves 
useful if you do not have a voice-messaging server that is 
configured for this phone.

Calling Search Space 
(Line)

Choose the partitions that are searched for numbers that 
are called from this directory number.

Note Changes cause an update of the Pickup Group 
Names that are listed in the Call Pickup Group 
field. The setting applies to all devices that are 
using this directory number.

Presence Group
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AAR Group Choose the automated alternate routing (AAR) group for 
this device. The AAR group provides the prefix digits 
that are used to route calls that are otherwise blocked due 
to insufficient bandwidth. 

Set AAR Group to <None> to prevent rerouting blocked 
calls.

User Hold Audio 
Source

Choose the music on hold audio source that plays when 
the user presses the Hold button or softkey to put a call 
on hold.

Network Hold Audio 
Source

Choose the music on hold audio source that plays when 
the system places a call on hold such as when user 
transfers a call or initiates a conference or call park. 

Auto Answer Choose this parameter if you want all lines that are 
updated here to use the auto answer feature. With auto 
answer, Cisco Unified CallManager automatically 
answers calls when a headset is in use. A zip tone plays 
to alert the user that an incoming call connected.

Call Forward and Call Pickup Settings

Calling Search Space 
Forward All 

Choose the calling search space to use when a call is 
forwarded to the specified destination.

Note This setting applies to all devices that are using 
this directory number. 

Forward All 
Destination

Enter the directory number to which all calls are 
forwarded.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward All to Voice 
Mail

Check this check box to forward all calls to the number 
that you chose in the voice-messaging profile.

Checking this check box makes the values in the Forward 
All Destination field and Calling Search Space check box 
not relevant. 

Calling Search Space 
Forward Busy 
External

Choose the calling search space to use when a call from 
an external number is forwarded to the specified 
destination.

Note This setting applies to all devices that are using 
this directory number. 

Calling Search Space 
Forward Busy 
Internal

Choose the calling search space to use when a call from 
an internal number is forwarded to the specified 
destination.

Note This setting applies to all devices that are using 
this directory number. 

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Forward Busy 
Destination External

Enter the directory number to which a call that is coming 
from an external number is forwarded when the line is in 
use.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward Busy 
Destination Internal

Enter the directory number to which a call that is coming 
from an internal number is forwarded when the line is in 
use.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward Busy to 
Voice Mail External

Check this check box to forward calls from an external 
number to the number that you chose in the 
voice-messaging profile when the line is in use.

Checking this check box makes the values in the Forward 
Busy Destination field and Calling Search Space check 
box not relevant. 

Forward Busy to 
Voice Mail Internal

Check this check box to forward calls from an internal 
number to the number that you chose in the 
voice-messaging profile when the line is in use.

Checking this check box makes the values in the Forward 
Busy Destination field and Calling Search Space check 
box are not relevant. 

Calling Search Space 
Forward No Answer 
External 

Choose the calling search space to use when a call from 
an external number is forwarded to the specified 
destination. The setting displays only if it is configured 
in the system.

Note This setting applies to all devices that are using 
this directory number.

Calling Search Space 
Forward No Answer 
Internal

Choose the calling search space to use a call from an 
internal number is forwarded to the specified destination. 
The setting displays only if it is configured in the system.

Note This setting applies to all devices that are using 
this directory number.

Forward No Answer 
Destination External

Enter the directory number to which a call that is coming 
from an external number is forwarded when the phone is 
not answered.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Forward No Answer 
Destination Internal

Enter the directory number to which a call that is coming 
from an internal number is forwarded when the phone is 
not answered.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward No Answer 
to Voice Mail 
External

Check this check box to forward unanswered calls from 
an external number to the number that you chose in the 
voice-messaging profile.

Checking this check box makes the values in the Forward 
No Answer Destination field and Calling Search Space 
check box are not relevant. 

Forward No Answer 
to Voice Mail 
Internal

Check this check box to forward unanswered calls from 
an internal number to the number that you chose in the 
voice-messaging profile.

Checking this check box makes the values in the Forward 
No Answer Destination field and Calling Search Space 
check box are not relevant. 

Calling Search Space 
Forward No 
Coverage External 

Choose the calling search space to use when a call from 
an external number is forwarded to the specified 
destination. The setting displays only if it is configured 
in the system.

Note This setting applies to all devices that are using 
this directory number. 

Calling Search Space 
Forward No 
Coverage Internal 

Choose the calling search space to use when a call from 
an internal number is forwarded to the specified 
destination. The setting displays only if it is configured 
in the system.

Note This setting applies to all devices that are using 
this directory number. 

Forward No 
Coverage 
Destination External

Enter the directory number to which a call that is coming 
from an external number is forwarded when the phone 
does not have coverage.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Forward No 
Coverage 
Destination Internal

Enter the directory number to which a call that is coming 
from an internal number is forwarded when the phone 
does not have coverage.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward No 
Coverage to Voice 
Mail External

Check this check box to forward calls from an external 
number to the number that you chose in the 
voice-messaging profile when the phone does not have 
coverage.

Checking this check box makes the values in the Forward 
No Answer Destination field and Calling Search Space 
check box are not relevant. 

Forward No 
Coverage to Voice 
Mail Internal

Check this check box to forward calls from an external 
number to the number that you chose in the 
voice-messaging profile when the phone does not have 
coverage.

Checking this check box makes the values in the Forward 
No Answer Destination field and Calling Search Space 
check box are not relevant. 

Calling Search Space 
Forward on CTI 
Failure 
External/Internal

(CTI ports only) Choose the calling search space to use 
when a call from an internal or external call is forwarded 
to the specified destination. The setting appears only if it 
is configured in the system.

Note This setting applies to all devices that are using 
this directory number.

Forward on CTI 
Failure Destination 
External/Internal

(CTI ports only) Enter the directory number to which a 
call coming from an internal or an external number 
should be forwarded when a phone or CTI application 
fails.

Forward on CTI 
Failure to Voice Mail 
External/Internal

(CTI ports only) Check this check box to forward failed 
calls from external or internal numbers to the number 
that you chose in the voice-messaging profile.

Call Forward No 
Answer Ring 
Duration

Enter the number of seconds (between 1 and 300) to 
allow the call to ring, before forwarding the call to the 
destination number entered in the Forward No Answer 
Destination field.

Note Leave this field blank to use the value that is set 
in the Cisco Unified CallManager service 
parameter, Forward No Answer Timer.

Call Pickup Group Choose a pickup group to specify the call pickup group, 
which can answer incoming calls to this directory 
number by dialing the appropriate pickup group number.

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
40-7
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 40      Updating Lines for User Device Profiles
Field Descriptions for Updating Lines
MLPP Alternate Party Settings

Target (Destination) 
MLPP

Enter the number to which MLPP precedence calls 
should be directed if this directory number receives a 
precedence call and neither this number nor its call 
forward destination answers the precedence call.

Values can include numeric characters, pound(#), and 
asterisk (*).

MLPP Calling 
Search Space

From the drop-down list box, choose the calling search 
space to associate with the alternate party target 
(destination) number.

MLPP No Answer 
Ring Duration

Enter the number of seconds (between 4 and 30) after 
which an MLPP precedence call will be directed to this 
directory number’s alternate party if this directory 
number and its call forwarding destination have not 
answered the precedence call.

Leave this setting blank to use the value that is set in the 
Cisco Unified CallManager enterprise parameter, 
Precedence Alternate Party Timeout.

Line null on Device null

Display (Internal 
Caller ID)

Use this field only if you do not want the directory 
number to show on the line appearance. Enter text that 
identifies this directory number for a line/phone 
combination. 

Suggested entries include boss’s name, department’s 
name, or other appropriate information to identify 
multiple directory numbers to secretary/assistant who 
monitors multiple directory numbers.

Line Text Label Enter text that identifies this directory number for a 
line/phone combination.

Note The default language specifies English

External Phone 
Number Mask

Enter the phone number (or mask) that is sent for Caller 
ID information when a call is placed from this line.

You can enter a maximum of 30 numbers and “X” 
characters. The Xs represent the directory number and 
must appear at the end of the pattern. For example, if you 
specify a mask of 972813XXXX, an external call from 
extension 1234 displays a caller ID number of 
9728131234.

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Message Waiting 
Lamp Policy

Use this field to configure the handset lamp illumination 
policy. Choose one of the following options:

• Use System Policy (The directory number refers to 
the service parameter “Message Waiting Lamp 
Policy” setting.)

• Light and Prompt 

• Prompt Only 

• Light Only 

• None

Setting applies only to the current device unless you 
check the check box at right (called Update Shared 
Device Settings) and click the Propagate selected 
button. (The check box at right displays only if other 
devices share this directory number

Ring Setting When 
Idle

Choose the type of ring for an incoming call on a phone.

Ring Setting when 
Active

Choose the type of ring for an incoming call on a phone, 
which is used when this phone has another active call on 
a different line.

Multiple Call/Call Waiting Settlings

Maximum Number 
of Calls

You can configure up to 184 calls for a line on a device 
in a cluster, with the limiting factor being the device. As 
you configure the number of calls for one line, the calls 
available for another line decrease. 

The default specifies 4. If the phone does not allow 
multiple calls for each line, the default specifies 2. 

For CTI route points, you can configure up to 10,000 
calls for each port. The default specifies 5000 calls. 

Use this field in conjunction with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum 
Number of Calls and Call Forward Busy, determines the 
maximum number of calls to be presented at the line. If 
maximum number of calls is set for 50 and the busy 
trigger is set to 40, then incoming call 41 gets rejected 
with a busy cause (and will get forwarded if Call Forward 
Busy is set). If this line is shared, all the lines must be 
busy before incoming calls get rejected.

Use this field in conjunction with Maximum Number of 
Calls for CTI route points. The default specifies 4500 
calls.

Forwarded Call Information Display

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Related Topics
Note To complete the procedure, go to the “Using Query to Update Lines” section on page 40-1.

Related Topics
• Using Query to Update Lines, page 40-1

• Field Descriptions for Updating Lines, page 40-3

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3

Caller Name Check this check box to include the caller’s name in the 
display when a forwarded call is received. Default leaves 
this check box checked.

Caller Number Check this check box to include the caller’s number in 
the display when receiving a forwarded call.

Redirected Number Check this check box to include the redirected number in 
the display when receiving a forwarded call.

Dialed Number Check this check box to include the dialed number in the 
display when a forwarded call is received. The default 
setting leaves this check box checked.

Table 40-1 Field Descriptions for Updating Line Details (continued)

Field Description
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Adding Lines in UDP 

You can add lines to a group of existing user device profiles. When you use the template to add new lines, 
you cannot change phone services or speed dials. Cisco Unified CallManager Bulk Administration 
(BAT) ignores those fields on the template when you add lines to existing devices. 

To add lines to existing phones or user device profiles, use the following procedure.

Before You Begin

• You must have a BAT template for this transaction. See the “Adding or Updating Lines in a BAT 
Template” section on page 3-4.

• You must have a CSV data file for this transaction. See the “Using the BAT Spreadsheet to Create 
User Device Profile CSV Data Files” section on page 32-2 for information.

Adding Lines to Existing UDPs
Use the following procedure to add lines to a group of existing user device profiles.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Add/Update Lines > Add Lines.

The UDP Add Lines Configuration window displays.

Step 2 In the File Name field, choose the CSV data file that you created for this bulk transaction.

Step 3 If you are changing the phone settings for existing phones in the template, check the Override the 
existing configuration check box. The user device profile information also gets updated when this 
check box is checked.

Step 4 In the Template Name field, choose the User Device Profile template to use for this bulk transaction.

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to insert the phone records immediately or, click Run Later to 
insert the phone records at a later time.

Step 7 Click Submit to create a job for inserting the phone records. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”
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Using the BAT Spreadsheet to Add Lines to Existing UDPs
For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 41-4.

Using the BAT Spreadsheet to Add Lines to Existing UDPs
To create the CSV data file by using the BAT spreadsheet for adding lines to existing UDPs, use the 
following procedure.

For information about installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet 
for Gathering Data” section on page 1-8.

Procedure

Step 1 To open the BAT Spreadsheet, locate and double-click the BAT.xlt file. 

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 To display the fields, click the Add Lines tab at the bottom of the spreadsheet.

Step 4 Enter data for an individual device profile on each line in the spreadsheet. Complete all mandatory fields 
and any relevant optional fields. Each column heading specifies the length of the field and whether it is 
required or optional. Table 41-1 describes the fields for adding lines in the BAT spreadsheet.

Step 5 To transfer the data from the BAT Excel spreadsheet into a CSV formatted data file, click Export to BAT 
Format.

The system saves the file to C:\XLSDataFiles\ or you can use Browse to save your file in another existing 
folder on your local workstation. The filename is

<tabname>-<timestamp>.txt 

where <tabname> represents the type of input file that you created, such as UDPs, and <timestamp> 
represents the precise date and time that the file was created.

Note If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when 
you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. 
The system does not convert data that is entered after a blank line to the BAT format.

Upload the CSV file to Cisco Unified CallManager Server first node. See “Uploading a File” section on 
page 2-3.

Note For information on how to read the exported CSV data file, click the link to View Sample File in the 
Insert Phones window in BAT.
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Additional Topics

See the “Related Topics” section on page 41-4.

Field Descriptions for Adding Lines By Using the BAT 
Spreadsheet

Table 41-1 provides the field descriptions when you are adding lines by using the BAT spreadsheet. For 
related procedures, see the “Related Topics” section on page 41-4.

Table 41-1 Field Descriptions for Adding Lines by Using the BAT Spreadsheet

Field Description

MAC 
Address/Device 
Name

Enter the MAC address for phones, VGC virtual phones, 
and VGC phones. Enter a unique identifier for CTI ports 
and H.323 clients. Enter the device name for UDPs

Line Index Enter a number between 1 and 34 for the line index of a 
phone.

Directory Number Enter a directory number, up to 24 numerals and special 
characters, for this line.

Display Enter the text that you want to display on the called 
party’s phone display, such as the user name (John 
Smith) or phone location (Conference Room 1).

Note If this filed is left blank the system uses the value 
that is entered in the Directory Number field.

Note The default language specifies English.

Line Text Label Enter text that identifies this directory number for a 
line/phone combination. 

Note The default language specifies English

Forward Busy 
External

Enter the directory number to which a call that is coming 
from an external number is forwarded when the line is in 
use.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward No Answer 
External

Enter the directory number to which a call that is coming 
from an external number is forwarded when the phone is 
not answered.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.
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Related Topics
Related Topics
• Adding Lines to Existing UDPs, page 41-1

• Using the BAT Spreadsheet to Add Lines to Existing UDPs, page 41-2

• Field Descriptions for Adding Lines By Using the BAT Spreadsheet, page 41-3

• Adding or Updating Lines in a BAT Template, page 3-4

Forward No 
Coverage External

Enter the directory number to which a call that is coming 
from an external number is forwarded when the phone 
does not have coverage.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward Busy 
Internal

Enter the directory number to which a call that is coming 
from an internal number is forwarded when the line is in 
use.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward No Answer 
Internal

Enter the directory number to which a call that is coming 
from an internal number is forwarded when the phone is 
not answered.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Forward No 
Coverage Internal

Enter the directory number to which a call that is coming 
from an internal number is forwarded when the phone 
does not have coverage.

Note This setting applies to any dialable phone 
number, including an outside destination unless 
restricted, and to all devices that are using this 
directory number.

Call Pickup Group Enter a Pickup Group Name to specify the call pickup 
group, which can answer incoming calls to this line by 
dialing the appropriate pickup group number.

Table 41-1 Field Descriptions for Adding Lines by Using the BAT Spreadsheet

Field Description
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Generating Reports for UDPs

Cisco Unified CallManager Bulk Administration (BAT) provides reports to help you manage records 
effectively. You can create and save reports that provide information about phones, users, user device 
profiles, managers and assistants, and gateway records. You can save these reports with a filename and 
store them in a folder on the first node server to review and print.

You can customize BAT reports for phones and for user device profiles to meet your particular needs by 
choosing items from a list of device fields and line fields. You can also choose how to arrange the fields 
in the report. The system generates the report in the CSV file format. Because reports for users, 
managers, assistants, and gateways have a fixed format, you cannot customize them.

Example

You need to have a list of all the directory numbers with their forwarding destinations by phone model. 
You can generate a Phone Report for the Cisco Unified IP Phone model 7960 and choose these query 
details: Device Name, Directory Number, Forward Busy Destination, Forward No Answer Destination, 
and Label. You can arrange the report fields, so the Label field follows the Directory Number field and 
precedes the two forward destination numbers.

Additional Information

See the “Related Topics” section on page 42-3.

Generating Reports for User Device Profiles
To generate reports for User Device Profiles (UDP), use this procedure.

Procedure

Step 1 Choose Bulk Administration > User Device Profiles > Generate UDP Reports.

The Find and List Device Profiles window displays.

Step 2 From the Find drop-down list box, choose one of the following options:

• User

• Autogenerated

• All

Step 3 From the first Device Profiles where drop-down list box, choose one of the following criteria: 

• Profile Name
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• Description

• Device Type

Step 4 From the second Device Profiles where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 5 Specify the appropriate search text, if applicable. 

Tip To find all UDPs that are registered in the database, click Find without entering any search text.

Step 6 To further define your query and to add multiple filters, check the Search Within Results check box, 
choose AND or OR from the drop-down box, and repeat steps 2 and 5.

Step 7 Click Find.

A list of discovered templates displays by:

• Name

• Description

• Device Type

• Profile Type

Step 8 Click Next to choose details for your type of report. The Device Profile Report Configuration window 
displays and shows the Query that you chose. If you want to change the type of query, click Back.

Step 9 In the Report File Name field, enter your name for this report (required). 

Step 10 In the Available Device Fields drop-down list box, choose a device item and click the arrow to move the 
item into the Selected Fields for this Report list. You can choose one or more fields to include in your 
report. For a list of device and live fields, see the “Reports for Phones and IP Telephony Devices” section 
on page 12-3.

Step 11 Arrange the order of the items in the Selected Device Fields for this Report list by choosing an item and 
clicking the Up arrow or Down arrow to move the item to another position in the list.

Step 12 In the Available Line Fields drop-down list box, choose a line item and click the arrow to move the item 
into the Selected Fields for this Report list. You can choose one or more fields to include in your report.

Step 13 Arrange the order of the line items in the Selected Line Fields for this Report list by choosing an item 
and clicking the Up arrow or Down arrow to move the item to another position in the list.

Note You must specify at least one device or line field to generate a report.

Step 14 In the Additional IP Services Fields area, check the check boxes for Speed Dial Services and/or IP phone 
Services, as needed.

Step 15 In the Job Information area, enter the Job description.
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Step 16 Click the Run Immediately radio button to generate report for UDPs immediately or, click Run Later 
generate reports at a later time.

Step 17 Click Submit to create a job for generate report for UDPs. 

Step 18 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 42-3.

Related Topics
• Generating Reports for User Device Profiles, page 42-1

• Reports for Phones and IP Telephony Devices, page 12-3

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
42-3
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 42      Generating Reports for UDPs
Related Topics
42-4
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



P A R T  8

Gateways





Cisco Unified C
OL-9421-01
C H A P T E R 43

Gateway Template

You can use Cisco Unified CallManager Bulk Administration (BAT) to configure some Cisco gateways 
and ports in the Cisco Unified CallManager database in batches, rather than to add each gateway and 
port individually.

The following topics provide information and procedures for these tasks:

• Adding Cisco Gateways, page 43-1

• Finding a Gateway Template, page 43-2

• Adding or Editing a Gateway Template, page 43-3

• Gateway Configuration Settings, page 43-9

• Port Configuration Settings, page 43-32

• Deleting Cisco Gateways, page 45-1

• Generating Reports for Cisco Gateways, page 46-1

Adding Cisco Gateways
You can use BAT to add the Cisco gateways to the Cisco Unified CallManager database. 

Before adding the VG200 gateways, you must first configure the gateway by using the Cisco IOS 
software command line interface (CLI). For gateway configuration procedures and commands, refer to 
the configuration documentation that is supplied with the gateway.

When using BAT to add the Cisco VG200 gateways to the Cisco Unified CallManager database, you can 
configure the following types of trunks or ports:

• Foreign Exchange Station (FXS) ports for analog devices

• Foreign Exchange Office (FXO) for loopstart or groundstart trunks 

• T1 Primary Rate Interface (PRI) trunks for ISDN services in North America—Currently available 
only for Cisco VG200 gateways

• E1 Primary Rate Interface (PRI) trunks for ISDN services in Europe—Currently available only for 
Cisco VG200 gateways.

• Digital Access T1 protocol trunks

To add Cisco VG200 gateways to Cisco Unified CallManager, perform the following tasks:

1. Create a Cisco VG200 gateway template to define common values for a set of gateways and ports. 
See the “Creating a Cisco VG200 Gateway Template” section on page 43-4.
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2. Create a CSV data file to define individual values for each gateway and port that you want to add. 
See the “Creating CSV Data Files for Cisco VG200 Gateways” section on page 44-1.

3. Insert gateways and ports in the Cisco Unified CallManager database. See the “Inserting Gateways 
to Cisco Unified CallManager” section on page 44-4.

To insert Cisco Catalyst 6000 (FXS) gateway and ports to Cisco Unified CallManager, you must 
perform the following tasks:

1. Create a Cisco Catalyst 6000 (FXS) gateway template. See the “Creating a Cisco Catalyst 6000 
(FXS) Gateway Template” section on page 43-8

2. To define common values for a set of FXS ports, create a Cisco Catalyst 6000 (FXS) ports template. 
See the “Field descriptions for FXS/FXO Port Configuration” section on page 43-13.

3. To define individual values for the FXS ports that you want to add, create a CSV data file. See the 
Creating the CSV Data File for Cisco Catalyst 6000 (FXS) Ports, page 44-3.

4. To insert the FXS ports in the Cisco Unified CallManager database, see the “Inserting Gateways to 
Cisco Unified CallManager” section on page 44-4. 

Before using BAT to add the FXS ports for the analog interface modules, you must install the 
Cisco Catalyst 6000 gateway by performing these tasks: 

1. Configure the gateway by using Cisco IOS software command line interface. See the documentation 
that was supplied with your gateway for configuration instructions.

2. Use Cisco Unified CallManager Administration to add the Cisco Catalyst 6000 gateway in the 
Cisco Unified CallManager database. In Cisco Unified CallManager Administration, choose 
Device > Gateway and click Add New. Choose the Cisco Catalyst 6000 24 Port FXS Gateway and 
device protocol and then click Next. For more information, refer to the Cisco Unified CallManager 
Administration Guide.

You can use BAT to add FXS ports on the Cisco Catalyst 6000 (FXS) analog interface modules for 
analog devices. You must configure a Gateway Directory Number template to associate with these FXS 
ports and a Catalyst 6000 (FXS) ports template before adding these ports to the 
Cisco Unified CallManager database.

Additional Topics

See the “Related Topics” section on page 43-36.

Finding a Gateway Template
Because you might have several gateway templates, Cisco Unified CallManager lets you locate specific 
template on the basis of specific criteria. Use the following procedure to locate templates.

Note During your work in a browser session, your find/list search preferences are stored in the cookies on the 
client machine. If you navigate to other menu items and return to this menu item, or if you close the 
browser and then reopen a new browser window, your Cisco Unified CallManager search preferences 
are retained until you modify your search.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template.

The Find and List Gateway window displays. 
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Step 2 From the first Find Gateways where drop-down list box, choose one of the following criteria:

• Name

• Description

• DN/Route Pattern

• Calling Search Space 

• Device Pool

• Route Group Name

• Device Type

Step 3 From the second Find Gateways where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable.

Tip To find all gateways that are registered in the database, click Find without entering any search 
text.

Step 5 Choose Show from the third drop-down list box to show the end points associated with gateways, and 
click Find.

A list of discovered templates displays by:

• Device Name

• Description

• Device Pool

• Status

• IP Address

Step 6 From the list of records, click the device name that matches your search criteria.

The Gateway Configuration window displays.

Additional Information

See the “Related Topics” section on page 43-36

Adding or Editing a Gateway Template
Use the following procedure to create a new VG200 or Cisco Catalyst 6000 (FXS) Ports template:
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Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template. The Find and List Gateway Template 
window displays. 

• To edit an existing gateway template, see the “Finding a Gateway Template” section on page 43-2 
and select the gateway you want to edit. 

See “Field Descriptions for VG200 Gateway Template” section on page 43-9 and “Field 
Descriptions for Cisco Catalyst 24 Port FXS Gateway Template” section on page 43-10.

• To add a new gateway, click Add New. The Add a New Gateway window displays. 

Step 2 Complete one of the following procedures:

• To create a VG200 template, see the “Creating a Cisco VG200 Gateway Template” section on 
page 43-4.

• To create Cisco Catalyst 6000 (FXS) Ports template, see “Creating a Cisco Catalyst 6000 (FXS) 
Gateway Template” section on page 43-8.

Creating a Cisco VG200 Gateway Template
You must create a Cisco VG200 template and then add endpoint identifiers for the network modules.

You must use a BAT template to configure the following endpoint identifiers:

• Foreign Exchange Station (FXS) ports 

• Foreign Exchange Office (FXO) trunks 

• T1 PRI trunks 

• E1 PRI trunks 

• T1 CAS trunks

Before You Begin

Use the following procedure to add a VG200 Gateway template.

Procedure

Step 1 Choose Bulk Administration > Gateways > Gateway Template. 

The Find and List Gateway window displays.

Step 2 Click Add New. The Add a New Gateway window displays.

Step 3 From the Gateway Type drop-down list box, choose Cisco VG200 and click Next. The Gateway 
Configuration window displays.

Step 4 Enter values for all the fields. See “Field Descriptions for VG200 Gateway Template” section on 
page 43-9:

Step 5 Click Save. When the insert completes, a new field displays on the pane.

Step 6 In the Subunit field(s), choose the appropriate type for each subunit field:

• VIC-2FXS—Foreign Exchange Station (FXS) voice interface card
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• VIC-2FXO—Foreign Exchange Office (FXO) voice interface card 

• VWIC-1MFT-T1—Voice WAN interface card with one endpoint for T1 CAS or T1 PRI

• VWIC-2MFT-T1—Voice WAN interface card with two endpoints for T1 CAS or T1 PRI

• VWIC-1MFT-E1—Voice WAN interface card with one endpoint for E1 PRI

• VWIC-2MFT-E1—Voice WAN interface card with two endpoints for E1 PRI

Step 7 Click Save. When the Status indicates that the update completed, the endpoint identifiers display as links 
to the right of the subunit drop-down list boxes. 

Step 8 Click an endpoint identifier (for example, 1/0/0) to configure device protocol information and add ports 
for the installed types of VICs.

For detailed instructions, see the following procedures:

• Adding FXS Ports to VG200 Gateway Template, page 43-5

• Adding FXO Ports to an VG200 Gateway Template, page 43-6

• Adding Digital Access T1 (T1-CAS) Ports to an VG200 Gateway Template, page 43-7

• Adding a T1 PRI or E1 PRI Device to an VG200 Gateway Template, page 43-7

Step 9 To reset the gateway and apply the changes, click Reset.

Step 10 Continue configuring endpoint information and ports as needed.

Adding Ports to a VG200 Gateway Template
The device protocols and port types that can be configured on VG200 gateways vary by the type of 
installed voice interface cards. This section contains the following procedures:

• Adding FXS Ports to VG200 Gateway Template, page 43-5

• Adding FXO Ports to an VG200 Gateway Template, page 43-6

• Adding Digital Access T1 (T1-CAS) Ports to an VG200 Gateway Template, page 43-7

• Adding a T1 PRI or E1 PRI Device to an VG200 Gateway Template, page 43-7

Adding FXS Ports to VG200 Gateway Template

You can use Foreign Exchange Station (FXS) ports to connect to any POTS device. Use this procedure 
to add FXS ports on a VG200 gateway template.

Before You Begin

You must add an VG200 gateway template before configuring ports. See the “Creating a Cisco VG200 
Gateway Template” section on page 43-4 for instructions.

Procedure

Step 1 To find the gateway template to which you want to add FXS ports, see “Finding a Gateway Template” 
section on page 43-2 

Step 2 From the Gateway Template Configuration window, click the endpoint identifier for the FXS VIC that 
you want to configure.
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The window refreshes and displays the Gateway Template Configuration window with the end-point 
icons.

Step 3 Enter the appropriate Gateway Information and Port Information settings. See the following sections 
for details about these fields:

• Field descriptions for FXS/FXO Port Configuration, page 43-13

• POTS Port Configuration Settings, page 43-33

Step 4 Click Save.

Note After you insert a POTS port, the window refreshes and displays the POTS port information at 
the bottom of the window. An Add a new DN link displays in the Directory Number Information 
area in the left panel.

Step 5 Click Add a new DN to add directory numbers to the POTS port or, if you configured another type of 
port, go to Step 7.

Note See “Adding or Updating Lines in a BAT Template” section on page 3-4 for information about 
adding and configuring DNs.

Step 6 To return to the main VG200 Gateway Template Configuration window for the gateway to which you 
just added the ports, choose Back to MGCP Configuration in the Related Links drop-down list box and 
click Go.

Step 7 To reset the gateway and apply the changes, click Reset.

Step 8 Repeat Step 2 through Step 6 to add additional FXS ports.

Additional Information

See the “Related Topics” section on page 43-36.

Adding FXO Ports to an VG200 Gateway Template

You can use Foreign Exchange Office (FXO) ports for connecting to a central office or PBX. Use this 
procedure to add and configure FXO ports for loop start or ground start on an VG200 gateway template.

Note Cisco Unified CallManager assumes all loop-start trunks lack positive disconnect supervision. 
Configure trunks with positive disconnect supervision as ground start, so active calls can be maintained 
during a Cisco Unified CallManager server failover.

Before You Begin

You must add a VG200 gateway template before configuring ports. See the “Creating a Cisco VG200 
Gateway Template” section on page 43-4 for instructions.

Procedure

Step 1 To find the gateway template to which you want to add FXS ports, see “Finding a Gateway Template” 
section on page 43-2 
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Step 2 From the Gateway Configuration window, click the endpoint identifiers of the FXO port that you want 
to configure.

Step 3 From the Port Type drop-down list box, choose either Ground Start or Loop Start.

Note You must choose the same port type for both endpoint identifiers of the VIC-2FXO port. If you 
choose different port types, a message displays.

Step 4 Enter the appropriate Gateway Configuration and Port Information settings described in “Field 
descriptions for FXS/FXO Port Configuration” section on page 43-13

Step 5 Click Save.

Step 6 To return to the main VG200 gateway configuration window for the gateway to which you just added the 
ports, choose Back to MGCP Configuration in the Related Links drop-down list box and click Go.

Step 7 To reset the gateway and apply the changes, click Reset.

Step 8 To add more FXO ports, repeat Step 2 though Step 5.

Additional Information

See the “Related Topics” section on page 43-36.

Adding Digital Access T1 (T1-CAS) Ports to an VG200 Gateway Template

Use this procedure to add Digital Access T1 (T1-CAS) ports to an VG200 gateway.

Step 1 To find the gateway template to which you want to add FXS ports, see “Finding a Gateway Template” 
section on page 43-2 

Step 2 From the Gateway Configuration window, click the endpoint identifier of the Digital Access T1 
(T1-CAS) port that you want to configure.

In the Device Protocol drop-down list box that displays, choose Digital Access T1 and click Next.

Step 3 Enter the appropriate Gateway Configuration settings. See the “Field Descriptions for Digital Access T1 
Trunks on a Cisco VG200 Gateway Template” section on page 43-16 for details.

Step 4 Click Save.

Step 5 To reset the gateway and apply the changes, click Reset.

Step 6 See the “Port Configuration Settings” section on page 43-32 for the appropriate settings for the port type 
that you choose.

Additional Information

See the “Related Topics” section on page 43-36.

Adding a T1 PRI or E1 PRI Device to an VG200 Gateway Template

Step 1 To find the gateway template to which you want to add FXS ports, see “Finding a Gateway Template” 
section on page 43-2 
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Step 2 From the Gateway Configuration window, click the endpoint identifier of the T1 PRI or E1 PRI port that 
you want to configure.

Step 3 Configure the T1 PRI or E1 PRI device protocol settings. See the “Field Descriptions for T1 PRI or E1 
PRI Trunks on a Cisco VG200 Gateway Template” section on page 43-19 for detailed field descriptions.

Step 4 Click Save.

Step 5 To reset the gateway and apply the changes, click Reset.

Additional Information

See the “Related Topics” section on page 43-36.

Creating a Cisco Catalyst 6000 (FXS) Gateway Template
To create a Cisco Catalyst 6000 FXS gateway template, use this procedure. You must complete all fields 
unless otherwise noted.

Step 1 Choose Bulk Administration > Gateways > Gateway Template. 

The Find and List Gateway window displays.

Step 2 Click Add New. The Add a New Gateway window displays.

Step 3 From the Gateway Type drop-down list box, choose Cisco Catalyst 6000 24 Port FXS Gateway. The 
Gateway Configuration window displays.

Step 4 In the Template Name field, enter a unique name for this template.

Step 5 Enter the settings for the fields. See the “Field Descriptions for Cisco Catalyst 24 Port FXS Gateway 
Template” section on page 43-10 for more information.

Step 6 Click Save.

Step 7 Click Add a New Port.

A port configuration dialog opens in a separate window.

Step 8 From the drop-down list box, choose POTS as the port type depending on the gateway model that you 
are configuring.“Field Descriptions for T1 PRI or E1 PRI Trunks on a Cisco VG200 Gateway Template” 
section on page 43-19

Step 9 Enter the appropriate port configuration settings as described in the “POTS Port Configuration Settings” 
section on page 43-33. 

Step 10 Click Save.

If you have inserted POTS ports, the window refreshes and displays the POTS port in the list on the left 
side of the window. An Add DN link displays to the right of the new port.

Step 11 To add a directory numbers to an FXS port, click Add DN. 

For information about adding and configuring directory numbers, see the “Adding or Updating Lines in 
a BAT Template” section on page 3-4 and the.

Step 12 Click Save. When the Status indicates that the update completed, the template displays on the Find and 
List Gateways window. To go back to the Find and List window, choose Back to Find and List from the 
Related Links drop-down list box in the top, right corner of the window.
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Additional Topics

See the “Related Topics” section on page 43-36.

Gateway Configuration Settings
See the following sections for tables that list detailed descriptions for all gateway configuration fields:

• Field Descriptions for VG200 Gateway Template, page 43-9

• Field Descriptions for Cisco Catalyst 24 Port FXS Gateway Template, page 43-10

• Field descriptions for FXS/FXO Port Configuration, page 43-13

• Field Descriptions for Digital Access T1 Trunks on a Cisco VG200 Gateway Template, page 43-16

• Field Descriptions for T1 PRI or E1 PRI Trunks on a Cisco VG200 Gateway Template, page 43-19

For detailed information about port configuration settings, see the “Port Configuration Settings” section 
on page 43-32.

Field Descriptions for VG200 Gateway Template
Table 43-1 provides detailed descriptions for VG200 gateway template configuration settings. For 
related procedures, see the “Related Topics” section on page 43-36.

Table 43-1 VG200 Gateway Configuration Settings

Field Description

Template Name Enter a name of up to 64 characters that identifies the Cisco VG200 
gateway template.

Description Enter a description that clarifies the purpose of the device.

Cisco Unified CallManager 
Group

From the drop-down list box, choose a Cisco Unified CallManager 
redundancy group. 

A Cisco Unified CallManager redundancy group includes a 
prioritized list of up to three Cisco Unified CallManagers. The first 
Cisco Unified CallManager in the list serves as the primary 
Cisco Unified CallManager. If the primary 
Cisco Unified CallManager is not available or fails, the gateway 
attempts to connect with the next Cisco Unified CallManager in the 
list and so on.

Configured Slots, VICs, and Endpoints

Note You must specify the beginning port number for some VICs. For example, if the VIC in 
Subunit 0 begins at 0 and has two ports (0 and 1), the VIC in Subunit 1 must begin at a port 
number greater than 1 and have two ports (2 and 3 or 4 and 5).

Note VG200 gateway has only one slot.
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Field Descriptions for Cisco Catalyst 24 Port FXS Gateway Template 
Table 43-2 lists configuration settings for Cisco Catalyst 6000 24 port FXS Gateway template. For 
related procedures, see the “Related Topics” section on page 43-36.

Module in Slot 1 For the available slot on the VG200 gateway, choose from the 
following type of modules:

• NM-1V—Network Module-1Voice has one voice interface card 
(VIC) in Sub-Unit 0 for FXS or FXO.

• NM-2V—Network Module-2Voice has two VICs, one in 
Sub-Unit 0 and one in Sub-Unit 1 for either FXS or FXO.

• NM-HDV—Network Module-High Density Voice has one VIC 
in Sub-Unit 0 either for T1 CAS or T1 PRI, or for E1 PRI.

• None—No network modules are installed.

Product-Specific Configuration

Model-specific configuration 
fields defined by the gateway 
manufacturer

The gateway manufacturer specifies the model-specific fields under 
product-specific configuration. Because they are dynamically 
configured, they can change without notice.

To view field descriptions and help for product-specific 
configuration items, click the “i” information icon to the right of the 
Product Specific Configuration heading to display help in a popup 
dialog box.

If you need more information, refer to the documentation for the 
specific gateway that you are configuring or contact the 
manufacturer.

Table 43-1 VG200 Gateway Configuration Settings (continued)

Field Description

Table 43-2 Cisco Catalyst 6000 24 Port FXS Gateway Configuration Settings

Field Description

Description Enter the purpose of the device.

Device Pool From the drop-down list box, choose the appropriate device pool. 

The device pool specifies a collection of properties for this device 
including CallManager Group, Date/Time Group, Region, and 
Calling Search Space for auto-registration of devices.

Media Resource Group List This list provides a prioritized grouping of media resource groups. 
An application chooses the required media resource, such as a 
Music On Hold server, from among the available media resources 
according to the priority order that a Media Resource Group List 
defines.
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Calling Search Space From the drop-down list box, choose the appropriate calling 
search space. The calling search space specifies a collection of 
partitions that are searched to determine how a collected 
(originating) number should be routed.

You can configure the number of calling search spaces that display 
in this drop-down list box by using the Max List Box Items 
enterprise parameter. If more calling search spaces exist than the 
Max List Box Items enterprise parameter specifies, the ellipsis 
button (...) displays next to the drop-down list box. Click the ... 
button to display the Select Calling Search Space window. Enter a 
partial calling search space name in the List items where Name 
contains field. Click the desired calling search space name in the 
list of calling search spaces that displays in the Select item to use 
box and click OK.

Note To set the maximum list box items, choose System > 
Enterprise Parameters and choose Unified CMAdmin 
Parameters.

AAR Calling Search Space Choose the appropriate calling search space for the device to use 
when it performs automated alternate routing (AAR). The AAR 
calling search space specifies the collection of route partitions that 
are searched to determine how to route a collected (originating) 
number that is otherwise blocked due to insufficient bandwidth.

Location Choose the appropriate location for this device. The location 
specifies the total bandwidth that is available for calls to and from 
this location. A location setting of None means that the locations 
feature does not keep track of the bandwidth that this device 
consumes.

AAR Group Choose the automated alternate routing (AAR) group for this 
device. The AAR group provides the prefix digits that are used to 
route calls that are otherwise blocked due to insufficient 
bandwidth. An AAR group setting of None specifies that no 
rerouting of blocked calls will be attempted.

Network Locale From the drop-down list box, choose the locale that is associated 
with the gateway. The network locale identifies a set of detailed 
information to support the hardware in a specific location. The 
network locale contains a definition of the tones and cadences that 
the device uses in a specific geographic area.

Note Choose only a network locale that is already installed and 
supported by the associated devices. The list contains all 
available network locales for this setting, but not all are 
necessarily installed. If the device is associated with a 
network locale that it does not support in the firmware, the 
device will fail to come up.

Table 43-2 Cisco Catalyst 6000 24 Port FXS Gateway Configuration Settings (continued)

Field Description
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Port Selection Order Choose the order in which ports are chosen. If you are not sure 
which port order to use, choose TOP_DOWN:

• TOP_DOWN—Selects ports in descending order, from port 1 
to port 8.

• BOTTOM_UP—Selects ports in ascending order, from port 8 
to port 1.

Load Information Enter the appropriate firmware load information for the gateway.

The values that you enter here override the default values for this 
gateway.

Transmit UTF-8 for Calling Party 
Name

This device uses the user locale setting of the device’s device pool 
to determine whether to send unicode and whether to translate 
received unicode information.

For the sending device, if you check this check box and the user 
locale setting in the device’s device pool matches the terminating 
phone’s user locale, the device sends unicode. If the user locale 
settings do not match, the device sends ASCII.

The receiving device translates incoming unicode characters 
based on the user locale setting of the sending device’s device 
pool. If the user locale setting matches the terminating phone’s 
user locale, the phone displays the characters.

Note The phone may display junk characters if the two ends of 
the trunk configure user locales that do not belong to the 
same language group.

Multilevel Precedence and Preemption (MLPP) Information

MLPP Domain From the drop-down list box, choose an MLPP domain to 
associate with this device. If you leave the value <None>, this 
device inherits its MLPP domain from the value that was set for 
the device’s device pool. If the device pool does not have an MLPP 
Domain setting, this device inherits its MLPP Domain from the 
value that was set for the MLPP Domain Identifier enterprise 
parameter.

MLPP Indication This device type does not have this setting.

MLPP Preemption This setting does not have this device type.

Table 43-2 Cisco Catalyst 6000 24 Port FXS Gateway Configuration Settings (continued)

Field Description
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Field descriptions for FXS/FXO Port Configuration
Table 43-3 provides detailed descriptions for FXS/FXO port configuration settings. For related 
procedures, see the “Related Topics” section on page 43-36.

For the VG200 gateway, not all switch emulation types support the network side. How you configure the 
gateway switch type determines whether you may or may not be able to set network side.

Product-Specific Configuration

Model-specific configuration 
fields that the gateway 
manufacturer defines

The gateway manufacturer specifies the model-specific fields 
under product-specific configuration. Because they are 
dynamically configured, they can change without notice.

To view field descriptions and help for product-specific 
configuration items, click the “i” information icon to the right of 
the Product Specific Configuration heading to display help in a 
popup dialog box.

If you need more information, refer to the documentation for the 
specific gateway that you are configuring or contact the 
manufacturer.

Table 43-2 Cisco Catalyst 6000 24 Port FXS Gateway Configuration Settings (continued)

Field Description

Table 43-3 FXS/FXO Port Configuration Settings

Field Description

Device Information

End-Point Name For VG200 gateways, this display-only field contains a string that 
Cisco Unified CallManager generates that uniquely identifies the 
VG200 analog interface. 

Description Enter a description that clarifies the purpose of the device.

Device Pool From the drop-down list box, choose the appropriate device pool.

The device pool specifies a collection of properties for this device 
including CallManager Group, Date/Time Group, Region, and 
Calling Search Space for auto registration of devices.

Media Resource Group List This list provides a prioritized grouping of media resource 
groups. An application chooses the required media resource, such 
as a Music On Hold server, from among the available media 
resources according to the priority order that is defined in a Media 
Resource Group List.
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Calling Search Space From the drop-down list box, choose the appropriate calling 
search space. A calling search space comprises a collection of 
route partitions that are searched to determine how a collected 
(originating) number should be routed.

You can configure the number of calling search spaces that 
display in this drop-down list box by using the Max List Box 
Items enterprise parameter. If more calling search spaces exist 
than the Max List Box Items enterprise parameter specifies, the 
ellipsis button (...) displays next to the drop-down list box. Click 
the ... button to display the Select Calling Search Space window. 
Enter a partial calling search space name in the List items where 
Name contains field. Click the desired calling search space name 
in the list of calling search spaces that displays in the Select item 
to use box and click OK.

Note To set the maximum list box items, choose System > 
Enterprise Parameters and enter a value for Max List 
Box Items in the Unified CMAdmin Parameters pane.

AAR Calling Search Space Choose the appropriate calling search space for the device to use 
when it performs automated alternate routing (AAR). The AAR 
calling search space specifies the collection of route partitions 
that are searched to determine how to route a collected 
(originating) number that is otherwise blocked due to insufficient 
bandwidth.

Location Choose the appropriate location for this device. The location 
specifies the total bandwidth that is available for calls to and from 
this location. A location setting of None means that the locations 
feature does not keep track of the bandwidth that this device 
consumes.

AAR Group Choose the automated alternate routing (AAR) group for this 
device. The AAR group provides the prefix digits that are used to 
route calls that are otherwise blocked due to insufficient 
bandwidth. An AAR group setting of None specifies that no 
rerouting of blocked calls will be attempted.

Network Locale From the drop-down list box, choose the locale that is associated 
with the gateway. The network locale identifies a set of detailed 
information to support the hardware in a specific location. The 
network locale contains a definition of the tones and cadences that 
the device uses in a specific geographic area.

Note Choose only a network locale that is already installed and 
that the associated devices support. The list contains all 
available network locales for this setting, but not all are 
necessarily installed. If the device is associated with a 
network locale that it does not support in the firmware, the 
device will fail to come up.

Table 43-3 FXS/FXO Port Configuration Settings (continued)

Field Description
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Transmit UTF-8 for Calling Party 
Name 

This device uses the user locale setting of the device’s device pool 
to determine whether to send Unicode and whether to translate 
received Unicode information.

For the sending device, if you check this check box and the user 
locale setting in the device’s device pool matches the terminating 
phone’s user locale, the device sends Unicode. If the user locale 
settings do not match, the device sends ASCII.

The receiving device translates incoming Unicode characters 
based on the user locale setting of the sending device’s device 
pool. If the user locale setting matches the terminating phone’s 
user locale, the phone displays the characters.

Note The phone may display junk characters if the two ends of 
the trunk configure user locales that do not belong to the 
same language group.

Multilevel Precedence and Preemption (MLPP) Information

MLPP Domain From the drop-down list box, choose an MLPP domain to 
associate with this device. If you leave the value <None>, this 
device inherits its MLPP domain from the value set for the 
device’s device pool. If the device pool does not have an MLPP 
Domain setting, this device inherits its MLPP Domain from the 
value set for the MLPP Domain Identifier enterprise parameter.

Port Information (POTS)

Port Direction Choose the direction of calls that are passing through this port: 

• Inbound—Use for incoming calls only. 

• Outbound—Use for outgoing calls. 

• Bothways—Use for inbound and outbound calls (default).

Prefix DN
(for FXS ports)

Enter the prefix digits that are appended to the digits that this 
trunk receives on incoming calls.

The Cisco Unified CallManager adds prefix digits after first 
truncating the number in accordance with the Num Digits setting.

Num Digits
(for FXS ports)

Enter the number of significant digits to collect, from 0 to 32.

Cisco Unified CallManager counts significant digits from the 
right (last digit) of the number called. 

Use this field for the processing of incoming calls and to indicate 
the number of digits starting from the last digit of the called 
number that is used to route calls coming into the PRI span. See 
Prefix DN.

Expected Digits
(for FXS ports)

Enter the number of digits that are expected on the inbound side 
of the trunk. For this rarely used field, leave zero as the default 
value if you are unsure.

Table 43-3 FXS/FXO Port Configuration Settings (continued)

Field Description
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Field Descriptions for Digital Access T1 Trunks on a Cisco VG200 Gateway 
Template

Table 43-4 provides detailed field descriptions for adding or updating values for the T1 CAS trunks on 
a Cisco VG200 gateway. 

Some fields display the values that were configured in Cisco Unified CallManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Consider an entry in fields 
without an asterisk as optional.

For related procedures, see the “Related Topics” section on page 43-36.

SMDI Port Number (0-4096) Use this field for analog access ports that connect to a 
voice-messaging system. 

Set the SMDI Port Number equal to the actual port number on the 
voice-messaging system to which the analog access port 
connects.

Note Voice-mail logical ports typically must match physical 
ports for the voice-messaging system to operate correctly.

Unattended Port Check this check box to indicate an unattended port on this 
device.

Port Information (Loop Start and Ground Start) (for FXO ports)

Port Direction Choose the direction of calls that pass through this port: 

• Inbound—Use for incoming calls only.

• Outbound—Use for outgoing calls.

• Both Ways—Use for inbound and outbound calls. 

Attendant DN Enter the directory number to which you want incoming calls 
routed; for example, zero or a directory number for an attendant.

Product-Specific Configuration

Model-specific configuration 
fields defined by the gateway 
manufacturer

The gateway manufacturer specifies the model-specific fields 
under product-specific configuration. Because they are 
dynamically configured, they can change without notice.

To view field descriptions and help for product-specific 
configuration items, click the “i” information icon to the right of 
the Product Specific Configuration heading to display help in a 
popup dialog box.

If you need more information, refer to the documentation for the 
specific gateway that you are configuring or contact the 
manufacturer.

Table 43-3 FXS/FXO Port Configuration Settings (continued)

Field Description
43-16
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 43      Gateway Template
Gateway Configuration Settings
Table 43-4 Digital Access T1 (T1-CAS) Configuration Settings

Field Description

End-Point Name For VG200 gateways, this display-only field contains a string that 
Cisco Unified CallManager generates that uniquely identifies the 
VG200 digital interface. 

For example:

S1/DS1-0@VG200-2

S1 indicates slot 1, DS1-0 designates the digital interface, and 
@VG200-2 designates the VG200 template name.

Description Enter a description that clarifies the purpose of the device.

Device Pool From the drop-down list box, choose the appropriate device pool. 

The device pool specifies a collection of properties for this device 
including CallManager Group, Date/Time Group, Region, and 
Calling Search Space for auto-registration of devices.

Call Classification This parameter determines whether an incoming call that is using 
this gateway is considered off the network (OffNet) or on the 
network (OnNet).

When the Call Classification field is configured as Use System 
Default, the setting of the Cisco Unified CallManager clusterwide 
service parameter, Call Classification, determines whether the 
gateway is OnNet or OffNet.

This field provides an OnNet or OffNet alerting tone when the call 
is OnNet or OffNet, respectively.

Media Resource Group List This list provides a prioritized grouping of media resource groups. 
An application chooses the required media resource, such as a 
Music On Hold server, from among the available media resources 
according to the priority order that is defined in a Media Resource 
List.

Calling Search Space From the drop-down list box, choose the appropriate calling search 
space. A calling search space designates a collection of route 
partitions that are searched to determine how a collected 
(originating) number should be routed.

You can configure the number of calling search spaces that display 
in this drop-down list box by using the Max List Box Items 
enterprise parameter. If more calling search spaces exist than the 
Max List Box Items enterprise parameter specifies, the ellipsis 
button (...) displays next to the drop-down list box. Click the ... 
button to display the Select Calling Search Space window. Enter a 
partial calling search space name in the List items where Name 
contains field. Click the desired calling search space name in the 
list of calling search spaces that displays in the Select item to use 
box and click OK.

Note To set the maximum list box items, choose System > 
Enterprise Parameters and choose Unified CMAdmin 
Parameters.
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AAR Calling Search Space Choose the appropriate calling search space for the device to use 
when automated alternate routing (AAR) is performed. The AAR 
calling search space specifies the collection of route partitions that 
are searched to determine how to route a collected (originating) 
number that is otherwise blocked due to insufficient bandwidth.

Location Choose the appropriate location for this device. The location 
specifies the total bandwidth that is available for calls to and from 
this location. A location setting of None means that the locations 
feature does not keep track of the bandwidth that this device 
consumes.

AAR Group Choose the automated alternate routing (AAR) group for this 
device. The AAR group provides the prefix digits that are used to 
route calls that are otherwise blocked due to insufficient bandwidth. 
An AAR group setting of None specifies that no rerouting of 
blocked calls will be attempted.

MLPP Domain From the drop-down list box, choose an MLPP domain to associate 
with this device. If you leave the value <None>, this device inherits 
its MLPP domain from the value that was set for the device’s device 
pool. If the device pool does not have an MLPP Domain setting, this 
device inherits its MLPP Domain from the value that was set for the 
MLPP Domain Identifier enterprise parameter.

Handle DTMF Precedence 
Signals

Check this box to enable this gateway to interpret special DTMF 
signals as MLPP precedence levels.

Load Information Enter the appropriate firmware load information for the gateway.

The values that you enter here override the default values for this 
gateway.

Port Selection Order Choose the order in which channels or ports are allocated for 
outbound calls from first (lowest number port) to last (highest 
number port) or from last to first.

Valid entries include TOP_DOWN (first to last) or BOTTOM_UP 
(last to first). If you are not sure which port order to use, choose 
TOP_DOWN.

Digit Sending Choose one of the following digit sending types for out-dialing:

• DTMF—Dual-tone multifrequency. Normal touchtone dialing

• MF—Multifrequency

• PULSE—Pulse (rotary) dialing

Table 43-4 Digital Access T1 (T1-CAS) Configuration Settings (continued)

Field Description
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Additional Topics

See the “Related Topics” section on page 43-36.

Field Descriptions for T1 PRI or E1 PRI Trunks on a Cisco VG200 Gateway 
Template

Table 43-5 provides field descriptions for adding or updating values for T1 PRI or E1 PRI trunks on a 
Cisco VG200 gateway.

Some fields display the values that were configured in Cisco Unified CallManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Consider an entry in fields 
without an asterisk as optional.

For related procedures, see the “Related Topics” section on page 43-36.

Network Locale From the drop-down list box, choose the locale that is associated 
with the gateway. The network locale identifies a set of detailed 
information to support the hardware in a specific location. The 
network locale contains a definition of the tones and cadences that 
the device uses in a specific geographic area.

Note Choose only a network locale that is already installed and 
supported by the associated devices. The list contains all 
available network locales for this setting, but not all are 
necessarily installed. If the device is associated with a 
network locale that it does not support in the firmware, the 
device will fail to come up.

SMDI Base Port Enter the first SMDI port number of the T1 span.

If you set this parameter to a nonzero value and this gateway 
belongs to an unknown type of route list, route group, or route list, 
hunting does not continue past this span.

Product-Specific Configuration

Model-specific configuration 
fields that the gateway 
manufacturer defines

The gateway manufacturer specifies the model-specific fields under 
product-specific configuration. Because they are dynamically 
configured, they can change without notice.

To view field descriptions and help for product-specific 
configuration items, click the “i” information icon to the right of the 
Product Specific Configuration heading to display help in a popup 
dialog box.

If you need more information, refer to the documentation for the 
specific gateway that you are configuring or contact the 
manufacturer.

Table 43-4 Digital Access T1 (T1-CAS) Configuration Settings (continued)

Field Description
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Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks

Field Description

Device Information

Endpoint Name For VG200 gateways, this display-only field 
contains a string that is generated by 
Cisco Unified CallManager that uniquely 
identifies the VG200 endpoint. 

For example:

S1/DS1-0@VG200-2

S1 indicates slot 1, DS1-0 designates the 
digital interface, and @VG200-2 designates 
the VG200 domain name.

Description Enter a description for the end-point that you 
are configuring.

Device Pool Choose the device pool for this group of 
gateways/ports. 

A device pool defines sets of common 
characteristics for devices, such as region, 
date/time group, Cisco Unified CallManager 
group, and calling search space for 
auto-registration.

Call Classification From the drop-down list box, choose an 
option to configure the device as on net, off 
net, or system default. 

If you chose ‘Use System Default’ at the 
device level, the system uses the value of the 
service parameter to determine whether the 
device is internal (on net) or external (off net).

Network Locale Choose the network locale that you want to 
associate with this gateway. 

The Network Locale comprises a set of tones 
and cadences that Cisco gateways and phones 
use when communicating with the PSTN and 
other networks in a specific geographical 
area. 

Media Resource Group List Choose the media resource group list 
(MRGL) for this group of gateways/ports.

An MRGL specifies a list of prioritized media 
resource groups. An application can choose 
required media resources from among the 
available ones according to the priority order 
that is defined in the MRGL.
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Location Choose the location for this group of 
gateways/ports. 

A location indicates the remote location that 
is accessed by using restricted bandwidth 
connections.

AAR Group Choose the automated alternate routing 
(AAR) group for this device. The AAR group 
provides the prefix digits that are used to 
route calls that are otherwise blocked due to 
insufficient bandwidth. An AAR group 
setting of None specifies that no rerouting of 
blocked calls will be attempted.

Load Information Enter the appropriate load information for the 
custom software for gateway. The values that 
you enter here override the default values for 
this gateway.

To use the default load, leave this field blank.

Transmit UTF-8 for Calling Party Name This device uses the user locale setting of the 
device’s device pool to determine whether to 
send Unicode and whether to translate 
received Unicode information.

For the sending device, if you check this 
check box and the user locale setting in the 
device’s device pool matches the terminating 
phone’s user locale, the device sends 
Unicode. If the user locale settings do not 
match, the device sends ASCII.

The receiving device translates incoming 
Unicode characters based on the user locale 
setting of the sending device’s device pool. If 
the user locale setting matches the 
terminating phone’s user locale, the phone 
displays the characters.

The phone may display junk characters if the 
two ends of the trunk configure user locales 
that do not belong to the same language 
group.

Multilevel Precedence and Preemption (MLPP) Information

MLPP Domain (e.g., “0000FF”) Enter a hexadecimal value for the MLPP 
domain that is associated with this device. 
Ensure that the value is blank or a value 
between 0 and FFFFFF.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Interface Information

PRI Protocol Type Choose the communications protocol for the 
span:

For E1 PRI spans, you have these options:

• PRI AUSTRALIAN—Australian ISDN 

• PRI EURO—European ISDN 

• PRI ISO QSIG E1—European inter-PBX 
signaling protocol 

For T1 PRI spans you have several options, 
depending on the carrier or switch:

• PRI 4ESS —AT&T interexchange 
carrier, Lucent Definity switch

• PRI 5E8 
Custom—Cisco Unified IP Phone, 
Nortel Meridian switch, Lucent Definity 
switches

• PRI 5E8 Teleos—Madge Teleos box

• PRI 5E8 Intecom—Intecom PBX

• PRI5E9—AT&T family local exchange 
switch or carrier 

• PRI NI2—Sprint local exchange switch 
or carrier 

• PRI DMS-100—Sprint local exchange 
switch or carrier 

• PRI DMS-250—MCI and Sprint local 
exchange switch or carrier 

• PRI ETSI SC—European local exchange 
carrier on T1; also, Japanese local 
exchange. 

• PRI ISO QSIG T1—Inter-PBX signaling 
protocol 

Protocol Side Choose the appropriate protocol side. This 
setting specifies whether the gateway 
connects to a Central Office/Network device 
or to a User device. 

Make sure that the two ends of the PRI 
connection use opposite settings. For 
example, if you connect to a PBX and the 
PBX uses User as its protocol side, choose 
Network for this device. Typically, use User 
for Central Office (CO) connections.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Channel Selection Order Choose the order in which channels or ports 
are enabled from first (lowest number port) to 
last (highest number port) or from last to first.

Valid entries include TOP_DOWN (last to 
first) or BOTTOM_UP (first to last). If you 
are not sure which port order to use, choose 
TOP_DOWN. The default specifies 
BOTTOM_UP.

Channel IE Type Choose one of the following values to specify 
whether channel selection is presented as a 
channel map or a slot map:

• Number—B-channel usage always 
presents a channel map format.

• Slotmap—B-channel usage always 
presents a slotmap format.

• Use Number When 1B—Channel usage 
presents a channel map for one B-channel 
but presents a slotmap if more than one 
B-channel exists. This represents the 
default value.

PUnified CMType Specify the digital encoding format. Choose 
one of the following formats:

• a-law: Use for Europe and the rest of the 
world.

• mu-law: Use for North America, 
Hong Kong, Taiwan, and Japan.

Delay for First Restart For this optional field, enter the rate, in 
1/8-second increments, at which the spans are 
brought in service. The delay occurs when 
many PRI spans are enabled on a system and 
the Inhibit Restarts at PRI Initialization check 
box is unchecked. The default value specifies 
32.

For example, set the first five cards to 0 and 
set the next five cards to 16. (Wait 2 seconds 
before bringing them in service.)

Delay Between Restarts Enter the time, in 1/8-second increments, 
between restarts. The delay occurs when a 
PRI RESTART is sent if the Inhibit Restarts 
check box is unchecked. The default value 
specifies 4.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Inhibit Restarts at PRI Initialization A restart message confirms the status of the 
ports on a PRI span. If RESTARTS are not 
sent, Cisco Unified CallManager assumes 
that the ports are in service. By default, the 
box gets checked.

When the D-channel successfully connects 
with another PRI trunk D-channel, it sends 
restarts when this box is unchecked.

Enable Status Poll Check the check box to enable the 
Cisco Unified CallManager advanced service 
parameter, Change B-Channel Maintenance 
Status. This service parameter allows you to 
take individual B-channels out of service 
while the B-channels are active.

Uncheck this check box to disable the service 
parameter Change B-Channel Maintenance 
Status.

Default leaves this field unchecked.

Unattended Ports Check this check box to indicate an 
unattended port on this device.

Call Routing Information - Inbound Calls

Significant Digits This field represents the number of final 
digits that a PRI span should retain on 
inbound calls. A trunk with significant digits 
enabled truncates all but the final few digits of 
the address that is provided on an inbound 
call.

Enable or disable this check box depending 
on whether you want to collect significant 
digits:

• If you do not check the check box, 
Cisco Unified CallManager does not 
truncate the inbound number.

• If you check the check box, you also need 
to choose the number of significant digits 
to collect. By default, the box remains 
checked.

Calling Search Space Choose the calling search space for this group 
of phones/ports.

A calling search space specifies the collection 
of Route Partitions that are searched to 
determine how a dialed number should be 
routed.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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AAR Calling Search Space Choose the appropriate calling search space 
for the device to use when it performs 
automated alternate routing (AAR). The AAR 
calling search space specifies the collection 
of route partitions that are searched to 
determine how to route a collected 
(originating) number that is otherwise 
blocked due to insufficient bandwidth.

Prefix DN For this optional field, enter the prefix digits 
that are appended to the digits that this trunk 
receives on incoming calls.

Cisco Unified CallManager adds prefix digits 
after first truncating the number in 
accordance with the Num Digits setting. 

Call Routing Information - Outbound Calls

Calling Line ID Presentation Choose whether you want the 
Cisco Unified CallManager to transmit or 
block the caller’s phone number. 

Choose Default if you do not want to change 
calling line ID presentation. Choose Allowed 
if you want Cisco Unified CallManager to 
send “Calling Line ID Allowed.” Choose 
Restricted if you want 
Cisco Unified CallManager to send “Calling 
Line ID Restricted.”

Calling Party Selection Any outbound call on a gateway can send 
directory number information. Choose which 
directory number is sent:

• Originator—Send the directory number 
of the calling device. This number serves 
as the default value.

• First Redirect Number—Send the 
directory number of the redirecting 
device.

• Last Redirect Number—Send the 
directory number of the last device that 
redirected the call.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Calling Party IE Number Type Unknown Choose the format for the type of number in 
calling party directory numbers.

Cisco Unified CallManager sets the calling 
directory number (DN) type. Cisco 
recommends that you do not change the 
default value unless you have advanced 
experience with dialing plans, such as NANP 
or the European dialing plan. You may need 
to change the default in Europe because 
Cisco Unified CallManager does not 
recognize European national dialing patterns. 
You can also change this setting when you are 
connecting to PBXs that are using routing as 
a non-national type number. 

Choose one of the following options:

• CallManager—The 
Cisco Unified CallManager sets the 
directory number type. This option 
represents the default value.

• International—Use when you are dialing 
outside the dialing plan for your country. 

• National—Use when you are dialing 
within the dialing plan for your country. 

• Unknown—This option specifies that the 
dialing plan is unknown.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Called Party IE Number Type Unknown Choose the format for the type of number in 
called party directory numbers. 
Cisco Unified CallManager sets the called 
directory number (DN) type. Cisco 
recommends that you do not change the 
default value unless you have extensive 
experience with dialing plans, such as NANP 
or the European dialing plan. You may need 
to change the default in Europe because 
Cisco Unified CallManager does not 
recognize European national dialing patterns. 
You can also change this setting when you are 
connecting to PBXs that use routing as a 
non-national type number.

Choose one of the following options:

• CallManager—For the default setting, 
the Cisco Unified CallManager sets the 
directory number type. 

• International—Use when you are dialing 
outside the dialing plan for your country. 

• National—Use when you are dialing 
within the dialing plan for your country. 

• Unknown—This option specifies that the 
dialing plan is unknown.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Called Numbering Plan Choose the format for the numbering plan in 
called party directory numbers. 

Cisco Unified CallManager sets the called 
DN numbering plan. Cisco recommends that 
you do not change the default value unless 
you have extensive experience with dialing 
plans, such as NANP or the European dialing 
plan. You may need to change the default in 
Europe because Cisco Unified CallManager 
does not recognize European national dialing 
patterns. You can also change this setting 
when you are connecting to PBXs that are 
using routing as a non-national type number. 

Choose one of the following options:

• CallManager—For the default setting, 
the Cisco Unified CallManager sets the 
Numbering Plan in the directory number.

• ISDN—Use when you are dialing outside 
the dialing plan for your country. 

• National Standard—Use when you are 
dialing within the dialing plan for your 
country. 

• Private—Use when you are dialing 
within a private network. 

• Unknown—This option specifies that the 
dialing plan is unknown.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Calling Numbering Plan Choose the format for the numbering plan in 
calling party directory numbers.

Cisco Unified CallManager sets the calling 
DN numbering plan. Cisco recommends that 
you do not change the default value unless 
you have extensive experience with dialing 
plans, such as NANP or the European dialing 
plan. You may need to change the default in 
Europe because Cisco Unified CallManager 
does not recognize European national dialing 
patterns. You can also change this setting 
when you are connecting to PBXs that are 
using routing as a non-national type number. 

Choose one of the following options:

• CallManager—For the default setting, 
the Cisco Unified CallManager sets the 
Numbering Plan in the directory number. 

• ISDN—Use when you are dialing outside 
the dialing plan for your country. 

• National Standard—Use when you are 
dialing within the dialing plan for your 
country. 

• Private—Use when you are dialing 
within a private network. 

• Unknown—This option specifies that the 
dialing plan is unknown.

Number of Digits to Strip Choose the number of digits, from 0 to 32, to 
strip on outbound calls. The default value 
specifies 0.

For example, 8889725551234 is dialed; the 
number of digits to strip is 3. In this example, 
Cisco Unified CallManager strips 888 from 
the outbound number.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Caller ID DN Enter the pattern, from 0 to 24 digits, that you 
want to use for caller ID. 

For example, in North America

• 555XXXX = Variable caller ID, where X 
equals an extension number. The CO 
appends the number with the area code if 
you do not specify it. 

• 5555000 = Fixed caller ID, for when you 
want the Corporate number to be sent 
instead of the exact extension from which 
the call is placed. The CO appends the 
number with the area code if you do not 
specify it. 

SMDI Base Port Enter the first SMDI port number of the T1 
span.

PRI Protocol Type Specific Information

Display IE Delivery For this optional field, check the check box to 
enable delivery of the display information 
element (IE) in SETUP and CONNECT 
messages for the calling and called party 
name delivery service. By default, the box 
remains unchecked.

Redirecting Number IE Delivery—Outbound For this optional field, check the check box to 
include the Redirecting Number IE in the 
SETUP message to indicate the first 
redirecting number and the redirecting reason 
of the call when a call is forwarded. By 
default, the box remains unchecked.

This setting applies to the SETUP message 
only on all protocols for digital access 
gateways. 

Redirecting Number IE Delivery—Inbound For this optional field, check the check box to 
include the Redirecting Number IE in the 
SETUP message to indicate the first 
redirecting number and the redirecting reason 
of the call when a call is forwarded. By 
default, the box remains unchecked.

This setting applies to the SETUP message 
only on all protocols for digital access 
gateways. 

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Send Extra Leading Character in Display IE Check this check box to include a special 
leading character byte (non ASCII, 
nondisplayable) in the DisplayIE field. 

Uncheck this check box to exclude this 
character byte from the DisplayIE field.

This check box only applies to the DMS-100 
protocol and the DMS-250 protocol.

Default leaves this setting disabled 
(unchecked).

Setup of Non-ISDN Progress Indicator IE 
Enable

For this optional field, you may need to 
specify a value in this field to force ringback 
on some PBXs.

The default specifies unchecked. Check this 
check box only if users are not receiving 
ringback tones on outbound calls.

When this setting is enabled, 
Cisco Unified CallManager sends Q.931 
setup messages out digital (that is, 
non-H.323) gateways with the Progress 
Indicator field set to non-ISDN.

This message notifies the destination device 
that the Cisco Unified CallManager gateway 
is non-ISDN and that the destination device 
should play inband ringback.

This problem usually associates with 
Cisco Unified CallManagers that connect to 
PBXs through digital gateways.

MCDN Channel Number Extension Bit Set to 
Zero

This field applies to DMS-100 protocol only. 
Check the check box to indicate that an 
Interface Identifier is present. By default, the 
box remains unchecked.

Send Calling Name in Facility IE This field applies to DMS-100 protocol only. 
Enter the value that you obtained from the 
PBX provider. Valid values range from 0 to 
255.

Interface Identifier Present This field applies to DMS-100 protocol only. 
Check the check box to indicate that an 
Interface Identifier is present. By default, the 
box remains unchecked.

Interface Identifier Value This field applies to DMS-100 protocol only. 
Enter the value that you obtained from the 
PBX provider. Valid values range from 0 to 
255.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Port Configuration Settings
See the following sections for tables that list detailed descriptions for all port type configuration fields:

• POTS Port Configuration Settings, page 43-33

• Field Descriptions for E & M Ports for Digital Access T1, page 43-34

For detailed information about gateway configuration settings, see the Gateway Configuration Settings, 
page 43-9.

Connected Line ID Presentation Choose whether you want the 
Cisco Unified CallManager to allow or block 
the connected party’s phone number.

Choose Default if you do not want to change 
the connected line ID presentation. Choose 
Allowed if you want 
Cisco Unified CallManager to send 
“Connected Line ID Allowed.” Choose 
Restricted if you want 
Cisco Unified CallManager to send 
“Connected Line ID Restricted.”

UUIE Configuration

Passing Precedence Level Through UUIE Check this check box to enable passing MLPP 
information through the PRI 4ESS UUIE 
field. This box is used for working along with 
DRSN switch.

The system makes this check box available 
only if the PRI Protocol Type value of 
PRI 4ESS is specified for this gateway.

The default value specifies unchecked.

Security Access Level Enter the value for the security access level. 
Valid values include 00 through 99. The 
system makes this field available only if the 
Passing Precedence Level Through UUIE 
check box is checked. The default value 
specifies 2.

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under product-specific 
configuration. To view field descriptions and help for product-specific configuration items, 
click the i information icon to the right of the Product Specific Configuration heading to 
display help in a popup window. If you need more information, refer to the documentation for 
the specific gateway that you are configuring.

Table 43-5 Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description
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Additional Topics

See the “Related Topics” section on page 43-36.

POTS Port Configuration Settings
Table 43-6 describes the POTS port configuration settings. For related procedures, see the “Related 
Topics” section on page 43-36.

Table 43-6 POTS Port Configuration Settings

Field Description

Port Type From the Port Type drop-down list box, choose POTS.

Beginning Port Number

Ending Port Number

Choose whether you want to add and configure all available ports, a 
single port, or a range of ports by setting values for the Beginning 
Port Number and Ending Port Number fields:

• To specify a range of ports, choose appropriate values for 
Beginning Port Number and Ending Port Number.

• To create a single port, choose the same number in the Beginning 
Port Number and Ending Port Number fields.

• To add all available ports, choose All Ports for both the 
Beginning Port Number and Ending Port Number fields.

Port Direction Choose the direction of calls that pass through this port: 

• Inbound—Use for incoming calls only. 

• Outbound—Use for outgoing calls. 

• Bothways—Use for inbound and outbound calls (default).

Audio Signal Adjustment into 
IP Network

This field specifies the gain or loss that is applied to the received audio 
signal relative to the port application type.

Note Improper gain setting may cause audio echo. Use caution 
when you are adjusting this setting.

Audio Signal Adjustment 
from IP Network

This field specifies the gain or loss that is applied to the transmitted 
audio signal relative to the port application type.

Note Improper gain setting may cause audio echo. Use caution 
when you are adjusting this setting.

Prefix DN Enter the prefix digits that are appended to the digits that this trunk 
receives on incoming calls.

The Cisco Unified CallManager adds prefix digits after it truncates 
the number in accordance with the Num Digits setting. 

Num Digits Enter the number of significant digits to collect, from 0 to 32.

Cisco Unified CallManager counts significant digits from the right 
(last digit) of the number that is called. 

Use this field for the processing of incoming calls and to indicate the 
number of digits starting from the last digit of the called number that 
are used to route calls that are coming into the PRI span. See Prefix 
DN.
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Additional Information

See the “Related Topics” section on page 43-36.

Field Descriptions for E & M Ports for Digital Access T1
Use the following field descriptions when you are adding or updating values for E&M ports for the T1 
CAS trunks on a Cisco VG200 gateway.

Some fields display the values that were configured in Cisco Unified CallManager Administration.

In the BAT user interface, field names that have an asterisk require an entry. Consider an entry in fields 
without an asterisk as optional.

Table 43-7 describes the E & M port configuration settings. For related procedures, see the “Related 
Topics” section on page 43-36.

Expected Digits Enter the number of digits that are expected on the inbound side of the 
trunk. For this rarely used field, leave zero as the default value if you 
are unsure.

Call Restart Timer 
(1000-5000 ms)

Call Restart Timer (1000-5000 ms); ms indicates time in milliseconds.

Offhook Validation Timer 
(100-1000 ms)

Offhook Validation Timer (100-1000 ms); ms indicates time in 
milliseconds.

Onhook Validation Timer 
(100-1000 ms)

Onhook Validation Timer (100-1000 ms); ms indicates time in 
milliseconds.

Hookflash Timer (100-1500 
ms)

Hookflash Timer (100-1500 ms); ms indicates time in milliseconds.

SMDI Port Number (0-4096) Use this field for analog access ports that connect to a 
voice-messaging system. 

Set the SMDI Port Number equal to the actual port number on the 
voice-messaging system to which the analog access port connects. 

Note Voice-mail logical ports typically must match physical ports 
for the voice-messaging system to operate correctly.

Product-Specific Configuration

Model-specific configuration 
fields that the gateway 
manufacturer defines

The gateway manufacturer specifies the model-specific fields under 
product-specific configuration. Because they are dynamically 
configured, they can change without notice.

To view field descriptions and help for product-specific configuration 
items, click the “i” information icon to the right of the Product 
Specific Configuration heading to display help in a popup dialog 
box.

If you need more information, refer to the documentation for the 
specific gateway that you are configuring or contact the manufacturer.

Table 43-6 POTS Port Configuration Settings (continued)

Field Description
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Table 43-7 E & M Port Configuration Settings

Field Description

Port Type From the Port Type drop-down list box, choose EANDM.

Beginning Port Number

Ending Port Number

Choose whether you want to add and configure all available ports, a 
single port, or a range of ports by setting values for the Beginning 
Port Number and Ending Port Number fields:

• To specify a range of ports, choose appropriate values for 
Beginning Port Number and Ending Port Number.

• To create a single port, choose the same number in the Beginning 
Port Number and Ending Port Number fields.

• To add all available ports, choose All Ports for both the 
Beginning Port Number and Ending Port Number fields.

Port Details

Port Direction Choose the direction of calls that pass through this port: 

• Inbound—Use for incoming calls only.

• Outbound—Use for outgoing calls.

• Both Ways—Use for inbound and outbound calls.

Calling Party Selection Any outbound call on a gateway can send directory number 
information. Choose which directory number is sent:

• Originator—Send the directory number of the calling device.

• First Redirect Number—Send the directory number of the 
redirecting device. 

• Last Redirect Number—Send the directory number of the last 
device to redirect the call.

• First Redirect Number (External)—Send the directory number of 
the first redirecting device with the external phone mask applied.

• Last Redirect Number (External)—Send the directory number of 
the last redirecting device with the external phone mask applied.

Caller ID Type This description will be provided in Release 5.0(2) of 
Cisco Unified CallManager Administration.

Caller ID DN Enter the pattern that you want to use for calling line ID, from 0 to 24 
digits. 

For example, in North America: 

• 555XXXX = Variable calling line ID, where X equals an 
extension number. The CO appends the number with the area code 
if you do not specify it. 

• 5555000 = Fixed calling line ID, where you want the Corporate 
number to be sent instead of the exact extension from which the 
call is placed. The CO appends the number with the area code if 
you do not specify it.
43-35
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 43      Gateway Template
Related Topics
Related Topics
• Adding Cisco Gateways, page 43-1

• Finding a Gateway Template, page 43-2

• Adding or Editing a Gateway Template, page 43-3

• Gateway Configuration Settings, page 43-9

• Port Configuration Settings, page 43-32

• Deleting Cisco Gateways, page 45-1

• Generating Reports for Cisco Gateways, page 46-1

Prefix DN Enter the prefix digits that are appended to the called party number on 
incoming calls.

The Cisco Unified CallManager adds prefix digits after first 
truncating the number in accordance with the Num Digits setting. 

Num Digits Choose the number of significant digits to collect, from 0 to 32. 
Cisco Unified CallManager counts significant digits from the right 
(last digit) of the number that is called. 

Use this field if you check the Sig Digits check box. Use this field for 
the processing of incoming calls and to indicate the number of digits 
starting from the last digit of the called number that are used to route 
calls that are coming into the PRI span. See Prefix DN and Sig Digits.

Expected Digits Enter the number of digits that are expected on the inbound side of the 
trunk. If you are unsure, leave zero as the default value for this rarely 
used field.

Unattended Port Check this check box to indicate an unattended port on this device.

Product-Specific Configuration

Model-specific configuration 
fields that the gateway 
manufacturer defines

The gateway manufacturer specifies the model-specific fields under 
product-specific configuration. Because they are dynamically 
configured, they can change without notice.

To view field descriptions and help for product-specific configuration 
items, click the “i” information icon to the right of the Product 
Specific Configuration heading to display help in a popup dialog 
box.

If you need more information, refer to the documentation for the 
specific gateway that you are configuring or contact the manufacturer.

Table 43-7 E & M Port Configuration Settings (continued)

Field Description
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Inserting Gateways

Use the following topics to insert gateways into Cisco Unified CallManager database:

• Creating CSV Data Files for Cisco VG200 Gateways, page 44-1

• Creating the CSV Data File for Cisco Catalyst 6000 (FXS) Ports, page 44-3

• Inserting Gateways to Cisco Unified CallManager, page 44-4

Creating CSV Data Files for Cisco VG200 Gateways
You can use the BAT spreadsheet to create a CSV data file for VG200 gateways and ports. See the 
following section:

• Using the BAT Spreadsheet for CSV Data Files for Cisco VG200 T1 CAS, T1 PRI, E1 PRI, FXS, 
or FXO Gateways and Ports, page 44-1

You can use a text editor to create a text file in CSV format for VG200 gateways and ports. See the 
following section:

• Creating a Text-Based CSV File for Cisco VG200 Gateways, page A-13

Using the BAT Spreadsheet for CSV Data Files for Cisco VG200 T1 CAS, T1 PRI, 
E1 PRI, FXS, or FXO Gateways and Ports

Use the BAT spreadsheet to create the CSV data file that contains the details, such as domain name, 
MGCP description, and port identifier, for individual T1 CAS, T1 PRI, E1 PRI, FXS or FXO ports.

For information about installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet 
for Gathering Data” section on page 1-8.

To create a text-based CSV data file for VG200 gateways, see the “T1 CAS, T1 PRI, or E1 PRI Trunks 
File Format” section on page A-14 for information and examples.

To create a text-based CSV data file for VG200 gateways, see the “FXO or FXS Trunks CSV File 
Format” section on page A-14 for information and examples.
44-1
allManager Bulk Administration Guide



Chapter 44      Inserting Gateways
Creating CSV Data Files for Cisco VG200 Gateways
Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xlt file 

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 Click the VG200 T1-Pri T1-Cas E1-Pri FXSFXO tab.

Step 4 For T1 CAS endpoints only, scroll to the right until you see the Number of Port Identifiers field. Enter 
the number of port identifiers that you want to add for each Cisco VG200 gateway. If you want only one 
port identifier, skip this step.

Step 5 In each row, provide the information for the following fields:

• MGCP Domain Name—Enter a name, from 1 to 64 characters that identifies the gateway. Use the 
Domain Name System (DNS) host name if it is configured to resolve correctly; otherwise, use the 
host name as defined on the Cisco MGCP gateway.

The host name must match exactly the host name that is configured on the Cisco IOS gateway. For 
example, if the host name is configured on the gateway to resolve to vg200-1 and the IP domain 
name is not configured, enter the host name in this field (in this case, vg200-1). If the host name is 
configured on the gateway as vg200-1 and the IP domain name is configured on the gateway as 
cisco.com, enter vg200-1.cisco.com in this field.

• MGCP Description—Enter a description, up to 100 characters for the gateway. Use a specific 
description that helps you locate the gateway.

• Port Description—Enter a description for port 1, up to 50 characters. Use a description to help 
identify the port in a list of ports. This applies to the description field for port 2 through port 4.

• Port Directory Number—Enter the directory number, up to 24 numerals and special characters, for 
this port. This applies to the directory number field for port 2 through port 4.

Note Port 1 Directory Number and Partition fields are required for FXS ports only. For FXO ports, 
leave these fields blank.

• Slot—Enter the slot number that you are trying to configure. For VG200, it is always 1.

• Subunit—Enter an integer for the subunit value

• Port Number—Enter an integer for the Port Number.

Note For T1 CAS only, the ports that you specify here must be the same ports that you specified in 
the VG200 template. In the CSV data file, you can specify none, some, or all ports that were 
configured in the template. Do not configure any ports in the CSV data file that were not also 
configured in the template, or an error will result when you attempt to insert the BAT VG200 
template and the CSV file.

For example, if you configured ports 1,2,3, and 4 in the template, you could configure none of 
the ports, or ports 1, 2, 3, and 4, or only ports 1 and 2 in the CSV file, and the insertion would 
be accepted. But if you configured ports 5 and 6 in the CSV file when they are not configured in 
the template, you will receive an insertion error in BAT.

Step 6 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles (or to your choice of another existing folder) as

VG200Gateways#timestamp.txt
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where “timestamp” represents the precise date and time that the file was created.

Tip If you enter a comma in one of the fields, BAT.xlt encloses that field entry in double quotes when 
you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the end of the file. 
Data that is entered after a blank line does not get converted to the BAT format.

You must upload the CSV data file to the first node of the Cisco Unified CallManager server, so BAT 
can access the data input file. For more information, see “Uploading and Downloading Files” section on 
page 2-1.

Note For information on how to read the exported CSV data file, click the link to View Sample File 
in the Insert Gateways window in BAT.

Additional Information

See the “Related Topics” section on page 44-5.

Creating the CSV Data File for CiscoCatalyst 6000 (FXS) Ports
To create the CSV data file that contains the details for each individual Cisco Catalyst 6000 (FXS) port, 
such as directory number, description of port, use the BAT spreadsheet.

For information about installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet 
for Gathering Data” section on page 1-8.

To create a text-based CSV data file for Catalyst 6000 (FXS) ports, see the “Creating a Text-Based CSV 
File for Cisco Catalyst 6000 FXS Ports” section on page A-15 for information and examples.

Procedure

Step 1 To open the BAT Spreadsheet, locate and double-click BAT.xlt file. 

Step 2 When prompted, click Enable Macros to use the spreadsheet capabilities.

Step 3 Click the Catalyst 6000 (FXS) Ports tab.

Step 4 Enter information for each port record in a row. Complete all mandatory fields and any relevant, optional 
fields. Each column heading specifies the length of the field.

• MAC Address—Enter the 12-character MAC address for the gateway.

• Port Number—Enter the numeric port number (1 through 24) that you want to add to the gateway.

• Directory Number—Enter a directory number, up to 24 numerals and special characters, for this 
port. You must enter a directory number if you have specified a partition.(Optional) 

• Partition—Enter the route partition, up to 50 characters, to which you want this port to belong. Do 
not specify a partition unless you also have specified a directory number. (Optional) 
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Caution The system treats blank rows in the spreadsheet as End of File and discards subsequent records. 

Step 5 To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles\ (or to your choice of another existing folder).

You must upload the CSV data file to the first node of the Cisco Unified CallManager server, so BAT 
can access the data input file. For more information, see “Uploading and Downloading Files” section on 
page 2-1.

Note For information on how to read the exported CSV data file, click the link to View Sample File 
in the Insert Gateways window in BAT.

Additional Information

See the “Related Topics” section on page 44-5.

Inserting Gateways to Cisco Unified CallManager
To add Cisco gateways and ports to Cisco Unified CallManager, use this procedure.

Before You Begin

• If you want to insert a Cisco VG200 gateway, you must have a Cisco VG200 gateway template for 
the trunks or ports and a CSV data file for the VG200 gateway ports. See “Creating a Cisco VG200 
Gateway Template” section on page 43-4 and “Creating CSV Data Files for Cisco VG200 
Gateways” section on page 44-1.

• If you want to insert a Cisco Catalyst 6000 Ports, you must have a Cisco Catalyst 6000 Ports 
template and a CSV data file that contains port details for this bulk transaction. See “Creating a 
Cisco Catalyst 6000 (FXS) Gateway Template” section on page 43-8 and “Creating the CSV Data 
File for Cisco Catalyst 6000 (FXS) Ports” section on page 44-3.

Procedure

Step 1 Choose Bulk Administration > Gateways > Insert Gateways. The Select the Gateway window 
displays. 

Step 2 Choose type of gateway you want to insert from the Gateway Type drop-down list box. The Insert 
Gateway Configuration window displays.

Step 3 In the File Name field drop-down list box, choose the name of the CSV data file that contains the Cisco 
VG200 gateway information to be added. 

Step 4 In the Gateway Template Name field, choose the name of the VG200 or the FXS gateway template that 
you created for this type of bulk transaction. 

Step 5 In the Job Information area, enter the Job description.

Step 6 Click the Run Immediately radio button to insert the gateway immediately or, click Run Later to insert 
at a later time.
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Step 7 Click Submit to create a job for inserting the gateways. 

Step 8 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Information

See the “Related Topics” section on page 44-5.

Related Topics
• Creating CSV Data Files for Cisco VG200 Gateways, page 44-1

• Creating the CSV Data File for Cisco Catalyst 6000 (FXS) Ports, page 44-3

• Inserting Gateways to Cisco Unified CallManager, page 44-4
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Deleting Cisco Gateways

To locate the records that you want to delete, you must define a query filter. Use the following procedure 
to delete a group of gateways from the Cisco Unified CallManager database. 

Using the Delete Gateway Configuration window, you can only delete Cisco VG200 and 
Cisco Catalyst 6000 gateways.

Deleting Cisco Gateways
To delete gateways from Cisco Unified CallManager, use the following procedure.

Procedure

Step 1 Choose Bulk Administration > Gateways > Delete Gateways.

The Find and List Gateway Configuration window displays.

Step 2 From the Find Gateways where drop-down list box, choose one of the following options:

• Name

• Description

• DN/Route Pattern

• Calling Search Space

• Device Pool

• Device Type

Step 3 From the second Find Gateways Report where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 From the third drop-down list box, choose Show to display the associated endpoints.

Step 5 Specify the appropriate search text, if applicable.
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Tip To find all gateways that are registered in the database, click Find without entering any search 
text.

Step 6 To further define your query, you can choose AND or OR to add multiple filters and repeat steps 2 
through 5.

Step 7 Click Find.

A list of discovered templates displays by:

• Device Name

• Description

• Device Pool

• Status

• IP address

Step 8 In the Job Information area, enter the Job description.

Step 9 Click the Run Immediately radio button to delete gateways immediately or, click Run Later to delete 
them at a later time.

Step 10 Click Submit to create a job for deleting the gateway records. 

Step 11 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Caution If you do not enter any information in the query text box, the system deletes all gateway records. Because 
the delete action is final, you cannot retrieve deleted records.

Additional Topics

See the “Related Topics” section on page 45-2.

Related Topics
• Deleting Cisco Gateways, page 45-1

• Inserting Gateways to Cisco Unified CallManager, page 44-4

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
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Generating Reports for Cisco Gateways

Reports for VG200 Gateways have a fixed format. You can generate a report for all VG200 Gateways or 
for a limited set of gateways.

Note The system does not make reports available for the Catalyst 6000 (FXS) gateway.

Generating Reports for Cisco Gateways
To generate a report for VG200 Gateways, use this procedure.

Procedure

Step 1 Choose Bulk Administration > Gateways > Generate Gateway Reports.

The Find and List Gateway window displays.

Step 2 From the Find Gateways Report where drop-down list box, choose one of the following options:

• Name

• Description

• DN/Route Pattern

• Calling Search Space

• Device Pool

• Device Type

Step 3 From the second Find Gateways Report where drop-down list box, choose one of the following criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 From the third drop-down list box, choose Show to display the associated endpoints.

Step 5 Specify the appropriate search text, if applicable.
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Tip To find all gateways that are registered in the database, click Find without entering any search 
text.

Step 6 To further define your query, you can choose AND or OR to add multiple filters and repeat steps 2 
through 5.

Step 7 Click Find.

A list of discovered templates displays by:

• Device Name

• Description

• Device Pool

• Status

• IP address

Step 8 Click Next to choose details for your type of report. The Gateway Report Configuration window displays 
and shows the query that you chose. If you want to change the type of query, click Back.

Step 9 In the File Name field, enter your name for this report (required). 

Step 10 Choose the file format from the drop-down list box.

Step 11 In the Job Information area, enter the Job description.

Step 12 Click the Run Immediately radio button to generate a report immediately or, click Run Later to generate 
reports at a later time.

Step 13 Click Submit to create a job for deleting assistants. 

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

You can search and download the report file using the Upload/Download Files option in the Bulk 
Administration menu. See Chapter 2, “Uploading and Downloading Files.”

Additional Information

See the “Related Topics” section on page 46-3.

Viewing Report Log Files
Cisco Unified CallManager Bulk Administration (BAT) generates log files for each report transaction 
and stores them on the first node of Cisco Unified CallManager server. You can find the link to log files 
for this job from the Job configuration window for this job. For more details, see Chapter 51, 
“Scheduling Jobs.”

Additional Information

See the “Related Topics” section on page 46-3.
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Related Topics
• Generating Reports for Cisco Gateways, page 46-1

• Viewing Report Log Files, page 46-2

• Uploading and Downloading Files, page 2-1

• Scheduling Jobs, page 51-1

• BAT Log Files, page 54-3
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Working with Client Matter Codes and Forced 
Authorization Codes

Forced Authorization Codes (FAC) and Client Matter Codes (CMC) allow you to manage call access 
and accounting. CMC assists with call accounting and billing for billable clients, while Forced 
Authorization Codes regulate the types of calls that certain users can place.

Client Matter Codes force the user to enter a code to specify that the call relates to a specific client 
matter. You can assign client matter codes to customers, students, or other populations for call 
accounting and billing purposes. The Forced Authorization Codes feature forces the user to enter a valid 
authorization code before the call completes.

The CMC and FAC features require that you make changes to route patterns and update your dial plan 
documents to reflect that you enabled or disabled FAC and/or CMC for each route pattern.

This chapter contains information on the following topics:

• CMC and FAC Configuration Checklist, page 47-1

• Important BAT Considerations, page 47-2

• Creating a CSV File by Using BAT.xlt, page 47-3

• Using a Text Editor to Create the CSV Data File for Client Matter Codes and Forced Authorization 
Codes, page 47-4

• Editing an Existing CMC or FAC CSV File, page 47-4

• Deleting Code Settings, page 48-1

• CMC and FAC CSV File Settings, page 47-5

• Using BAT to Update the Cisco Unified CallManager Database, page 47-6

CMC and FAC Configuration Checklist
Table 47-1 provides steps in the order in which you should use Cisco Unified CallManager Bulk 
Administration (BAT) to implement CMC and FAC. For more information about related procedures, see 
the “Related Topics” section on page 47-7.
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Important BAT Considerations
Before you use BAT to configure CMC or FAC, review the following information:

• Create separate CSV files for CMC and FAC. Do not mix the two features in a single CSV file.

• When you add CMC or FAC settings for the first time, you can create a CSV file through BAT.xlt 
or create a custom text-based CSV file.

• To update, delete, or add more CMC or FAC settings (not first time), you can edit an existing CSV 
file or create a custom text-based CSV file.

• In the file/spreadsheet, do not enter two or more codes (and corresponding settings) on a single line. 
Designate a single line for each code (and corresponding setting). For example, use the following 
format when you enter codes for Forced Authorization Codes:

(Authorization Code, Authorization Code Name, Authorization Level)

1234,John Smith,20

Table 47-1 Cisco CMC and FAC Configuration Checklist

Configuration Steps Related Procedures and Topics

Step 1 Review important BAT information and 
general information about the CMC and 
FAC features.

• Important BAT Considerations, page 
47-2

• Cisco Unified CallManager Features 
and Services Guide

Step 2 Create a CSV file for CMC or FAC and 
enter the CMC and FAC configuration 
information.

• Creating a CSV File by Using BAT.xlt, 
page 47-3

• Using a Text Editor to Create the CSV 
Data File for Client Matter Codes and 
Forced Authorization Codes, page 47-4

• CMC and FAC CSV File Settings, page 
47-5

Step 3 To update the Cisco Unified CallManager 
database, insert the CSV file in BAT.

• Using BAT to Update the 
Cisco Unified CallManager Database, 
page 47-6

• BAT Settings for Updating the 
Cisco Unified CallManager Database, 
page 47-7

Step 4 Enable FAC or CMC by adding or updating 
route patterns in 
Cisco Unified CallManager 
Administration.

• Cisco Unified CallManager 
Administration Guide

• Cisco Unified CallManager Features 
and Services Guide

Step 5 Update your dial plan documents or keep a 
printout of the BAT CSV file with your dial 
plan documents.

Refer to your dial plan documents.

Step 6 Provide all necessary information, for 
example, codes, to users and explain how 
the features work.

Cisco Unified CallManager Features and 
Services Guide
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1235,Lisa Mendez,10

5551,Debbie Dunn,30

• Deleting information from a file and leaving the information blank does not remove the information 
from the Cisco Unified CallManager database; in other words, a blank value does not overwrite an 
existing value in the database. Updating the values overwrites the existing value in the database.

• Make sure that you upload the appropriate CSV files to the first node of the 
Cisco Unified CallManager server. For more information, see the“Uploading a File” section on 
page 2-3.

• Any time that you create or change a CSV file, you must insert the CSV file in BAT, as described 
in “Using BAT to Update the Cisco Unified CallManager Database” section on page 47-6.

Creating a CSV File by Using BAT.xlt
To create a CSV file for CMC or FAC by using BAT.xlt, perform the following procedure:

Procedure

Step 1 The BAT.xlt file exists on the first node of the Cisco Unified CallManager server; however, you 
normally do not have Microsoft Excel installed on the server. In that case, you must copy the file from 
the first node and move it to the local machine, which must have Microsoft Excel installed.

Step 2 Download BAT.xlt file from the server. See the “Downloading a File” section on page 2-2 to a local 
machine where Microsoft Excel is installed.

Step 3 In Microsoft Excel, open BAT.xlt. When, prompted, click Enable Macros.

Tip Remember that you must create two separate CSV files, one for CMC and one for FAC.

Step 4 Click one of the following tabs:

• Insert CMC—If you are creating a CMC CSV file

• Insert FAC—If you are creating a FAC CSV file

Step 5 Use Table 47-2 to enter CMC or FAC settings in the columns.

Step 6 Repeat Step 5 until you enter all codes.

Step 7 To transfer the Excel spreadsheet format to a CSV file, click Export to BAT Format. 

The system automatically saves CSV files to C:\XlsDatafiles on the local machine. Click Browse to 
choose a different location.

Step 8 Upload the CSV files to the first node of the Cisco Unified CallManager server. For more information, 
see “Uploading a File” section on page 2-3.

Step 9 You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using BAT to Update the 
Cisco Unified CallManager Database” section on page 47-6.

Additional Topics

See the “Related Topics” section on page 47-7.
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Using a Text Editor to Create the CSV Data File for Client Matter 
Codes and Forced Authorization Codes

You can create the CSV data file by using lines of ASCII text with values separated by commas. The 
comma separated values (CSV) file provides textual information in tabular form. For more information 
about text-based CSV files for client matter codes and forced authorization codes, see the “Creating a 
Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes” section on 
page A-16.

Additional Topics

See the “Related Topics” section on page 47-7.

Editing an Existing CMC or FAC CSV File
You update existing codes by manually updating an existing CSV file in Notepad or by creating a new 
file in Notepad.

Perform the following procedure:

Procedure

Step 1 To edit an existing CSV file where you previously inserted codes, download the CSV files from the first 
node of the Cisco Unified CallManager server. For more information, see “Uploading a File” section on 
page 2-3.

Step 2 In Notepad, open and edit the existing CSV file; delete existing settings, add new codes, or update 
existing settings by using the text-based representation in Table 47-2.

If you are updating a CMC CSV file, for example, you may enter 5555,Acme Toys, where 5555 equals 
the mandatory client matter code, and Acme Toys equals the description.

If you are updating a FAC CSV file, for example, you may enter 1234,John Smith,20, where 1234 equals 
the forced authorization code, John Smith equals the authorization code name, and 20 equals the 
authorization level.

Caution If you add new codes at the same time that you update them, make sure that you enter all required 
information. You can change any part of an existing record, but you must include the code; for example, 
the forced authorization code or client matter code. Deleting information and leaving it blank does not 
remove the information from the database; a blank value does not overwrite an existing value in the 
database, but, updating the value, for example, to Acme Toys, Inc. or John L. Smith from the preceding 
examples, overwrites the existing value in the database.

Step 3 Upload the CSV files to the first node of the Cisco Unified CallManager server. For more information, 
see “Uploading a File” section on page 2-3.

Step 4 You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using BAT to Update the 
Cisco Unified CallManager Database” section on page 47-6.
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Additional Topics

See the “Related Topics” section on page 47-7.

CMC and FAC CSV File Settings
Use Table 47-2 in conjunction with the following sections:

• Creating a CSV File by Using BAT.xlt, page 47-3

• Using a Text Editor to Create the CSV Data File for Client Matter Codes and Forced Authorization 
Codes, page 47-4

• Editing an Existing CMC or FAC CSV File, page 47-4

• Deleting Code Settings, page 48-1

For more information about related procedures, see the “Related Topics” section on page 47-7.

Table 47-2 Configuration Settings for CMC and FAC

Setting/Column Description

For CMC CSV file

Client Matter Code Enter a unique code of no more than 16 digits that the 
user will enter when placing a call. The client matter 
code displays in the CDRs for calls that use this 
code.

Description Enter a name of no more than 50 characters. This 
optional field helps you associate a client code with 
a client.

For FAC CSV File

Authorization Code Enter a unique authorization code that is no more 
than 16 digits. The user enters this code when the 
user places a call through a FAC-enabled route 
pattern.
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Using BAT to Update the Cisco Unified CallManager Database
To update the Cisco Unified CallManager database, you must insert the CMC or FAC CSV file in BAT. 
To update the database, perform the following procedure:

Before You Begin

Before you can update Cisco Unified CallManager, you must create or edit a CMC or FAC CSV file.

Procedure

Step 1 In Cisco Unified CallManager Administration, choose one of the following options, depending on 
whether you use a CMC or FAC CSV file:

• For CMC—Bulk Administration> Client Matter Codes > Insert Client Matter Codes

• For FAC—Bulk Administration> Forced Authorization Codes > Insert Forced Authorization 
Codes

Step 2 In the File Name drop-down list box, choose the CSV file that contains the updated codes.

Tip To view the contents of the file that you want to insert, click View File.

Step 3 If you updated an existing list of codes, check the Override the existing configuration check box, as 
described in Table 47-3.

Authorization Code 
Name

Enter a unique name that is no more than 50 
characters. The authorization code name ties the 
authorization code to a specific user or group of 
users; this name displays in the CDRs for calls that 
use this code.

Tip If you plan to assign an authorization code to 
every user in the system, make sure that the 
code name includes an identifier for the user, 
such as the user name or another unique, 
non-sensitive identifier; for example, an 
email alias or employee/student number. Do 
not use identifiers such as a social security 
number because the authorization code name 
writes to CDRs, which are not secure.

Authorization Level Enter a three-digit authorization level that exists 
within the range of 0 to 255; the default equals 0. The 
level that you assign to the authorization code 
determines whether the user can route calls through 
FAC-enabled route patterns. To successfully route a 
call, the user authorization level must equal or be 
greater than the authorization level that is specified 
for the route pattern for the call.

Table 47-2 Configuration Settings for CMC and FAC

Setting/Column Description
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BAT Settings for Updating the Cisco Unified CallManager Database
Step 4 In the Job Information area, enter the Job description.

Step 5 Click the Run Immediately radio button to generate a report immediately or, click Run Later to generate 
reports at a later time.

Step 6 Click Submit to create a job for inserting FAC and CMC. 

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 47-7.

BAT Settings for Updating the Cisco Unified CallManager 
Database

Use Table 47-3 in conjunction with the “Using BAT to Update the Cisco Unified CallManager 
Database” section on page 47-6. For more information about related procedures, see the “Related 
Topics” section on page 47-7.

Related Topics
• CMC and FAC Configuration Checklist, page 47-1

• Important BAT Considerations, page 47-2

• Creating a CSV File by Using BAT.xlt, page 47-3

• Using a Text Editor to Create the CSV Data File for Client Matter Codes and Forced Authorization 
Codes, page 47-4

• Editing an Existing CMC or FAC CSV File, page 47-4

Table 47-3 Settings in BAT for Inserting CSV Files

Setting in BAT Description

File Name From the drop-down list box, choose the CMC or 
FAC file that you want to insert.

Override the existing 
configuration

This check box applies if you are updating code for 
existing settings. 

Checking this check box overwrites the existing 
authorization code name (FAC), authorization level 
(FAC), or description (CMC) with the information 
that is contained in the file that you want to insert 
(existing authorization and client matter codes do not 
change). If you do not check the check box, an error, 
which writes to the log file, indicates that the 
authorization or client matter code already exists; 
therefore, no updates occur.
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Related Topics
• Deleting Code Settings, page 48-1

• CMC and FAC CSV File Settings, page 47-5

• Using BAT to Update the Cisco Unified CallManager Database, page 47-6

• BAT Settings for Updating the Cisco Unified CallManager Database, page 47-7

• Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, 
page A-16
47-8
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Cisco Unified C
OL-9421-01
C H A P T E R 48

Deleting Forced Authorization Codes and Client 
Matter Codes

You can delete codes from the system by using a custom file that contains the codes that you want to 
delete. You can edit a custom file where you previously inserted or updated authorization codes, or you 
can create a new CSV file where you manually enter the codes that you want to delete.

To delete Forced Authorization Codes and Client Matter Codes, use the following procedures.

• Deleting Code Settings, page 48-1

• Deleting Forced Authorization Codes and Client Matter Codes, page 48-2

Deleting Code Settings
If you plan to edit an existing CSV file, you must update the file, so only the lines that contain the codes 
that you want to delete remain in the file.

Example for CMC (Existing CSV File)

You obtain a file that contains the following information, and you decide to delete the client matter 
codes, 5550, 5551, and 5555:

• 5550,Phil Jones DDS

• 5551,Southwest Shades

• 5552,Happy Pharmaceuticals

• 5553,Weddings by Joyce

• 5554,Peterson Plumbing

• 5555,Acme Toys

• 5556,Chicago Paralegals

Before you delete the entries, the file must contain only the following entries:

• 5550,Phil Jones DDS

• 5551,Southwest Shades

• 5555,Acme Toys
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Example for CMC (New CSV File)

If you create a new file to delete the codes, list only the codes, separated by lines, as shown in the 
following example:

5550

5551

5555

Example for FAC (Existing CSV File)

You obtain a file that contains the following information, and you decide to delete the authorization 
codes that are assigned to John, Dave, and Bill:

• 1233,Sandy Brown,30

• 1234,John Smith,20

• 1235,Dave Green,30

• 1236,John David,20

• 1237,Alex Anderson,30

• 1238,Bill Jones,20

• 1239,Jennifer Summers,20

Before you can delete the entries for John, Dave, and Bill, the file must contain only the following 
entries:

• 1234,John Smith,20

• 1235,Dave Green,30

• 1238,Bill Jones,20

Example for FAC (New File)

If you create a new file to delete the codes, list only the codes, separated by lines, as shown in the 
following example:

1234

1235

1238

To delete batches of codes, see the “Deleting Forced Authorization Codes and Client Matter Codes” 
section on page 48-2.

Additional Topics

See the “Related Topics” section on page 48-3.

Deleting Forced Authorization Codes and Client Matter Codes
Before you Begin

• Perform one of the following tasks:

• Create a new file for codes that you want to delete, as described in the “Example for CMC (New 
CSV File)” section on page 48-2 and “Example for FAC (Existing CSV File)” section on page 48-2.
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Related Topics
• On the Cisco Unified CallManager server download the appropriate CSV files from the first node 
of the Cisco Unified CallManager server. For more information, see “Uploading a File” section on 
page 2-3.

• In Notepad, open and edit the existing CSV file to delete the entries.

• Upload the modified CSV files to the first node of the Cisco Unified CallManager server. For more 
information, see “Uploading a File” section on page 2-3:

Procedure

Step 1 In Cisco Unified CallManager Administration, choose one of the following options, depending on 
whether you plan to delete client matter codes or forced authorization codes:

• For CMC—Bulk Administration > Client Matter Codes > Delete Client Matter Codes

• For FAC—Bulk Administration > Forced Authorization Codes > Delete Forced Authorization 
Codes

Step 2 Choose a custom file from the drop-down list box and click Find.

Step 3 The Find and List Client Matter Codes window or Find and List Forced Authorization window displays.

Step 4 In the Job Information area, enter the Job description.

Step 5 Click the Run Immediately radio button to generate a report immediately or, click Run Later to generate 
reports at a later time.

Step 6 Click Submit to create a job for deleting FAC and CMC.

Note Make sure that you browse the entire list of the displayed results before submitting the job for deletion. 

Step 7 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 48-3.

Related Topics
• CMC and FAC Configuration Checklist, page 47-1

• Important BAT Considerations, page 47-2

• Creating a CSV File by Using BAT.xlt, page 47-3

• Using a Text Editor to Create the CSV Data File for Client Matter Codes and Forced Authorization 
Codes, page 47-4

• Editing an Existing CMC or FAC CSV File, page 47-4

• CMC and FAC CSV File Settings, page 47-5

• Using BAT to Update the Cisco Unified CallManager Database, page 47-6
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Related Topics
• Deleting Code Settings, page 48-1
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Working With Call Pickup Groups

Call pickup groups allow you to pick up incoming calls within your own groups or in other groups when 
you dial the appropriate pickup group number.

This chapter contains information on the following topics:

• Important BAT Considerations, page 49-1

• Creating a CSV File by Using BAT.xlt, page 49-2

• Using a Text Editor to Create the CSV Data File for Call Pickup Groups, page 49-3

• Editing an Existing Call Pickup Group CSV File, page 49-3

• Call Pickup Group CSV File Settings, page 49-4

• Using BAT to Update the Cisco Unified CallManager Database, page 49-4

• BAT Settings for Updating the Cisco Unified CallManager Database, page 49-5

Important BAT Considerations
Before you use BAT to configure call pickup groups, review the following information:

• When you add call pickup group settings for the first time, you can create a CSV file through BAT.xlt 
or create a custom, text-based CSV file.

• To update call pickup group settings, you can edit an existing CSV file or create a custom, text-based 
CSV file.

• Designate a single line for each pickup group name (and corresponding setting). For example, use 
the following format when you enter information for pickup groups:

– (Pickup Group Name, Pickup Group Number, Partition, Other Pickup Group Name-Member1... 
Other Pickup Group Name-Member10)

– Marketing,7815,Part1,Marketing,Managers,Training

• When you add new pickup groups, you must complete all required fields like the pickup group name 
and pickup group number. If the procedure specifies an entry as mandatory, you must provide the 
information in the file.

• Deleting information from a file and leaving the information blank does not remove the information 
from the Cisco Unified CallManager database; in other words, a blank value does not overwrite an 
existing value in the database. Updating the values overwrites the existing value in the database.

• Upload the appropriate CSV files to the first node of the Cisco Unified CallManager cluster. For 
more information see the “Uploading a File” section on page 2-3
49-1
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• Any time that you create or change a CSV file, you must insert the CSV file in BAT, as described 
in “Using BAT to Update the Cisco Unified CallManager Database” section on page 49-4.

Additional Information

See the “Related Topics” section on page 49-6.

Creating a CSV File by Using BAT.xlt
To create a CSV file for call pickup groups by using BAT.xlt, perform the following procedure:

Procedure

Step 1 The BAT.xlt file exists on Cisco Unified CallManager server; however, you normally do not have 
Microsoft Excel installed on the Cisco Unified CallManager server. In that case, you must copy the file 
from the Cisco Unified CallManager server and move it to the local machine, which must have 
Microsoft Excel installed.

Step 2 Choose Bulk Administration > Upload/Download Files. The Find and List Files window opens. 

Step 3 Click Find and download the BAT.xlt file. For more details on uploading or downloading files, see 
Chapter 2, “Uploading and Downloading Files.”

Step 4 Copy BAT.xlt to a local machine where Microsoft Excel is installed.

Step 5 In Microsoft Excel, open BAT.xlt.

Step 6 Click the Call Pickup Group tab.

Step 7 Use Table 49-1 to enter call pickup group settings in the columns.

Step 8 Repeat Step 7 until you enter all pickup groups.

Step 9 To transfer the Excel spreadsheet format to a CSV file, click Export to BAT Format. 

The system automatically saves CSV files to C:\XlsDatafiles on the local machine. To choose a different 
location to save the CSV file, click Browse and select the desired location. 

Step 10 Upload the CSV file to the first node of the Cisco Unified CallManager cluster. For more information 
see the “Uploading a File” section on page 2-3

Step 11 You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using BAT to Update the 
Cisco Unified CallManager Database” section on page 49-4.

Additional Information

See the “Related Topics” section on page 49-6.
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Using a Text Editor to Create the CSV Data File for Call Pickup 
Groups

You can create the CSV data file by using lines of ASCII text with values separated by commas. The 
comma separated values (CSV) file provides textual information in tabular form. For more information 
about text-based CSV files for call pickup groups, see the “Creating a Text-Based CSV File for Call 
Pickup Groups” section on page A-19.

Additional Information

See the “Related Topics” section on page 49-6.

Editing an Existing Call Pickup Group CSV File
You update existing codes by manually updating an existing CSV file in Notepad or by creating a new 
file in Notepad.

Perform the following procedure:

Procedure

Step 1 To edit an existing CSV file where you previously inserted call pickup groups information, download 
the appropriate CSV file from the first node of the Cisco Unified CallManager cluster. For more 
information see the “Downloading a File” section on page 2-2:

Step 2 In Notepad, open and edit the existing CSV file; delete existing settings, add new call pickup groups, or 
update existing settings by using the text-based representation in Table 49-1.

For example, to update a call pickup group CSV file, you may enter 
Marketing,,,Marketing,Managers,Training, where Marketing is the mandatory pickup group name. 
Marketing, Managers, and Training are the other pickup group names associated to the pickup group 
Marketing.

Caution You can change any part of an existing record, but you must include the pickup group name. When you 
update the Pickup Groups, existing Other Pickup Groups will be disassociated. Do not leave Other 
Pickup Group as blank fields. Enter all Other Pickup Groups, that you want to associate with Pickup 
Group, continuously.

Step 3 Upload the CSV files to the first node of the Cisco Unified CallManager cluster. For more information 
see the “Uploading a File” section on page 2-3

Step 4 You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using BAT to Update the 
Cisco Unified CallManager Database” section on page 49-4.

Additional Information

See the “Related Topics” section on page 49-6.
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Call Pickup Group CSV File Settings
Use Table 49-1 in conjunction with the following sections:

• Creating a CSV File by Using BAT.xlt, page 49-2

• Using a Text Editor to Create the CSV Data File for Call Pickup Groups, page 49-3

• Editing an Existing Call Pickup Group CSV File, page 49-3

• Deleting Call Pickup Groups, page 50-1

For more information about related procedures, see the “Related Topics” section on page 49-6.

Using BAT to Update the Cisco Unified CallManager Database
To update the Cisco Unified CallManager database, you must insert the call pickup group CSV file in 
BAT. To update the database, perform the following procedure:

Before You Begin

Before you can update Cisco Unified CallManager, you must create or edit a call pickup group CSV file 
and upload it on the first node on the Cisco Unified CallManager server. See the “Uploading a File” section 
on page 2-3

For more information see the following sections:

• Creating a CSV File by Using BAT.xlt, page 49-2

• Using a Text Editor to Create the CSV Data File for Call Pickup Groups, page 49-3

Table 49-1 Configuration Settings for Call Pickup Group

Setting/Column Description

For CPG CSV file

Pickup Group Name For this mandatory field, enter a unique call pickup 
group name of no more than 50 alphanumeric 
characters.

Pickup Group Number For this mandatory field, enter a pickup group 
number of no more than 24 digits that the user will 
enter to pick up incoming calls.

Partition Choose a route partition to which the directory 
number (pickup group number) belongs.

Note The directory number (pickup group) can 
appear in more than one partition.

Note The combination of Pickup Group Number 
and Partition should be unique. 

This field is optional. 

Other Pickup Group 
Name-Member(x)

Enter the name of the other pickup group to be 
associated with the new pickup group. This optional 
field allows each pickup group to be associated with 
maximum of ten other pickup groups. 
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• Editing an Existing Call Pickup Group CSV File, page 49-3

• Call Pickup Group CSV File Settings, page 49-4

Procedure

Step 1 In BAT, choose Bulk Administration > Call Pickup Group > Insert Call Pickup Groups. 

The Insert Pickup Groups window displays.

Step 2 In the File Name drop-down list box, choose the CSV file that contains the updated pickup groups.

Tip To view the contents of the file that you want to insert, click View File.

Step 3 If you updated an existing list of pickup groups, check the Override the existing configuration check 
box, as described in Table 49-2.

Step 4 In the Job Information area, enter the Job description.

Step 5 Click the Run Immediately radio button to insert pickup groups immediately or, click Run Later to insert 
at a later time.

Step 6 Click Submit to create a job for deleting assistants. 

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Information

See the “Related Topics” section on page 49-6.

BAT Settings for Updating the Cisco Unified CallManager 
Database

Use Table 49-2 in conjunction with the “Using BAT to Update the Cisco Unified CallManager 
Database” section on page 49-4. For more information about related procedures, see the “Related 
Topics” section on page 49-6.
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Additional Information

See the “Related Topics” section on page 49-6.

Related Topics
• Important BAT Considerations, page 49-1

• Creating a CSV File by Using BAT.xlt, page 49-2

• Using a Text Editor to Create the CSV Data File for Call Pickup Groups, page 49-3

• Editing an Existing Call Pickup Group CSV File, page 49-3

• Deleting Call Pickup Groups, page 50-1

• Call Pickup Group CSV File Settings, page 49-4

• Using BAT to Update the Cisco Unified CallManager Database, page 49-4

• BAT Settings for Updating the Cisco Unified CallManager Database, page 49-5

• Creating a Text-Based CSV File for Call Pickup Groups, page A-19

Table 49-2 Settings in BAT for Inserting CSV Files

Setting in BAT Description

File Name From the drop-down list box, choose the call pickup 
file that you want to insert.

Override the existing 
configuration

This check box applies if you are updating pickup 
groups for existing settings. 

Checking this check box overwrites the other pickup 
group name- members with the information that is 
contained in the file that you want to insert. If you do 
not check the check box, an error, which writes to the 
log file, indicates that the other pickup group name 
already exists; therefore, no updates occur.

Note For each pickup group, ensure the 
combination of Pickup Group Number and 
Partition is unique. 

Note While updating pickup groups, Pickup Group 
Number and Partition values will be ignored 
and existing Other Pickup Groups will be 
disassociated.
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Deleting Call Pickup Groups

You can delete Call pickup groups by creating a query to locate the pickup group records you want to 
delete. 

Deleting Call Pickup Groups
Use the following procedure to delete call pickup groups.

Procedure 

Step 1 In BAT, choose Bulk Administration > Call Pickup Group > Delete Call Pickup Groups

The Find and List Call Pickup Groups window displays.

Step 2 In first Find Call Pickup Groups where drop-down list box, choose from the following options:

• Pickup Group Number

• Pickup Group Name

• Partition

Step 3 From the second Find Call Pickup Groups where drop-down list box, choose one of the following 
criteria:

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 Specify the appropriate search text, if applicable.

Step 5 To add multiple filters, check the Search Within Results check box and select, AND or OR. To further 
define your query, repeat Step 2 through Step 4.

Step 6 To add the defined filter to the query, click Find. 

Step 7 In the Job Information area, enter the Job description.

Step 8 Click the Run Immediately radio button to delete pickup groups immediately or, click Run Later to 
delete at a later time.
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Step 9 Click Submit to create a job for deleting pickup groups. 

Note If you do not enter any information in the query text box, the system creates a job for deleting all pickup 
group records.

Caution Confirm that you want to delete all the pickup groups displayed in the result set by browsing the entire 
set of results, before submitting a job for deleting call pickup groups.

Step 10 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Related Topics
• Important BAT Considerations, page 49-1

• Creating a CSV File by Using BAT.xlt, page 49-2

• Using a Text Editor to Create the CSV Data File for Call Pickup Groups, page 49-3

• Editing an Existing Call Pickup Group CSV File, page 49-3

• Call Pickup Group CSV File Settings, page 49-4

• Using BAT to Update the Cisco Unified CallManager Database, page 49-4

• BAT Settings for Updating the Cisco Unified CallManager Database, page 49-5
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Scheduling Jobs

You can schedule bulk transactions and specify a time when they need to start these transactions. 

All jobs that are submitted through the Bulk Administration menu in the Cisco Unified CallManager 
Administration, queue up on the Bulk Provisioning Service (BPS). Depending on the start time specified 
for a job, the transaction starts running. If no start time is mentioned, the transactions execute in the order 
that they are received.

The following topics provide information about activating BPS and scheduling jobs:

• Activating Bulk Provisioning Service, page 51-1

• Starting/Stopping/Restarting BPS, page 51-2

• Deactivating BPS, page 51-2

• Finding a Job, page 51-3

• Scheduling Jobs, page 51-4

Activating Bulk Provisioning Service
Before submitting a job for execution BPS should be activated. 

Use the following procedure to activate BPS.

Procedure

Step 1 From Cisco Unified CallManager Serviceability window, choose Tools > Service Activation.

The Service Activation window displays.

Step 2 From the Service drop-down list box, choose the server that is running Cisco Unified CallManager.

Step 3 In the Database and Admin Services area, check the check box corresponding to Cisco Bulk 
Provisioning Service. 

Note If the service is already activated, the Activation Status will display as Activated.

Step 4 Click Update.

Step 5 The window refreshes and the Activation Status corresponding to Bulk Provisioning Service displays 
Activated.
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Note BPS starts automatically after it is activated. See the “Starting/Stopping/Restarting BPS” section on 
page 51-2 to stop, start, or restart the service.

Note Every time that the service is started, BPS synchronizes with Cisco Unified CallManager database.

Starting/Stopping/Restarting BPS
BPS starts automatically after it is activated by using Cisco Unified CallManager Serviceability. This 
section describes the procedures to stop or restart the BPS.

Procedure

Step 1 In Cisco Unified CallManager Serviceability, choose Tools > Control Center - Feature Services.

The Control Center–Feature Services window displays. 

Step 2 Choose the Cisco Unified CallManager server from the Servers drop-down list box. 

Cisco Bulk Provisioning Service displays in list under Service Name column, in the Database and 
Admin Services area. 

Note If BPS was activated using “Activating Bulk Provisioning Service” section on page 51-1, the 
Status displays as Activated. 

Step 3 Check the check box corresponding to BPS.

Step 4 If you want to restart BPS, click Restart.

The service restarts, and the message, Service Successfully Restarted, displays.

Step 5 If you want to stop BPS, click Stop.

The service stops, and the message, Service Successfully Stopped, displays.

Step 6 If you want to start the stopped BPS, click Start.

The service starts, and the message, Service Successfully Started, displays.

Deactivating BPS
You can deactivate BPS when you do not require it. This section describes the procedure to deactivate 
BPS service and log out of the tool.

Procedure

Step 1 In Cisco Unified CallManager Serviceability, choose Tools > Service Activation.
51-2
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 51      Scheduling Jobs
Finding a Job
The Service Activation window displays.

Step 2 Choose the Cisco Unified CallManager server from the Servers drop-down list box. 

Cisco Bulk Provisioning Service displays in the list under Service Name column, in the Database and 
Admin Services area. 

Step 3 Uncheck the check box corresponding to the Cisco Bulk Provisioning Service and click Update.

The service deactivates, and the Status column displays the status as Deactivated.

Finding a Job
Use the following procedure to find jobs that are already submitted to BPS through the Bulk 
Administration menu on Cisco Unified CallManager Administration.

Procedure

Step 1 Choose Bulk Administration > Job Scheduler. The Find and List Job window displays.

Step 2 From the first Find Job where drop-down list box, choose one of the following options.

• User

• Status

• Job ID

• Description

• Scheduled Date Time

Step 3 From the second Find Job where drop-down list box, choose one of the following options.

• begins with

• contains 

• is exactly

• ends with

• is empty

• is not empty

Step 4 From the third drop-down list box, choose Show to display completed jobs.

Step 5 Specify the appropriate search text, if applicable.

Tip To find all jobs that are registered in the database, click Find without entering any search text.

Step 6 To further define your query, you can choose AND or OR to add multiple filters and repeat steps 2 
through 5.

Step 7 Click Find.

A list of discovered jobs displays by:

• Job Id
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• Scheduled Date Time

• Submit Date Time

• Sequence

• Description

• Status

• Last User

Note The Status displays Hold if Run Later radio button was selected while scheduling the job. The 
Status displays Pending if Run Immediately radio button was selected. The Status displays 
Completed for completed jobs and it displays Incomplete for jobs that had an error and could 
not be completed.

Step 8 Click the Job ID for the job in process or on hold, that you want to schedule and/or activate. The job 
Configuration window displays.

Additional Topics

See the“Related Topics” section on page 51-6 

Scheduling Jobs
Use the following procedure to schedule submitted jobs.

Procedure

Step 1 Find the job you want to schedule using the “Finding a Job” section on page 51-3.

Step 2 In the Job Configuration window, enter the settings for scheduling and activating the job as described in 
Table 51-1.

Table 51-1 Job Configuration Settings

Field Description

Job Id Displays the job ID that is created when the job is 
submitted.

Job Status Displays the status of the job from one of the 
following options:

• Hold

• Pending

• Completed

• Incomplete

Scheduled Date Time Choose the month, date, year from the drop-down 
list boxes. Enter the time when you want the job 
to be scheduled.
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Step 3 Click Activate job to activate the job at the scheduled time or click Save to save the configuration 
settings to activate the job at a later time.

The Find and List Jobs window displays.

Note If a Job is saved, but not activated then status of the job will be displayed as Hold. These jobs 
will not be processed by BPS unless they are activated.

Step 4 Click the job ID for the job you have activated. In the Job Configuration window, the following 
information displays in the Job Results area, for all jobs that are complete, incomplete, stop requested, 
or processing.

• Job Launched Date

• Job Result Status

• Number of records Processed

Submit Date Time Displays the date and time when the job was 
submitted.

Sequence Choose from the drop-down list box, the sequence 
in which the job should be run. You can choose a 
number between 1 and 20.

Note If the scheduled date and time is same for 
two or more jobs, then the jobs are queued 
in BPS according the sequence number. If 
the scheduled date and time, and 
Sequence is same, then the jobs are 
queued depending on the submitted date 
and time.

Job Description Displays the description you entered when the job 
was created.

Frequency Choose from the following options, the frequency 
of the transaction:

• Once

• Monthly

• Weekly

• Daily

• Hourly

For example, if you choose Daily, the transaction 
will be repeated daily at the time entered in the 
Schedule Time and Date field.

Job End Time Displays the end time for recurring (frequency) 
job.

last Modified By Displays the user ID of the administrator who last 
modified this job.

Table 51-1 Job Configuration Settings

Field Description
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• Number of Records Failed

• Total Number of Records

• Log File Name 

Note Click on the link in the Log File Name column to view the log file for this transaction.

Step 5 To go back to the list of jobs, choose Back to Find/List from the Related Links drop-down list box and 
click Go.

Related Topics
• Activating Bulk Provisioning Service, page 51-1

• Starting/Stopping/Restarting BPS, page 51-2

• Deactivating BPS, page 51-2

• Finding a Job, page 51-3

• Scheduling Jobs, page 51-4
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Working with the Cisco Unified CallManager 
Auto-Register Phone Tool

The Cisco Unified CM Auto-Register Phone Tool enables phone users to call the Unified CM 
Auto-Register Phone Tool directory number and download the preconfigured phone settings for the 
user's directory number. Unified CM Auto-Register Phone Tool works in conjunction with 
Cisco Unified CallManager Administration to provide these capabilities:

Configure Unified CM Auto-Register Phone Tool—Allows you to enable Unified CM Auto-Register 
Phone Tool usage for all phones that use auto-registration or to limit Unified CM Auto-Register Phone 
Tool to only phones that are added through BAT with dummy MAC addresses. See the “Configuring 
Auto-Registration Options for Unified CM Auto-Register Phone Tool” section on page 52-7.

Secure Unified CM Auto-Register Phone Tool—Allows you to keep some directory numbers from 
being updated through Unified CM Auto-Register Phone Tool. See the “Setting Secure Directory 
Numbers” section on page 52-8

User Locales for Unified CM Auto-Register Phone Tool—Allows you to choose the languages for 
Unified CM Auto-Register Phone Tool prompts. See the “Setting the User Locales for Unified CM 
Auto-Register Phone Tool” section on page 53-1.

The following topics provide information about using, installing, and configuring Unified CM 
Auto-Register Phone Tool:

• Introducing Cisco Unified CM Auto-Register Phone Tool, page 52-2

• Installing Unified CM Auto-Register Phone Tool, page 52-4

• Uninstalling Unified CM Auto-Register Phone Tool, page 52-5

• Activating Unified CM Auto-Register Phone Tool Service, page 52-6

• Starting/Stopping/Restarting Unified CM Auto-Register Phone Tool, page 52-6

• Setting Unified CM Auto-Register Phone Tool Options, page 52-7

• Setting Secure Directory Numbers, page 52-8

• Viewing Unified CM Auto-Register Phone Tool Log Files, page 52-10

• Unified CM Auto-Register Phone Tool Information for End Users, page 53-2
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Introducing Cisco Unified CM Auto-Register Phone Tool
Unified CM Auto-Register Phone Tool components get installed on the Cisco Unified CallManager first 
node as part of the Cisco Unified CallManager installation. You must enable auto-registration in 
Cisco Unified CallManager Serviceability for Unified CM Auto-Register Phone Tool to function. 

Note When you use Unified CM Auto-Register Phone Tool, it leads to the depletion of auto-registration range 
on the Cisco Unified CallManager. After update through Unified CM Auto-Register Phone Tool, the 
auto-registered directory number (DN) of the phone becomes an unassigned DN. You should delete 
unassigned DNs using BAT periodically to free up the auto-registration range. For more information, 
refer to Cisco Unified CallManager Administration Guide.

You must install Unified CM Auto-Register Phone Tool application on the Cisco Customer Response 
Solutions (Cisco CRS) server. Unified CM Auto-Register Phone Tool requires the Cisco IP Interactive 
Voice Response (IP IVR) application that runs on the Cisco CRS server for the user interface and 
prompts.

Administrators need to provide instructions to tell end users how to use Unified CM Auto-Register 
Phone Tool to configure their new phones. For end user instructions, see the “Unified CM Auto-Register 
Phone Tool Information for End Users” section on page 53-2

Note Cisco recommends that you stop the Unified CM Auto-Register Phone Tool service when you are not 
using Unified CM Auto-Register Phone Tool to add phones to Cisco Unified CallManager database. 

Additional Topics

See the “Related Topics” section on page 52-10.

Auto-registration Options for Unified CM Auto-Register Phone Tool
You can set the following options for using Unified CM Auto-Register Phone Tool to update 
auto-registering phones.

• Update MAC addresses and download a predefined configuration for new phones.

• Reload the configuration for replacement phones.

Use the following topics.

• Using Unified CM Auto-Register Phone Tool with New Phones, page 52-2

• Using Unified CM Auto-Register Phone Tool for Reloading Configurations, page 52-3

Using Unified CM Auto-Register Phone Tool with New Phones

After BAT has added the new phone configurations with dummy MAC addresses in 
Cisco Unified CallManager Administration, you can plug the phones into the network. You or the phone 
user can dial a Unified CM Auto-Register Phone Tool directory number that causes the phone to 
download its configuration. At the same time, the phone gets updated in Cisco Unified CallManager 
Administration with the correct MAC address. You must make sure that Auto-registration is enabled in 
Cisco Unified CallManager Administration for Unified CM Auto-Register Phone Tool to function. 
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Note When you use Unified CM Auto-Register Phone Tool, it leads to the depletion of auto-registration range 
on the Cisco Unified CallManager. After update through Unified CM Auto-Register Phone Tool, the 
auto-registered directory number (DN) of the phone becomes an unassigned DN. You should delete 
unassigned DNs using BAT periodically to free up the auto-registration range. For more information, 
refer to Cisco Unified CallManager Administration Guide.

Example

You have 100 new-hire employees starting on Monday. You must add these users and their new phones 
to Cisco Unified CallManager Administration. You can use BAT to create a phone template for these 
100 phones and a CSV data file for phones and users. By using the dummy MAC address option in the 
CSV data file, you do not need to add the individual MAC addresses for the new phones. With 
auto-registration enabled in Cisco Unified CallManager, you can plug the phones directly into the 
network. You or the new employee can load the configuration by dialing the Unified CM Auto-Register 
Phone Tool directory number and following the voice-prompt instructions.

Using Unified CM Auto-Register Phone Tool for Reloading Configurations

When you must replace an existing phone that is not functioning, you can use Unified CM Auto-Register 
Phone Tool to download the existing phone configuration to the new phone. After the user receives the 
new phone and plugs the phone into the network, the user dials the Unified CM Auto-Register Phone 
Tool directory number to download configuration for the previous phone. The user makes no 
configuration changes during this process.

In Cisco Unified CallManager Administration, you must enable auto-registration. You must ensure that 
you configure Unified CM Auto-Register Phone Tool usage for all phones to enable a user to download 
an existing phone configuration. See the “Configuring Auto-Registration Options for Unified CM 
Auto-Register Phone Tool” section on page 52-7.

Note When you use Unified CM Auto-Register Phone Tool, it leads to the depletion of auto-registration range 
on the Cisco Unified CallManager. After update through Unified CM Auto-Register Phone Tool, the 
auto-registered directory number (DN) of the phone becomes an unassigned DN. You should delete 
unassigned DNs using BAT periodically to free up the auto-registration range. For more information, 
refer to Cisco Unified CallManager Administration Guide.

Example

John’s Cisco Unified IP Phone model 7940 gets short-circuited during a lightning storm. He receives a 
new Cisco Unified IP Phone model 7940 and plugs it into the network. John can dial the Unified CM 
Auto-Register Phone Tool directory number, and the new phone will download the configuration that 
was previously used for the damaged phone. Unified CM Auto-Register Phone Tool automatically 
updates device information in Cisco Unified CallManager Administration.

Additional Topics

See the “Related Topics” section on page 52-10.
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Secured Directory Numbers
Because Unified CM Auto-Register Phone Tool can replace a directory number, you can protect certain 
directory numbers from being overwritten. To protect important directory numbers, you can use the 
Secure Unified CM Auto-Register Phone Tool option. See the “Setting Secure Directory Numbers” 
section on page 52-8 for more information.

Example

The directory number 5000 provides voice-messaging access for your system. You do not want a new 
user to mistakenly configure 5000 on the new phone. The Secure Unified CM Auto-Register Phone Tool 
option allows you to specify that Unified CM Auto-Register Phone Tool cannot access directory number 
“5000.”

Additional Topics

See the “Related Topics” section on page 52-10.

Language Prompts for Unified CM Auto-Register Phone Tool Users
You can configure user prompts for Unified CM Auto-Register Phone Tool to play in several languages. 
Administrators can choose the languages to make available to users. See the “Setting the User Locales 
for Unified CM Auto-Register Phone Tool” section on page 53-1. 

If you need to use language prompts other than English prompts, make sure that you installed the 
Cisco Unified CallManager Locale Installer on every Cisco Unified CallManager and Cisco CRS server 
in the cluster before you install, upgrade, or configure Unified CM Auto-Register Phone Tool. Using the 
locale installer ensures that you have the latest translated text, translated voice prompts, country-specific 
phone tones, and country-specific gateways tones available for the phones. For more information on the 
Cisco Unified CallManager Locale Installer, refer to the specific locale installer documentation.

Additional Topics

See the “Related Topics” section on page 52-10.

Installing Unified CM Auto-Register Phone Tool
This section provides information about installing, reinstalling, and uninstalling Unified CM 
Auto-Register Phone Tool. Unified CM Auto-Register Phone Tool interfaces with both 
Cisco Unified CallManager server and Cisco Customer Response Solution (CRS) 4.5 server. This 
installation procedure involves installing Unified CM Auto-Register Phone Tool on the CRS server.

You cannot use Windows Terminal Services to install Unified CM Auto-Register Phone Tool. You must 
install Unified CM Auto-Register Phone Tool directly from the Cisco Unified CallManager first node 
server and the Cisco CRS server.

Before You Begin

The following prerequisites apply to the Unified CM Auto-Register Phone Tool installation for BAT 
Release 5.2(1):

• Make sure that the Cisco Unified CallManager first node database is configured and running. 

• Have the IP address for the Cisco Unified CallManager first node server.
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• Ensure the Cisco CRS  server is configured. The Cisco CRS 4.5 application can reside on its own 
dedicated server.

• Be sure to use the locale installer to create the country-specific Unified CM Auto-Register Phone 
Tool prompts.

To install Unified CM Auto-Register Phone Tool on CRS application server, use the following 
procedure:

Procedure

Step 1 Log on with administrator privileges to the system that is running the Cisco Unified CallManager first 
node database.

Step 2 Choose Applications > Plugins. The Find and List Plugins window displays.

Step 3 Find Cisco Unified CallManager Auto-Register Phone Tool for Windows and click Download and save 
the plugin to your Windows server where the CRS application server is installed. 

Step 4 The Welcome window for the installation wizard opens. This installation program installs Unified CM 
Auto-Register Phone Tool on the CRS applications server. Click Next.

Note When you are installing Unified CM Auto-Register Phone Tool in a network with a dedicated 
CRS server, you must run the Unified CM Auto-Register Phone Tool installation program again 
on the CRS server. Use CRS online help for assistance with installation and configuration.

Step 5 Enter the CRS application server IP address in the IP Address field, and click Next.

Step 6 The Installing Unified CM Auto-Register Phone ToolonAppsServer window displays a progress bar that 
shows the status of the installation. Click Next to begin the installation.

Step 7 The Installation Completed window displays when the installation ends. Click Finish.

Additional Topics

See the “Related Topics” section on page 52-10.

Configuring the Unified CM Auto-Register Phone Tool Application in CRS 
Applications Server

You can review the Cisco CRS 4.5 application server documentation by browsing to Cisco Voice 
Applications and Tools at http://www.cisco.com. Refer to the Cisco Customer Response Administration 
Guide for instructions on how to configure an application.

Additional Topics

See the “Related Topics” section on page 52-10.

Uninstalling Unified CM Auto-Register Phone Tool
The uninstall program removes the Unified CM Auto-Register Phone Tool applications from the 
Cisco CRS server. 
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To uninstall Unified CM Auto-Register Phone Tool by using the Add/Remove Programs in the Control 
Panel, use the following procedure. 

Procedure

Step 1 On the Cisco CRS server, choose Start > Settings > Control Panel > Add/Remove Programs.

Step 2 Choose Unified CM Auto-Register Phone Tool and click the Change/Remove button. A message 
displays that confirms the uninstall operation.

Step 3 To uninstall Unified CM Auto-Register Phone Tool, click Yes or No to cancel. If you clicked Yes, 
Unified CM Auto-Register Phone Tool uninstalls from the Cisco CRS server.

Step 4 To exit the uninstallation, click OK.

Additional Topics

See the “Related Topics” section on page 52-10.

Activating Unified CM Auto-Register Phone Tool Service
You can activate and deactivate Unified CM Auto-Register Phone Tool service by using 
Cisco Unified CallManager Serviceability after you access it by using the appropriate URL. Use the 
following procedure to activate the service.

Procedure

Step 1 Access Cisco Unified CallManager Serviceability.

Step 2 Choose Tools > Service Activation.

The Service Activation window displays. 

Step 3 Choose the appropriate server from the drop-down list box. Click Next.

Step 4 Choose Cisco Unified CM Auto-Register Phone Tool Service from Database and Admin Services of the 
Unified CMServices list and click Save.

Note If the service is already activated, the Activation Status will display as Activated.

Step 5 The service gets activated, and the Activation Status column displays the status as Activated. 

Starting/Stopping/Restarting Unified CM Auto-Register Phone 
Tool

The Unified CM Auto-Register Phone Tool service starts automatically after it is activated by using 
Cisco Unified CallManager Serviceability. This section describes the procedures to stop or restart the 
Unified CM Auto-Register Phone Tool service.
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Procedure

Step 1 In Cisco Unified CallManager Serviceability, choose Tools > Control Center - Feature Services.

The Control Center–Feature Services window displays. 

Step 2 Choose the Cisco Unified CallManager server from the Servers drop-down list box. 

Cisco Unified CM Auto-Register Phone Tool Service displays in list under Database and Admin 
Services column, in the Unified CMServices. 

Note If Unified CM Auto-Register Phone Tool was activated by using “Activating Unified CM 
Auto-Register Phone Tool Service” section on page 52-6, the Status displays as Activated. 

Step 3 Check the check box that corresponds to Cisco Unified CM Auto-Register Phone Tool Service.

Step 4 If you want to restart the Unified CM Auto-Register Phone Tool service, click Restart.

The service restarts, and the message, Service Successfully Restarted, displays.

Step 5 If you want to stop the Unified CM Auto-Register Phone Tool service, click Stop.

The service stops, and the message, Service Successfully Stopped, displays.

Step 6 If you want to start a stopped Unified CM Auto-Register Phone Tool service, click Start.

The service starts, and the message, Service Successfully Started, displays.

Setting Unified CM Auto-Register Phone Tool Options
Administrators can choose how to use Unified CM Auto-Register Phone Tool in their 
Cisco Unified CallManager system. These Unified CM Auto-Register Phone Tool feature options 
provide more flexibility when allowing users to update phones or download phone profiles. Unified CM 
Auto-Register Phone Tool options include:

• Configuring Auto-Registration Options for Unified CM Auto-Register Phone Tool, page 52-7

• Setting Secure Directory Numbers, page 52-8

• Setting the User Locales for Unified CM Auto-Register Phone Tool, page 53-1

Configuring Auto-Registration Options for Unified CM Auto-Register Phone 
Tool

The Configure Unified CM Auto-Register Phone Tool option provides two ways to use Unified CM 
Auto-Register Phone Tool to update phones that auto-register with the Cisco Unified CallManager 
database. 

• For phones that are added by using BAT and have a dummy MAC address. 

• For existing phones in Cisco Unified CallManager Administration

The default setting limits use of Unified CM Auto-Register Phone Tool to phones that have a dummy 
MAC address with a device name that starts with the prefix “BAT.” 
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You can set the Configure Unified CM Auto-Register Phone Tool option to allow any phone to 
auto-register in the Cisco Unified CallManager system, including phones that have a standard MAC 
address. 

Note When you use Unified CM Auto-Register Phone Tool, it leads to the depletion of auto-registration range 
on the Cisco Unified CallManager. After update through Unified CM Auto-Register Phone Tool, the 
auto-registered directory number (DN) of the phone becomes an unassigned DN. You should delete 
unassigned DNs using BAT periodically to free up the auto-registration range. For more information, 
refer to Cisco Unified CallManager Administration Guide.

To set the Configure Unified CM Auto-Register Phone Tool option, use this procedure.

Procedure

Step 1 In the Cisco Unified CallManager Administration window, choose System > Service Parameters. The 
Service Parameter Configuration window displays. 

Step 2 From the Server drop-down list, choose the appropriate server. 

Step 3 From the Service drop-down list, choose Cisco Unified CM Auto-Register Phone Tool Service.

Step 4 Choose one of these two options from the Parameter Value drop-down list box.

• Allow Auto-Registered phones to reset with a profile with a dummy MAC address.

Unified CM Auto-Register Phone Tool updates auto-registered phones with a profile that have the 
dummy MAC address only.

• Allow Auto-Registered phones to reset with any profile. 

Unified CM Auto-Register Phone Tool updates auto-registered phones with any profile.

Step 5 Click Save. A status message indicates that the update is successful.

Step 6 To return to the Unified CM Auto-Register Phone Tool Options window, click Back.

Additional Topics

See the “Related Topics” section on page 52-10.

Setting Secure Directory Numbers
The Secure Unified CM Auto-Register Phone Tool options let you specify directory numbers that 
Unified CM Auto-Register Phone Tool cannot access. Use this capability when you want to protect 
directory numbers from being accidentally assigned to another phone.

Note When you use Unified CM Auto-Register Phone Tool, it leads to the depletion of auto-registration range 
on the Cisco Unified CallManager. After update through Unified CM Auto-Register Phone Tool, the 
auto-registered directory number (DN) of the phone becomes an unassigned DN. You should delete 
unassigned DNs using BAT periodically to free up the auto-registration range. For more information, 
refer to Cisco Unified CallManager Administration Guide.

Use the following sections to find restricted directory numbers or to add restrict more directory numbers:
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• Finding Secure Directory Numbers, page 52-9

• Restricting Directory Numbers, page 52-9

• Lifting Restriction on a Directory Number, page 52-10

Finding Secure Directory Numbers
Use the following procedure to find and list the directory numbers that have been restricted.

Procedure

Step 1 Choose Bulk Administration > Unified CM Auto-Register Phone Tool > Secure Unified Unified CM 
Auto-Register Phone Tool. The Find and List Secure Directory Numbers window displays. 

Step 2 Click Next. The Secure Directory Numbers window displays.

Step 3 Enter the appropriate search criteria and click Search. A list of restricted directory numbers displays.

Step 4 To restrict more directory numbers, see the “Restricting Directory Numbers” section on page 52-9. To 
lift restriction on a directory number, see the, “Lifting Restriction on a Directory Number” section on 
page 52-10. 

Additional Topics

See the “Related Topics” section on page 52-10.

Restricting Directory Numbers
To block Unified CM Auto-Register Phone Tool from using directory numbers that you specify, use this 
procedure. Unified CM Auto-Register Phone Tool cannot use any directory number that you include in 
the list of secured directory numbers.

Procedure

Step 1 Choose Bulk Administration > Unified CM Auto-Register Phone Tool > Secure Unified CM 
Auto-Register Phone Tool. The Find and List Secure Directory Numbers window displays. 

Step 2 Click Add New. The Secure Directory Numbers Configuration window displays.

Step 3 In the Directory Number field, enter the number(s) that you want to protect from Unified CM 
Auto-Register Phone Tool. To enter multiple Directory Numbers, use one line for each Directory 
Number entry.

Step 4 Click Save. 

Step 5 To return to Find and List Directory Numbers window, choose Back to Find/List from the Related links 
drop-down list box on the right, top corner of the window and click Go. 

Unified CM Auto-Register Phone Tool cannot use the directory numbers that are shown in this list. If a 
user tries to update a device profile by entering one of the directory numbers in this list, Unified CM 
Auto-Register Phone Tool will refuse the request.
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Additional Topics

See the “Related Topics” section on page 52-10.

Lifting Restriction on a Directory Number
To remove a directory number from the list of directory numbers that Unified CM Auto-Register Phone 
Tool cannot access, use this procedure.

Procedure

Step 1 Choose Bulk Administration > Unified CM Auto-Register Phone Tool > Secure Unified CM 
Auto-Register Phone Tool. The Find and List Secure Directory Numbers window displays. 

Step 2 To find the directory numbers you want to delete, see“Finding Secure Directory Numbers” section on 
page 52-9. 

Step 3 Choose the directory numbers that you want to remove from the secure directory number list and click 
Delete.

Note If two or more phones lines share an unrestricted directory number, and you are trying to update any of 
these phones, you will be prompted to enter the external phone mask of your phone.

Additional Topics

See the “Related Topics” section on page 52-10.

Viewing Unified CM Auto-Register Phone Tool Log Files
Use the following procedure to view Unified CM Auto-Register Phone Tool log files.

Step 1 Choose Bulk Administration > Unified CM Auto-Register Phone Tool > View Taps Log File.

Step 2 The View Unified CM Auto-Register Phone Tool Log File window displays.

Step 3 Each row of the log file represents each Unified CM Auto-Register Phone Tool transaction.

Additional Topics

See the“Related Topics” section on page 52-10. 

Related Topics
• Introducing Cisco Unified CM Auto-Register Phone Tool, page 52-2

• Installing Unified CM Auto-Register Phone Tool, page 52-4
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• Uninstalling Unified CM Auto-Register Phone Tool, page 52-5

• Activating Unified CM Auto-Register Phone Tool Service, page 52-6

• Starting/Stopping/Restarting Unified CM Auto-Register Phone Tool, page 52-6

• Setting Unified CM Auto-Register Phone Tool Options, page 52-7

• Setting Secure Directory Numbers, page 52-8Auto-registration Options for Unified CM 
Auto-Register Phone Tool, page 52-2

• Viewing Unified CM Auto-Register Phone Tool Log Files, page 52-10

• Setting the User Locales for Unified CM Auto-Register Phone Tool, page 53-1

• Unified CM Auto-Register Phone Tool Information for End Users, page 53-2
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User Locales for Unified CM Auto-Register 
Phone Tool

Administrators can specify the languages for TAPs voice prompts by using the User Locales for 
Unified CM Auto-Register Phone Tool option. You can configure user prompts for Unified CM 
Auto-Register Phone Tool in several languages. Make sure that the Cisco Unified CallManager Locale 
Installer is installed on every Cisco Unified CallManager and Cisco CRS server in the cluster. 

Using the locale installer ensures that you have the latest translated text, translated voice prompts, 
country-specific phone tones, and country-specific gateways tones that are available for the phones. For 
more information on the Cisco Unified CallManager Locale Installer, refer to the specific locale installer 
documentation. 

Note You have to select at least one user locale for Unified CM Auto-Register Phone Tool to work.

Setting the User Locales for Unified CM Auto-Register Phone 
Tool

Use the following procedures to add or remove languages for Unified CM Auto-Register Phone Tool 
prompts:

• Adding Languages for Unified CM Auto-Register Phone Tool Prompts, page 53-1

• Removing Languages for Unified CM Auto-Register Phone Tool Prompts, page 53-2

Adding Languages for Unified CM Auto-Register Phone Tool Prompts
To set the languages for Unified CM Auto-Register Phone Tool prompts, use the following procedure.

Procedure

Step 1 In the Cisco Unified CallManager Administration window, choose Bulk Administration > Unified CM 
Auto-Register Phone Tool > User Locales for Unified CM Auto-Register Phone Tool. The User 
Locales Configuration window displays.
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Step 2 In the User Locales list box, which is the list of languages that are installed on 
Cisco Unified CallManager, choose the languages that you want to use for user prompts. Click the arrow 
to move the chosen language to the Selected User Locales list box.

You can choose as many languages as you need for user prompts and move them to the Selected User 
Locales list box.

Step 3 After you have chosen the languages for user prompts, to create a job, click Submit. 

Step 4 Use the Job Scheduler option in the Bulk Administration main menu to schedule and/or activate this job.

For more information on jobs, see the Chapter 51, “Scheduling Jobs.”

For information on log files, see “BAT Log Files” section on page 54-3.

Additional Topics

See the “Related Topics” section on page 53-3.

Removing Languages for Unified CM Auto-Register Phone Tool Prompts
To remove the languages for Unified CM Auto-Register Phone Tool prompts, use the following 
procedure.

Procedure

Step 1 Choose Bulk Administration > Unified CM Auto-Register Phone Tool > User Locales for 
Unified CM Auto-Register Phone Tool. The Select User Locales window displays. The User Locales 
Configuration window displays.

Step 2 In the Selected User Locales list box, which is the list of languages that is chosen for user prompts, 
choose the language that you want to remove. 

Step 3 Click the arrow to move the chosen language to the User Locales list box.

You can choose one or many languages from user prompts and move them to the User Locales list box.

Step 4 Click Submit. A status message indicates that the update is complete.

Step 5 To return to the Unified CM Auto-Register Phone Tool Options window, click Back.

Additional Topics

See the “Related Topics” section on page 53-3.

Unified CM Auto-Register Phone Tool Information for End Users
To configure your new phone, use this procedure.

Procedure

Step 1 Plug the phone into a port.
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The phone automatically registers and displays a number.

Note It takes around 20-25 seconds for downloading phone profile and making necessary updates in 
first node and directory.

Step 2 Dial the CTI Route Point number provided by your system administrator and follow the prompts. 

Step 3 Dial the Unified CM Auto-Register Phone Tool extension that your system administrator provided.

Step 4 A voice prompts you to choose the language that you want to use. Choose appropriately. 

Step 5 Dial your personal extension number, that your system administrator provided, followed by #.

Note You may be instructed to enter the complete telephone number (including area code).

Step 6 To confirm, enter your personal extension number again, followed by #.
You will receive confirmation prompt.

Step 7 Hang up the phone.

The phone resets and displays your extension number.

If you experience any problems, contact your system administrator.

Additional Topics

See the “Related Topics” section on page 53-3.

Related Topics
• Setting the User Locales for Unified CM Auto-Register Phone Tool, page 53-1

• Unified CM Auto-Register Phone Tool Information for End Users, page 53-2

• Installing Unified CM Auto-Register Phone Tool, page 52-4

• Uninstalling Unified CM Auto-Register Phone Tool, page 52-5

• Activating Unified CM Auto-Register Phone Tool Service, page 52-6

• Starting/Stopping/Restarting Unified CM Auto-Register Phone Tool, page 52-6

• Setting Unified CM Auto-Register Phone Tool Options, page 52-7

• Setting Secure Directory Numbers, page 52-8
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Troubleshooting BAT and Unified CM 
Auto-Register Phone Tool

For information about problems and messages that you might encounter when you are using 
Cisco Unified CallManager Bulk Administration (BAT) or Unified CM Auto-Register Phone Tool, use 
the following topics.

• BAT Log Files, page 54-3

• Viewing Trace Configuration Files, page 54-1

• Troubleshooting BAT, page 54-3

• Troubleshooting Unified CM Auto-Register Phone Tool, page 54-7

• Unified CM Auto-Register Phone Tool Error Messages, page 54-7

Viewing Trace Configuration Files
Trace files provide a means of tracking problems in the functioning of a tool. The system writes trace 
files for BAT and Unified CM Auto-Register Phone Tool to the server on which BAT and Unified CM 
Auto-Register Phone Tool are installed. You can choose to enable or disable the writing of trace files 
feature from the Service Control window in Cisco Unified CallManager Serviceability. 

This section describes the procedure to enable and disable the writing of trace files.

Use the following procedure to enable the feature.

Procedure

Step 1 In Cisco Unified CallManager Serviceability, choose Trace > Trace Configuration.

The Trace Configuration window displays. 

Step 2 Choose the Cisco Unified CallManager server, from the Server drop-down list box.

Step 3 Choose one of the following services from the Configured Services drop-down list box.

• For BAT trace file settings, choose Cisco Bulk Provisioning Service

• For Unified CM Auto-Register Phone Tool trace file settings, choose Cisco Unified CM 
Auto-Register Phone Tool Service

Step 4 To activate the trace feature, click the Trace On check box.
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Step 5 In the Trace Filter Settings, choose the trace level that you want to set from the Debug Trace Level 
drop-down list box. Click the desired debug trace level as described in Table 54-1. 

Step 6 Check the check boxes for Cisco Bulk Provisioning Service Trace Fields and Device Name Based Trace 
Monitoring, as needed.

Step 7 In the Trace Output Settings, enter values for the maximum number of files, maximum number of lines 
per file, and maximum number of minutes per file.

Step 8 Click Update.

The system enables the feature, and the trace files get written to the following locations on the server:

• BAT trace files: /var/log/active/cm/trace/bps/log4j

• Unified CM Auto-Register Phone Tool trace files: /var/log/active/cm/trace/taps/log4j

The BAT trace file displays in the following format: 

bps<index number>.log

The Unified CM Auto-Register Phone Tool trace file displays in the following format

taps<index number>.log

where <index number> ranges from 1- 250.

After you have configured information that you want to include in the trace files, you can collect and 
view trace files by using the trace and log central option in the Real-Time Monitoring Tool (RTMT). For 
more information, refer to Cisco Unified CallManager Serviceability System Guide.

Use the following procedure to disable the writing trace files feature.

Procedure

Step 1 In Cisco Unified CallManager Serviceability, choose Trace > Trace Configuration.

The Trace Configuration window displays. 

Step 2 Choose the Cisco Unified CallManager server from the Server drop-down list box.

Table 54-1 Debug Trace Levels

Level Description 

Fatal Traces very severe error events that may cause the 
application to abort.

Error Traces alarm conditions and events. Used for all 
traces that are generated in abnormal path. Uses 
minimum number of CPU cycles.

Warn Traces potentially harmful situations.

Info Traces the majority of servlet problems and has a 
minimal effect on system performance.

Debug Traces all State Transition conditions plus media 
layer events that occur during normal operation.

Trace level that turns on all logging.
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Step 3 Choose Cisco Bulk Provisioning Service from the Configured Services drop-down list box.

Step 4 To deactivate the trace feature, uncheck the Trace On check box.

Step 5 Click Update.

This action means that the feature is disabled.

BAT Log Files
BAT generates log files for each bulk transaction. The log file shows the key value of a record, so the 
administrator may reexamine the record. The MAC address of the phone serves as the key value when 
you are adding, updating, or modifying phones. When users are added, the User ID serves as the key 
value. To view the log files for each job that is created in BAT, find the appropriate job, by using 
“Finding a Job” section on page 51-3, and click on the link in the Log File Name column. A pop-up 
window displays the log file details of that job.

The log file names designate the operation that was performed and the time that the operation ended.

• Log File Names—File name shows the Job ID, which is a unique identifier that the system creates 
when a job is submitted.

• TimeStamp—The timestamp format that is included in the log file name specifies 
mmddyyyyhhmmss.

• The log file name is of the format jobid#timestamp.txt

Additional Topics

See the “Related Topics” section on page 54-8.

Troubleshooting BAT
The following list describes some scenarios that could occur and provides possible resolutions.

Symptom Bulk Administration menu does not display in Cisco Unified CallManager Administration.

Explanation Bulk Administration menu is accessible only from first node of 
Cisco Unified CallManager.

Recommended Action Make sure that you are logged into first node of Cisco Unified CallManager.

Symptom Cannot access complete Bulk Administration functionality.

Explanation After logging into Cisco Unified CallManager Administration, all the Bulk 
Administration windows are not accessible.

Recommended Action This problem may arise due to restricted access to the application given to the 
User ID. Contact the System Administrator to be granted required permissions
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Symptom Export to BAT Format button does not work in BAT.xlt file.

Explanation Clicking the Export to BAT Format button in the BAT.xlt file does not seem to do 
anything.

Recommended Action Click a blank cell. The button can seem to be disabled if the cursor is on the 
text in a cell or in the text box.

Symptom BAT Excel spreadsheet gives a compilation error while exporting data to the CSV format. 

Explanation Check the version of Microsoft Excel that you are using. Customers have reported 
problems with BAT.xlt when they were using Excel 97.

Recommended Action Use Microsoft Excel 2000 version or higher.

Symptom BAT Excel spreadsheet does not respond to actions.

Explanation .BAT Excel spreadsheet does not respond to actions like Add More Lines and so on.

Recommended Action .Ensure that Enable Macros option is selected while opening BAT Excel 
spreadsheet.To enable macros in BAT.xlt use the following steps:

a. Open BAT.xlt. 

b. Go to Menu >Tools >Macro > Security. 

c. Set the Security Level to Medium. 

d. Close BAT.xlt and open it again. When prompted, choose Enable Macros.

Symptom Data files (CSV) format do not match Phone Template/Sample File.

Explanation The number of lines in the data file should be less than or equal to the number of lines 
that are configured in the BAT phone template, but is not. For example, the phone template has three 
lines, and, of these, Lines 1, 2, and 3 are configured. You should use a phone data file with up to 
three configured lines. 1111, 2222, 4444 results in Line1-1111, Line2-2222, Line3-none, 
Line4-4444. 

Recommended Action Check the BAT phone template that you intend to use. The number of lines that 
are specified on the CSV data file should not exceed the number of lines that are configured in the 
BAT phone template. Also, the number of speed dials that the CSV data file specifies should not 
exceed the maximum possible number of speed dials for the BAT phone template that you plan to 
use.
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Symptom Uploaded CSV file does not display in the File Name drop-down list box.

Explanation The CSV file that you uploaded to Cisco Unified CallManager Server using File Upload 
Configuration widow, does not display in the File Name drop-down list box field for various 
operations. For example, if you uploaded a CSV file for inserting phones using 
Uploading/Downloading menu option in Bulk Administration menu, but the file does not appear as 
one of the options in the Insert Phone Configuration window File Name drop-down list box.

Recommended Action Check and make sure that the file is uploaded for the right function. In the 
preceding example, the you might have uploaded the file for Phones - Insert All details, where as 
the CSV file actually belongs to Phones -Insert Specific details. 
Delete the file through Upload/Download Files menu option and upload it for the right function.

Symptom Jobs remain in Pending state even after the scheduled time expires.

Explanation You schedule jobs with a specific scheduled time for execution. But, the jobs remain in 
Pending state, even after the scheduled time.

Recommended Action Check for the following details:

a. Check that Cisco Bulk Provisioning Service (BPS) is started. 

b. Check that there is no other job in Processing state. BPS can process only one job at a time. 

c. Check if Stop Processing is requested for BPS transactions. If so, go to Job Scheduler window 
and click Start Processing.

Symptom Jobs remain in Hold state.

Explanation After you submit jobs with all the required data, the jobs show in Hold state on the job 
scheduler window. These jobs do not get executed.

Recommended Action You need to activate jobs that are in Hold state, before they can be executed by 
BPS. Go to Job Scheduler window and follow the process to activate the job.

Symptom Job does not display in the Find and List Jobs window.

Explanation After you submit a job with all the required data, choose Bulk Administration > Job 
Scheduler. Enter the appropriate search criteria for the job you scheduled and click Find. The job 
does not display in the search results. Check if Hide is chosen in the third drop-down list box in the 
Search Options area of the Find and List Jobs window. This option hides all the completed jobs. If 
the job you submitted is already complete then it will not be displayed in the Search Results area.

Recommended Action In the Find and List jobs window, choose Show from the third drop-down 
window and click Find again. The search results now display completed jobs also.
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Symptom Port number not configured in the template.

Explanation The CSV file specified the port number, but no corresponding ports are configured in 
the BAT template.

Recommended Action In the BAT template, configure the ports that you have specified in the CSV 
file.

Symptom MAC address values are not allowed in the file if dummy MAC address values are desired.

Explanation The CSV file contains MAC addresses. You cannot provide dummy MAC addresses 
when MAC addresses are present in any row in the CSV file.

Recommended Action If you want to use dummy MAC addresses, create a new CSV file that contains 
only those records for which you have not specified MAC addresses. Alternatively, you can specify 
MAC addresses in the CSV file and not check the Create Dummy MAC Address check box.

Symptom The BAT.xlt spreadsheet does not work with Microsoft Excel XP (Office XP)

Explanation In Microsoft Excel packaged with Office XP, macro security is set to high by default. 
Due to this setting, macros in BAT.xlt cannot run which renders BAT.xlt unusable. 

Recommended Action To enable macros in BAT.xlt use the following steps:

a. Open BAT.xlt. 

b. Go to Menu >Tools >Macro > Security. 

c. Set the Security Level to Medium. 

d. Close BAT.xlt and open it again. When prompted, choose Enable Macros.

Troubleshooting BAT Performance
Keep in mind that it is best to send bulk transactions during low-traffic periods. When you insert BAT 
files to the first node database during the time when Cisco Unified CallManager is processing a high 
volume of calls, the BAT transactions can be slow. In fact, you can adversely affect how 
Cisco Unified CallManager processes calls. 

You can improve BAT performance by restricting the file size of the file to less than 12000 records per 
file.

You can also improve BAT performance by stopping the TFTP service before you insert the BAT files to 
the first node database. You must restart the TFTP service when the insert transaction complete. 

Use the following procedure to stop the TFTP service on the Cisco Unified CallManager first node 
server.

Procedure

Step 1 In Cisco Unified CallManager Serviceability window, choose Tools > Control Center - Feature 
Services.

Step 2 Choose Cisco TFTP from the Unified CMService list by clicking the corresponding radio button. 
54-6
Cisco Unified CallManager Bulk Administration Guide

OL-9421-01



Chapter 54      Troubleshooting BAT and Unified CM Auto-Register Phone Tool
Troubleshooting Unified CM Auto-Register Phone Tool
Step 3 Click Stop and click OK.

Note You must restart the TFTP service when the insert transaction is complete. Use the same procedure and 
click Start to restart the service.

Additional Topics

See the “Related Topics” section on page 54-8.

Troubleshooting Unified CM Auto-Register Phone Tool 
When you install Unified CM Auto-Register Phone Tool, you must install the application on the 
Cisco Unified CallManager CRS server console. If you attempt to use Windows Terminal Services to 
install Unified CM Auto-Register Phone Tool, you receive a message that indicates that Unified CM 
Auto-Register Phone Tool installation is not supported over Terminal Services.

As a general rule, Cisco recommends that you stop Cisco Unified CallManager Unified CM 
Auto-Register Phone Tool service when Unified CM Auto-Register Phone Tool is not in use. You can 
prevent undesired Unified CM Auto-Register Phone Tool usage by stopping the service, and you can 
save some CPU time.

Additional Topics

See the “Related Topics” section on page 54-8.

Viewing Unified CM Auto-Register Phone Tool Log Files
Unified CM Auto-Register Phone Tool generates a row of information for each 

To view Unified CM Auto-Register Phone Tool log file, choose Bulk Administration > Unified CM 
Auto-Register Phone Tool > View Unified CM Auto-Register Phone Tool Log File.

Unified CM Auto-Register Phone Tool Error Messages
You may receive the following messages while running Unified CM Auto-Register Phone Tool on the 
Cisco CRS server.

Symptom When dialing the Unified CM Auto-Register Phone Tool route point number, the caller 
receives a busy tone.

Explanation The busy tone indicates that the maximum number of simultaneous sessions for 
Unified CM Auto-Register Phone Tool has been reached. The maximum number of sessions for 
Unified CM Auto-Register Phone Tool equals the number of ports that are assigned to the 
Unified CM Auto-Register Phone Tool application in CRS configuration.

Recommended Action You must increase the number of ports that are assigned to Unified CM 
Auto-Register Phone Tool in CRS configuration to prevent this situation.
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Symptom When the Cisco CRS server starts, the JTAPI subsystem shows partial service or out of service

Explanation Message occurs because of configuration problems in the Cisco Unified CallManager 
or the Cisco CRS server.

Recommended Action Perform one or all of the following steps until the problem has been corrected:

• Verify that Cisco Unified CallManager is started.

• Make sure that JTAPI is installed on the Cisco CRS server.

• Make sure that the JTAPI version on the CRS server is the same as the JTAPI version that is 
installed on Cisco Unified CallManager. If the version is not the same, install the JTAPI client 
from the Cisco Unified CallManager plug-ins window on the CRS server.

• Verify that the CRS engine configuration has a valid application engine host name. You can use 
the IP address to eliminate name resolution issues.

• Make sure that the Route Points and CTI ports are properly configured on the 
Cisco Unified CallManager.

• Verify that the Allow control of device from CTI check box is checked for the JTAPI user; you 
can verify that this in the user window in Cisco Unified CallManager Administration.

• Verify that the CTI Manager service is started.

• Verify that the ports and the route point are associated to the user in the 
Cisco Unified CallManager user configuration.

For further troubleshooting, collect and review MIVR log files for Cisco CRS server. You can find 
these files on the CRS server in the following folder: C:\program files\wfavvid\log\.

Additional Topics

See the “Related Topics” section on page 54-8.

Related Topics
• BAT Log Files, page 54-3

• Viewing Trace Configuration Files, page 54-1

• Troubleshooting BAT, page 54-3

• Troubleshooting BAT Performance, page 54-6

• Troubleshooting Unified CM Auto-Register Phone Tool, page 54-7
54-8
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Text-Based CSV Files

Cisco Unified CallManager Bulk Administration (BAT) uses data that is entered in a comma separated 
values (CSV) file format to provide information for insert transactions to the Cisco Unified CallManager 
database on the first node server. By using the CSV data format, you can build a textual file that contains 
data records in a tabular format.

You can create a CSV data file by using a text editor, such as Microsoft Notepad. You must use a separate 
line to enter data for each record. Separate each data field with a comma and include comma separators 
for blank fields. Enter data on every line in the data file because an error occurs during the insert 
transaction if you enter a blank line in a CSV file.

When you insert the data records to the Cisco Unified CallManager database, BAT accesses a set of 
designated folders that reside on the server that is running the first node database. For BAT to access the 
appropriate CSV data file for the transaction, you must upload the CSV data file to the first node 
database server of Cisco Unified CallManager. See the “Uploading a File” section on page 2-3. 

The following topics provide information and file formats for the following text-based CSV files:

• Creating a Text-Based CSV File for Phones, page A-1

• Creating a Text-Based CSV File for Users, page A-6

• Creating a Text-Based CSV File for User Device Profile, page A-9

• Creating a Text-Based CSV File for Cisco Unified CM Assistant Manager-Assistant Associations, 
page A-12

• Creating a Text-Based CSV File for Cisco VG200 Gateways, page A-13

• Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports, page A-15

• Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, 
page A-16

• Creating a Text-Based CSV File for Call Pickup Groups, page A-19

Creating a Text-Based CSV File for Phones 
Instead of using the BAT spreadsheet for data input when you are adding phones, you can create the 
comma separated values (CSV) file by using lines of ASCII text with values separated by commas.

Use the following procedure to create a CSV text file for phones, IP telephony devices, and user 
combinations.
A-1
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Procedure

Step 1 Open a text editor (such as Microsoft Notepad) or any application that allows you to export or create a 
CSV file.

Step 2 Use a separate line to enter the values for each phone, IP telephony device, or user combination that you 
want to add to Cisco Unified CallManager. You must create separate CSV files for each type of device. 
Keep in mind the following rules when you create the CSV data file.

• Always include comma separators, even if a field is blank. 

• Specify the user ID if the phone is to be associated to a user.

• Directory Number fields are optional only when you are creating the CSV file for use with a BAT 
template that has no lines. If lines are configured on the BAT phone template, you must supply 
directory numbers in the CSV file for each device.

• An error occurs when you insert a CSV file with blank lines.

See the “Phone CSV Data File Formats” section on page A-2 for information about the CSV data file 
formats that you must use for different phone types.

Step 3 Upload the CSV file to the first node of Cisco Unified CallManager. See the “Uploading a File” section 
on page 2-3.

For information about CSV file formats for other phone types, see these topics:

• Phone CSV Data File Formats, page A-2

• Export File Fields for All Phone Details Option, page A-4

• Phone CSV File Examples, page A-5

Phone CSV Data File Formats
Different types of phones require specific data formats. Keep in mind that fields that are labeled as 
optional in the phone file format become mandatory fields when certain conditions are met. 

The following topics provide the formats and samples for these phone types:

• Phones With Users Combinations File Format, page A-2

• CTI Ports/H.323 Clients File Format, page A-3

• CTI Ports-Users and H.323 Client-Users Combinations File Format, page A-3

Phones With Users Combinations File Format

The following sample shows the field length and whether the field is optional or mandatory for a 
text-based CSV file for phones and the fixed user format.

First Name(Mandatory, 1 to 50 characters), Last Name(Mandatory, 1 to 50 characters), User 
ID(Mandatory, 1 to 30 characters), Password(Optional, up to 20 characters), Manager USer 
ID(Optional, up to 30 characters, must use the ID that exists in global directory), Department(Optional, 
up to 50 characters), PIN(Optional up to 20 numerals),Default Profile(Optional, up to 50 
characters),User Locale (Optional, up to 50 characters),Telephone Number (Optional, up to 20 
numerals),Primary Extension (Optional, up to 50 numerals),Associated PC(Optional, up to 50 
characters),ICD Extension(Optional, up to 50 numerals),Mail ID (Optional, up to30 
A-2
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characters),Presence Group (Optional, up to 50 characters),Subscribe Calling Search Space 
(Optional, up to 50 characters), MAC Address (Mandatory, up to 12 characters),Description (Optional, 
up to 50 characters), Location (Optional, up to 50 characters), Directory Number (Optional, up to 24 
numerals and special characters), Display (Optional, up to 30 characters), Line Text Label (Optional, 
up to 30 characters), Forward Busy External (Optional, up to 50 numerals and special characters), 
Forward No Answer External (Optional, up to 50 numerals and special characters), Forward No 
Coverage External (Optional, up to 50 numerals and special characters), Forward Busy Internal 
(Optional, up to 50 numerals and special characters), Forward No Answer Internal (Optional, up to 50 
numerals and special characters), Forward No Coverage Internal (Optional, up to 50 numerals and 
special characters), Call Pickup Group (Optional, up to 50/50 characters), Speed Dial (Optional, up to 
50 numerals and special characters), Speed Dial Label (Optional, up to 30 characters)

Sample
John,Smith,johns,abcde,Daviss,12,12345,johnProfile,English United 
States,1,1231123245AB,Dallas,9725557154,9725557154,Mike,9725557172,9725557196,9725557112,9
725557127,9725557158,9725557189,9725557121/TollByPass,1230000000,Helpdesk

CTI Ports/H.323 Clients File Format

The following sample shows the field length and whether the field is optional or mandatory for a 
text-based CSV file for CTI ports and H.323 clients format.

Device Name (Mandatory, up to 15 characters for CTI ports and up to 50 characters for H.323 
Clients),Description (Optional, up to 50 characters) Location (Optional, up to 50 
characters),User ID(Optional, 1 to 30 characters),Directory Number(Optional, up to 24 numerals and 
special characters),Display (Optional, up to 30 characters), Line Text Label(Optional, up to 30 
characters),Forward Busy External(Optional, up to 50 numerals and special characters),Forward No 
Answer External(Optional, up to 50 numerals and special characters),Forward No Coverage 
External(Optional, up to 50 numerals and special characters),Forward Busy Internal(Optional, up to 
50 numerals and special characters),Forward No Answer Internal(Optional, up to 50 numerals and 
special characters),Forward No Coverage Internal(Optional, up to 50 numerals and special 
characters),Call Pickup Group (Optional, up to 50/50 characters)

Sample
Unified CM Auto-Register Phone Tool Port 1,CTI Unified CM Auto-Register Phone Tool Port 
1,Dallas,johns,9728437154,9728437154, 
Mike,9728437172,9728437196,9728437127,9728437154,9728437178, 
9728437189,9728437121/TollByPass,1230000000,Helpdesk

CTI Ports-Users and H.323 Client-Users Combinations File Format

The following sample shows the field length and whether the field is optional or mandatory for a 
text-based CSV file for CTI ports with users and H.323 clients with users format.

First Name(Mandatory, 1 to 50 characters),Last Name(Mandatory, 1 to 50 characters),User 
ID(Mandatory, up to 30 characters),UserID (Mandatory, 1 to 30 characters),Password (Optional, up to 
20 characters),Manager User ID(Optional, up to 30 characters, must use existing ID in global 
directory),Department (Optional, up to 50 characters),PIN (Optional, up to 20 numerals),Default 
Profile (Optional, up to 50 characters),User Locale (Optional, up to 50 characters),Telephone Number 
(Optional, up to 20 numerals),Primary Extension (Optional, up to 50 numerals),Associated PC 
(Optional, up to 50 characters),ICD Extension(Optional, up to 50 numerals),Mail ID (Optional, up to30 
characters),Presence Group (Optional, up to 50 characters),Subscribe Calling Search Space 
(Optional, up to 50 characters),Device Name (Mandatory, up to 15 characters for CTI ports-users 
combination and up to 50 characters for H.323client-users combinations),Description (Optional, up to 
A-3
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50 characters),Location (Optional, up to 50 characters),Directory Number (Optional, up to 24 
numerals and special characters),Display (Optional, up to 30 characters),Line Text Label (Optional, up 
to 30 characters),Forward Busy External (Optional, up to 50 numerals and special 
characters),Forward No Answer External (Optional, up to 50 numerals and special 
characters),Forward No Coverage External(Optional, up to 50 numerals and special 
characters),Forward Busy Internal (Optional, up to 50 numerals and special characters),Forward No 
Answer Internal (Optional, up to 50 numerals and special characters),Forward No Coverage Internal 
(Optional, up to 50 numerals and special characters),Call Pickup Group (Optional, up to 50 characters)

Sample
John,Smith,johns,abcde,Daviss,12,12345,johnProfile,English United States,1,Unified CM 
Auto-Register Phone Tool Port 1,CTI Unified CM Auto-Register Phone Tool Port 
1,9725557154,9725557154,Mike,9725557172,9725557196,9725557112,9725557127,9725557158,972555
7189,9725557121/TollByPass,1230000000,Helpdesk

Note If you use a comma or double quotes as part of the value in one of the fields, you must enclose the entire 
text value with double quotation marks to designate it as a single value. 
For example, if you entered John, Bill as a text value, then you must enter the value as “John,Bill”. 
If you entered a double quote in a value, then you must replace the double quote with two consecutive 
double quotes and enclose the value with double quotes. For example you must enter John “Chief as 
“John”“Chief”.

Additional Topics

See the “Related Topics” section on page A-21.

Export File Fields for All Phone Details Option 
When you are using the export utility to generate a file that containing all the details for the phone 
records, the export file has the following format. 

Caution Cisco does not recommend editing the file that is generated with the export utility. The system 
dynamically generates fields, such as Logout time and Login time, that must not be edited at all. You 
must ensure that the login user ID and Product Specific XML fields are accurate for them to work 
properly, and you must not edit them. Use BAT to update the product specific configurations.

<<DEVICE>>Device Name,Description,Device Pool,Phone Template,CSS,AAR 
CSS,Location,Extension Mobility,Network Locale,Media Resource Group List,User Hold Audio 
Source,Network Hold Audio Source,Device User Locale,Signal Packet Capture Mode,Packet Capture 
Duration,Built in Bridge,Privacy,Retry Video Call as Audio,Ignore Presentation Indicators,Softkey 
Template,Module 1,Module 2,Phone Load Name,Module 1 Load Name,Module 2 Load 
Name,Information,Directory,Messages,Services,Authentication Server,Proxy Server,Idle,Idle 
Timer,MLPP Indication,MLPP Preemption,MLPP Domain,Device Type,User ID,Common 
Profile,Owner User ID,Allow CTI Control Flag,Device Presence Group,Security Profile,Device 
Subscribe CSS,Unattended Port,Require DTMF Reception,RFC2833 Disabled,Certificate 
Operation,Authentication String,Certification Operation Completion Time,Device Protocol,Secure 
Shell User,Secure Shell Password,XML,Dial Rules,CSS Reroute,CSS Refer,DTMF Signalling,Default 
DTMF Capability,SIP Profile,SIPCodec_MTPPreferredOrigCodec,Logout Profile,MTP 
Required,Digest User
A-4
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<<LINE>>Directory Number,Partition,Voice Mail Profile,Line CSS,AAR Group,Line User Hold Audio 
Source,Line Network Hold Audio Source ,Auto Answer,Forward All Voice Mail,Forward All 
Destination,Forward All CSS,Forward Busy Internal Voice Mail,Forward Busy Internal 
Destination,Forward Busy Internal CSS,Forward Busy External Voice Mail,Forward Busy External 
Destination,Forward Busy External CSS,Forward No Answer Internal Voice Mail,Forward No Answer 
Internal Destination,Forward No Answer Internal CSS,Forward No Answer External Voice 
Mail,Forward No Answer External Destination,Forward No Answer External CSS,Forward No 
Coverage Internal Voice Mail,Forward No Coverage Internal Destination,Forward No Coverage Internal 
CSS,Forward No Coverage External Voice Mail,Forward No Coverage External Destination,Forward No 
Coverage External CSS,Forward No Answer Ring Duration,Call Pickup Group,MLPP Target,MLPP 
CSS,MLPP No Answer Ring Duration,Line Text Label,External Phone Number Mask,Maximum 
Number of Calls,Busy Trigger,Message Waiting Lamp Policy,Ring setting (Phone Idle),Ring Setting 
(Phone Active),Caller Name,Caller Number,Redirected Number,Dialed Number,Line 
Description,Alerting Name,Alerting Name ASCII,Line Presence Group,Secondary CSS for Forward 
All,Forward on CTI Failure Voice Mail,Forward on CTI Failure Destination,Forward on CTI Failure 
CSS,Display,ASCII Display

<<SPEEDDIALS, SERVICES, PARAMETERS, AND BUSY LAMP FIELDS>> Speed Dial 
Number,Speed Dial Label,Speed Dial Label ASCII,Service Name,Subscribed Service Name,Subscribed 
Service URL,Subscribed Service Name ASCII,Parameter Name,Parameter Value,Busy Lamp Field 
Destination,Busy Lamp Field Directory Number,Busy Lamp Field Label,Busy Lamp Field Label ASCII

Additional Topics

See the “Related Topics” section on page A-21.

Phone CSV File Examples
The following list provides examples of commonly used phone CSV data files:

Using a Template Attribute-Forward Busy Destination

If Forward Busy Destination is 3001 on a phone template, all records in a CSV file that have no value 
for Forward Busy Destination use 3001.

1,1231123245AB,SEP1231123245AB,Dallas,johns,9728437154,9728437154,Mike,,9728437196,9728437
127,9728437154,9728437178,9728437189,9728437121/TollByPass,1230000000,Helpdesk 

No Phone Description Entry

If the description for a phone is blank, use this format:

1,1231123245AB,,Dallas,johns,9728437154,9728437154,Mike,9728437172,9728437196,9728437127,9
728437154,9728437178,9728437189,9728437121/TollByPass,1230000000,Helpdesk

No Active Line or Location Entry

If no active line is required and the location is also blank, use this format:

0,1231123245AB,SEP1231123245AB,,,1230000000,HelpDesk

Two Active Lines

If two active lines are required, use this format:

1,1231123245AB,SEP1231123245AB,Dallas,johns,9725557154,9725557154,Mike,9725557172,97255571
96,9728437127,9728437154,9728437178,9728437189,9725557121/TollByPass,9725557155,9725557155
,Kelvin,9725557133,9725557196,9728437112,9728437145,9728437187,9728437198,9725557112/TollB
yPass,1230000000,Helpdesk
A-5
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Note For the MAC Address, enter MAC address values or check the option for creating dummy MAC addresses.

Mandatory Phone Entries

If one line is required and you want to include only the required values and none of the optional values, 
use this format:

1231123245AB,,,,9725557154,,,,,

Using Dummy MAC Address Option

If the option is checked for a dummy MAC address and you want one line, use this format:

SEP1231123245AB,Dallas,9725557154,9725557154,Mike,9725557172,9725557196,9728437127,9728437
154,9728437178,9728437189,9725557121/TollByPass,johns,1230000000,Helpdesk 

Additional Topics

See the “Related Topics” section on page A-21.

Creating a Text-Based CSV File for Users
Instead of using the BAT spreadsheet for data input when you are adding users, you can create the comma 
separated values (CSV) file by using lines of ASCII text with values separated by commas.

Use this procedure to create a CSV text file for users.

Procedure

Step 1 Open a text editor (such as Microsoft Notepad) or any application that allows you to export or create a 
CSV file.

Step 2 Using a separate line for each user, enter the values for each user that you want to add to 
Cisco Unified CallManager. See Users File Format, page A-7, for detailed information about the 
formatting that you must use in the text-based CSV file.

You can associate any number of existing devices to a new user by entering the device name of all the 
devices separated by a comma at the end of the record.

You can associate a directory number to a user, even if that user does not control any device.

Note An error occurs if any blank lines exist in the CSV file.

Step 3 Upload the file to first node of the Cisco Unified CallManager. See “Downloading a File” section on 
page 2-2.

Related Topics

See the “Related Topics” section on page A-21.
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Users File Format

Tip You must specify PIN and Password values, either on the CSV file or when using BAT for file 
insertion. If you want to apply individual PINs or passwords for each user or group of users, specify 
the PIN and password information in the CSV file. If you want to use a default PIN and password 
that all users can use, do not specify PIN or password values in the CSV file and instead provide this 
information when you use BAT to insert the CSV file in Cisco Unified CallManager. 

The following sample format and examples show the fields, field length, and whether the field is optional 
or mandatory for a text-based CSV file for users.

First Name(Mandatory, 1 to 50 characters),Last Name(Mandatory, 1 to 50 characters),User 
ID(Mandatory, up to 30 characters),Manager User ID(Optional, up to 30 characters, must use existing 
ID in global directory),Department (Optional, up to 50 characters),PIN (Optional, up to 20 
numerals),Default Profile(Optional, up to 50 characters),User Locale (Optional, up to 50 
characters),Telephone Number (Optional, up to 20 numerals),Primary Extension (Optional, up to 50 
numerals),Associated PC (Optional, up to 50 characters),ICD Extension(Optional, up to 50 
numerals),Mail ID (Optional, up to30 characters),Presence Group (Optional, up to 50 
characters),Subscribe Calling Search Space (Optional, up to 50 characters)

Sample
John,Smith,johns,abc123de,karend,0012055,9989,johns profile,English
United States,SEP1231123245AB,9725557154,SEP0010EB001234

You must specify delimiters even if a field is blank. Refer to the following examples and sample CSV 
records when you are creating CSV files.

Example 1

If the manager for a user is blank, use this format:

John,Smith,johns,abc123de,,0012055,9989,johns profile,English United
States,SEP1231123245AB,9725557154,SEP0010EB001234

Example 2

When you want to complete only the mandatory fields, use this format:

John,Smith,johns,,,,,,,,

Example 3

When you want to complete only the mandatory fields and associate the user to a phone, use this format:

John,Smith,johns,,,,,,,SEP1231123245AB,

Example 4

A user can control more than one device. You can add device names for additional devices at the end of 
the record.

• If the user controls only one device, use this format:

John,Smith,johns,abc123de,karend,0012055,9989,johns profile,English
United States,SEP1231123245AB,9725557154
A-7
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• If the user controls three devices, use this format:

John,Smith,johns,abc123de,karend,0012055,9989,johns profile,English 
UnitedStates,SEP1231123245AB,9725557154,SEP0010EB001234,SEP0010EB432101

Updating Users File Format
Use a text editor to create the CSV text file for updating users. Upload the file to first node server. See 
“Uploading a File” section on page 2-3.

When you are updating a record, you need to supply all mandatory fields for a file. If you have stored 
values in the optional fields, and you update a record with blank optional fields, you will reset the values 
to blank. See the “Retaining Stored Values” section on page 17-1 for information about keeping 
previously stored values.

The following sample format shows the field length and string types followed by examples of CSV files 
for updating users.

UserID (Mandatory, 1 to 30 characters),Password (Optional, up to 20 characters),Manager (Optional, 
up to 30 characters, must use existing ID in global directory),Department (Optional, up to 50 
characters),PIN (Optional, up to 20 numerals),Default Profile(Optional, up to 50 characters),User 
Locale (Optional, up to 50 characters),Telephone Number (Optional, up to 20 numerals),Primary 
Extension (Optional, up to 50 numerals),Associated PC (Optional, up to 50 characters),ICD 
Extension(Optional, up to 50 numerals),Mail ID (Optional, up to30 characters)

Sample
johns,Daviss,123,johnProfile,English United States,SEP8612113425AC,9725557154

Note You must specify delimiters even if a field is blank. Refer to the following examples and sample CSV 
records when you are creating CSV files.

Example 1

If the manager for a user is blank. use this format:

johns,,123,johnProfile,English United States,SEP8612113425AC,9725557154

Example 2

Enter your preferred language first, followed by the country. Use the following three examples as a 
guide:

English United States, French France, German Germany

Example 3

Mandatory fields include the following fields:

John,Daviss,123,johnProfile,,,

Additional Topics

See the “Related Topics” section on page A-21.
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Creating a Text-Based CSV File for User Device Profile
Instead of using the BAT spreadsheet for data input when you are adding user device profiles, you can 
create the comma separated values (CSV) file by using lines of ASCII text with values separated by 
commas.

Note If you use comma or double quotes as part of string in one of the fields, you must enclose the entire text 
string with double quotes. 

To create a CSV text file for user device profiles, use this procedure.

Procedure

Step 1 Open Microsoft Notepad to create the CSV file.

Step 2 Using a separate line for each user device profile, enter the values for each user device profile that you 
want to add to Cisco Unified CallManager. See User Device Profiles File Format, page A-9, for detailed 
information about the formatting that you must use in the text-based CSV file.

Note An error occurs if any blank lines exist in the CSV file.

Step 3 Upload the CSV file to the first node server for Cisco Unified CallManager.

Additional Topics

See the “Related Topics” section on page A-21.

User Device Profiles File Format
The following sample format shows the field length and string types followed by examples of a CSV 
files for user device profiles.

Device Profile Name(Mandatory, 1 to 50 characters),Description(Optional, 1 to 50 characters),Login 
UserID (Optional, 4 to 30 characters),Directory Number(Optional, up to 24 numerals and special 
characters),Display(Optional, for internal Caller ID, up to 30 characters),Line Text Label(Optional, up 
to 30 characters),Forward Busy External Destination(Optional, up to 50 numerals),Forward No 
Answer External Destination(Optional, up to 50 numerals),Forward No Coverage 
External(Optional, up to 50 numerals),Forward Busy Internal Destination(Optional, up to 50 
numerals),Forward No Answer Internal Destination(Optional, up to 50 numerals),Forward No 
Coverage Internal(Optional, up to 50 numerals),Call Pickup Group(Optional, up to 50/50 
characters),Speed Dial Number(Optional, up to 50 numerals),Speed Dial Label(optional, up to 30 
characters)

Sample
John Profile,John's 
Profile,Johns,9725557154,9725557154,Mike,9725557172,9725557196,9725557126,9725557154,97255
57178,9725557189,9725557121/TollByPass,1230000000,Helpdesk 
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Example 1

You must specify delimiters even if a field is blank. The following example shows the correct format for 
not specifying a Display setting:

1,John Profile,John's 
Profile,Johns,9725557154,,Mike,9725557172,9725557196,9725557126,9725557154,9725557178,9725
557189,9725557121/TollByPass,1230000000,Helpdesk 

Example 2

If it is a 0-line profile and only mandatory fields are added, use the following example: 

John Profile,,,,

Example 3

If only the mandatory fields are completed and you want to associate the user device profile to only one 
directory number, use this format:

John Profile,,,9725557154,,,,,

User Device Profile with Two Lines and Two Speed Dials

The following example format shows the field length and string types of a CSV file for user device 
profiles with two lines.

User Device Profile Name(Mandatory, 1 to 50 characters),Description(Optional, 1 to 50 
characters),Login UserID (Optional, 4 to 30 characters),Directory Number1(Optional, up to 24 
numerals and special characters),Display1(Optional, for internal Caller ID, up to 30 characters),Line 
Text Label1(Optional, up to 30 characters),Forward Busy External Destination1(Optional, up to 50 
numerals),Forward No Answer External Destination1(Optional, up to 50 numerals),Forward No 
Coverage External Destination1(Optional, up to 50 numerals),Forward Busy Intermal 
Destination1(Optional, up to 50 numerals),Forward No Answer Internal Destination1(Optional, up 
to 50 numerals),Forward No Coverage Internal Destination1(Optional, up to 50 numerals),Call 
Pickup Group1(Optional, up to 50/50 characters),Directory Number2(Optional, up to 24 numerals and 
special characters),Display2(Optional, for internal Caller ID, up to 30 characters),Line Text 
Label2(Optional, up to 30 characters),Forward Busy External Destination2(Optional, up to 50 
numerals),Forward No Answer External Destination2(Optional, up to 50 numerals),Forward No 
Coverage External Destination2(Optional, up to 50 numerals),Forward Busy Intermal 
Destination2(Optional, up to 50 numerals),Forward No Answer Internal Destination2(Optional, up 
to 50 numerals),Forward No Coverage Internal Destination2(Optional, up to 50 numerals),Call 
Pickup Group2(Optional, up to 50/50 characters),Speed Dial Number1(Optional, up to 50 
numerals),Speed Dial Label1(optional, up to 30 characters),Speed Dial Number2(Optional, up to 50 
numerals),Speed Dial Label2(optional, up to 30 characters)

Example
John Profile,John's 
Profile,John’s,9725557154,9725557154,Mike,9725557172,9725557196,9725557126,9725557154,9725
557178,9725557189,9725557121/TollByPass,9725557155,9725557155,Kelvin,9725557133,9725557196
,9725557113,9725557145,9725557187,9725557198,9725557112/TollByPass,1230000000,Helpdesk,214
9523460,Keith
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Export File Fields for User Device Profile with All Details Option 

When you are using the export utility to generate a file that contains all the details for the user device 
profiles, the export file will have the following format. The example shows the length and type of fields 
in the export all details file. 

The export utility does not generate model specific fields for user device profiles.

Caution Cisco does not recommend editing the file that is generated with the export utility. The system 
dynamically generates some fields, such as Logout time and Login time, that must not be edited at all. 
You must ensure that the login user ID and Product Specific XML fields are accurate for them to work 
properly and you must not edit them. Use BAT to update the product-specific configurations.

<<DEVICE>>Device Profile Name,Description,Device Pool,Phone Template,CSS,AAR 
CSS,Location,Extension Mobility,Network Locale,Media Resource Group List,User Hold Audio 
Source,Network Hold Audio Source,Device User Locale,Signal Packet Capture Mode,Packet Capture 
Duration,Built in Bridge,Privacy,Retry Video Call as Audio,Ignore Presentation Indicators,Softkey 
Template,Module 1,Module 2,Phone Load Name,Module 1 Load Name,Module 2 Load 
Name,Information,Directory,Messages,Services,Authentication Server,Proxy Server,Idle,Idle 
Timer,MLPP Indication,MLPP Preemption,MLPP Domain,Device Type,User ID,Common 
Profile,Owner User ID,Allow CTI Control Flag,Device Presence Group,Security Profile,Device 
Subscribe CSS,Unattended Port,Require DTMF Reception,RFC2833 Disabled,Certificate 
Operation,Authentication String,Certification Operation Completion Time,Device Protocol,Secure 
Shell User,Secure Shell Password,XML,Dial Rules,CSS Reroute,CSS Refer,DTMF Signalling,Default 
DTMF Capability,SIP Profile,SIPCodec_MTPPreferredOrigCodec,Logout Profile,MTP 
Required,Digest User

<<LINE>>Directory Number,Partition,Voice Mail Profile,Line CSS,AAR Group,Line User Hold Audio 
Source,Line Network Hold Audio Source ,Auto Answer,Forward All Voice Mail,Forward All 
Destination,Forward All CSS,Forward Busy Internal Voice Mail,Forward Busy Internal 
Destination,Forward Busy Internal CSS,Forward Busy External Voice Mail,Forward Busy External 
Destination,Forward Busy External CSS,Forward No Answer Internal Voice Mail,Forward No Answer 
Internal Destination,Forward No Answer Internal CSS,Forward No Answer External Voice 
Mail,Forward No Answer External Destination,Forward No Answer External CSS,Forward No 
Coverage Internal Voice Mail,Forward No Coverage Internal Destination,Forward No Coverage Internal 
CSS,Forward No Coverage External Voice Mail,Forward No Coverage External Destination,Forward No 
Coverage External CSS,Forward No Answer Ring Duration,Call Pickup Group,MLPP Target,MLPP 
CSS,MLPP No Answer Ring Duration,Line Text Label,External Phone Number Mask,Maximum 
Number of Calls,Busy Trigger,Message Waiting Lamp Policy,Ring setting (Phone Idle),Ring Setting 
(Phone Active),Caller Name,Caller Number,Redirected Number,Dialed Number,Line 
Description,Alerting Name,Alerting Name ASCII,Line Presence Group,Secondary CSS for Forward 
All,Forward on CTI Failure Voice Mail,Forward on CTI Failure Destination,Forward on CTI Failure 
CSS,Display,ASCII Display

<<SPEEDDIALS, SERVICES, PARAMETERS,AND BUSY LAMP FIELDS>>Speed Dial 
Number,Speed Dial Label,Speed Dial Label ASCII,Service Name,Subscribed Service Name,Subscribed 
Service URL,Subscribed Service Name ASCII,Parameter Name,Parameter Value,Busy Lamp Field 
Destination,Busy Lamp Field Directory Number,Busy Lamp Field Label,Busy Lamp Field Label ASCII 

Note Use True and False for settings with Boolean values.
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Creating a Text-Based CSV File for Cisco Unified CM Assistant Manager-Assistant Associations
Additional Topics

See the “Related Topics” section on page A-21.

Creating a Text-Based CSV File for Cisco Unified CM Assistant 
Manager-Assistant Associations

Instead of using the BAT spreadsheet for data input when you are adding Unified CM Assistant managers 
and assistants, you can create the comma separated values (CSV) file by using lines of ASCII text with 
values separated by commas.

To create a CSV text file for Unified CM Assistant manager and assistants, use this procedure.

Procedure

Step 1 Open a text editor (such as Notepad) or any application that allows you to export or create a CSV file.

Step 2 Using a separate line for each manager-assistants association, enter the values for each manager-assistant 
that you want to add to Cisco Unified CallManager. See Managers and Assistants File Formats, page 
A-12, for detailed information about the formatting that you must use in the text-based CSV file.

Note An error occurs if any blank lines exist in the CSV file.

You can assign multiple assistants to a manager by entering the user IDs of the manager and assistants 
separated by a comma at the end of the record.

Step 3 Upload the file to the server that is running the first node database for Cisco Unified CallManager. See 
the “Uploading a File” section on page 2-3.

Additional Topics

See the “Related Topics” section on page A-21.

Managers and Assistants File Formats
The following sample formats and examples show the field length and string types for Unified CM 
Assistant manager and assistant associations. Use the user ID of the manager for the Manager ID and the 
user ID of the assistant for the Assistant ID. You can also associate many managers to one assistant by 
putting the Assistant ID first, followed by a list of Manager IDs. When you insert the CSV file, you select 
the type of association.

Default Manager-Assistant Association

Use the following default format for manager-assistant association.

ManagerID (Mandatory, 1 to 30 characters),AssistantID 1 (Mandatory, 1 to 30 characters),AssistantID 
2 (Mandatory, 1 to 30 characters)...AssistantID # (Mandatory, 1 to 30 characters)
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Sample
Johns,Mikeh,Larryh

Default Assistant-Manager Association

Use the following default format for assistant-manager association.

AssistantID (Mandatory, 1 to 30 characters),ManagerID 1(Mandatory, 1 to 30 characters),ManagerID 
2 (Mandatory, 1 to 30 characters)...ManagerID # (Mandatory, 1 to 30 characters)

Sample
Larryh,Johns,Mikeb,Karend

Custom Manager-Assistant Association

For proxy line configurations, you can build a CSV data file that specifies the proxy lines on assistant 
phones by using this format.

ManagerID (Mandatory, 1 to 30 characters),Device Name (Optional, 15 characters),Intercom DN 
(Optional, 1 to 24 characters),Assistant User ID (Mandatory, 1 to 30 characters),Device Name 
(Optional, 15 characters),Intercom DN (Optional, 1 to 24 characters),Proxy Line DN (Mandatory, 1to 
24 characters),Manager Line DN (Mandatory, 1 to 24 characters)

Example
Johns,SEP1231123245AB,90001,Mikeh,SEP2342342342AB,20001,20002,90002

Additional Topics

See the “Related Topics” section on page A-21.

Creating a Text-Based CSV File for Cisco VG200 Gateways
Instead of using the BAT spreadsheet for data input when you are adding Cisco VG200 gateways, you 
can create the comma separated values (CSV) file by using lines of ASCII text with values separated by 
commas.

To create a CSV text file for VG200 gateways, use this procedure.

Procedure

Step 1 Open a text editor (such as Notepad) or any application that allows you to export or create a CSV file.

Step 2 Using a separate line for each gateway, enter the values for each gateway and port that you want to add 
to Cisco Unified CallManager.

The sections, FXO or FXS Trunks CSV File Format, page A-14, and T1 CAS, T1 PRI, or E1 PRI Trunks 
File Format, page A-14, provide descriptions and examples.

Note An error occurs if any blank lines exist in the CSV file.
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Creating a Text-Based CSV File for Cisco VG200 Gateways
Step 3 Upload the file to the server that is running the first node database for Cisco Unified CallManager. See 
the “Uploading a File” section on page 2-3.

Additional Topics

See the “Related Topics” section on page A-21.

FXO or FXS Trunks CSV File Format
The following sample format shows the required field length and string types followed by sample of CSV 
files for a Cisco VG200 gateway.

MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100 
characters),Slot(Mandatory, up to 3 numerals), Subunit (Mandatory, up to 3 numerals), Port 
Number(Mandatory, up to 3 numerals), Port Description Optional, up to 50 characters),Port Directory 
Number(Optional, up to 24 numerals and special characters)

Sample
MGCPTest,VG200 Lab Gateway,0,1,0,Port 0,97255576601
MGCPTest,VG200 Lab Gateway,0,1,1,Port 1,97255572001

Note You must include comma separators even if a field is blank. Specify the directory number and route 
partition only if the port type in the Cisco VG200 gateway template is POTS.

Example 1

If the Description for a Cisco VG200 gateway is blank, use this format:

MGCPTest, ,0,1,0,Port 0,97255576601

Additional Topics

See the “Related Topics” section on page A-21.

T1 CAS, T1 PRI, or E1 PRI Trunks File Format
The following sample format shows the required field length and string types followed by examples of 
CSV files for the Cisco VG200 gateway.

T1 CAS Trunks

MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100 
characters),Slot(Mandatory, up to 3 numerals),Subunit(Mandatory, up to 3 numerals),Port 
Number(Mandatory, up to 3 numerals),Port Description (Optional, up to 50 characters),CAS Port 
Number(Optional, up to 3 numerals)

Sample 1
MGCPTest,VG200 Lab Gateway,001,001,001,,,
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T1 PRI or E1 PRI

MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up to 100 
characters),Slot(Mandatory, up to 3 numerals), Subunit(Mandatory, up to 3 numerals), Port 
Number(Mandatory, up to 3 numerals), Port Description (Optional, up to 50 characters)

Sample 2
MGCPTest,VG200 Lab Gateway,001,001,001,,

Note You must include comma separators even if a field is blank.

Example for Both Trunk Options

If you provide only the mandatory value, use this format:

MGCPTest,,001,001,001,,

T1 CAS Examples

If the Description for a Cisco VG200 gateway is blank, use this option:

MGCPTest,,001001,001,001,MGCP Port,

For port identifiers, the first digit is either 0 or 1 (signifying either Sub-Unit 0 or Sub-Unit 1), followed 
by the port number, 01 to 24. Acceptable values include 001 through 024 or 101 through 124. If the Cisco 
VG200 gateway template has three port identifiers, use this option:

MGCPTest,VG200 Lab Gateway,001,002,003

Additional Topics

See the “Related Topics” section on page A-21.

Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS 
Ports

Instead of using the BAT spreadsheet for data input when you are adding Cisco Catalyst 6000 FXS ports, 
you can create the comma separated values (CSV) file by using lines of ASCII text with values separated 
by commas.

Use this procedure to create a CSV text file for Cisco Catalyst 6000 FXS ports.

Procedure

Step 1 Open a text editor (such as Notepad) or any application that allows you to export or create a CSV file.

Step 2 Using a separate line for each port, enter the values for each port that you want to add to 
Cisco Unified CallManager. See Cisco Catalyst 6000 (FXS) Ports File Format, page A-16, for detailed 
information about the formatting that you must use in the text-based CSV file.

Note An error occurs if any blank lines exist in the CSV file.
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Step 3 Upload the CSV file to the first node of Cisco Unified CallManager. See the “Uploading a File” section 
on page 2-3.

Additional Topics

See the “Related Topics” section on page A-21.

Cisco Catalyst 6000 (FXS) Ports File Format 
The CSV file contains information about each port as a record. Each record specifies the gateway MAC 
address and port number on that gateway to which you want to add or update the port details. 

Note BAT does not add Cisco Catalyst 6000 (FXS) gateways. It only adds or updates ports to an existing 
gateway.

For the MAC address, enter no MAC address values for an existing Cisco Catalyst 6000 (FXS) gateway. 
This MAC address uses the last 12 characters in the Gateway Name.

If you provide no values for Partition for any record on the CSV file, the system uses values from the 
BAT template for these fields.

The following sample format shows the required field length and string types followed by examples of 
CSV files for Catalyst 6000 (FXS) ports. 

MAC Address (Mandatory, 12 characters),Port Number (Mandatory, 2 numerals),Directory 
Number(Optional, up to 24 numerals and special characters)

Sample
1231123245AB,23,9725557250

Note You must include comma separators even if a field is blank. 
Do not specify a partition unless you have also specified a directory number.

Examples

If the directory number for a port is blank, use this format:

1231123245AB,23,,

If you want to add only the mandatory values, use this format:

1231123245AB,23,,

Additional Topics

See the “Related Topics” section on page A-21.

Creating a Custom Text-Based CSV Files for Client Matter Codes 
and Forced Authorized Codes

To create a custom text-based CSV file, perform the following procedure:
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Procedure

Step 1 Open a text editor (such as Notepad) or any application that allows you to export or create a CSV file.

Step 2 Using a separate line for each code, create a custom Client Matter Codes (CMC) CSV file or a Forced 
Authorized Codes (FAC) CSV file, as described in the following steps:

• For CMC—Step 3 and Step 5

• For FAC— Step 4 and Step 5

Tip Remember that you must create two separate CSV files, one for CMC and one for FAC.

Step 3 To create a CMC CSV file, enter the corresponding information, where x, y represent the following 
fields:

• x—The client matter code (mandatory entry for all additions, updates, and deletions)

• y—The description (optional if you update the entry)

For example, you may enter 5555,Acme Toys, where 5555 equals the mandatory client matter code, and 
Acme Toys equals the description.

Step 4 To create a FAC CSV file, enter the corresponding information, where x,y,z represent the following 
fields:

• x—The forced authorization code (mandatory entry for all additions, updates, and deletions)

• y—The authorization code name (optional if you update the entry)

• z—The authorization level (optional if you update the entry)

For example, you may enter 1234,John Smith,20, where 1234 equals the forced authorization code, John 
Smith equals the authorization code name, and 20 equals the authorization level.

Caution If you add new codes at the same time that you update them, make sure that you enter all required 
information. You can change any part of an existing record, but you must include the code; for example, 
the forced authorization code or client matter code. Deleting information and leaving it blank does not 
remove the information from the database; a blank value does not overwrite an existing value in the 
database, but, updating the value, for example, to Acme Toys, Inc., or John L. Smith from the preceding 
examples, overwrites the existing value in the database.

Step 5 Upload the CSV file to the first node of Cisco Unified CallManager. See the “Uploading a File” section 
on page 2-3.

Step 6 Perform one of the following tasks:

• If you made additions or updates, insert the file in BAT, as described in “Using BAT to Update the 
Cisco Unified CallManager Database” section on page 47-6.

• If you plan to delete code settings, see the “Deleting Code Settings” section on page 48-1.

Note You cannot perform insert and update operations simultaneously with the same CSV file. You have to 
create separate CSV files for insert and update.
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Additional Topics

See the “Related Topics” section on page A-21.

CMC File Format
The following sample format and examples show the fields, field length, and whether the field is optional 
or mandatory for a text-based CSV file for client matter codes.

Client Matter Code(Mandatory, 1 to 16 numerals),Description(Optional, 1 to 50 Characters)

Sample
1234567890123456,Marketing

Example

If the value of the field includes a comma, that field must be enclosed in double quotes. Use this format 
for fields with commas:

1234567890123456,"Marketing, team” 

Additional Topics

See the “Related Topics” section on page A-21.

Updating CMC File Format
Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by examples of CSV files 
for updating client matter codes.

Client Matter Code(Mandatory, 1 to 16 numerals),Description(Optional, 1 to 50 Characters)

Sample
1234567890123456,Marketing

Example

If the description is empty, use this format:

1234567890123456, 

Additional Topics

See the “Related Topics” section on page A-21.

FAC File Format
The following sample format and examples show the fields, field length, and whether the field is optional 
or mandatory for a text-based CSV file for forced authorization codes. 

Forced Authorization Code(Mandatory, 1 to 16 numerals),Authorization Code Name (Mandatory, 1 
to 50 Characters),Authorization Level(Mandatory,values range from 0 to 255)
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Sample
1234567890123456,John FAC,251

Additional Topics

See the “Related Topics” section on page A-21.

Updating FAC File Format
Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by examples of CSV files 
for updating forced authorization codes.

Forced Authorization Code(Mandatory, 1 to 16 numerals),Authorization Code Name (Mandatory, 1 
to 50 Characters),Authorization Level(Mandatory,values range from 0 to 255)

Sample
1234567890123456,John FAC,251

Example

Values you do not want to update must still include the delimiter. If only the Authorization Code Name 
has to be updated use the following format:

1234567890123456,John FAC, 

If only the Authorization level has to be updated, use the following format:

1234567890123456,John FAC, 

Additional Topics

See the “Related Topics” section on page A-21.

Creating a Text-Based CSV File for Call Pickup Groups
To create a custom text-based CSV file, perform the following procedure:

Procedure

Step 1 Open a text editor (such as Notepad) or any application that allows you to export or create a CSV file.

Step 2 Using a separate line for each call pickup group name, create a custom call pickup group CSV file as 
described in the following steps:

Step 3 Enter the Pickup Group Name, Pickup Group Number, Partition, Other Pickup Group Name-Member1... 
Other Pickup Group Name-Member10.

For example, you may enter Marketing,7815,Part1,Marketing,Managers,Training, where Marketing is 
the mandatory pickup group name, 7815 is the mandatory pickup group number. Part1 is the partition, 
Marketing, Managers, and Training are the other pickup group names that are associated to the pickup 
group Marketing.
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Caution Deleting information and leaving it blank does not remove the information from the database; a blank 
value does not overwrite an existing value in the database, but updating the value, for example, to Sales 
from Marketing, from the preceding examples, overwrites the existing value in the database.

Step 4 Upload the CSV file to the first node of Cisco Unified CallManager. See the “Uploading a File” section 
on page 2-3.

Step 5 Perform one of the following tasks:

• If you made additions or updates, insert the file in BAT, as described in “Using BAT to Update the 
Cisco Unified CallManager Database” section on page 47-6.

• If you plan to delete call pickup groups settings, see the “Deleting Code Settings” section on 
page 48-1.

Additional Topics

See the “Related Topics” section on page A-21.

CPG File Format
The following sample format and examples show the fields, field length, and whether the field is optional 
or mandatory for a text-based CSV file for call pickup groups.

Pickup Group Name(Mandatory, 1 to 50 characters),Pickup Group Number(Mandatory, 1 to 24 
numerals),Partition(Optional, 1 to 50 Characters),Other Pickup Group Name-Member1... Other 
Pickup Group Name-Member10(Optional, 1 to 50 Characters) 

Sample
Marketing,7815,Part1,Marketing,Managers,Training

Example

Optional values that you do not want to specify at this time must still include the delimiter (a comma) 
except for Other Pickup Group members. 

If the Partition for a Pickup Group is blank, use the following format:

Marketing,7815, 

Additional Topics

See the “Related Topics” section on page A-21.

Updating CPG File Format
Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by examples of CSV files 
for updating call pickup groups.

Pickup Group Name(Mandatory, 1 to 50 characters),Pickup Group Number(Mandatory, 1 to 24 
numerals),Partition(Optional, 1 to 50 Characters),Other Pickup Group Name-Member1... Other 
Pickup Group Name-Member10(Optional, 1 to 50 Characters) 
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Sample
Marketing,,,Marketing,Managers,Training 

Example

If you do not want to update Other Pickup Group member, do not include the delimiter (a comma). Use 
the following format:

Marketing,,,Managers,Marketing,Training 

Additional Topics

See the “Related Topics” section on page A-21.

Related Topics
• Creating a Text-Based CSV File for Phones, page A-1

• Creating a Text-Based CSV File for Users, page A-6

• Creating a Text-Based CSV File for User Device Profile, page A-9

• Creating a Text-Based CSV File for Cisco Unified CM Assistant Manager-Assistant Associations, 
page A-12

• Creating a Text-Based CSV File for Cisco VG200 Gateways, page A-13

• Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports, page A-15

• Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes, 
page A-16

• Creating a Text-Based CSV File for Call Pickup Groups, page A-19
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